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FOREWORD

Water is often thought of as the source of civilization; hence the hypothesis that the development of
hydraulics is related to the evolution of ancient societies such as those of Mesopotamia and Egypt.
Owing to the structure of the early states, which entailed a closed system of absolute monarchy and
monopoly with only a small number of literate scholars, the pace of technological advancement was
cumbersome. The basket remained the only water-lifting device in Egypt until the sheduf was
introduced during the time of the New Kingdom — almost 3 500 years after the commencement of
agriculture in Egypt and 1 500 years after the rise of the nation-state. The development of the
waterwheel and the Archimedes clean water screw followed 1 000 years later in Alexandria.

Founded by the Egyptian ruler, during the Ptolemies dynasty (323 BC to AD 30), the Mouseion in
Alexandria hosted scholars such as Euclid and Archimedes (287 to 212 BC) who made significant
advances in mathematics of cones and cylinders as well as differential equations leading to major
advances in hydraulic engineering. These Alexandrian scholars laid the foundations of theoretical
hydrology in connection with practical applications. Around the same time the Persians too had
already made an ingenious contribution to hydraulic engineering by developing a water delivery
system known as ganats — a subterranean system of tunnels connecting wells. However, it is the
Romans who were instrumental in expanding the science of hydraulic engineering to various parts of
their empire.

Through the ages, civil engineers have always had to cope with unforeseen natural forces. The
external forces created by climatic change, and further exacerbated by human induced variables, can
unexpectedly and significantly influence the hydrological cycle with serious socio-economic effects.
Although mathematical analysis and modelling cannot cater for every eventuality, we can certainly
attempt to scientifically predict the behaviour of these natural forces and minimise their impacts on
our environment.

South Africa, for instance, is known for its low average annual rainfalls and large seasonal variations.
Despite the latter, abnormal rainfalls have historically had disastrous consequences. Although our
problems are not without precedent, societies are always inter-linked and local catastrophes could have
serious regional and national repercussions.

The channelling of water by societies for usage and development has remained an on-going challenge
since the days of the early mathematicians through to modern-day engineers. We trust that this
Application Guide, published as a guide to both students and practitioners will assist in meeting these
challenges. It must, however, be emphasised that it is merely an aid and should ultimately not replace
sound engineering analysis and judgement.

LeN<E
-F"'-{Y_—
Nazir Alli
Chief Executive Officer
The South African National Roads Agency Limited
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LIST OF SYMBOLS

future value

annual discount rate as a decimal fraction

internal rate of return technique

discount period in years

net present value

rate at which the left-hand and right-hand sides of the equation are equal, resulting
in a NPV of zero

constant

area of catchment (km?)

area reduction factor (%)

area reduction factor (%)

constant

run-off coefficient (dimensionless)

catchment parameter with regard to reaction time

run-off coefficient for rural area with a value between zero and one
rural run-off coefficient incorporating the effect of dolomites

rural run-off coefficient incorporating the effect of dolomites and initial saturation
factor

calibration coefficient (SDF method)

calibration coefficient (SDF method)

run-off coefficient for urban area with a value between zero and one
run-off coefficient for lakes with a value between zero and one
Curve Number

Final Curve Number

Curve Number for wet conditions

retardance factor approximated by the initial Curve Number unadjusted for
antecedent soil moisture

run-off coefficient according to average soil permeability

run-off coefficient according to average catchment slope

combined run-off coefficient for T-year return period (dimensionless)
run-off coefficient according to average vegetal growth

storm duration (hours)

lag coefficient

adjustment factor for initial saturation for return period T

flood run-off factor (%)

height (m)

height of most remote point above outlet of catchment (m)

elevation height at 10% of the length of the watercourse (m)
elevation height at 85% of the length of the watercourse (m)
effective rainfall (mm)

rainfall intensity (mm/hour)

initial losses (abstractions) prior to the commencement of stormflow, comprising of
depression storage, interception and initial infiltration (mm)

average rainfall intensity for return period T (mm/h)

regional constant

constant for T-year return period

constant for T-year return period

dimensionless factor

hydraulic length of catchment along the main channel (m)
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L = hydraulic length of catchment (watercourse length) (km)

L = catchment lag time (h)

distance from outlet to centroid of catchment area (km)

2-year return period daily rainfall from TR102

mean annual precipitation (mm/a)

length of record (years)

mean annual rainfall (mm/annum)

probability (%)

= daily rainfall depth (mm), usually input as a one-day design rainfall for a given
return period

P, =  probability of at least one exceedence during the design life

<25
>
>
TR

o U T S
[

Paver = average rainfall over the catchment for the T-year return period (mm)

P avgir = average rainfall for T-year storm duration (mm)

Pir = point intensity for the return period T (mm/h)

Pr = point rainfall for the return period T (mm)

Pir = the precipitation depth for a duration of # minutes and a return period of T years
dp = peak discharge (m’/s)

Q = peak discharge (m%/s)

Q = stormflow depth (mm)

Q. = peak discharge of unit hydrograph (m?*/s)

Qir = peak discharge for T-year return period (m3/s)

Qp = unit hydrograph peak discharge (m?/s)

QrmF = regional maximum flood peak flow rate (m?%/s)

Qr = peak discharge for T-year return period (m?3/s)

r = roughness coefficient

R = average number of days per year on which thunder was heard (days/year)
S = potential maximum soil water retention (mm),

Sav = average slope (m/m)

T = time (hours)

T = return period (years)

Tc = time of concentration (hours)

TL = lagtime L (hours)

T, = time to peak (hours)

Tsp = storm duration (hours)

t = duration (minutes)

o = area distribution factor

B = area distribution factor

Y = area distribution factor

Aqp = peak discharge of incremental unit hydrograph (m’/s)

AQ = incremental stormflow depth (mm)

AD = unit duration of time, used with the distribution of daily rainfall to account for
rainfall intensity variations (hours)

f30 = 30-minute rainfall intensity for the 2-year return period (mm/h)

Chapter 4

A = sectional area (m?)

Ay = upstream sectional area (m?)

As =  downstream sectional area (m?)

B = free surface width of cross section (m)

C = Chézy constant

E =  specific energy (m)

Fr = Froude number
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gravitational acceleration (m/s?)

transition loss (m)

friction losses (m)

measure of absolute roughness (m)

distance (m)

wetted perimeter (m)

discharge per unit width (m?3/s/m)

discharge (m®/s)

centre line radius (m)

hydraulic radius i.e. area divided by wetted perimeter (m)
Reynolds number

Bed slope (m/m)

energy slope, which is equal to bed slope only when flow is uniform (m/m)
uniform channel velocity (m/s)

average velocity (m/s)

critical flow velocity (m/s)

~ 5B
= E
[

@

IS OO0 T
[ | ||

o

w2
S
Il

o

= depth of flow measured perpendicular to the streambed (m)

<< <« <<
[

= distance between water surface and centre of gravity of section (m)
Ye = critical flow depth (m)

normal/uniform flow depth (m)

bed level at point where depth of flow =y (m)

specific weight (value for water 9,8 x 10° N/m”)

distance (m)

mass density = 1 000 kg/m’ for water

= kinematic viscosity (= 1,14 x 10° m?¥/s for water)

SO >= N
>< =1
1 | | R T |

5

F
=3
o
a
[}

= effective cross-sectional plan area of the opening (m?)

cross sectional area (m?)

total flow width (m)

inlet coefficient (0,6 for sharp edges or 0,8 for rounded edges)
Chézy constant

discharge coefficient

flow depth of water (mm)

depth of flow (m)

particle size (m)

side slope particle size (m)

specific energy (m)

blockage factor (say, 0,5)

Froude number

total energy head above grid (m)

energy head = flow depth for upstream conditions (m)

head (m)

rainfall intensity (mm/h)
discharge coefficient

length of flow path (m)
Manning roughness value (s/m
road crossfall (%)

road gradient (%)

wetted parameter (m)
discharge (m?/s)

hydraulic radius i.e. area divided by wetted perimeter (m)
= energy gradient (m/m)

&)
| | B R
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S = bed slope (m/m)

St = slope of flow path (m/m)

v = average velocity (m/s)

W = width of roadway (m)

y = depth of flow at deepest point (m)

Chapter 6

Agver = area of flow over structure at the flow depth selected (m?)

At = the effective inlet area through the structure (m?)

B = the width of the channel (or the length of the structure) (m)

d = depth of flow over the structure (m)

D = the height of the soffit of the deck above the river invert level (m)
fi = adimensionless factor related to the design level

Fr = Froude number

g =  gravitational acceleration (9,81 m/s?)

Lp = the total width of the deck of the structure (m)

n = Manning n-value (s/m'?)

Neoncrete = Manning roughness coefficient of concrete (s/mm)

Nyiver = Manning roughness coefficient of the river bed (s/m” 3)

Peent = the total wetted perimeter of each cell (m)

Peoncrete = the part of the wetted perimeter that has a concrete surface per cell (m)
Pt = X P (effective wetted perimeter for the flow passing through the structure) (m)
Pover = wetted perimeter at the flow depth selected (m)

Priver = the part of the wetted perimeter that is made up by the riverbed per cell (m)
Q = discharge with a 1:2 year return period (m?/s)

Qdesign = design discharge (m?/s)

Qover = discharge over the structure within the selected flow depth (m3/s)
Qunder = discharge capacity of the openings through the structure (m?/s)
R = hydraulic radius (m)

So = slope in direction of flow (m/m)

V under = average velocity of flow through the structure (m/s)

X = thickness of the deck (depending on the structural design outcome) (m)
Chapter 7

A = cross sectional area (m?)

B = width (inside of culvert) (m)

Cg = inlet coefficient for culverts

Cu = inlet coefficient for culverts

D = inside diameter (m)

D = height (inside of culvert) (m)

Fr = Froude number

he, = friction losses between cross-section 1 and 2 (m)

> hy, = transition losses between cross-section 1 and 2 (m)

H, = upstream energy level, relative to the invert level (m)

H, = downstream energy level, relative to the invert level (m)

Kin = inlet secondary loss coefficients

Kout = outlet secondary loss coefficients

R = hydraulic radius i.e. area divided by wetted perimeter (m)

So = natural slope (m/m)

S. = critical slope (m/m), where Fr=1

v = average velocity (m/s)

Vi = normal flow depth (m)

Ve = critical flow depth (m)
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Chapter 8

A, = flow area at section 1 (m?)

Ay = flow area at section 4 (m?)

A, = flow area at for normal flow conditions (m?)

A = projected flow area at constricted section 2 below normal water level (m?)
B = mean channel width (m)

B, = mean channel width for normal flow conditions (m)

B, = total flow width for the normal stage (m)

b = pier width (m)

C = Chézy coefficient

(O = backwater coefficient

D = flow depth (m)

dso = average particle diameter (m)

Dso = median size of bed material (m)

davg = average depth in the main channel

D. = critical particle size for the critical velocity V. (m)

ds = local scour depth at pier (m)

Es = specific energy (m)

Fp = distance of the design flood, Qr, below a deck soffit (underside of deck) (m)
Fr = Froude number

Fr, = Froude number directly upstream of the pier

F, = side factor to describe bank resistance to scour

Fspp = freeboard to shoulder breakpoint (m)

g = gravitational acceleration (9,81 m/s?)

h* = backwater damming height, afflux (m)

h*;A = backwater damming height abnormal stage conditions (m)
ks = absolute roughness of river bed (m)

K’ = secondary energy loss coefficient

K = pier shape coefficient (1,5 for round-nosed and 1,7 for rectangular piers)
K = factor applied for abutments

K, = afactor defined

K, = correction for pier nose shape

K, = correction factor for angle of attack of flow

K; = correction factor for bed condition

K4 = correction factor for armouring due to bed material size

L = pier length (m)

n = Manning’s coefficient of roughness (s/m'"?)

Q = total discharge (m%/s)

Q = equivalent steady discharge which would generate the channel geometry (m?*/s)
Qr = design flood (m?/s)

Qur = twice the recurrence interval design flood (m?3/s)

S = energy slope (m/m)

s = specific gravity of soil particles

SF = required stability factor to be applied

q = discharge per unit width (m?/s.m)

q = discharge through the sub-channel (m*/s.m)

\Y = velocity on pier (m/s)

v, = average velocity through sub-channel (a, b or ¢)

v, = average velocity through Section 1 (m/s)

v, = mean velocity upstream of the pier (m/s)

v, = average approach velocity (m/s)

Vou = average velocity in constriction during abnormal stage conditions (m/s)
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Ve = average critical velocity in constriction (m/s)

Voo = average flow velocity at section 2 based on A,

v, = average velocity in the main channel

Ve = shear velocity (m/s)

Vi, = critical shear velocity (m/s)

Vi = approach velocity when particles at pier begin to move (m/s)

A% = characteristic average velocity in the contracted section (m/s)

Vs = particle settling velocity (m/s)

Vr = velocity ratio

Veso = critical velocity for Dsy bed material size (m/s)

Voo = critical velocity for Dyy bed material size (m/s)

y = mean depth of flow (m)

y = depth of flow in the contracted bridge opening (m)

y = projected normal flow depth in the constriction (m)

Yo = depth upstream of pier (m)

Vi = flow depth directly upstream of pier (m)

V2 = flow depth under bridge (m)

Vae = critical depth in constriction (m)

Vs = scour depth (m)

Y, = total maximum scour depth (m)

Yo = maximum general scour depth (m)

Y = local scour depth (m)

o = velocity coefficient

o = velocity head coefficient for the constriction

0 = bank angle with the horizontal (°)

p = density of water (kg/m’)

P = dry bulk density (kg/m®)

Ps = saturated bulk density (kg/m’)

0] = riprap angle of repose (°)

Te = critical tractive stress for scour to occur (N/m?)

v = kinematic fluid viscosity (m?%s)

Chapter 9

A = full-flow area (m?)

A, Ay = full-flow area for the inlet pipe and outflow pipe (m?)

D = pipe inner diameter (m)

g = gravitational acceleration (9,81 m?/s)

h = difference in elevation between the highest incoming pipe invert and the centreline
of the outlet pipe (m)

hei = friction losses between cross-section 1 and 2 (m)

hp = minor loss (m)

hyj = secondary losses between cross-section 1 and 2 (m)

k = minor loss coefficient

ks = absolute roughness of conduit (m)

n = coefficient of roughness (s/m"”)

P = wetted perimeter (m)

Q = flow rate (m%/s)

R = hydraulic radius (m) — A/P

S = slope of the energy grade line (m/m)

Vi, V2 = velocity of flow in the inlet pipe and outflow pipes (m/s)

Ve = critical depth (m)
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Chapter 10
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Chapter 11
A

dy

invert elevations of the inflow pipes relative to the outlet pipe invert (m)
specific weight (value for water 9,8 x 10° N/m’®)
kinematic viscosity (m?*/s)

vertical dimension of the existing culvert.

the change in storage over the time step of dt (m°)

average inflow (m?/s)

auxiliary function (m?/s)

outflow through culvert (m3/s)

average outflow (m?3/s)

design flood for the design return period which was obtained from the review of
the road classification, R¢g and the index flood, Q, (m*/s).

maximum calculated existing inlet capacity of the culvert by limiting the total
energy head to 1,2D (m?/s)

maximum calculated current existing hydraulic capacity of the culvert by limiting
the total energy head to be equal to the shoulder brake point level (SBP) (m?/s)
design flood for the design return period which was obtained from the review of
the road classification, Rc_jand the index flood, Q.o (m3/s)

index flood for the contributing catchment with a return period of 20 years (m?/s)
flow rate related to a return period twice that which was obtained for the design
flood, Qro (M3/s)

flood rate related to a return period twice that which was obtained for the design
flood, Qr; (m%/s)

original road classification

reflects the selection of a road classification which is one class less than that
determined for the road

temporal storage or ponding volume (m?)

sum of the storage volume of the prism and the wedge (m”)

design return period

time of concentration (h)

total time during the routing of the flood when the upstream energy head is more
than 1,2D (h)

maximum storage volume upstream of the culvert assuming level-pool routing
conditions and an inflow hydrograph with a peak flow rate of Qr; and a triangular
distribution with a base width of 3T, and the peak discharge occurring at T, (m?)
calculated storm volume based on the assumption of an inflow hydrograph with a
peak flow rate of Qr and a triangular distribution with a base width of 3T, and the
peak discharge occurring at T, (m?®)

a dimensionless weighting factor indicating the relative importance of the inflow
(D) and the outflow (O) in determining the storage (S) in the reach

change in storage volume (m?)

time step that is used (s)

average volumetric inflow (m?)

average volumetric outflow (m?)

cross sectional flow area (m)
top width (m)
change in water depth (m)
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dx = distance over which change occurs (m)
sc specific minimum energy (m)

sl
Il

Fr = Froude number

g = gravitational acceleration (m/s?)

h =  stage height (m)

Q = flow rate (m?/s)

S = bed slope (m/m)

Se = critical slope (m/m)

S¢ = represents the slope of the total energy line

So = bed slope (m/m)

\Y = mean cross-sectional velocity

y = flow depth (m)

Ve = critical flow depth (m)

Y = normal flow depth (m)

a = velocity coefficient

AE; = specific energy (m)

Chapter 12

A = surface area (m°)

A, =  geotextile area available for flow (m?)

Ay = total geotextile area (m?)

AOS = apparent opening size (mim)

B = acoefficient (dimensionless)

B = width of collector drain (m)

C, = the uniformity coefficient

d = diameter of pipe (m)

Dgs = soil particle size for which 85% of openings are smaller (mm)
Dy = the sieve size through which x% of the material passes (mm)
g = longitudinal slope of the road (m/m)

i = hydraulic gradient (m/m)

I = design infiltration rate (mm/h)

k = Darcy coefficient of permeability (m/s) and

ks =  permeability of material (m/day)

ks, =  permeability of an open-graded layer (m/day)

k; = permeability of the channel backfill (m/day)

L = length of the pipe (m)

L = length of paving (1 m wide) subject to infiltration (m)
n = Manning’s n (s/m"?)

Ny = porosity of an open-graded layer

Ogs = opening size in geotextile for which 95% of openings are smaller (mm)
P = 1h duration/1 year return period rainfall intensity (mm/h)
q = drainage rate (mm/day)

q = discharge per meter width (m?/s.m)

S = spacing (m)

S = cross-slope of a drainage layer (m/m)

S, = slope of the pipe (m/m)

t = depth of flow in material (mm)

T = drainage period for layer (h)

ty = thickness of drainage layer (mm)

ty = effective thickness of drain layer (mm)

W = width of the drainage layer (m)

\ = geotextile permittivity
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1 CHAPTER 1 - INTRODUCTION

The SANRAL Drainage Manual had a major update in 2006 which included additional chapters,
worked examples and links to applicable drainage software. SANRAL decided to revise and upgrade
the manual to be used as a user tool for all persons involved in the design of drainage structures and
systems. The purpose of the Drainage Manual (cover shown in Figure 1.1) is to provide a reference
document with regard to drainage and to demonstrate and reference some software for the modelling
and analysis of drainage problems.

The numerous worked examples were well received by industry as well as academia whom prescribe
the Drainage Manual as part of the Civil engineering curriculum that it was decided to expand this.
The document was split into the Drainage Manual and the Drainage Manual Application Guide (this
document).

The South African National Roads Agency SOC Limited

DRAINAGE
MANUAL

6th Edition

Figure 1.1: SANRAL Drainage Manual
The Drainage Manual Application Guide contains the following:
e Hand calculations of typical problems.
e Reference to applicable software utilities and user manuals for the programs.

e Step-by-step worked examples using freeware software programs.
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1.1 Layout of the Drainage Manual Application Guide

The Drainage Manual Application Guide contains twelve chapters. The focuses in the different
chapters are:

Chapter 1: Provides an introduction to the Drainage Manual Application Guide.

Chapter 2: Review the economic considerations.

Chapter 3: Illustrate the various flood calculation methods for different recurrence intervals.
Chapter 4: Reflects basic hydraulic calculations.

Chapter 5: Demonstrates surface drainage design.

Chapter 6: Hydraulic analysis of low-level crossings.

Chapter 7: Contains analysis and design details for lesser culverts and storm water pipes.
Chapter 8: Focuses on bridges and major culverts and scour at these structures.

Chapter 9: Storm water analyses and design.

Chapter 10: Assessment of hydraulic capacity of existing drainage structures and the application of
flood routing.

Chapter 11: Free surface flow determination.
Chapter 12: Discusses sub-surface drainage.

It is trusted that the document will provide valuable assistance in the design of drainage systems.
References to all the figures and literature can be found in the Drainage Manual
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2 ECONOMIC EVALUATION OF DRAINAGE SYSTEMS

The following three simple examples have been included to illustrate the use of the economic
evaluation procedures. The supporting software is capable of determining the NPV, IRR and LCA for
more complex income and expenditure streams. It is suggested that the supporting software be used to
conduct sensitivity analyses.

2.1 Example 2.1 — Net Present Value

Evaluate which of the future income streams S1 or S2 is more favourable if the cost of capital is 10%
on a yearly basis and the amounts realize at the beginning of the year.

Year S1 S2
1 250 100
2 350 400
3 600 350
4 100 600
5 400 250

Solution Example 2.1

If you assume year 1 to be the base year then the NPV’s of the two income streams are:
NPVs; =R1412.39
NPVs, =R1 374.43

These calculations reflect that the income stream S1 is more favourable when comparing the Net
Present Values (NPV).

The NPV was calculated using the following formula:

NPV = F ..(2.D)
(1+1)
Where:
F = future value
1 = interest rate
n = periods

Each future value was brought back to present values and accumulated to obtain the total NPV for
each income stream.

2.2 Example 2.2 — Present Value

Determine the current investment that should be made for the replacement of a R1,5 million
installation (current cost) after 15 years, if the expected CPIX is 15 % and the return on a fixed
investment is 8% p.a.

Solution Example 2.2

Firstly the future value (F) of the investment should be determined. The current installation (P) is
worth R1 500 000 and the escalation will be 15 % for a 15-year period.

F=P(1+i) (2.2
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F=1500000(1+0,15)° =R12205592

Now the current investment (P) should be calculated by discounting the future required value (F) by
8% per annum for the 15-year period.

p= .(23)
(1+i)

p= 12209992 _pigyr71
(1+0,08)

2.3 Example 2.3 — Internal Rate of Return (IRR)

Determine the Internal Rate of Return (IRR) for the following cash flow.

Year Cash flow
0 -1 300
1 250
2 350
3 600
4 100
5 400

Solution Example 2.3
The internal rate of return is the rate where the NPViycome = NPV eypenditure

NPV _ 250 N 350 N 600 N 100 N 400 24)

(i) (i) (1+i) (1+i) (1+i)

NPVexpenditure = L000 .. (25)
(1 + 1)

Equation (2.11) = Equation (2.12)

250 350 600 100 400 1300
+ + + + =

(1+i)  (+i)° @+i) @+ Q+if (1+i)

17341
1

Solving from this equation for

IRR =9,525%
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3 FLOOD CALCULATIONS

The main aim of this section is to provide the reader with a step-by-step explanation of the procedures
used to calculate flood magnitudes for different return periods.

In the two paragraphs below, flood peaks will be calculated for a small as well as a large catchment
using the various relevant deterministic, statistical and empirical methods.

3.1 Worked example 3.1 - Small catchment

The first worked example reflects the flood calculation for a small bridge on the Moretele Spruit,
which runs through the eastern part of Pretoria in a north-westerly direction (see Figure 3.1).

The small bridge, as shown in Figure 3.2, is located in Pretoria East (location indicated on Figure
3.1). The flooding of the bridge has to be analysed for the 1:20 year and 1:50 year recurrence interval
flood peaks to determine the risk of flooding Hans Strijdom Drive, which has become an important
artery in the eastern suburbs of Pretoria.

Small bridge
| structure
across the
Moretele Spruit

yd M& ma_‘m N MM'\“ ; s " 2 3 \ ] :
)\ ﬁ‘:' L AARET v el narTURE RE S§R’\M>\/ NG [‘\ A‘“/::%L LS

Figure 3.1: Moretele Spruit catchment area (shown on a 1:50000 topographical map)
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Figure 3.2: Small Bridge across the Moretele Spruit (Hans Strijdom Drive)
3.1.1 Rational method
Data requirements

The Rational method requires the following data:

o Area of catchment

. Length of longest watercourse and average slope to calculate time of concentration

o Catchment characteristics to calculate run-off coefficients

. Mean annual precipitation and rainfall region to determine average rainfall intensity
Calculation procedure

Step 1: Determine the catchment area (km?).
Topographical maps (1: 50 000) are normally used to determine the area of a catchment.
However, the accuracy and contour intervals on these maps are not always as required and it
is often useful to obtain 1: 10 000 maps, if available. Ortho-photographs should also be
used, if available. Use graph paper or a planimeter to determine the total catchment area,
which will contribute to the peak flow. Pans or areas that are artificially isolated should thus
be excluded.

The use of Geographical Information Systems (GIS) has permeated almost every field in the
engineering, natural and social sciences. GIS do not inherently have all the hydrological
simulation capabilities that complex hydrological models do, but are used to determine many
of the catchment parameters that hydrological models or design flood estimation methods
require. Other software applications such AutoCAD could also be used to determine the
catchment area.
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The catchment area of the Moretele Spruit up to the small bridge is 28,5 km? as shown in
Figure 3.3.

| f ®
3
gy
1 : o
\
| | s ..
4
\ )
5 8
Ao g«
B | a

Figure 3.3: Determined catchment area

Step 2: Determine the length of the longest watercourse (km).
For the defined catchment area as required for Step 1, the longest watercourse and its length
are determined. The length of the watercourse for this example is L = 7,25 km.

Step 3: Determine the average slope of the longest watercourse.
Utilising the 10-85 method (m/m) as developed by the US Geological Survey, and tested by
the UK Institute of Hydrology, calculate the average slope. A longitudinal profile of the
Moretele Spruit along the longest watercourse is shown in Figure 3.4.

Sav _ H0,85L _HO,IOL .. (3.D
(1000)0,75L)

where:
S.w = average slope (m/m)

Ho oo = elevation height at 10% of the length of the watercourse (m)

Hogs. = elevation height at 85% of the length of the watercourse (m)

L = length of watercourse (km)
The elevation at 10% of the length of the longest watercourse is Hy o, = 1 412,1 m and at
85% of the length the elevation is Hygs;, = 1 528,8 m.

The calculated average slope for this example is 0,02146 m/m.
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Step 4:

Step 5:
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Figure 3.4: Longitudinal profile of the Moretele Spruit

Calculate the time of concentration from catchment characteristics. The recommended
empirical formula for calculating the time of concentration in natural channels has been
developed by the US Soil Conservation Services.

08702 )"
T. =|—>——"— ...(3.2)
¢ (1 000S,, ]
where:
Tc = time of concentration (hours)
L = length of watercourse (km)
S.w = average slope (m/m)

In most cases the longest water path includes both overland and channel flows. In large
catchments the channel flow is usually dominant, but in small catchments it may be
necessary to determine Tc as the sum of the flow times for both the overland and channel
flow stretches. To obtain a broad indication, it may usually be accepted that a defined
watercourse exists when the average slope of the catchment is greater than 5 per cent and the
catchment itself is larger than 5 km?.

The time of concentration of the Moretele Spruit up to the specific point is 7¢c = 1,338 hours.

Obtain the mean annual precipitation (MAP), from the South African Weather Service or
from the simplified Figure 3.5.

When there are two or more rainfall stations in the catchment area the Thiessen method or
weighted area method can be used to determine the representative rainfall for the catchment.
The catchment area in this example contains one rainfall station within the catchment and
two adjacent as shown in Figure 3.6.
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Figure 3.5: Mean Annual Precipitation
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Figure 3.6: Rainfall stations used in determining the representative MAP
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The weighted area method was used to determine the representative mean annual
precipitation as shown in Table 3.16 based on the applicable areas. All the stations in this
example are located in a straight line and thus the Thiessen method could not be utilized in
this example.

Table 3.1: Mean annual precipitation of catchment area

Weather Service rainfall Latitude Longitude MAP Area
station D M D M (mm) (km?)

0513529 — Garsfontein 25° 49 28° 18' 771.,8 16,53
0513531 - Rietvlei Agr. 25° 51 28° 18 714,0 9,69
0513528 - Constantia Park 25° 48 28° 18 702,5 2,28
Total 746,6 28,5

Also determine the rainfall region in which the catchment falls.

The mean annual precipitation (MAP) for this catchment is 746,6 mm (see Table 3.1) and
the catchment is located in the inland region.

Historically there have beem a number of ways in which the rainfall intensity could be
determined. These alternative methods have been retained in this document although the latest
method using the Design Rainfall Estimation Software is recommended (Alternative 3).

e Alternative 1 — Original method using Depth-Duration-Frequency Diagram.

e Alternative 2 — The TR102 representative rainfall data and the modified Hershfield equation
is used (in the past this was referred to as the Alternative Rational Method).

e Alternative 3 — The design rainfall from the Design Rainfall Estimation software is used to
determine the point rainfall of the catchment.

Alternative 1

Step 6a: Determine the point rainfall values (Pt) (mm) for the required return periods. Based on the
mean annual precipitation (MAP), the rainfall region, the time of concentration (T¢) and the
required return period, Figure 3.7 can be used to determine the point rainfall. As shown in
Figure 3.7 the point rainfall for the 1:20 year and 1:50 year return periods are determined
using the co-axial Depth-Duration-Frequency diagram.

The point rainfall for the 1:20 and 1:50 year return periods is P,g = 78 mm and Psg = 104 mm
respectively.

Step 7a: Calculate the point intensity (mm/hour)

The point intensity (P;r) is the point rainfall divided by the time of concentration (if T¢ >
0,25 hours). If T¢ < 0,25 hours divide by 0,25 hours.

Py
= ...(33)
T T,
where:
Pir = point intensity for the different return periods (mm/h)
Pr = point rainfall (mm)
Tc = time of concentration (hours)

The point intensities for the 1:20 and 1:50 year return periods are Py =583 mm/h and
Piso = 77,7 mm/h respectively.
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Figure 3.7: Determining the point rainfall utilizing Depth-Duration-Frequency diagram

Step 8a: Determine the area reduction factors (ARF) for the different return periods.

In this example the catchment area is small and thus Figure 3.8 is used. The resulting ARFs
are ARFy = 94% and ARFs, = 9126 for the 1:20 and 1:50 years return periods respectively.
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Figure 3.8: Expected percentage run-off as a function of point intensity (small areas), ARF

Step 9a: Determine the average rainfall intensity or effective catchment precipitation.

ARE;
=P ...(34
I, PIT( 100) (3.4)
where:

It = rainfall intensity averaged over the catchment in millimetres/hour
for the return period T.

ARFr = area reduction factor as a percentage for return period T (should be
smaller than 100%)

Pir = point intensities for the different return periods (mm/h)

The average rainfall intensities are I,y = 54,79 mm/h and Isy = 70,71 mm/h.
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Alternative 2

Step 6b: Determine the representative rainfall from the available TR102 South African Weather
Service stations in and around the catchment (see Table 3.2).

Table 3.2: Representative rainfall station from TR102

Weather Service station Pretoria (The Willows)

Weather Service station no 513524

Mean annual precipitation 647 mm

Coordinates 25°44'28° 18'

Duration Return period

(days) 2 5 10 20 50 100 200
1 day 60 83 101 121 150 175 202
2 days 75 105 129 155 192 224 259
3 days 83 117 143 171 211 245 282
7 days 110 160 199 241 303 355 412

Step 7b: Based on the calculated time of concentration and representative rainfall, determine the
precipitation depth. In this example the time of concentration is 80 minutes, in other words
less than 6 hours, and thus the modified Hershfield relationship will be used.

P, =1,13(0.41+0,64InT)(~ 0,11+ 0,27Int ) (0,79M **R **') ... (3.5)
where:

P,r = precipitation depth for a duration of t minutes and a return period of T

years (mm)

t = duration (minutes)

T = return period

M = 2-year return period daily rainfall from TR102

R = average number of days per year on which thunder was heard (days/year)

(Figure 3.9)

The average number of days on which thunder was heard (R) is equal to 61 and M is
60 (from Table 3.2). The calculated precipitation depths are:
Pt20 = 85,55 mm and P[50 = 107,]0 mm

Step 8b: Calculate the point intensity (mm/hour)
The point intensity (P;r) is the point rainfall divided by the time of concentration (if T¢ >

0,25 hours). If T¢ < 0,25 hours, divide by 0,25 hours.
P

P, =—" ... (3.6)
T TC
where:
Pir = point intensity for the different return periods (mm/h)
Pir = precipitation depth for a duration of t minutes and a return period of T
years (mm)
Tc = time of concentration (hours)

The point intensity for the 1:20 and 1:50 year return periods is Pio = 63,93 mm/h and
Piso = 80,04 mm/h respectively.
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Figure 3.9: Average number of days per year on which thunder was heard

Step 9b: Determine the area reduction factors (ARF) for the different return periods from Figure 3.10
or equation 3.7.

ARF = (90000 — 12800InA + 9830In(60T,. ))** .37
where:
ARF = area reduction factor as a percentage (should be less than 100%)
A = catchment area (km?)

Tc time of concentration (hours)
The resulting ARF = 96 % for the 1:20 and 1:50 years return periods.

Step 10b: Determine the average rainfall intensity or effective catchment precipitation

I, =PiT{ARFTj ... (3.9)
100
where:

It = rainfall intensity averaged over the catchment (mm/h) for the
return period T.

ARFr = area reduction factor as a percentage for return period T (should
be smaller than 100 %)

Pir =  point intensities for the different return periods (mm/h)

The average rainfall intensities are Iy = 61,4 mm/h and lso = 76,9 mm/h.
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Figure 3.10: Area reduction factors
Alternative 3

This is the preferred method of obtaining point rainfall data for use in the
Rational Method procedure.

Step 6¢: The design rainfall from the Design Rainfall Estimation software is the recommended
method to determine the point design rainfall of a catchment (see Figure 3.11). Utilising the
Design Rainfall Estimation in South Africa software application the representative weather
station or coordinates as shown in Figure 3.12 can be entered. A summary of all the closest
rainfall stations as well as the n-day rainfall values as shown in Figure 3.13 is obtained. The
software enables the estimation of design rainfall for durations ranging from 5 minutes to 7
days and for 2 to 200 year return periods at any 1' latitude x 1' longitude point in South
Africa.

Enter the coordinates or station and click on the proceed button (Figure 3.12) to obtain a
summary of all the closest rainfall stations as well as the n-day rainfall values (see Figure
3.13).
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Figure 3.11: Snapshot of design rainfall database

Design Rainfall Estimation in South Africa

About

Search Method
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Help
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Figure 3.12: Design Rainfall estimation software
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" 1
| Moretele Spruit.bt - Notepad =3 Eoh =<

File Edit Format View Help

user selection has the following criteria: -

Station Number: 0513529

purations requested: 5m, 10 m, 15m, 30 m, 45m, 1 h, 1.5h, 2h, 4 h, 6h, 8h, 10 h, 12 h, 16 h, 20 h, 24 h, 1 d, 2d, 3d, 4d, 5d, 6 d|E

Return Periods requested: 2 yr, 5 yr, 10 yr, 20 yr, 50 yr, 100 yr, 200 yr

Block Size requested: 3 minutes

pata extracted from paily Rainfall Estimate Database File

The station selected and the five closest stations are listed

Station Name SAWS Distance Record Latitude Longitude MAP Altitude Duration Return Period (years)

Number (km) (vears) (') (") (P? ') (mm) (m) (m/h/d) 2 2L 2u 5

GARSTFONTEIN 0513529 W 0.0 34 25 49 28 17 741 1440 1d 55.9 55.6 56.2 77.2 76
2d 73.3 72.8 73.8 101.6 101
3d 82.0 81.6 82.3 112.9 112
4d 90.1 89.7 90.5 122.9 122
5d 95.7 95.3 96.2 130.2 129
6d 102.9 102.5 103.7 139.8 139
7d 108. 3 107.8 108.8 146.6 145

RIETVLEI-AGR. 0513531_A 4.0 21 25 51 28 18 743 1510 1d 61.4 61.1 61.7 84.8 84
2d 71.8 71.4 72.3 99.6 99
3d 78.5 78.2 78.9 108.2 107
4.d 85.5 85.2 85.9 116.7 116
5d 92.6 92.2 93.1 126.0 125
6d 97.4 96.9 98.1 132.2 131
7d 101.7 101.3 102.2 137.7 137

PRETORIA-LYNNWOOD 0513496_W 5.4 S5 25 46 28 17 706 1360 1d 57.4 57.1 57.6 79.2 78
2d 70.3 69.9 70.8 97.6 96
3d 79.1 78.7 79.4 109.0 108
4.d 85.7 85.3 86.0 116.9 116
5d 92.5% 92.1 93.0 125.8 125
6 d 99.5 99.1 100.3 135.2 134
7d 105.1 104.7 105.6 142.3 141

PRETORIA-WATERKLOOF-CNT RY 0513437 _w 6.5 81 25 47 28 14 741 1470 1d 62.3 62.0 62.6 86.0 85
2d 78.4 77.9 78.9 108.7 108
3d B86.5 86.1 86.9 119.2 118
4.d 93.2 92.8 93.6 127.2 126
5d 100.1 99.7 100.7 136.2 135
6d 106.3 105.9 107.2 144.4 143
7d 110.7 110.2 111.1 149.8 149

PTA-UNIV-PROEFPLAAS, 0513465_A 7.4 50 25 45 28 16 687 1360 i1d 57.8 57.5 58.0 79.8 79
2d 70.1 69.6 70.6 97.2 96
3d 78.6 78.2 78.9 108.3 107
4d 86.1 85.7 86.4 117.4 116
5d 94.6 94.2 95.1 128.7 128
6 d 101.4 101.0 102.2 137.7 137
7d 108.1 107.6 108.6 146.4 145

PRETORIA-BROOKLYN-3 0513405_w 7.6 31 25 46 28 14 692 1400 1d 62.2 61.9 62.5 85.9 85
2d 75.6 75.1 76.1 104.9 104
3d 85.3 84.9 85.7 117.5 117
4d 93.4 93.0 93.8 127.5 126
5d 100.1 99.7 100.7 136.2 135
6 d 104.7 104.2 105.5 142.2 141
7d 111.5 111.0 112.0 150.9 150

« it »

Figure 3.13: Design Rainfall estimation results

Step 7c: Based on the calculated time of concentration and representative rainfall, determine the point
rainfall values (see Figure 3.14) for the catchment area.

The calculated precipitation depths are Py, = 57 mm and Pyso = 70 mm.
Step 8c: Calculate the point intensity (mm/hour)

The point intensity (P;r) is the point rainfall divided by the time of concentration (if T¢ >
0,25 hours). If Tc £0,25 hours, divide by 0,25 hours.

-1 ... (3.9)

iT ,1]:
where:
Pir = point intensity for the different return periods (mm/h)
P;r = precipitation depth for a duration of t minutes and a return period of T
years (mm)
Tc = time of concentration (hours)

The point intensity for the 1:20 and 1:50 year return periods is Py = 42,6 mm/h and Piso = 52,3 mm/h
respectively.
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| Moretele Spruit.bt - Notepad =3 Eoh =<
File Edit Format View Help
Gridded values of all points within the specified block
Latitude Longitude map altitude puration Return Period (years)
¢y ) Y ) (om) (m) (m/h/d) 2 20 2u 5 sL 5u 10 10L 10u 20 2
25 51 28 17 716 1520 5m 8.7 8.0 11.3 13.3 11.1 15.6 16.1 13.4 18.9 19.1 15 %
10 m 14.4 12.1 16.6 19.8 16.7 23.0 24.0 20.2 27.8 28.4 23
15 m 18.1 15.4 20.8 25.0 21.3 258.8 30.2 25.7 34.8 35.8 30
30m 22.9 19.6 26.3 1.7 27.1 36.3 38.3 32.8 43.8 45.3 38
45 m 26.3 22.6 30.1 36.4 31.2 41.5 44.0 37.8 50.2 52.0 44
1h 29.0 25.0 33.1 40.1 34.5 45.7 48.5 41.8 55.3 57.4 49
1.5 h 33.3 28.8 37.9 46.0 39.8 52.3 55.7 48.1 63.3 65.9 56
2 h 36.8 31.9 41.7 50.8 44.0 57.6 61.4 53.2 69.6 72.7 62
4 h 43.4 38.1 48.7 59.9 52.6 67.3 2.5 63.6 Bl.4 85.8 75
6 h 47.9 42.3 53.4 66.1 58.4 73.7 79.9 70.6 89.1 94.5 83
8 h 51.3 45.6 56.9 70.8 62.9 78.6 85.6 76.1 95.1 101.3 89
10 h 54.1 48.3 59.9 74.7 66.7 82.7 90.3 80.6 100.0 106.8 95
12 h 56.5 50.6 62.4 78.0 69.9 86.2 94.3 B4.5 104.1 111.6 99
16 h 60.5 54.5 66.5 83.6 75.3 91.9 101.0 91.0 111.1 119.6 107
20 h 63.8 57.7 70.0 88.1 79.7 96.6 106.6 96.4 116.8 126.1 113
24 h 66.7 60.5 72.9 92.1 83.6 100.7 111.3 101.0 121.7 131.8 119
1id 55.5 50.3 60.6 76.6 69.5 83.7 92.6 84.0 101.2 109.6 99
2d 68.3 63.5 73.1 94.3 87.7 101.0 114.1 106.0 122.1 135.0 125
3d 77.2 72.7 81.7 106.6 100.4 112.8 128.9 121.4 136.3 152.5 143
4d B4.1 78.6 89.6 116.1 108.6 123.8 140.4 131.2 149.6 166.2 154
5d 89.9 83.5 96.3 124.1 115.4 133.0 150.1 139.4 160.8 177.7 164
6d 95.0 87.7 102.2 131.1 121.2 141.1 158.5 146.5 170.6 187.6 172
7d 99.4 91.5 107.4 137.3 126.4 148.3 166.0 152.7 179.3 196.5 180
25 52 28 17 702 14935 sm 9.5 7.9 11.1 13.2 11.0 15.4 15.9 13.2 18.6 18.8 15
10 m 14.3 12.1 16.5 19.7 16.7 22.8 23.9 20.1 27.6 28.2 23
15 m 17.9 15.2 20.6 24.7 21.0 25.4 29.8 25.4 34.3 35.3 29
30m 22.7 19.4 26.0 31.4 26.9 35.9 37.9 32.5 43.4 44.9 38
45 m 26.2 22.5 29.9 36.1 31.0 41.3 43.7 37.5 49.9 51.7 44
1h 28.9 24.9 32.9 39.9 34.4 45.5 48.3 41.6 55.0 57.1 49
1.5 h 33.3 28.8 37.8 46.0 39.7 52.2 55.6 48.0 63.1 65.8 56
2 h 36.3 31.4 41.1 50.1 43.4 56.8 60.6 52.5 68.7 7.7 61
4 h 43.0 37.7 48.3 59.4 52.1 66.7 71.8 63.0 80.6 84.9 74
6 h 47.5 42.0 53.0 65.6 58.0 73.2 79.3 70.1 B8.5 93.8 82
8 h 51.0 45.3 56.6 70.3 62.5 78.2 85.1 75.6 94.6 100.7 89
10 h 53.8 48.0 59.6 74.3 66. 3 82.3 89.8 80.1 99.5 106. 3 94
12 h 56.3 50.4 62.2 7.7 69.6 85.9 93.9 84.1 103.8 111.2 99
16 h 60.4 54.3 66.4 B83.4 75.0 91.8 100.8 90.7 110.9 119.3 107
20 h 63.8 57.6 70.0 88.1 79.6 96.6 106.5 96.2 116.8 126.0 113
24 h 65.3 59.2 71.4 90.2 81.7 98.7 109.0 98.8 119.3 129.0 116
id 54.3 49.2 59.4 75.0 68.0 82.0 90.7 82.2 99.2 107.3 96
2d 67.8 62.9 72.6 93.6 87.0 100.3 113.2 105.1 121.2 134.0 124
3d 75.6 71.2 79.9 104.3 98.3 110.4 126.1 118.8 133.4 149.3 140
4d 82.9 77.5 88.4 114.5 107.0 122.0 138.4 129.3 147.5 163.9 152
5d 89.2 82.7 95.5 123.1 114.3 131.9 148.8 138.1 159.5 176.2 163
6d 94.6 87.3 101.8 130.6 120.6 140.6 157.9 145.8 170.0 186.9 172
7d 97.1 89.2 104.9 134.0 123.2 144.9 162.0 148.9 175.1 191.8 175
25 52 28 18 712 1520 im 9.6 8.0 11.2 13.2 11.0 15.5 16.0 13.3 18.7 18.9 15
10 m 14.2 12.0 16.4 19.6 16.5 22.7 23.7 20.0 27.4 28.1 23
15 m 18.0 15.3 20.7 24.8 21.1 28.5 30.0 25.5 34.5 35.5 30
30m 22.7 19.4 26.0 31.4 26.8 35.9 37.9 32.4 43.4 44.9 38 |
« it »

Figure 3.14: Gridded point rainfall values

Now that the intensities have been calculated using three alternative methods the run-off
coefficient can now be determined.

Step 10: Identify the catchment characteristics to determine the run-off coefficient.

The run-off coefficient in the rational method is an integrated value representing the many
factors influencing the rainfall run-off relationship.

There is no objective theoretical method for determining C and as a result the subjective
elements of experience and engineering judgement play a very important role in the
successful application of this method.

Table 3.3 provides recommended values of C for the calculation of the run-off coefficient.
The Moretele Spruit catchment is classified as 40% rural and 60% urban based on the latest
information available (i.e. topographical maps and confirmed by a visit to the catchment (see

Figure 3.3)i.e.a =0,4; = 0,6 and y = 0,0.

Based on the available data from the catchment, the following tables were compiled to
characterise the catchment (Table 3.4 and Table 3.5).

3-18 Flood calculations



Table 3.3: Recommended values of run-off factor C for use in the rational method

Rural (C)) Urban (C,)
Mean annual rainfall (mm)
Component Classification <600 600 - > 900 Use Factor
900
Surface Vleis and pans (<3%) 0,01 0,03 0,05 Lawns
slope Flat areas (3 to 10%) 0,06 0,08 0,11 - Sandy, flat (<2%) 0,05-0,10
) Hilly (10 to 30%) 0,12 0,16 0,20 | - Sandy, steep (>7%) 0,15-0,20
s Steep areas (>30%) 0,22 0,26 0,30 - Heavy soil, flat (<2%) 0,13-0,17
- Heavy soil, steep (>7%) | 0,25 —0,35
Very permeable 0,03 0,04 0,05 Residential areas
Permeability | Permeable 0,06 0,08 0,10 - Houses 0,30 -0,50
<) Semi-permeable 0,12 0,16 0,20 - Flats 0,50 -0,70
Impermeable 0,21 0,26 0,30
Industry
- Light industry 0,50 - 0,80
Thick bush and 0,03 0,04 0,05 | - Heavy industry 0,60 - 0,90
plantation
Vegetation Light bush and farm 0,07 0,11 0,15 | Business
(Cy) lands - City centre 0,70 - 0,95
Grasslands 0,17 0,21 0,25 | - Suburban 0,50-0,70
No vegetation 0,26 0,28 0,30 | - Streets 0,70 - 0,95
- Maximum flood 1,00

Table 3.4: Catchment characteristics (Rural)
Rural (C)
Component Classification %
Vleis and pans (<3%) 20
Surface slope Flat areas (3 to 10%) 70
(Cs) Hilly (10 to 30%) 10
Steep areas (>30%) 0
Very permeable 0
Permeability Permeable 50
(Cp) Semi-permeable 50
Impermeable 0
Thick bush and plantation 0
Vegetation Light bush and farm lands 45
(Cy) Grasslands 50
No vegetation 5

Utilising Table 3.4 the run-off coefficient for the rural area is calculated using the following formula:

C,=C,+C, +C,

a0
T w»n
i

The average rainfall falls between 600 and 900 mm, and thus:

run-off coefficient with a value between zero and one
run-off coefficient according to average catchment slope
run-off coefficient according to average soil permeability
run-off coefficient according to average vegetal growth

... (3.10)
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C, =(0,20x 0,03 + 0,70 x 0,08 + 0,10 x 0,16)
+(0,50 x 0,08 + 0,50 x 0,16)
+(0,45x 0,11+ 0,50 x 0,21 + 0,05 x 0,28)
C, =0,3665

If it is estimated that up to 10% (D) of the area could be dolomitic, then the run-off factor should be
reduced as described earlier in this chapter. Based on the defined slopes, the following factors (Dyctor)
are used to adjust the run-off coefficient.

. Vleis and pans (slopes <3%) - 0,10
. Flat areas (3 to 10%) - 0,20
. Hilly (10 to 30%) - 035
. Steep areas (slopes >30%) - 0,50

Cp = Cl(l - D%)+ C,D,, (Dfactor x Cgy, ))
C,p = 0,3665(1-0,1)+ 0,3665(0,1)(0,10 x 0,20 + 0,20 x 0,70 + 0,35 x 0,1)
C,, = 0,337

C\p is the rural run-off coefficient that incorporates the effect of the dolomitic area.

The influence of initial saturation is incorporated by means of an adjustment factor. Using these
adjustment factors (Fr) for rural areas, the run-off coefficients (C,p) for the 1:20 and 1:50 year return
periods are adjusted as follows with Fyy = 0,67 and Fso = 0,83.

C,=C,, xF, .. (3.11)
Thus C1(20) = 0,2258 and Cl(j()) = 0,2797

The run-off coefficient for the urban area (C,) is calculated using the defined catchment
characteristics (Table 3.5) and the most conservative coefficients of Table 3.5 (for this
example).

C, =(0,20x 0,10 + 0,10 x 0,20)
+(0,40 x 0,50 + 0,05 x 0,70)
+(0,05 x 0,80)
+(0,10x 0,70 + 0,10 x 0,95)

C,=0,48

The combined run-off coefficient is calculated as follows:
C;=aC,;+pC,+yC, ...(3.12)
With a=0,4; = 0,6 and y = 0,0.
C20 = 0,3783
Csp = 0,3999
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Table 3.5: Catchment characteristics (Urban)

Urban (C,)

Use %
Lawns
- Sandy, flat (<2%) 20
- Sandy, steep (>7%) 10
- Heavy soil, flat (<2%) 0
- Heavy soil, steep (>7%) 0
Residential areas
- Houses 40
- Flats 5
Industry
- Light industry 5
- Heavy industry 0
Business
- City centre 0
- Suburban 10
- Streets 10
- Maximum flood 0

Step 11: Determine the peak flow for each of the required return periods utilising the simple linear
relationship and for this example the various methods used to calculate the average rainfall
intensity (Alternatives 1 to 3):

The peak flow rates based

3.1.2

Step 1:

Step 2:

Q, = C, LA
3,6
where:
Qr peak flow rate for T-year return period (m?3/s)
Cr = combined run-off coefficient for T-year return period
It
period (mm/hour)
A effective area of catchment (km?)
3,6 conversion factor

... (3.13)

= average rainfall intensity over catchment for a specific return

on the rational method for the 1:20 year and 1:50 year return periods
(calculated by means of equation 3.13) are:

Peak flood Alternative 1 Alternative 2 Alternative 3

Q1 164 m3/s 184 m3/s 128 m3/s

Qs 224 m’/s 243 m’/s 166 m’/s
Unit Hydrograph method

The first three steps of the Rational method described above are also applicable to the Unit

Hydrograph method, thus A = 28,5 km’, L = 7,25 km and S = 0,02146 m/m.

Determine the veld-type zone in which the catchment is located from Figure 3.15. The
catchment of the Moretele Spruit falls in Zone 8.
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Figure 3.15: Regions with generalised veld types in South Africa

Step 3: Calculate the catchment index by means of the following formula:

Index = ﬁ ...(3.14)
Vs
where: L = hydraulic length of catchment (km)
Le = distance between outlet and centroid of catchment (km)
S = average slope (as for Rational method in m/m)

The measured length from the catchment outlet along the watercourse and then
perpendicular to the centroid is Lc = 4,65 km. The calculated catchment index is 230, 1.

Step 4: Determine the lag time in hours from Figure 3.16 based on the catchment index and
veld-type zone. The Lag time (T.) equals 1,35 hours.
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Figure 3.16: Ratio of lag time to catchment index

Step 5: From Table 3.6 obtain the value of Ky for the specific veld-type. For this example Ku =
0,367.

Table 3.6: Values of Ky for various veld types

Re(%lioglzlz:‘len;;nsl))er Generalised veld type Factor K,
1 Coastal tropical forest 0,261
2 Schlerophyllous bush 0,306
3 Mountain sourveld 0,277
4 Grasslands of interior plateau 0,386
5 Highland sourveld and Dohne sourveld 0,351
Sa As for Zone 5 — but soils weakly developed 0,488
6 Karoo 0,265
7 False Karoo 0,315
8 Bushveld 0,367
9 Tall sourveld 0,321

Step 6: The peak flow rate for the unit hydrograph according to the regional classification given in
Table 3.6 in zone 8 is calculated using the following formula:

A
Q =K, — ... (3.15)
p T L
where:
Q = peak flow rate of unit hydrograph (m?/s)
A = size of catchment (km?)
T, = Lag time (hours)

The unit hydrograph peak discharge is 7,75 m¥s.

Step 7: Obtain the mean annual precipitation (MAP), as described for the Rational method. The
determined MAP for this catchment is 746,6 mm/a.

Step 8: This step has to be repeated for different storm durations as well as for different return
periods. The main aim is to determine the effective rainfall (he;r) for the different storm
durations with which the dimensionalised unit hydrograph peak flow could then be
multiplied.
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Step 8.1:  Determine the point rainfall for the required return periods (Pr) based on the mean
annual precipitation (MAP), the rainfall region, and the storm duration (Tsp). Point
precipitation for various durations, normally shorter than or equal to the lag time, is
obtained. Figure 3.5 may be used to determine the point rainfall although it is
preferred that the Design Rainfall software utility is used (see Figure 3.12). The
probable maximum flood can also be calculated using the Unit hydrograph method,
see the Drainage Manual Chapter 3 for more details.

For this example the point rainfalls for the 0,25 hour, 0,5 hour, 1 hour and 2 hour
storms have been determined for the different return periods 1:20 and 1:50 year (see
Table 3.7).

Step 8.2:  Calculate the point rainfall intensity (mm/hour). The point intensity (P;r) is the point
rainfall divided by the storm duration (Tsp).

iT:P_T ... (3.16)
TSD
where:
Pir = point intensities for the different return periods (mm/h)
Pr = point rainfall (mm)
Tsp = storm duration (hours). If duration < 0,25 hours use 0,25 hours.

See solution in Table 3.7.

Step 8.3:  Determine the area reduction factors (ARF;r) for the different return periods based on
the catchment area and different storm durations from Figure 3.8. The determined
ARF;jr values are shown in Table 3.7.

Step 8.4:  Calculate the average rainfall (Pa.r) for the different return periods and storm
durations. This is the area reduction factor (ARF;r) multiplied by the point rainfall
(Pr). The average rainfall values are shown in Table 3.7.

Step 8.5:  Determine the flood run-off factor from Figure 3.17. This factor is based on the
average rainfall, veld-type zone and catchment area. The flood run-off factors (fir) are

given in Table 3.7.

Step 8.6:  Calculate the effective rainfall (he;r) for each return period and selected storm duration
by multiplying the flood run-off factors (fir) with the average rainfall values (Paygir).

Table 3.7: Calculation of effective rainfall values (he;r)

Return period . .

Description Unit 1:20 1:30

Storm duration (Tgp) hours 0,25 0,5 1 2 0,25 0,5 1 2
Point rainfall (Py) mm 41 63 84 97 50 77 102 118
Point intensity (P;r) mm/hour | 164 126 84 48,5 200 154 102 59
Area reduction factor (ARF;r) % 84 88 92 95 80 85 90 94
Average rainfall (Paygr) mm 34,44 | 5544 | 77,28 | 92,15 | 40,00 | 65,45 | 91,80 | 110,92
Flood run-off factor (fir) % 12 16 19 22 13 18 22 24
Effective rainfall (he;r) mm 4,13 8,87 | 14,68 | 20,27 | 520 | 11,78 | 20,20 | 26,62
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Figure 3.17: Average storm losses

Step 9: The maximum flood peak is obtained by multiplying the effective rainfall for specific storm
durations with the unit hydrograph peak flow. The duration of storms that cause the
maximum peak discharge is obtained by trial and error. Since the standard duration of a unit
hydrograph is one hour (from the one-hour rainfall), the duration should be increased or
decreased to make provision for other rainfall durations.

An S-curve is obtained by staggering a number of unit hydrographs by the unit duration and
then summing them as shown Figure 3.18. It is recommended that an S-curve be constructed

in all cases.

Once the S-curve has been drawn, lagging an identical second S-curve by the duration and
then subtracting one from the other provides a unit hydrograph of the lagged duration. The
resulting values only need to be multiplied by a proportionate factor to obtain a new unit run-
off hydrograph. This unit hydrograph could again be dimensionalised using the values of
Qp and Ty. It is thus advisable to calculate the run-off values for the original unit hydrograph
at such time intervals that the duration of the required hydrographs will be divisible by these

time intervals.
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Figure 3.18: Illustration of S-curve

The dimensionless one-hour unit hydrograph for veld-type zone 8 is shown in Figure 3.19,
obtained from Table 3.8, and the constructed S-curve in Figure 3.20. The rising and falling
limbs of the unit hydrograph used to construct the S-curve are not equal. If the ordinates of
the staggered unit hydrographs are summed, the constructed S-curve is not constantly
increasing until it reaches the maximum value thereof. As illustrated in this example, this
leads to an uneven S-curve as shown in Figure 3.20. It is suggested that this be rectified as
shown by preventing the S-curve values for example (Q/Q,); being less than (Q/Qp)..i. This
approach is conservative, which could probably lead to an over-estimation in calculating the
volume of discharge, but should provide a conceptually correct answer in terms of the flood
peak value.

QQ ,

Unit hydrograph (Zone 8)

1.0 7

0.8 -

0.6 7

0.4 7

T/T.

Figure 3.19: Dimensionless one-hour unit hydrograph for veld type Zone 8
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Table 3.8: Dimensionless one hour unit hydrographs for various veld zone regions

Time as Run-off as Q/Qp for veld-type regions
T/Ty 1 2 3 4 5 5a 6 7 8 9

0 0,000 0,000 0,000 0,000 0,000 0,000 0,000 0,000 0,000 0,000
0,05 0,035 0,012 0,010 0,011 0,018 0,004 0,024 0,006 0,006 0,011
0,10 0,070 0,024 0,023 0,024 0,038 0,011 0,052 0,014 0,014 0,027
0,15 0,112 0,036 0,039 0,038 0,063 0,019 0,087 0,024 0,025 0,043
0,20 0,163 0,052 0,057 0,041 0,095 0,027 0,140 0,032 0,035 0,065
0,25 0,228 0,072 0,074 0,070 0,142 0,037 0,260 0,044 0,050 0,093
0,30 0,306 0,091 0,106 0,089 0,220 0,05 0,700 0,058 0,069 0,142
0,35 0,414 0,121 0,139 0,111 0,315 0,064 0,983 0,074 0,100 0,225
0,40 0,524 0,152 0,184 0,138 0,500 0,083 1,000 0,095 0,150 0,350
0,45 0,709 0,198 0,261 0,175 0,685 0,107 0,970 0,121 0,245 0,570
0,50 0,921 0,258 0,376 0,220 0,810 0,140 0,915 0,160 0,655 0,772
0,55 0,983 0,342 0,518 0,350 0,936 0,210 0,848 0,275 0,905 0,930
0,60 0,996 0,472 0,670 0,700 0,985 0,425 0,795 0,480 0,980 0,982
0,65 0,998 0,676 0,809 0,980 1,000 0,885 0,754 0,700 0,994 1,000
0,70 0,964 0,940 0,970 1,000 0,960 0,958 0,714 0,950 0,991 0,985
0,75 0,893 0,991 1,000 0,987 0,800 0,993 0,678 0,975 0,966 0,945
0,80 0,826 0,995 0,990 0,885 0,675 0,991 0,641 0,993 0,860 0,900
0,85 0,758 0,973 0,935 0,760 0,588 0,955 0,605 1,000 0,755 0,814
0,90 0,700 0,888 0,840 0,670 0,524 0,740 0,572 0,995 0,655 0,750
0,95 0,652 0,807 0,755 0,580 0,473 0,535 0,540 0,980 0,565 0,670
1,00 0,605 0,741 0,675 0,530 0,432 0,440 0,514 0,900 0,500 0,600
1,05 0,563 0,678 0,612 0,470 0,397 0,385 0,488 0,805 0,440 0,530
1,10 0,525 0,622 0,546 0,430 0,365 0,340 0,465 0,730 0,392 0,472
1,15 0,491 0,567 0,500 0,393 0,340 0,300 0,443 0,655 0,355 0,413
1,20 0,463 0,513 0,460 0,364 0315 0,265 0,422 0,590 0,322 0,364
1,25 0,437 0,467 0,424 0,336 0,295 0,235 0,402 0,530 0,294 0,316
1,30 0,411 0,425 0,395 0,310 0,276 0,209 0,382 0,477 0,270 0,280
1,35 0,387 0,394 0,368 0,288 0,260 0,187 0,365 0,432 0,250 0,260
1,40 0,362 0,364 0,347 0,271 0,242 0,169 0,347 0,388 0,231 0,241
1,45 0,341 0,338 0,325 0,252 0,228 0,152 0,330 0,350 0,215 0,225
1,50 0,321 0,313 0,305 0,235 0,214 0,140 0315 0,308 0,200 0,210
1,55 0,302 0,291 0,290 0,218 0,200 0,128 0,300 0,280 0,186 0,198
1,60 0,283 0,272 0,276 0,201 0,187 0,116 0,287 0,255 0,174 0,188
1,65 0,265 0,253 0,264 0,187 0,174 0,105 0,274 0,232 0,164 0,176
1,70 0,252 0,236 0,252 0,172 0,163 0,097 0,260 0,211 0,155 0,168
1,75 0,238 0,220 0,238 0,159 0,152 0,088 0,249 0,194 0,146 0,158
1,80 0,226 0,206 0,228 0,147 0,143 0,081 0,237 0,177 0,137 0,151
1,85 0,215 0,192 0,216 0,136 0,134 0,074 0,225 0,164 0,130 0,144
1,90 0,204 0,181 0,208 0,125 0,126 0,067 0,214 0,152 0,122 0,137
1,95 0,194 0,171 0,200 0,115 0,120 0,061 0,203 0,140 0,115 0,131
2,00 0,183 0,160 0,194 0,108 0,112 0,055 0,193 0,130 0,110 0,124
2,05 0,174 0,152 0,186 0,098 0,106 0,050 0,183 0,120 0,103 0,119
2,10 0,165 0,143 0,178 0,089 0,100 0,046 0,173 0,111 0,098 0,113
2,15 0,157 0,136 0,171 0,081 0,094 0,041 0,164 0,102 0,091 0,108
2,20 0,149 0,130 0,165 0,074 0,088 0,038 0,155 0,094 0,086 0,103
225 0,142 0,123 0,158 0,068 0,084 0,034 0,147 0,087 0,081 0,097
2,30 0,135 0,118 0,152 0,062 0,079 0,031 0,138 0,081 0,075 0,093
2,35 0,128 0,114 0,147 0,056 0,074 0,028 0,130 0,075 0,070 0,087
2,40 0,121 0,108 0,142 0,052 0,070 0,025 0,122 0,069 0,066 0,085
2,45 0,116 0,104 0,139 0,047 0,066 0,023 0,115 0,063 0,062 0,079
2,50 0,110 0,100 0,132 0,043 0,062 0,021 0,109 0,058 0,058 0,075
2,55 0,105 0,096 0,128 0,039 0,058 0,019 0,102 0,053 0,054 0,071
2,60 0,100 0,093 0,124 0,035 0,055 0,017 0,097 0,049 0,050 0,070
2,65 0,096 0,089 0,120 0,032 0,051 0,015 0,090 0,045 0,047 0,063
2,70 0,091 0,085 0,114 0,029 0,048 0,013 0,085 0,041 0,044 0,061
2,75 0,087 0,081 0,111 0,026 0,045 0,012 0,080 0,039 0,041 0,055
2,80 0,082 0,078 0,107 0,023 0,042 0,011 0,075 0,036 0,038 0,053
2,85 0,078 0,074 0,103 0,021 0,039 0,010 0,069 0,033 0,035 0,049
2,90 0,074 0,070 0,099 0,019 0,036 0,009 0,064 0,030 0,032 0,045
2,95 0,070 0,066 0,095 0,017 0,033 0,008 0,059 0,029 0,029 0,041
3,00 0,066 0,063 0,091 0,016 0,030 0,006 0,054 0,026 0,026 0,038
3,05 0,062 0,060 0,087 0,012 0,027 0,004 0,049 0,023 0,024 0,035
3,10 0,057 0,056 0,084 0,011 0,025 0,003 0,044 0,021 0,022 0,030
3,15 0,054 0,053 0,081 0,009 0,022 0,002 0,040 0,019 0,020 0,027
3,20 0,050 0,050 0,078 0,008 0,020 0,001 0,036 0,017 0,019 0,022
325 0,047 0,047 0,075 0,006 0,018 0,000 0,031 0,015 0,017 0,018
3,30 0,043 0,044 0,071 0,004 0,016 0,000 0,027 0,013 0,015 0,014
3,35 0,039 0,040 0,068 0,003 0,013 0,000 0,022 0,011 0,013 0,010
3,40 0,036 0,037 0,064 0,002 0,011 0,000 0,018 0,010 0,011 0,007
3,45 0,032 0,034 0,062 0,001 0,010 0,000 0,013 0,008 0,009 0,004
3,50 0,029 0,031 0,059 0,000 0,008 0,000 0,010 0,006 0,007 0,002
3,55 0,025 0,027 0,056 0,000 0,006 0,000 0,005 0,005 0,005 0,000
3,60 0,022 0,024 0,051 0,000 0,004 0,000 0,000 0,004 0,004 0,000
3,65 0,019 0,021 0,048 0,000 0,002 0,000 0,000 0,001 0,002 0,000
3,70 0,016 0,018 0,046 0,000 0,001 0,000 0,000 0,000 0,001 0,000
3,75 0,012 0,015 0,043 0,000 0,000 0,000 0,000 0,000 0,000 0,000
3,80 0,009 0,011 0,040 0,000 0,000 0,000 0,000 0,000 0,000 0,000
3,85 0,005 0,008 0,037 0,000 0,000 0,000 0,000 0,000 0,000 0,000
3,90 0,003 0,005 0,035 0,000 0,000 0,000 0,000 0,000 0,000 0,000
3,95 0,000 0,002 0,032 0,000 0,000 0,000 0,000 0,000 0,000 0,000
4,00 0,000 0,000 0,029 0,000 0,000 0,000 0,000 0,000 0,000 0,000
4,05 0,000 0,000 0,027 0,000 0,000 0,000 0,000 0,000 0,000 0,000
4,10 0,000 0,000 0,024 0,000 0,000 0,000 0,000 0,000 0,000 0,000
415 0,000 0,000 0,021 0,000 0,000 0,000 0,000 0,000 0,000 0,000
420 0,000 0,000 0,011 0,000 0,000 0,000 0,000 0,000 0,000 0,000
425 0,000 0,000 0,000 0,000 0,000 0,000 0,000 0,000 0,000 0,000
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Step 10: The 0,25, 0,5 and 2-hour unit hydrograph peaks are obtained by multiplying the maximum
obtained values from the previous step with the peak flow rate of the unit hydrograph (Q,),

see Table 3.9.

Step 11: The last step is to calculate the peak flows for the different return periods and storm
durations. The maximum peak flow for each return period is then used as the design peak
flood for that specific return period as shown in Table 3.9. The peak values are adjusted as

indicated for Qp;1/Qp < 1; in this case 0,9923.
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Figure 3.20: S-curve for veld type Zone 8 and lagged by 0,25 hour

Table 3.9: Peak flows utilising the discharge unit hydrograph method

Return period . .

Variable Unit 1:20 1:30

Storm duration hours | 025 0,5 1 2 0,25 0,5 1 2

(Tsp)

](Ehf:ec)tlve rainfall mm 4,13 8.87 | 14,68 | 2027 | 5,20 11,78 | 20,20 | 26,62
iT

}g“t ;’Ydrograph peak mis | 2452 | 1448 | 7.68 | 477 | 2452 | 1448 | 7.68 | 477
PiT

fg‘l; flow m¥ls | 101,34 | 12842 | 112,73 | 96,64 | 127,50 | 170,56 | 155,05 | 126,91
iT

Adjusted for Qur/Qp <1 | m¥s | 102,12 [ 129,42 | 113,60 | 97,39 | 12849 | 171,88 | 156,26 | 127,89

The peak flow rates, based on the unit hydrograph method, for the 1:20 year and 1:50 year return

periods are:

Q19 =129 m3/s and Qso =172 Md/s
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3.1.3 SDF method
The calculation sequence to determine the flood peaks based on the SDF method is as follows:

Step 1: Identify the drainage basin in which the site is located from Figure 3.21. The catchment falls
in drainage basin number /.

Step 2: Determine the area of the catchment. In this example it has already been calculated as
A =285 km?

Step 3: Determine the length of the main channel. In this example it has already been calculated as
L=725km.

Step 4: Determine the average slope of the catchment as described for the Rational method. The
calculated average slope (S) for this example is 0,02146 m/m.

AR s
A e
oy

&
J1 lira
< Yo
= R
..-‘i"-' PORT tuzm:' =

Figure 3.21: Standard Design Flood drainage basins

Step S:  Apply the US Soil Conservation Service formula to determine the time of concentration
Tc (hours) as suggested in HRU1/72 2.

08702 |
T. =| —=>2—"—"—_ ... (3.17
¢ [moosav} G17

The time of concentration is as calculated earlier, i.e. Tc = 1,338 hours.
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Step 6: Convert Tc¢ (hours) to t (minutes) and determine the point precipitation depth Py (mm) for
the different the return period T (years). In this example the modified Hershfield equation
will be used.

P =1,13(0,41+0,64InT)(- 0,11+ 0,271nt)(0,79M°’69R°’2°) ... (3.18)
where:
M = mean of the annual daily maxima from Table 3B.1 (in Appendix B)
equals 56 mm.
R = average number of days per year on which thunder was heard from

Table 3B.1 equals 30.

Table 3.10: Calculating point precipitation

Return period 1:20 1:50
P¢r (mm) 70,84 88,69
Step 7: Multiply the point precipitation depth Py (mm) by the area reduction factor ARF (%) to
determine the average rainfall over the catchment for the required return period (Payer). The
corresponding rainfall intensity It (mm/h) is obtained by dividing this value by the time of
concentration.
ARF = (90000 —12800InA + 9830Int)** ... (3.19)
Table 3.11: Calculating point intensity
Return period 1:20 1:50
ARF (%) 96 96
PAver (Mm) 68,00 85,14
Iy (mm/hour) 50,83 63,63
Step 8: The above steps constitute the standard procedures used in the conventional rational method.

The SDF uses calibrated run-off coefficients C, (2-year return period) and C,oy (100-year
return period) from Table 3B.1 instead of determining these from catchment characteristics.
The run-off coefficients for the range of return periods are derived by applying the return
period factors Y in Table 3.12, using the equation below:

o G (Y YCu €
T 100 \2,33)0100 100
Table 3.12: Return period factors
T 2 5 10 20 50 100 200

1,64 2,05 2,33 2,58

... (3.20)

Yr 0 0,84 | 1,28

With the calibrated coefficients being C, = 10 % and C,op = 40 %, and the return period factors Yo =
1,64 and Yo = 2,05 the run-off coefficients are calculated for the 1:20 and 1:50 year return periods:

Cy = 10,3112 and Csy = 0,3639

Step 9: Finally, the flood peak Qr (m?®/s) for the required return period is calculated as follows:

Q; =% .. (3.21)

3-30

Flood calculations



Table 3.13: Calculating flood peaks

Return period 1:20 1:50
Cr 0,3112 0,3639
Iy (mm/hour) 50,83 63,63
Qr (m%/s) 125 183

Step 10: The SDF hydrograph is triangular in shape with the duration of the rising limb equal to the

3.1.4

time of concentration Tc (hours), and that of the falling limb equal to twice the time of
concentration. Use linear interpolation between these two values.

SCS method

The SCS method requires a minimum input of catchment area, the catchment response time (Time of
Concentration), design rainfalls and soils and land cover classification. The catchment can be divided
into sub-areas or Hydrological Response Units (HRUs) which are areas with similar soils and land
cover and hence have a relatively similar hydrological response to rainfall.

Step 1:

Step 2:

Catchment information
The following information is provided or has been calculated above:

Table 3.14: Previously determined information

Catchment name Moretele Spruit
Latitude 25°47,75
Longitude 28°17,95
Total catchment area - A 28,5 | (km?)
Catchment time of concentration - T, | 1,334 | (h)

The catchment is 40% rural and 60 % urban.
Initial Curve Number determination

From the ISCW images of soil Land Types, the following Land Types are found in the
catchment: Ib7, Ba3 and Ba9. For each of the Land Types, the dominant terrain unit was
assumed to represent the entire HRU. Similarly, the dominant land class and soil series
within a terrain unit was assumed to respresent the entire unit and, where more than one soil
series is grouped to form the land class, the median SCS soil classification was used. For
each soil series representing each HRU, the appropriate SCS soil classification was
determined using tables from the Visual SCS-SA User Manual. The classification determined
as described above is summarised in Table 3.15, with the catchment divided into four HRUs.
For each HRU in Table 3.15 the soil and land cover classification is used to determine the
initial CN using information contained in Table 3E.3 (in Appendix 3E). From the initial
CN, values of S can be determined using Equation 3.22.

- 25400

— 254 ...(3.22)
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Table 3.15: Determination of initial CN and S

SOIL LAND COVER
AR C Initial | S
HRU % over .
( A‘T) Form Series Texture GSCS Cover | Class | Lractice/ | Stormflow | —on | ()
i roup Treatment | potential
(S/I/D)
1 30 | Glenros | Trevanian | SaClLm | B/C | Urban I 30% imp 77 75,9
2 30 | Glenros | Trevanian | SaClLm | B/C | Urban I 25% imp 75 84,7
3 20 | Hutton | Msinga SaClLm A Veld I Moderate 49 264,
4 20 | Glenros | Trevanian | SaClLm B/C | Veld I Moderate 75 84,7

Step 3:

Step 4:

Step 5:

Lag estimation

The catchment lag is computed from the time of concentration for the catchment using
Equation 3.23.

L = (0,6)1,334) = 0,8 hours ... (3.23)
Areal reduction factor (ARF)

Given that the SCS method is primarily intended to estimate peak discharge from small
catchments, over which a uniform daily rainfall may be assumed, the reduction of point to
catchment rainfall by means of an ARF is generally not applied. However, to be consistent
with the example, an ARF, = 94% and ARF5, = 91% for the 20 and 50 year return periods
respectively is used.

One-day design rainfall estimation

The SCS method requires the input of one-day design rainfalls which can be estimated using

a number of different methods. The Visual SCS-SA software includes the following options:

(1)  User estimated design rainfalls computed directly from raingauge data.

(i)  Design rainfall extracted for a selected station from Adamson’s TR102 report.

(ii1) Using at-site design rainfall calculated from the representative rainfall stations used to
represent the rainfall in each of the 712 hydrological zones.

(iv) Design rainfall estimated using the regional method developed by Smithers and
Schulze (2003).

Given the regional approach used and the longer periods of record from all available stations
used in the analysis compared to all previous studies, it is recommended that the regional,
scale invariance approach to design rainfall estimation developed for South Africa by
Smithers and Schulze (2003) be used to estimate the one-day design rainfall.

The results from the application of this approach at the location of the three rain gauges
located in and close to the catchment are summarised in Table 3.16. Given the relatively
small differences in design rainfall between the values computed from the at-site data and
the RLMA&SI methodology, as well as between the different locations, the RLMA&SI
values for Garsfontein were used in the estimation of the design floods. These were then
reduced by the areal reduction factors of 94 % and 91 % for the 20 and 50 year return period
events respectively in order to determine the catchment design rainfalls.
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Table 3.16: Estimation of one-day design rainfalls at stations around the Moretele Spruit
catchment used in this example

Location Return period (years)
20 50
At-site | RLMA&SI | At-site | RLMA&SI
(mm) (mm) (mm) (mm)

0513529 — GARSFONTEIN
Latitude: 25°49' 110,5 118,6 135,4 145,7
Longitude: 28° 17'

0513531 — RIETVLEI
Latitude: 25°51' 121,4 114,6 148,8 140,5
Longitude: 28° 18'

0513528 - CONSTANTIA PARK
Latitude: 25°48' * 120,4 * 147,7
Longitude: 28° 18'

* No at-site values available

Step 6: Catchment one-day design rainfall
The AREF is used to calculate the catchment design rainfall, as shown in Table 3.17.

Table 3.17: Calculation of one-day catchment design rainfall
Return period (years) 20 50

Areal reduction factor - ARF (%) 94 91
Design daily rainfall depth - P, (mm) | 118,6 | 145,7

Catchment design rainfall 111,5 | 132,6

Step 7: Design stormflow depth estimation

For each sub-area or HRU which the catchment has been divided into, the stormflow is
calculated using Equation 3.24, as shown in Table 3.18. For example, the computation for
the 20 year return period stormflow from HRU 1 is:

(P -IL)?
=——— forP>1], ...(3.24
Q P-I,+S (324)
where
Q = stormflow depth (mm),
P = daily rainfall depth (mm), usually input as a one-day design rainfall for a

given return period,

S = potential maximum soil water retention (mm),
=~ index of the wetness of the catchment's soil prior to a rainfall event,
I, = initial losses (abstractions) prior to the commencement of stormflow,

comprising of depression storage, interception and initial infiltration (mm)
0,1S (recommended for use in South Africa)

[111,5-(0,1x75.9)]

Q0 = [115-(0,1x75.9) + 75.9]

= 60,0 mm
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Table 3.18: Calculation of stormflow depth (mm)

Return period (years) 20 | 50

Sub-Area Design stt();lmmt;ow depth
HRU 1 60,0 77.8
HRU 2 56,5 73,8
HRU 3 20,7 30,4
HRU 4 56,5 73,8

Step 8: Total stormflow depth

The stormflow from each sub-area is area weighted to calculate an equivalent stormflow
depth from the entire catchment using Equation 3.25 with the results shown in Table 3.19.

N
0=> 04 ... (3.25)
i=1
where
Q = average stormflow depth from entire catchment (mm)
Q; = stormflow depth (mm) from i-" sub-area calculated using Equation 3.24
A, = fraction of sub-area of total catchment area for i-™ sub-area
N = number of sub-areas

Table 3.19: Calculation of total stormflow depth

Return period (years) 20 50

Total runoff depth (mm) | 50,4 | 66,3

Step 9: Total runoff volume

The stormflow volume from the catchment is calculated using Equation 3.26 and is given in

Table 3.20.
vo A ... (3.26)
1000
where
V = stormflow volume (m*x10°)
Q = stormflow depth (mm)
A = catchment area (km?)

Table 3.20: Calculation of total stormflow volume

Return period (years) 20 50

Total runoff volume (m3 x106) 1,4 1,9

Step 10: Peak discharge estimation

The peak discharge from the catchment is calculated using Equation 3.27.

_0,2083AQ

(327
I~ 8L 32D
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For the 20 year return period, the peak discharge is calculated as:

(0,2083)(28,5)50.,4)

- =204,5 m/s

Ip (1,83)(0.,8)

Results

The computed peak discharge for the 20 and 50 year return periods are summarised in Table 3.21 for
both the manual calculation method, as summarised above, and computed by the Visual SCS-SA
software. The differences in the calculated peak discharge by the two methods are a result of:

(1) No adjustment of the initial CNs into final CNs is included in the manual method. In the
Visual SCS-SA method, the median condition method was used to adjust the initial CNs into
final CNs, thus accounting for typical soil moisture conditions.

(i1) The manual method does not use the incremental unit hydrograph approach and does not take
into account the regionalised typical rainfall hyetographs, both of which are used in the Visual

SCS-S4 software.

Table 3.21: Computed peak discharge

Return period (years)

20

50

Peak discharge (m*/s): Manual method | 204,5

2689

Peak discharge (m?/s): Visual SCS-SA | 181,7

245,0

A standard calculation sheet is included in Appendix 3C for the manual method. The output from the
Visual SCS-SA software is shown in Figure 3.22 and Figure 3.23. The manual method outlined in this
guide is a simplified version of the adaptations to the SCS method for South Africa. The full
adaptations can be performed manually using the SCS-based design runoff user manual developed by
Schmidt and Schulze (1987b). The full adaptations are incorporated into the Visual SCS-SA software,
including the estimation of design rainfall using the RLMA&SI developed by Smithers and Schulze

(2003).
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Figure 3.22: Hydrographs generated by Visual SCS-SA
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CATCHMENT NAME . Garsfontein

PROJECT NO :  Example
RUN NO o1
TOTAL CATCHMENT AREA (km?) : 28.50
STORM INTENSITY DISTRIBUTION TYPE : 3
CATCHMENT LAG TIME (h) ;0,80
COEFFICIENT OF INITIAL ABSTRACTION : 0,10
CURVE NUMBERS: Initial Final
Sub-catchment 1 77 72,1
Sub-catchment 2 75 70,4
Sub-catchment 3 49 49,0
Sub-catchment 4 75 70,4
RETURN PERIOD (YEARS) 20 50
DESIGN DAILY RAINFALL DEPTH (mm) 111 132
DESIGN STORMFLOW DEPTH (mm)
Sub-catchment 1 51,4 67,8
Sub-catchment 2 48,6 64,5
Sub-catchment 3 20,5 30,1
Sub-catchment 4 48,6 64,5
TOTAL RUNOFF DEPTH (mm) 43,8 58,6

DESIGN STORMFLOW VOLUME
(thousands m®)

Sub-catchment 1 439,3 579,5
Sub-catchment 2 415,2 5514
Sub-catchment 3 116,8 171,7
Sub-catchment 4 276,8 367,6
TOTAL STORMFLOW VOLUME 1,2 1,7
(millions m’)
COMPUTED CURVE NUMBER 67,3 67,1
PEAK DISCHARGE (m’/s) 181,7 245,0

Figure 3.23: Output from Visual SCS-SA
3.15 Empirical methods

Peak discharges for return periods less than or equal to 100 years can be determined by means of an
empirical deterministic method developed by Midgley and Pitman. The formula reads:

Q,; =0,0377K,PA*C*? ... (3.28)
where
Qr = peak flow for T return period (m?/s)
Kt = coefficient based on veld-type region (see Figure 3.24 and Table 3.22).
P = mean annual precipitation over catchment (mm/a) (see Figure 3.5 or utilise Design
Rainfall software for the catchment (see Figure 3.11).
and C= AVS (Catchment parameter with regard to reaction time) ... (3.29)

C
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where:
A
S
L
Lc

Table 3.22: Constant values of Kt for different veld types

area of catchment (km?)

= average slope of stream (m/m)
= hydraulic length of catchment (km)

= distance between outlet and centre of gravity of catchment (km)

Return period T in years 10 20 50 100
1 Coastal tropical forest 0,17 0,23 0,32 0,40
Winter 0,42 0,52 0,68 0,80
(-5} ) ) ) P
= 2 [ All year | Schlerophyllous bush 0,83 | 1,04 | 136 | 1,60
% 3 Mountain sourveld 0,29 0,40 0,55 0,70
>
§ 4 Grasslands of interior plateau 0,59 0,68 0,95 1,20
‘s © :
5 : 5 Highland sourveld and Dohne 0,59 0.80 L1 1,40
£ sourveld
L] - .
C_-g 5 | s As for Zone 5 — but soils weakly 0,59 0.68 0.95 1.20
S = developed
o= o [Winter | 033 | 045 | 0,63 0,80
.qné All year 0,67 0,91 1,26 1,60
2 7 False Karoo 0,67 0,91 1,26 1,60
3]
K Bushveld 042 | 057 | 079 | 1,00
9 Tall sourveld 0,50 0,68 0,95 1,20

With the catchment being in veld-type zone 8, the Kt values are 0,57 and 0,79 for the 1:20 and 1:50
year return periods respectively. The calculated catchment parameter C with regard to reaction time is

0,1238.

The flood peaks as determined with the empirical method for the 1:20 and 1:50 year return periods are
78,85 m?¥/s and 109,28 m3/s respectively.
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Figure 3.24: Regions with generalised veld types in South Africa

3.1.6 Comparison of solutions

Table 3.23 summarises the results for the five methods used in this example.

Table 3.23: Comparison of solutions

Return period
Method 1:20 1:50
Rational (Alternative 1) 164 224
Rational (Alternative 2 184 243
Rational (Alternative 3) 128 166
Unit Hydrograph 129 172
SDF 125 183
SCS-SA 205 269
Empirical 79 109
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3.2 Worked example 3.2 - Large catchment

The second worked example is a design flood calculation for a new low-level bridge across the Tsitsa
River, which runs through the Eastern Cape in a south-easterly direction (see Figure 3.25). The
position of the proposed Tsitsa low-level river bridge is shown on Figure 3.25.

Planned Tsitsa low-
level river bridge

Figure 3.25: Proposed Tsitsa low-level river bridge position

The catchment characteristics were determined (see Table 3.24 ), and are used in the calculation of the
flood peaks for various recurrence intervals.

Table 3.24: Catchment characteristics

Description of characteristic Determined value Comment
Catchment area (see Figure 3.25) 4318 km? Catchment area may be clearly defined
Starts at Antelope Spruit, joins the
Length of longest watercourse 179.5 km Tsitsana River and further downstream
(see Figure 3.27) ’ joins the Ixnu River to form the Tsitsa
River
Height difference Total height difference equals 1 814 m,
(1085-method) 500 m very steep slopes along the upper reaches
(See Figure 3.28) of the water course
Average catchment slope 0,37% See detailed description below
Distance to catchment centroid 85 km
SDF Drainage basin number 23
Based on calculated average from a
Average rainfall 860 mm number of weather stations in the T35
drainage basin
Catchment area falls within regions K5
RMF K-factor 5,0-5.2 and K6 (assume highest value).
(See Figure 3.26)
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Description of characteristic

Determined value

Comment

Description of catchment run-off
characteristics

Rural area only with a
combination of flat and hilly
zones, steep slopes along
perimeter of catchment and
pans with slopes <3%;
permeability varying from
permeable to semi-
permeable, light bush and
cultivated lands, as well as
grasslands.

Generalised veld type zone
(Figure 3.24)

Zone 2

Gauging station (see Figure 3.29)

T3HO016 Tsitsa River
Xonkonxa

Latitude: 31°14°13”’
Longitude: 28°51°15”’

@

This gauging station is close to the

N2 river

Skm upstream of the proposed

bridge site

bridge approximately

i)

]

3 ¢ g g g

k)

g & & 3 £

&

ws)

32‘3_F
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Figure 3.26: Maximum flood peak regions in southern Africa from Kovacs
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Figure 3.27: Catchment area and longest watercourse (3.21)
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Figure 3.28: Watercourse profile and average slope
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Figure 3.29: Gauging station (T3H016 Tsitsa River @ Xonkonxa)

3.2.1 Statistical method

There is a gauging station approximately 5 km upstream of the proposed bridge site, and flow data
from 1951/52 until 1997/98 are available. Historical flood data for the gauging station were obtained
from the Department of Water Affairs and Forestry. The gauging station, T3HO16, is situated at the
N2-Bridge. The data unfortunately contain periods, full hydrological years and parts thereof, during
which the flow was not measured. The hydraulic capacity of the structure, which is 1091 m3/s, was
exceeded on at least three occasions. The data as used in the statistical analysis are shown in Table
3.25.

The flood peak of March 1976 measured at the Tsitsa River gauging station was one of the flood peaks
used in the derivation of the Francou-Rodier K-values for this specific region.

The historical data indicated that the flood peak was higher than 1091 m?®/s, which is the maximum
capacity of the gauging station. In a technical report entitled, “Maximum flood peak discharges in
South Africa: An empirical approach”, Report No. TR105, by Kovécs, a peak flow of 1 699 m?/s was
used in deriving the Francou Rodier K-value. The maximum recorded water level was 3,48 m. This
represented the highest peak flow recorded up to March 1976. The other high peak flow of February
1972 was less than this peak flow (i.e. between 1091 and 1699 m3/s), and it was estimated as
1 364 m%/s.

Another peak flow event, during which the measuring weir was overtopped, occurred in October 1976.
It is estimated that this peak flow was 1347 m?/s.
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Table 3.25: Historical annual maximum flood peaks for T3H016

Year |Discharge Comment Description Adopted peak flow
(m?/s) value (m?*/s)

1951/52 60 60
1952/53 112 112
1953/54 120 Incomplete year Includes summer period 120
1954/55 197 Incomplete year Too short year -1
1955/56 126 126
1956/57 188 188
1957/58 188 188
1958/59 274 274
1959/60 185 185
1960/61 52 Incomplete year Too short year -1
1961/62 338 338
1962/63 788 788
1963/64 488 488
1964/65 322 322
1965/66 343 343
1966/67 492 492
1967/68 111 111
1968/69 380 Incomplete year Includes summer period 380
1969/70 303 Incomplete year Too short year -1
1970/71 660 660
1971/72 1091  [Rating limit exceeded |From TR105 1364
1972/73 229 229
1973/74 326 326
1974/75 297 297
1975/76 1091 Rating limit exceeded |From TR105 1699
1976/77 1091 Rating limit exceeded [From TR105 1347
1977/78 926 926
1978/79 82 Incomplete year Too short year -1
1979/80 97 Incomplete year Includes summer period 97
1980/81 -1 Missing data -1
1981/82 -1 Missing data -1
1982/83 -1 Missing data -1
1983/84 295 295
1984/85 851 851
1985/86 443 443
1986/87 332 332
1987/88 881 881
1988/89 904 904
1989/90 672 672
1990/91 90 90
1991/92 301 301
1992/93 110 110
1993/94 580 580
1994/95 273 273
1995/96 995 Incomplete data Includes summer period 995
1996/97 486 Incomplete data Includes summer period 486
1997/98 709 Incomplete data Includes summer period 709
1998 - 2004 -1 Missing data -1

Based on the historical flow records the results from statistical analyses are shown in Table 3.26.
Equations and statistical tables are included in Appendix 3A.
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Table 3.26: Statistical analyses for Tsitsa river gauging station T3H016 (missin

data excluded)

Return | Extreme value General Log Pearson Log extreme
. Log normal
period Type 1 extreme value Type 3 value
2 421 414 352 358 307
5 766 758 714 719 645
10 994 991 1035 1022 1057
20 1214 1221 1401 1359 1696
50 1497 1527 1980 1850 3126
100 1710 1764 2507 2286 4953

The frequency distribution curve that fitted the data the best was the Log Pearson Type 3 curve (LP3)
(see Figure 3.30).

T3H016 @ Tsitsa River @ Xonkonxa on theTsitsa : Catchment area = 4318 km* :Period 1951 to 2004
ADJUSTED STATISTICS [log(10) - transformed data]
Mean = 25420 Standard deviation = 03619 Skewness coefficient = -0.16 SINGLE STATION ANALYSIS
LP3/MM DISTRIBUTION LOGARITHMIC-NORMAL PROBABILITY SCALES AND CUNANE PLOTTING POSITION
Probability (%) 10 20 50 80 95 99 998 9995 9999
10000
1000
Peak
Value
100
10
1.0 110 1.24 2 10 50 200 1000 5000
YT= 53 NA= 1 NB= 33 NC= 13 LW= 0 ZR= 0 Relun Period (years)

Figure 3.30: Log Pearson Type 3 fit through historical data points

The following gauge record information relates to Figure 3.30.
YT (record length in years) = 53

NA (peaks > high threshold) = 1

NB (peaks between thresholds excluding missing data) = 39
LW (non-zero peaks below low threshold) = 0

ZR (zero flows) =0

NC (missing data) = 13

3.2.2 SDF method

The calculation sequence to determine the flood peaks has been described in the first worked example,
and will therefore not be repeated here. The main results are presented in Table 3.27. In this example
the point precipitation is obtained from the weather service station selected for this basin from TR102;
i.e. Station nr. 180439 @ INSIZWA.
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Table 3.27: Results of SDF calculation

Description Answer obtained

Area (km?) 4318

L (km) 179,5

S (m/m) 0,0037

Tc (hours) 31,16

M (mm) 60

R (days) 45

C; (%) 10

Cioo (%) 80

Return period 1:10 1:20 1:50 1:100
Per 116,81 144,32 180,69 208,20
ARF (%) 80 80 80 80
P,yer (mm) 93,23 115,19 144,21 166,17
Iy (mm/hour) 2,99 3,70 4,63 5,33
Cr 0,485 0,593 0,716 0,80
Qr (m¥/s) 1739 2628 3974 5117

3.23 Empirical methods

Peak discharges for return periods less than or equal to 100 years could be determined by means of an
empirical deterministic method developed by Midgley and Pitman. The formula reads:

Q, =0,0377K ,PA"°C*? ... (3.30)

where:
Qr = peak flow for T return period (m?%/s)
Kt = coefficient based on veld-type region (see Figure 3.24 and Table 3.22).
P = mean annual precipitation over catchment (mm/a) (see Figure 3.5 or utilise Design

Rainfall database for the catchment (see Figure 3.11).

A8

and C=

where:

A =
S =
L =
LC =

C

area of catchment = 4318 km?

average slope of stream = 0,0037 m/m
hydraulic length of catchment = /79,5 km
distance between outlet and centroid of catchment = 85 km

(Catchment parameter with regard to reaction time)

... (3.31)

In this example the catchment falls within Zone 2 (4l year) with Ky values of Ky = 0,83,
K20 = 1,04, K50 = 1,36 and KIOO = 1,60

The calculated catchment parameter C with regard to reaction time is 0,01721.

The flood peaks as determined using the empirical method (Equation 3.30) for the different return
periods are shown in Table 3.28.

Table 3.28: Flood peaks based on empirical method

Return period | Peak flows (m®/s)
10 1812
20 2270
50 2 969
100 3493
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The regional maximum flood may be calculated as follows using the Francou-Rodier relationship:

A 1-0,1K
QRMF=106(WJ ..(3.32)
where:
Qrvr = regional maximum flood peak flow rate (m?%/s)
K = regional constant (Obtainable from the regional classification detailed
in Figure 3.26 and simplified in Table 3.29)
10° = total world MAR (m?/s)
108 = total world catchment area (km?)

Step 1: Determine the catchment area: 4318 km?.

Step 2: Identify the region in which the site is located (Figure 3.26). In this example, as shown in
Table 3.24, the region is K6 (higher K-value). Note that the regions on the map refer to the
location of the site and not to the catchment. Only if the site is located near a boundary
between regions would it be necessary to consider adjusting the K-factor.

Step 3: Utilise the equation provided in Table 3.29 to calculate the RMF as 8059 m¥s

Table 3.29: RMF region classification in southern Africa

Kovics Number Transition zone Flood zone
region K of Area range Qrwmr Area range Qrmr
floods # (km?) (m?/s) (km?) (m?/s)
K1 2,8 6 1 —500 30A%% 500 — 500 000 | 1,74A%"
K2 3,4 12 1-300 50A%% 300 — 500 000 | 5,25A%°
K3 4,0 26 1-300 70A%* 300 —300 000 | 15,9A%°
K4 4.6 55 1-100 100A%*® | 100— 100000 | 47,9A%*
K5 5,0 155 1 - 100 100A>° 100 — 100 000 | 100A%°
K6 5,2 61 1-100 100A%® 100 — 30 000 145A%4%
K7 5,4 34 1-100 100A% 100 — 20 000 209A%4
K8 5,6 25 1-100 100A%%® 100-10000 | 302A%*

Notes: # Recorded flood data are reflected in the DWAF report TR105
3.24 Comparisons of solutions

Comparing the calculated flood peaks below (Table 3.30) provides an overview of the range of
expected floods. Based on the flood calculations above, a structurally sound low-level bridge structure
was designed to withstand the high floods and provide a safe crossing during the lower floods (Figure
3.31 and Figure 3.32). Further analysis was also performed on the historical flow data to ensure that
the bridge will not be inundated for prolonged periods, cutting off communities from each other.

Table 3.30: Comparison of calculated peak flows (m?3/s)

Return Empirical Standard Regional Statistical
period design flood | maximum (LP3)
flood (RMF)
10 1812 1739 1022
20 2270 2 628 1359
50 2 969 3974 3951%* 1 850
100 3493 5117 4 796* 2 286
8 059

*Using Q1/Qrur ratios as detailed in Appendix 3D.
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Figure 3.31: Tsitsa crossing downstream view

Figure 3.32: Tsitsa crossing
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4 HYDRAULIC CALCULATIONS
4.1 Example 4.1 - Flow characterisation, energy gradient and normal

Problem description Example 4.1

depth

The total discharge through a channel section is 477 m?/s. The dimensions and absolute roughness

values for the channel are shown below (Figure 4.1).

— —

®

LSS

T T TN

rl l ‘RR“‘--._ kh =0.7m o
AV e e Y Y
3 8 3 3 7 | 2.5
Figure 4.1: Cross-section of channel
Determine:
6)] The energy gradient (Sy).
(i1) Whether the flow is sub- or supercritical.
(ii1) The average velocity through section 3.
(iv) Whether the flow is laminar or turbulent.
) The normal flow depth.

Solution Example 4.1

Divide the channel as shown above and derive the following details (Table 4.1):

Table 4.1: Channel characteristics (Example 4.1)

Section
Parameter 1 ) 3

Area (A) 28,5 m? 9,0 m? 49,25 m?
Wetted perimeter (P) 12,24 m 3,0m 15,42 m

Hydraulic radius (R = A/P) 2,33 m 3,0m 3,19m

Absolute roughness (k) 0,3m 0,7 m 0,7 m

Chézy

C=181log (f—RJ 35,4 m"/s 30,8 m”/s 31,3 m"/s

The energy gradient (S;)

By assuming uniform flow conditions the local slope of the channel, Sy, may be set equal to
the energy slope, Sy. Continuity of mass and energy (Chézy equations) combined provide the

following relationships:
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Quu =2,Q
Qtotal :Al Cl Rlsf +A2 C2 stf +A3 C3 R3Sf

“Quu = ((28.5(35.4)42.33 +(9.0)(30,8)/3.0+(49,25)31,3)4/3.19 S,

< Quw = (1541+ 480+ 2754)/S,

2
_ Q total

=767 =0,01 m/m (Energy gradient)

"f

Determine the flow regime

2 2
(Froude)? = QB = (477) (25’5) — Fr= 0,952 < 1,0 thus subcritical

gA’  (9,81)86,75)°

Determine the average velocity through section 3

v, &zﬁxﬂziwm/s
A, 4776 49,25

Identify the flow type
Calculate the Reynolds Number
R 'R
v
v= ZQ = 477 =5,50 m/s
DA 28,5+9+49.25
— A
XA 86,75 C28m
P 12,24+3,0+1542
v = 1,14 x 10° m?/s (kinematic viscosity of water)
R =R (5.50)(2.83) =13,65x10°

" v 1,14x10°
R.>>2000 .. Highly turbulent

Calculation of normal flow depth

The normal (uniform) flow depth for a given discharge is calculated by the same procedure,
except that the flow depth is the unknown quantity and the energy gradient, Sy, is equal to the

average (near constant) bed slope, So.

Quu =4770=A,C, RS, +A,C,JR,S; + A, C,/R;S;

As shown above, the area, wetted perimeter and hydraulic radius can be written in terms
of the unknown depth, Y. If Y is the depth in section 3, then the variables may be written

as shown in Table 4.2.
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Table 4.2: Channel characteristics written in terms of unknown flow depth (Example 4.1)

Section
Parameter 1 3 3
2 1 Y?
Area (A) (m?) EY +6Y 14 3(Y -2) T+9Y—2
5
Wetted perimeter (P) (m) (8 +~2(Y - 2)) 3,0 (\/§ +7+ \/;Y)
Hydraulic raz?rllgls (R=A/P) (A/P) * (Y ) 2) (A/P) *
Absolute roughness (k;) (m) 0,3 0,7 0,7
Chézy
C=181log (IkZR] (m”/s) * * *

Note: * The relationship is not shown, but could be obtained from the combination of the given relationships.
With a known slope, Sy, and flow rate, Q, Y can be solved. In this case Y =5 m.

4.2 Example 4.2 - Gradually varying river flow (backwater calculation — simple sectional
details)

Problem description Example 4.2

Determine the flood level at section 3 for a river of trapezoidal section with side slopes 1:2 and
varying bed width. The characteristics of the cross-sections are reflected in Table 4.3.

Qs =43,3m’/s

Table 4.3: Characteristics of the river cross-sections

7 Base width Bed level Chainage Manning, n
Section I i) (i) (s/m"?) Remark
1 6 1203,02 0 0,032 Downstream
2 4,8 1203,24 65 0,026
3 5,6 1203,75 147 0,024 Site
4 5,4 1203,99 214 0,028
5 5,6 1204,42 280 0,024 Upstream

Using the principle of conservation of mass and energy would solve this problem. It is assumed that
the flow rate is constant at 43,3 m?/s. It is necessary to determine the type of flow to establish the
control, and then to work away from the control.

Although the assumption that uniform flow will be present at the cross-sections is incorrect,
calculation of the “normal flow depth” at each section will give an indication of the type of flow. In
Table 4.4 the “normal flow depths” have been calculated. This is not the solution to the problem but
merely a way to establish the type of flow!

Solution Example 4.2

From Table 4.4 it could be concluded (Fr < 1) that the flow will be subcritical and hence that the
control will be downstream.
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Table 4.4: Flow characteristics (Example 4.2)

Calculation based on uniform flow assumption
Section Position Invert | Slope (local) Y, A P R Cal Q Fr
1D ID (m) (m/m) (m) (m?) (m) (m) (m?/s)
a* b c d e f g h i j
1 Downstream | 3,02 0,003 1,980 19,718 14,854 1,327 43,3 0,589
2 3,24 0,006 1,653 13,403 12,194 0,973 43,3 0,952
3 Site 3,75 0,004 1,725 15,614 13,316 1,027 43,3 0,792
4 3,99 0,007 1,622 14,026 12,656 0,958 43,3 0,908
5 Upstream 4,42
Note: * Refer to the legend table (Table 4.6)
Now start with the assumption of a flow depth at section 1 (downstream) and work upstream by
applying the continuity of energy as shown in Table 4.5. Assume that the secondary losses will be
negligible.
The flow depth at section 1 is assumed to be 2,258 m. The total energy level at this section is then
equal to 2,427 m.
Table 4.5: Flood level calculations
Section| AX H total Fr Area P Velocity E; St (So=St)avg E, A(Ey-E;)| Water
energy level
ID (m) (m) (m?) (m) (m/s) (m) (m/m) | (m/m) (m) (m) (m)
a k 1 m n o p q r S t u v
1 1205,246| 0,589 [ 19,718 | 14,854 2,196 |1205,246| 0,00338 1205,00
65 0,000198 [1205,245| -0,001
2 1205,5441 0,675 | 17,499 | 13,709 | 2,474 |1205,544] 0,00299 1205,23
82 0,002349 |1205,545| 0,000
3 1205,832| 0,904 | 14,105 | 12,765 3,070 |1205,832] 0,00475 1205,35
67 -0,000622 |1205,833| 0,001
4 1206,195| 0,692 | 17,282 | 13,829 | 2,506 [1206,195| 0,00366 1205,87
66 0,002394 |1206,195| 0,000
5 1206,505| 0,889 | 14,286 | 12,832 3,031 [1206,505| 0,00459 1206,04

Notes: A brief description of the columns content for the above tables is listed in Table 4.6

Table 4.6: Legend table

Column ID | Description of the variable
a Section identification
b Description of the position
c Invert level (m)
d Local slope calculated from the level difference between that of the section and the
upstream section divided by the distance between the sections
e Y, is the calculated flow depth assuming that uniform flow characteristics will occur
f Calculated area for the given Y,
g Calculated wetted perimeter for the given Y,
h Calculated hydraulic radius for the given Y,
i Calculated flow rate
j, m Froude number
k Distance between the sections
n Calculated area
0 Calculated wetted perimeter
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Table 4.6: Legend table (continued)

Column ID | Description of the variable

p Calculated velocity
Calculated total energy
Calculated energy slope
Calculated difference of the energy slope and the channel slope
Specific energy
Difference in the specific energy
Calculated water level

<l || |~ |

4.3 Example 4.4 — Negligible energy losses (converging flow over short distance)
Problem description Example 4.4

A concrete chute with a stream width of 0,6 m conveys water down the side of an embankment 3,0 m
high with a slope of 1,5 vertical to 1,0 horizontal, see Figure 4.2. The discharge is 0,1 m?/s and the
water flows away from a trough in the road profile. Calculate the flow velocity, depth of flow and
Froude number at the toe.

0.6m
— -

3.0m

77777

Figure 4.2: Concrete chute down embankment

Solution Example 4.3

Since the water has to dam in order to run off, a control is created at the upper end (Fr = 1)

QB _,

gAl
With:
Q = 0,1 m%/s
B = 0,6 m
Ac = By.=0,06y.
g = 9,81 m/s?
Yo = 0,141 m
v, = 1,178 m/s

v? (1,178)°

and E_=vy, +;_°=0,141+ =0212m
g

2(9,81)

Since the channel is very steep, the energy losses will be small in relation to the change in level.
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=2
Consequently H=3,0+0,212=y, + \2/—2 can be assumed.
g

q=v,y, = 0,167 m*/sm

vV, =7,9m/s; y,=0,021 mand Fr, = =17
gy,

The actual velocity will be slightly lower. (If H>>y,, then v, = ,/2gH)

4.4 Example 4.4 — Transition losses

Problem description Example 4.5

The normal (uniform) flow depth in a long 2 m wide, rectangular canal is 2 m and the normal flow
velocity 2 m/s. The Manning n-value is 0,02 s/m">. There is a 90° bend with a centre-line radius of
7 m. Calculate the Froude number for uniform flow conditions.

Solution Example 4.4

Calculate the flow depths just upstream and just downstream of the 90° bend.

Fr =—“n_ 2.0 =0,452 (based on the normal flow depth)

" Jey., 9.81)2,0)

.Downstream control and hence the depth just downstream of the bend will be 2 m.

—2 2
Energy head loss through bend: h, = BV (2’0 )(2’0 )(2’0)

= P REAT T (,1165
r, 2¢  (7,0)(2)9,81) -

Energy equation:

=2
Upstream energy head: H, =H, + h, = ;’_ +y, +h,
g

2
H, = 2.0) +2,0+0,1165=2,321m
(2)9,81)
VZ
y, +—-=2732Im
2g

Write the velocity in terms of the upstream flow depth (y;) using continuity:

_Q  (2002,0+2,0) 40

A ()R2o) oy,
(4’0J2
Yi :
=2,321 m. Solving the only unknown term -
Y1 0)o.81) m s Y V!

y1 = 2,143 m (depth upstream of bend)
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4.5 Example 4.5 — Identification of acting controls
Problem description Example 4.5
Water flows across a 16 m wide road. The road has cross-falls of 2%. Calculate the discharge per unit

width that would flow across the road when the adjacent level rises 0,5 m above the shoulder, see
Figure 4.3.

0, 16m

16.0m

Figure 4.3: Flow across the road
Solution Example 4.5
Assume that the control (point of release) occurs at the crown (B). If there are no energy losses
between A and B, the specific energy at the top of the crown will be 0,5 — 0,16 = 0,34 m and the
critical depth y. = 0,227 m (two thirds of the specific energy).

The corresponding discharge per unit width:

3
q=V.y, = \/gyc =0,338m’/s.m Assume that the actual discharge is 0,3 m*/s.m

q’ 3
y, =3—=0209m and ECZEYc=03314m
g

With this discharge, the normal flow depth (Manning) will be given by:

501
yssE

q =
n
With a Manning n-value = 0,013 s/m'"?
) 1
_y2(0,02)

0,3
0,013

y,=0116 m <y, =0,209 m

The slope of 2% is thus hydraulically steep and the control is indeed at B. If y, was found to be greater
than y. this would mean that the control was at C, and the depth there would be y., from which point
calculations would then progress upstream. Because the depths of flow are small, one should test to
see whether the flow is indeed turbulent.

Re=Y 0,3

T114x10° 2,6 x10° >>2000 , indicating the flow is turbulent.
v , X

Now determine the depth y, at A.
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=2 =2
0,5=y, +-2 +0,35-4
2g 2g

and y, v, = 0,3 (continuity)

Thus y, = 0,472 m

(Energy equation with provision for transition losses)

The depth varies from 0,209 to 0,472 m and since the cross-sectional areas differ by more than 40%,
more than one increment should be used. Use three increments; i.e. depths of: 0,209; 0,297; 0,384 and

0,472 m (see Figure 4.4), and Table 4.7.

| —
l =4 24
B % q 3t
S i <
! A ij AX_}
X] —
o

Figure 4.4: Increments of flow depth across the road

i—E =S, — St (Energy equation for prismatic channels)
X
dE =2 =2
Ax = I dE = i = Y, V_z
S, = S; 2g 2g
) v’n?
S, =-0,02 m/m (uphill) Sy =—;
y 3
Table 4.7: Calculation table (Example 4.5)
y E St Staverage) Ax
(m) (m) (m/m) (m/m) (m)
0,209 0,314 0,002792
0,001831 1,60
0,297 0,349 0,000870
0,000619 3,23
0,385 0,416 0,000368
0,000277 3,81
0,472 0,493 0,000185
YAx = 8,64 m

YAx = 8,64 > 8,0 thus the discharge per unit width should be less (i.e. q should be smaller).
Choose smaller q and repeat until XAx = 8,0 m for a more accurate answer.
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5 SURFACE DRAINAGE

A number of typical problems are explained below.

5.1 Worked Example 5.1 - Flow depth on the road surface
Problem description Example 5.1

Determine the depth of flow if the rainfall intensity is 100 mm/h on a roadway with a width of 10 m
and a cross-fall of 2%. The road gradient is 6%.

The aim should always be to limit the flow depth on the road surface to a maximum of 6 mm to
prevent hydroplaning.

Solution Example 5.1

Figure 5.1 provides the relationship between the road gradient and road cross-fall, width of the
roadway, the energy slope and the flow depth.
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Figure 5.1: Depth of sheet flow on road surface (Laminar flow conditions assumed)

Figure 5.1 could be used to determine the flow depth by starting with the road gradient (n,) and
moving anti-clockwise on the nomograph.

Sy, the energy slope is dependent on n; and n; and may be calculated as follows:

Sp=y/nj +n; (5.1
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S, =4[22 +6

S, =6,32%

Calculate the flow path length, Ly
1

L, :W{H%Jz =(10)(1 + (6)2 ]2

n @) .(52)
L, =3162
d=(4,6x102 )(L,1)*(s,*2) (5.3)

d=(4.6x107)((31,62)(100)*(0,0632) ** = 4,49 mm
5.2 Worked Example 5.2 — Capacity of side channel

Problem description Example 5.2

Determine the flow capacity in a side channel cross section shown in Figure 5.2, and the dimensions
provided below.

/]
= )
A v'| 1B
> 1
X ; A 7V x TZp
1 z
¥ A 7] A
/1
X zpy!'

Figure 5.2: Channel cross section

Manning roughness, n = 0,015 s/m'?
Flow depth, Y = 100 mm

Y'=40 mm
1/Z,=1/20
1/Z5 = 1/40

Road gradient=5 %

Solution Example 5.2

The following relationships could be obtained for geometry (units in mm):

X=ZAY-Y" (5.4

X = (20)(100 — 40)

X =1200

ZsY' = (40)(40)

ZsY' = 1600

Top width, T = 1200 + 1600 = 2800 mm

Z=—
Y
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Q=0Qa+ Qs

S=0,05m/m

Manning n = 0,015 s/m

see calculations in Table 5.1.

1/3

Table 5.1: Channel flow characteristics

Parameter Section A Section B
c - . A, =(0,5)0,1+0,04)1,2) A, =(0,5)0,040)1,6)
ross-sectional area (m?) A, 0,084 A, = 0,032

Wetted perimeter (m)

P, =0.1+](0,06) + (2]

P, =1,6[(0,04) +(0,001)* " /0,04

P, =1,302 P, =1,6001
Hydraulic radius (m) R =0,06454 Rp= 0,020
Flow rate from Manning (m’/s)
0= R%%78% A Qx=0,2015 Qg =0,03514
n

The total capacity of the channel is:

Qtotal = 05

5.3

2366 m’/s

Worked Example 5.3 — Capacity of drop grid inlet

Problem description Example 5.3

Determine the flow capacity of a drop grid inlet, dimensions of 0,9 by 0,6 m and a submergence of
0,2 m if the approaching flow is subcritical. For comparison with Figure 5.6 assume that the inlet
coefficient = 0,8 and the blockage factor, F = 0,5.

Solution Example 5.3

Figure 5.3 provides the relationship of flow rate for an orifice control or a broad-crested weir.

-'---.-______ _____.--'-'-'-.—-
B —— Flow
—_—— H : / —————
TLLLLoy = //f— Tl yia i
\ l
|()p:.:ninu|

Q=CFA,2gH

where:

T >0
[

Figure 5.3: Section through outlet: Drowned conditions

..(5.5)

inlet coefficient (0,6 for sharp edges or 0,8 for rounded edges)

blockage factor (say 0,5)

effective cross-sectional plan area of the opening (m?)

total energy head above grid (m)
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Figure 5.4: Example of typ 0 grid inlet |

From Equation 5.5:
Q=1,77A VH
A =(0,9)0,6)= 0,54 m?

Q =1,77(0,54 ),/0,2

Q=0,427 m’/s

The calculation of the flow rate was based on the orifice equation.

5.4 Worked Example 5.4 — Kerb flow

Problem description Example 5.4

Determine the kerb flow rate if the flow depth is 100 mm and the road gradient is 4%. The road cross-

fall is 2% and the Manning roughness is 0,015 s/m"”.

Solution Example 5.4

The Manning equation may be used.

A= % YT=(0,5)(0,1)(5,0)= 0,25 m?
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P=Y+Y?+T? =0,1++(0,1 +(5,0) =5,10Im

s=-% _ 004 m/m
100
1 (0,25)§

0,04 = 0,446 ms .
0.015) 5 101;

Q=

Strictly speaking, the very wide section with variable velocities should be subdivided into narrower

sections.
5.5 Worked Example 5.5 — Scour velocity

Problem description Example 5.5

Determine the maximum flow depth and velocity in a wide channel with a slope, S is 2%. The channel
is lined with stones (relative density 2,65) and representative size (more than 50% by mass) of

250 mm.
Solution Example 5.5

For a wide channel it is known that:

R=D=y
where:
R = hydraulic radius (m)
D = y=flowdepth (m)
From Chezy:

V= 1810g(1i—R}/ RS

N

From Shields (Equation 5.7) it follows that for a stable channel:

d, > 11 DS
(0,25)
D=y=—-"2_=114

YToe2) "

Now the velocity can be calculated using Equation 5.6:

V= 1810g(1(2(§1£15j)}/il,14 0,02)

v=4,71 m/s

...(5.6)

.(5.7)
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5.6 Worked Example 5.6 — Protection measures

Problem description Example 5.6

Determine the required diameter of stones to protect the sides and bottom of a trapezoidal channel
with side angles of 25° and a flow depth of 1,8 m. The stones are slightly angular and have an angle of
repose of 30°. The channel slope is 0,1%.

Solution Example 5.6

For a stable bed the particle size (d;) should at least be:

d, =11DS =(11)(1,8)(0,001) = 0,0198 m

For stable side slopes the particle size (d,) should at least be:

d, = 8,3Ds
tan’0
cosf, [1 — ——
t
me .(5.8)
where:
0 = angle of slope of sides of the channel (°)
@ = angle of repose of stone material (°)

8.3 Ds

da=
d;=> 11Ds 2 Cos8 |1 tanz 0
tan?

Figure 5.5: Required sizes of the stone for erosion protection of loose bed channels
(The side slope, 0, should always be smaller than the angle of repose, @, to ensure stability.)

From Equation 5.8:

a, = (8.3)(1.8)(0,001) 0028 m

2
cos (25),[1 - tan7(25)
a

tan”(30)
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6 LOW LEVEL CROSSINGS
6.1 Worked Example 6.1 — Low level crossing
Problem description Example 6.1

A river crossing structure is to be provided for a tertiary road linking rural settlements on both
banks of a river. No structure exists and vehicles such as tractors, four-wheel drive vehicles, LDVs
and donkey carts cross via the sandy riverbed. The route is not accessible for motorcars. Motorcars use
an alternative route via the main road with a length of 45 km. Although the current traffic volume is 50
vehicles per day, it is expected to increase to 300 vehicles per day, should a proper river crossing
structure be provided. The expected traffic growth rate for the next 20 years is 2% per year.

At the point of the crossing the river has a catchment area of 360 km?. The 1:2 year flood has been
determined as 120 m?/s.

Test pits were excavated in the sandy riverbed. Solid rock was encountered at depths varying between
1,2 m and 2,0 m. Rock is also day lighting in places.

The approach gradients of the road are moderate and there is no horizontal curvature. The preliminary
design of the vertical alignment of the road across the structure to be provided has also been done. The
straight section in the middle (L,) has a length of 20 m, and K, and K; are both 4 m (refer to Figure
6.1). The slope of the road on the southern bank is - 5,6%, and on the northern bank 7,0%.

Gla — Road surface Water surface (iz%/
/ %

/' X Aj Ay Az ~
) B =
NSO —~— (% —— _.,\/< -
VPI 4P, P, Py _+<VPI,
L Ly L L,
Z 2 2 2
| |
L, L, Ls
Vertical curve | Vertical curve 3
Curviture value K | Curviture value K|

Figure 6.1: Definition of symbols for the flow over the structure

The deck thickness is taken as 500 mm, and the soffit of the deck is on average 1 400 mm above the
riverbed.

Solution Example 6.1
e Design flow rate

The design level is determined as per Section 6.3.3. Design level 1 is taken as the initial choice.
Because of the expected traffic volume of 300 vehicles per day exceeding the suggested 250 vehicles
per day, the design level is increased to level 2. This is supported by the availability of an alternative
route of length less than the suggested 50 km. As the criteria suggested for design level 3 are not met,
design level 2 is selected.
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The design flow rate is determined from Equation 6.1:

=T
es
Qd sign i Q2

..(6.1)

From Table 6.1 follows that f, is 0,50 and Q, is the discharge with a 1:2 year return period (120 m?/s).

Table 6.1: Levels of design for low-level structures®

Average no of times flow can be | Average length of period flow is
Design | Dimensionless | expected to be exceeded per year exceeded (hours)
level factor, f; Min Max Average Min Max Average
value value value value value value
0,25 0,0 4,2 1,3 0,0 30 9,0
2 0,50 0,0 2.4 0,8 0,0 13 5,5
1,00 0,0 1,4 0,5 0,0 6 3.4

Note: * Based on observed data from the Northern Province

Quesien = 0,5 x 120 m?/s
=60 m®/s

o Cross-section

With a design period of 20 years and 2% growth in traffic per year, the anticipated 300 vehicles per
day is expected to increase to 446 vehicles per day after 20 years. Because of this being less than the
suggested 500 vehicles per day and visibility being good, a single-lane structure is opted for. The
cross-fall in the direction of flow is taken as 2%.

° Selection of structure

Because of good, but uneven founding conditions a low-level bridge is opted for. Six spans of 6 m
each fit the river cross-section well. Piers are 300 mm thick.

. Hydraulic calculations

The capacity of the structure is determined as the sum of the flow that can be accommodated over the
structure and through the structure.

Flow over the structure

Assume supercritical flow and decide on a maximum flow depth of 0,1 m (d). The flow that can be
accommodated over the structure is determined from Equation 6.2.

ALY
Qover = P ...(6.2)
A=A +A,+A ,0r
A, _Lq 800K ,d +dL, 1 800K ,d ...(6.3)
3

and
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Py.. =P, +P, +P,,0r

over

P, =%,/800K1d +L, + %,/800K3d ..(6.4)

where:
Qover = the discharge that could be accommodated over the structure within the
selected flow depth (m’/s)
Agver = area of flow over structure at the flow depth selected (m?)
So = slope in direction of flow, for example 0,02 or 0,03 m/m
n = Manning n-value. For a concrete deck neoncrete
Pover = wetted perimeter at the flow depth selected (m)

A, Ay, A; = the areas defined in Figure 6.1 (mz)

depth of flow over the structure (m)

the geometric K value for vertical curve 1

K, = the geometric K value for vertical curve 3

With K being a vertical road alignment parameter, defined as the horizontal length of
road required for a 1% change in the gradient of the road.

F:Q-
I

173

So is 0,02 (2% as above) and Manning n roughness parameter for concrete is 0,016 s/m . The cross-

section area of flow is determined using Equation 6.2.

A %d 800K,d +dL, + éd 800K ,d where K, and K; are both 4 and L, is 20 m (Equation 6.3)

over

oner = 3519 1’1’12
P =% BOOK d +1L, + %,/800K3 = 37,89 m (equation 6.4)

From Equation 6.2:
B IRE S(l)/z B (3’19)5/3 (0502)1/2

Q over
over -

nP2  (0,016)(37.89)
Qover = 5,42 m3/s

Establish whether flow is indeed supercritical by calculating the Froude number (Equation 6.5):

2
B
Fr= |QouB ..(6.5)
gAOVer

where:
B = L;+L,;+L;(m), the width of the channel (or the length of the structure)
g 9,81 m/s?, the gravity constant

and L, =%,/800K1d and L, =%,/800K3d

B=L;+L,+L; L =L;=8,94mand L, is 20 m, giving B equal to 37,89 m

Fr= 1,87, which is > 1,0 m, confirming supercritical flow over the deck of the structure.

Flow passing through the structure
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Assume outlet control, then:
Qundcr = Vundcr Acff .. (66)

V er 18 determined from Equation 6.7, for which the following is required:

unde

Vo = ...(6.7)
where:

Acgr = the effective inlet area through the structure (m?) = XA (the effective

inlet area through the structure)

Lg = the total width of the deck of the structure (m)

Viuw = thevelocity of flow through the structure (m/s)

C = factor that reflects the transition losses (Equation 6.8)
C = Z (K inl + Kout )each cell . (68)

K and K are determined as follows for rectangular sections:

K, at outlet control: Sudden transition: Kin= 0,5
Gradual transition: Kin= 0,25
K. at outlet control:  Sudden transition: Kow= 1,0
Gradual transition: Kow= 1,0 for 45° <6 < 80°

0,7 for 6 = 30°
0,2 for 6 =15°

- DATUM

B

Figure 6.2: Definition of symbols
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By applying the conservation of energy principle, determine the depth upstream of the structure, h as
shown in Figure 6.2, that is required to pass the flow rate, Qqye:

h=—=+d ...(6.9)
2g
H=h+x+D ...(6.10)
where:
X = the thickness of the deck (depending on the structural design outcome) (m)

D = the height of the soffit of the deck above the river invert level (m)
H,=D-L,S, ...(6.11)
where:

Lg = the total width of the deck of the structure (m)

Sy = slope of the conduit underneath the structure (m/m)

Determine the depth upstream of the structure, h, that is required to pass the flow rate, Qgye; using
Equation 6.9.

=2
h= ‘2/—2 +d, where Vz = Qover/oner = 1570 m/s
g
h=0,247m

From Equation 6.10:
H;,=h+x + D, where h is as above, x=0,5mand D = 1,4 m
H,=2,147m

From Equation 6.11:

H, =D — Lg Sy, where Lg = (4,0) + (2)(0,25) = 4,5 m (for the guide-blocks)
H,=1,4-(4,5) (0,02)

H,=1,31m

Assume K;,; = 0,5 and K, = 1,0 (both sudden transitions), then
C=6x(0,5+1,0), see Equation 6.8.
C=9

P.en is the total wetted perimeter of each cell (m).
P =(5,7)(2)+(1,4)(2)=142m

n,, = concre; D eoncrete Priver D ver and assume Nyiver tO be 0’03 s/m1/3
cell cell
N (5,7 +(2)(1,4))0,016) .\ (5,7)(0,03)
eell 14,2 14,2

Neen = 0,022 s/m'?

Per= 2P = (6)(14,2) =852 m
Z(n cell Pcell)
Peff
(6X(0,022)14,2))
85,2
Negr = 0,022 s/m"”

eff

eff
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R= Aeff/ Peff where
A= (6)(5,7)(1,4) = 47,88 m’

R=10,562m

V e 1T0om Equation 6.7 is:

v = ﬁ 2,147-1,31

under 2 L = 5

€ Ner Ls 9 (0022) (45)
2g  R¥ 209.81)  (0,562)"

Vonder = 1,344 m/s

Also from Equation 6.6 Q .. =V .. A = 6435m’/s

Design discharge
The capacity of the structure at the design level Qoyer + Quuder = 69,8 m3/s

AS Qqver T Qunder 18 larger than Qgesign (60 m?/s), the design is complete as the structure is adequate. If
this was not the case, the level of the deck would have to be adjusted, and the calculation be redone.
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7 LESSER CULVERTS AND STROMWATER PIPES

7.1 Example 7.1 - Determination of the required culvert size

Problem description Example 7.1

A culvert size needs to be determined which would handle the design flood (Qp). The calculated 1:20
year flood (Qa) is 85 m’/s and the road can be assumed to be a Class 3 road. From Figure 7.1 the

design flood frequency is determined as T = 15 years and the calculated 1:15 year flood (Qys) is
44,5 m’/s.

100 Road Class 1 1

Rl

8-

50

Road Class 2

40

Design flood frequency (T years)

0~

2

Sr Road Class 4 & 5

S Road Class 6

T T T T T T
1] 20 40 60 80 100 120 140 160 180 200

1:20 year flood (m'/s)

Figure 7.1: Design flood frequency estimate

No significant debris is anticipated since the catchment area consists mainly of grassland. The client
favours the use of circular (pipe) culverts. The final level of the roadworks across the river will be at a
level of 2,5 m above the riverbed.

The absolute roughness, k, for the trapezoidal river channel is 0,1 m. The cross-sectional details are
provided in Figure 7.2. The natural slope of the river, Sy, is 0,0015 m/m upstream from the culvert and
it is 0,004 m/m downstream from the culvert. The culvert will be placed at the same slope as the
upstream river section. The submergence of the culvert should be limited to a H/D ratio of about 1,2.
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— Road surface
1

SO0

Figure 7.2: Cross-sectional details of the natural channel
Solution Example 7.1

First calculate the normal flow depth, Y, and flow conditions in the channel upstream and downstream
of the planned culvert.

. Determine the upstream normal flow depth

For a uniform channel the relationship of Cheézy can be used.

Q=CyRSA (7.1)
where:

Q = flow rate (m’/s)

C = Chézy constant

R = hydraulic radius (m)

A = area (m?)

Youpstream = Y = upstream normal flow depth (notation used here) (m)
44,5=1 SIOg(IE—RJ JvRS A
44,5=181log % ﬁA

kP P

Substituting the values for A, P, S and k; in the above equation provides:

(8Y +(2)(0,5)(Y*)(2))

14518 10g((12)(8Y + (2)(0,5)(Y2)(2))j \/ (8Y +(2)(0,5)(Y*)(2))0,0015)

0,18+ (25 Y) 8+ (25Y)
Solve the upstream normal flow depth Y in the above equation.
Y =2,0mand A=24,0 mz, hence V = 1,851 m/s.

The flow type can be determined by calculating the Froude number,

2
Fr? = QAI? =0,2327 and Fr = 0,482
g

7-69 Lesser culverts and stormwater pipes



The flow is thus subcritical (Fr < 1) and therefore the cross-sectional area of the river may be reduced,
resulting in a deceleration of the flow and some damming upstream from the intended structure (Note:
In the case of supercritical flow it is not allowed to decelerate the flow, because it might lead to the
creation of a hydraulic jump that might breach the downstream structure).

. Determine the downstream normal flow depth

In a similar way as above, the downstream normal flow depth can be determined. In this case
the downstream normal flow depth, Y4,= 1,541 m, Fry; = 0,841 and the flow is subcritical.

=2

Total energy head upstream of the culvert, H = A +Y=2,175m
2g

. Determine the size of the culverts to manage the flow

The height difference between the river bed and the final road level is 2,5 m. If the optimum H/D ratio
of 1,2 is used the maximum vertical dimension of the culvert (D) is 2,5/1,2 = 2,08. Based on Figure
7.4 multiples of 1,8 m diameter pipe culverts will be used.

For a culvert with a diameter of 1,8 m and the downstream flow depth of 1,541 m, the flow will
probably be inlet controlled (to be verified) and the flow can be evaluated based on the relationship for
inlet control (Table 7.1).

Table 7.1: Relationships for the flow rate under inlet control

ROUND CULVERTS RECTANGULAR CULVERTS
o D = height (inside) (m)
D inside diameter (m) B = width (inside) (m)
For: For:
0<H,/D<0,8 0<H,/D<12

0,05 1,9
L=0,48 S_O i Q:chBH1 %ng
D*./gD 0,4 D 3 V3

Where: Cg = 1,0 for rounded inlets (r > 0,1B)
Cg = 0,9 for square inlets

And for: 0,8 <H/D <1,2 * And for: Hy/D > 1,2
_Q  _gaq S ML Q=C,BD,2¢g(H, -C,D)
D2\ /gD |04 D

Where: C;, = 0,8 for rounded inlets

(S¢ = slope of culvert bed with slight Cy = 0,6 for square inlets

effect on capacity)
Note:
* For Hi/D > 1,2, the orifice formulae

applies Q=C, A4 /2g[H1 —gj with

CDz 0,6

In this example, the maximum —L === —1 39 and the flow rate through a culvert can be determined.
1,8

H, 25
D
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Table 7.1 reflects that for a circular pipe culvert, under submerged conditions with H/D > 1,2, the
flow rate can be determined as follows:

D
Q=C,A 2g(H1 —5) ..(72)

Q=(0,6) \/ (2)9.8 1)(2,5 - %) [n@) ~8,55m%/s

The number of pipes required = 44,5/8,55 = 5,20.

Determine if it is practical to install 6 pipe culverts in the cross-section of the river.

Assume the distance between the pipes is 100 mm and the wall thickness of the pipes is about 78 mm,
then the total width of six culverts will be = (6)[1,8+(2)(0,078)] +(5)(0,1) = 12,236 m. With some
groundwork it is possible to place the culverts as is shown in Figure 7.3.

Figure 7.3: Positioning of the 6 pipe culverts
There are, however, also box culverts that could have been used here.

Figure 7.4 reflects the required culvert size for a given (design) flow rate and a H/D ratio of 1,2.
Reference to pipe and portal (box) culverts are reflected here.

By means of Figure 7.4 and by assuming that a portal (box) culvert could be used as an alternative to
the calculation above, the required culvert size for Inlet Control conditions could be obtained.

Assume that 5 culverts will be used, the flow per culvert = 44,5/5 = 8,9 m%/s.
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Hi=H;+Z-H:;(m) H, (m)
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DEFINITION SKETCHES
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INLET CONTROL OUTLET CONTROL
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w = o w

L
©
|
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=
[

EFEEE EFERER B
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Culverts with square inlets Culverts with rounded inlets

L (m)

Figure 7.4: Diagram for the determination of sizes of culverts and storm water pipes
Using Figure 7.4 for a square culvert and following the lines for Inlet Control (clockwise), the value
for H; = 2,4 m for the flow of 8,9 m%s, a 1800 x 1800 mm portal culvert could be selected (as shown

in Figure 7.5). The H/D ratio will however be 1,33 and the capacity of the 5 culverts needs to be
verified.

This result can be checked with the following formula (Table 7.1):
Q=ChBD1/2giH1 —ChDi (73)

Where C,, = 0,8 for rounded inlets and C;, = 0,6 for square inlets.

Q=(0,6)(1,8)1,8)y2(9,81)2,4 —(0,6)1,8)) =9,893 m*/s
and hence 5 culverts will be sufficient.
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Figure 7.5: Determining culvert size (inlet control)
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. Evaluation of the same problem with the upstream slope equal to the downstream slope

It follows from the new slope details (So upstream aNd So downstream 15 0,0015 m/m) that the upstream and
downstream normal flow depths will be 2,0 m, as was determined before. If the upstream water level
is limited to a maximum of 2,5 m to prevent the inundation of the road, the culvert flow rate can be
determined as follows.

For inlet control conditions the length, roughness, slope and hydraulic radius of the culvert have no
influence on the discharge rate. For outlet control these variables do influence the flow rate and have
to be considered.

Assume that the following information is still valid:

Slope of the culvert, Sp = 0,0015 m/m

Roughness of the culvert, k; = 0,002 m

Diameter of the culvert, D = 1 800 mm

Length of the culvert, L =25 m

By assuming that 6 culverts will be used the flow rate per culvert = 44,5/6 = 7,417 m>/s.

It was reflected above that the upstream flow is subcritical, i.e. Fr = 0,482, hence downstream control
will be experienced in the channel prior to the placing of the culvert.

By applying the energy equation between the upstream/inlet (Position subscript 1) and the
downstream/outlet (Position subscript 2) (as represented in Figure 7.6) the required upstream energy,
H,, can be determined by using the energy principle.

|> ‘t:l TEL

| >
T T
AT T T T “ —

o
T T T
1
(l) & (57777“

Figure 7.6: Energy components of flow through a culvert

H +S,L=H, +h, +h;

(between Position 1 (upstream) and Position 2 (downstream))

(74

For the flow of 7,417 m3/s the flow velocity in the pipe culvert can be determined as follows:

RETL
7(0,9)

v=

The secondary losses, h;, can be determined as follows:

hllr2 = hl inlet T hl outlet . (75)

v’ (2,915)

hy, =K +Kope)7—=(05+1 = 0,649
I, ( + outlet) 2g ( Dt ) 2(9’81) m

inlet
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The friction losses, hy, can also be determined, assuming that full bore flow conditions in the culvert
will prevail:

ALV
~ 2gD ...(7.6)

¢

For rough turbulent flow conditions,

1 3,7D

—=2lo

7 2ol K ) (17
2=0,02015

h, =0,121m

For outlet control conditions, the upstream conditions can now be determined (Equation 7.4):
H =H,-Z + th + th

H,=(2,0+0,175)-0,0015(25) + 0,649 + 0,121
H; =2,908 m

The value of H; for outlet control is greater than the maximum allowable damming height of 2,5 m,
hence outlet control will be maintained through the culvert. The only way to reduce the upstream flow
depth is to consider more culverts of similar dimension in parallel or larger culverts.

Assume that seven culverts will be used. With the flow of 44,5/7 = 6,357 m*/s (v = 2,498 m/s) and the
value of the losses, H, = th + th =0,477 + 0,089 = 0,566 m, the upstream conditions can now be

determined.

H,=H,-Z,+H,

H;=(2,0+0,175) - 0,0015(25) + 0,566

H; =2,704 m (which is still greater than the allowable upstream damming height)

To illustrated the use of Figure 7.4, start at Q = 6,357 m®/s (flow rate in each of the 7 culverts) and
Hy = 0,566 m, then it can be seen that the 1 800 mm pipe culvert is still insufficient to transport the
flow (Figure 7.7). Figure 7.4 could thus be used to consider other culvert sizes.

Placing the seven culverts in parallel will also however result in a section width of about
(ND[1,8+(2)(0,078)] +(6)(0,1) = 14,3 m, which is much wider than the river base of 8,0 m.

The number of 1,8 m pipe culverts required to prevent overtopping of the road will be eight (although
still marginally undersize). Alternatively portal culverts with a larger vertical dimension (2,1 m) could
be used following the same procedure as above.

An economic/technical assessment of the alternatives i.e. re-alignment of the road against provision of
a practical culvert design have to be conducted to select the solution for implementation without
changing the risk of failure.
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Figure 7.7: Determining culvert size (outlet control)
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7.2 Example 7.2 - Erosion protection downstream from a culvert
Problem description Example 7.2

In Example 7.1 it was indicated that for inlet control it is possible to convey 8,9 m*/s (for H/D = 1,2)
through a 1,8 m diameter circular culvert. You are now requested to design the protection works for a
single 1,8 m diameter culvert, functioning under inlet control conditions with H/D = 1,2. The concrete
culvert is 28 m long with an estimated absolute roughness of 0,003 m. The culvert will be installed at a
slope of 0,01 m/m.

The flow releases into a natural trapezoidal river section with a base width of 2,00 m and side slopes of
1V:2H. The natural slope of the river is 0,004 m/m and the roughness is 0,05 m. Details of the cross-
section are given in Figure 7.8.

r Road surface

P
-

o
-
1

-
/;I
///
=

2000

Figure 7.8: Upstream view of the culvert
Solution Example 7.2

The uniform flow equations of Manning and Chezy can only be used if uniform flow occurs. Uniform
flow will occur if the cross-sectional parameters, roughness and slope remain constant. With the
culvert length of only 28 m it is unlikely that the normal flow depth will be reached within the culvert.
By assuming that the normal flow depth will be reached, the analysis is conservative, resulting in a
flow depth that is less (for the slope steeper that the critical slope, Sy > S,) or the flow depth will be
greater for a subcritical slope (Sp < S,).

Firstly the normal flow depth, yn, downstream from the culvert in the river is determined by using the
Chezy formula:

v=CvRS ...(7.8)
12R
=vA=18| log—— |WRSA
Q=v [Og k. J ..(1.9)
where:
Q = flow rate (m3/s)
vV = average velocity (m/s)
R = hydraulic radius (m)
ks = absolute roughness (m)

S = slope of the river section (m/m)
Table 7.2 reflects the cross-sectional parameters for a circular pipe.
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Firstly the normal flow depth, y,, downstream from the culvert in the river is determined by using the
Chezy formula:

=C+/RS

Q=vA=18 (log IE—R}/RSA

<|

..(7.8)

..(7.9)

where:
= flow rate (m’/s)
average velocity (m/s)
hydraulic radius (m)
absolute roughness (m)
= slope of the river section (m/m)
Table 7.2: Sectional parameters for a circular cross-section

Ve
I

wnE
[

Variable Y < D/2 (0 < 7 radials) Y > D/2 (0 > & radials)

]

Cross-sectional view

3 i i
d+y = J?

5 . 2 2 (0
:21?2’) R%0-2(0,5)(R - y)Sln(gJR mR> —(R*0)-2(0,5)R - y)Sm(z)R

Wetter perimeter,

P (m) R(0) R(27-6)

Hydraulic radius,
R (m)

e~ R

By substituting the known values:

8,9=18 1ogﬁ R(0,004)A
0,05

>

with:

where:
yn = the unknown normal flow depth (m)

Solving for y,:
Yo = 1,068 m

This indicates that the normal flow depth in the river section downstream from the culvert will have no
backwater influence on the culvert flow (y, < D).
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Now the flow depth at the outlet of the culvert is determined. (Refer to the reasoning above where the
influence of assuming uniform flow in the culvert was explained.)

The critical slope in the culvert can be determined. Critical conditions will occur when Fr = 1, and the
critical slope S. can be determined for full flow conditions as follows:

S _ VZ _ Q2
° CR C’A’R ...(7.10)

S =0,00792 m/m

This indicates that the flow depth in the culvert will reduce downstream from the position where
critical flow occurs near the inlet of the culvert because Sy > S..

If it is assumed that the flow depth in the culvert Y is more than D/2, solve for a potential flow depth,
Y.

It is found that:

y = 1,330 m; A = 2,015 m*>; B = 1,582 m (top width of flow); v = 4,417 m/s and Fr = 1,25
(subcritical).

y/D = 1,330/1,8 = 0,739

Figure 7.9 can now be used to select the appropriate erosion protection.

In this example the appropriate protection falls in the Type III. Figure 7.10 can now be used to obtain
dimensions for outlet erosion protection.
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Figure 7.9: Limiting values for different methods of erosion protection at culvert outlets
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Calculated dimensions:
50 = 0,258 m

= 10,8 m

9,0 m

9,0 m

0,517 m

1,8 m

= 09m

TEHO®W»>OU
Il

Section B-B

Type 111

Type 3(a) Stone Type 3(b) Stone
Shallow Stilling Basin Deep Stilling Basin

Q333 5333 1333 a3
Dsp=0,0552 /Dy Dsp=0,0362 /D, (m)
C =3Du+ 6F (m)
A =2Do + 6F (m)
B =2Do + 6F (m)
D =2Dso (m)
E =Do (m)
F =0,5D, (m) F=D (m)

Figure 7.10: Dimensions for the outlet erosion protection

Using Figure 7.11 with a flow of 8,9 m®/s in a circular culvert the values of Froude and the flow depth
can also be obtained which will correspond with the calculated values.
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Figure 7.11: Diagram for the determination of outlet velocities for steep culverts and storm
water pipes (Only H1/D = 1,2, So > Sc)
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8 BRIDGES AND MAJOR CULVERTS

8.1 Worked Example 8.1 — Backwater at a bridge

Problem description Example 8.1

Determine the backwater caused by a proposed bridge across the Broekspruit. Details of the bridge

are shown below in Figure 8.1.

Design discharge Q = 150 m’/s
Average bed slope S, = 0,00082 m/m
Angle of skew o = 15°
Bridge span on skew b, = 17,6 m
Projected bridge span b = 17,0 m
No of rows of piers N, = 1
Projected width of pier W, = 2,00 m
[]
n=0,035 | n=(,03 | n=0,035 |
| |
T
VAN Anticipated water level s S AN
Za
£ Bridge 4 £
iz ning <
I: River bed level RS /é\ o
=81.40m N
ALK
11,34m | 1.61m_| 17m | 8.37m
| ! |
38.32m
Figure 8.1: Upstream view of the bridge
Determine:
(1) Characteristics of the unconstricted flood state

(i1) The flow type

(i)  Bridge opening ratio

(iv) Velocity head coefficients
) Calculate backwater

Solution Example 8.1

(i) Characteristics of the unconstricted flood state:

First determine the normal flow depth, y,.
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Table 8.1: Sub-section details

Sub-section n; A; (m?) P; (m)
1 0,035 1,602y (y> + 10,26 yH)**
2 0,030 18,61y 18,61
3 0,035 1,163y* (y* + 5,41 y)*°

Utilising the Manning equation the normal flow depth can be calculated, y, = 3,157 m.

Table 8.2: Sub-section flow characteristics

A, _ "
Sub- Ai Pi Ri = ?1 qi i = 2_
section (m?) (m) i (m’/s) i
(m) (m/s)
1 15,96 10,59 1,51 17,17 1,08
2 58,75 18,61 3,61 120,69 2,05
3 11,59 7,99 1,45 12,14 1,05
86,30 37,19 150,00
This result in the:
Flood stage level 84,56 m
Width at flood stage = 36,06 m

(ii) Determine flow type:

Fr, =

(QZBJ% _((150)2(36,06)J%

gA? ) (9,81)86,30)

0,359 <1

Flow is Type I or Type II.

Calculate specific energy (Es,) of unconstricted normal flow:

with y, = 3,157 m (Flood stage level — river bed level)

Q 150
A, 86,30
1,738 m/s
— 2 2
y. 4 =3,157+(l’738)
" 2g 2(9,81)
3,31l m
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Calculate specific energy (E,.) of constricted flow critical depth:

2 VA 2\

v = Q" | _[_Uso)_ = 1,995 m
gb (9,81)17)

- Q 150 _
v = = 4,424 m/

% y,.b  (2,817)17) e

- 2 2
Ec = Yoo V22°g = 1,995+(‘2"(g%1)) =2992m<  Eyindicating Type I flow (see
Figure 8.2).
4
_______ N.W.§

NN
VARG R

——

e

Type I flow (subcritical throughout)

e ———
—_—

Figure 8.2: Type I flow with substantial damming and does not reach critical conditions

Because the values of E, and E. are fairly close, and other losses are so far ignored, it would be
prudent to check Type I and Type II flow.

(iii) Calculate bridge opening ratio:

Qv =

(120,69 _7 M =
17 +1,61

110,25 m’/s =

(iv) Calculate velocity head coefficients:

o =

(05)

> (av?)
Qv,’
1,20
1,15 (from Figure 8.3)

Q, 11025
Q 150
0,735
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Figure 8.3: Estimation of the velocity coefficient, o, (generic example)

Calculate backwater

v)

For Type I flow:

Determine secondary energy loss coefficient K from Figure 8.4:

r\p
I Ap2

Ap - Projected area of
piers in flow direction
A5 - Area based on b cos of
ignoring piers

_M ch!]

1.0 ‘

.

094

08+
07+

B Q=0Q,+0Q+0Q
05T M :%b-

04T Example:

03T

02T

01+

k* = 0,8

30 28 25 24 22 20 18 e 14 1.2 10 osl o6 04 o2 02 04 06 Ulfh' 10 12 14 16 18 20 22 24 26 28 30
K, A K, | K#
|
v Q. ! Qo ! Q, | O 1
L i ! ( 0.6+
I
nanoms l annnnnnna e
UL ] 104
\ 1
; : : 12+
e=1- %:‘ Q. < Q,
14
T Q;
e=1- G:L Q,< Q¢ L6+
L8+
Eccentricity (e) 2,04 AI"I?'DHL‘II ()]
angle
¢=0-08 =T > Q’l:;,)
e=10 gl &= 4509 = 1

K+ AK+AK ¢

Figure 8.4: Chart to determine the backwater coefficient, K*
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Projected area of piers in flow direction and projected area below normal water level.

A, = W)y, A = (bcoso)(yn)
- QG157 - (17c0s(15°)(3.157)
= 6,314 m? = 51,84 m?
J _ A, _6314
A, 5184
= 0,122  (use J=0,1 from Figure 8.4)
Eccentricity
e _ - % - 12,14
¢ 17,17 +(120,69) -7
17 +1,61
= 0,56
From Figure 8.4 and with ¢ = 15°
K = 0,80
Approximate backwater (to estimate A in Equation 8.1):
C eV ALY (ALY |9
h! =K', 22 + g, [ “ZJ o i S (8.1
2g A, A, 2g
where:
K = secondary energy loss coefficient
oy, Oy = velocity coefficients
vV, = Q (m/s) where Q = design discharge (m?/s)
AnZ
Ap = projected flow area at constricted section 2 below normal water level of the
river section (m?)
A = flow area at section 1, including the influence of the backwater on the flow
depth (m?)
Ay = flow area at section 4 (m?)
v, = Q _ 150
A, 5184
= 2,894 m/s
V 2
h™ = Ko, —2 ...(8.2)
2g
: 2,894)°
h = 0,80)1L,15 2.
1 (0.80)115) 2(9.81)
= 0,393 m
A = A, +h' B=(86,3)+(0,393 )36,06)
= 100,46 m?
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Final estimate of backwater (Equation 8.1):

A 2 A 27
b, _ h' +a, ( an _( nzj Vi
A, A, 2g
2 2 2
1,84 1,84 2,894
= (0,393)+(1,20) o184 (518 ( A9 )
86,30 100,46 2(9,81)
= 0,441 m
For Type II flow:
b = (b-3W,)=170-20
= 15,0 m
G = 0,152 from Figure 8.5
0.4
@) h* + Y-Yor, &, /vy )2
S 0.3 o av T,
= 2 )
2
o
& S S
2 02 ST F——1_
3! e ] |
Z o041 ~S
[
0 =
0 0.1 0,2 0,3 0.4 0,5 0,6 0,7 0,8 0,9 1,0
Bridge opening ratio, M
Figure 8.5: Estimation of the Backwater Coefficient, C,
B Qz 3 (150)2 3
Yae B 2| T 2
gb, (9,81)15)
= 2,168 m
g/ _ A, 51,84
b 17
= 3,050 m
In 1% iteration, assume
_ Q 150
v, = —=
A, 86,30
= 1,738 m/s

for v, based on the net width:

V2c

(gy2e )" =(0.81)2.168)*
4,612 m/s
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— 2 — 2

b= a, e (C, +1)-q, Tt Yoo 7Y
2g 2g

1,15)4,612)°(0,152+1) (1,20)1,738)’
= (15X 2(9)85) )_{ 2()5 ) ) +(2,168)—(3,050)
1,436 - 0,185 + 2,168 - 3,050
0,371 m

Adjust result for improved value of v,:
A, = A, +h' B=(86,30)+(0,371)36,06)
= 99,67 m?

150
99,67
1,505 m/s

*1

2
h _ 1436 (1,20)(1,505)

2(9.,81)

+2,168-3,050

0,417 m

Although the difference in this case is negligible, to be conservative, the higher value should be used.
From the calculations h,”' for Type II flow was 0,417 m which is less than the backwater calculated
for Type I flow, thus Type I flow prevails i.e. h; ' = 0,441 m.

Note that this example was also modelled in HEC-RAS (provided on the supporting flash drive) and
that the highest backwater was obtained by the Standard Step Energy Method. The backwater is
300 mm, which is less than the value of 441 mm obtained above. However, in this model the
ineffective flow area option had been used. The model was then re-run, with this option switched off
and a higher backwater of 580 mm was obtained in the revised model.

Users of HEC-RAS should therefore carefully consider the option where the bridge approach
conditions are “smoothed”, thereby reducing the backwater.

8.2 Worked Example 8.2 — Scour at a bridge
Problem description Example 8.2

Consideration is being given to construct a bridge across the Sand River, which is some 730 m wide at
the proposed bridge site. The potential scour at the bridge should be determined. This problem was
also evaluated with HEC-RAS, and the data files are included with the data files as Example2.prj.

Figure 8.6 shows a plan view (obtained from the HEC-RAS problem evaluation) and the position of
the bridge relative to the other cross-sections. The cross-sectional information for all the sections is
available. The bridge will be positioned at cross-section 6.5 (downstream from cross-section 7 and
upstream of cross-section 6).
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76.5

Upper reach

Figure 8.6: General layout of the cross-sections and the position of the bridge
The bridge data is described below and the bridge cross-section is shown in Figure 8.7.

The bridge opening between the sloping abutments is approximately 126,61 m wide and the bridge is
supported by five piers, each with a width of 1,5 m (equally spaced). The high (road surface) and
low cord (bridge soffit) values for the bridge deck on the upstream side are 6,7 and 5,5 m respectively.
The user can open the project (Example2.prj) in HEC-RAS and by selecting the appropriate icons,
review the bridge data which is not repeated here in detail.

The design flow rate for which the scour analyses have to be conducted is the 1:100 year flood (Qjgo),
which has been determined to be 850 m?/s.

The flow in the river is downstream control and the normal flow depth, y,, could be calculated at the
bridge, assuming a representative slope of 0,002 m/m.

Bed material characteristics
The sieve analyses (percentage passing) of the bed material revealed the following:

D50: 0,0020 m
D90: 0,0045 m
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Figure 8.7: Upstream and downstream bridge cross-section from the HEC-RAS analysis
Cross-section details
The cross-section details are given in the Table 8.3 below. These details can be obtained from
analysis of the surveyed cross-section information, using software such as HEC-RAS, or computing
the variables by hand, as illustrated in Example 8.1.

Slope of the river

The general slope of the river is 0,2 %.

Determine
(1) Short-term general scour
(i1) Contraction scour

(iii) Local scour at the piers and abutments
(iv) Total scour
) Verify the scour depth with the method based on the principle of applied stream power.

Solution Example 8.2

For this analysis the design flood discharge of 850 m*/s will be used (Chapter 3 describes procedures
to determine the design flood).

The contracted width at the bridge will be 126,61 m. This will result in a discharge per unit width of
850/126,61 = 6,713 m’/s.
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The normal flow depth (fixed bed), y,, of the river can be determined by the assumption of the energy
slope to be equal to the bed slope 0,002 m/m and by using the Chezy or Manning equations.

It is estimated that the bed roughness under flood conditions will be 0,002m, equal to Dsy the
representative sediment material size.

Table 8.3: Details of cross-section 6.5 (Obtained from HEC-RAS analysis)

Section Yo (m) | Area (m?) Wetted(l;f )rlmeter Flow rate (m’/s)
Left bank 209,97 288,17 168,75
Main channel 2,98 258,73 126,67 542,60
Right bank 185,40 283,48 138,65
Total 654,10 698,32 850,00

R=0,937mand v = 1,299 m/s

Top flow width = 698,2 m for the calculated normal flow depth of 2,98 m.

It is assumed that the bed material consists of deep alluvial sand with no cohesion.
(i) Short-term general scour

The regime equations are applied to establish equilibrium conditions at the design flow:

B=14Q Dy F* ...(8.3)
where:
B = mean channel width (m)
y = mean depth of flow (m)
Q = equivalent steady discharge which would generate the channel geometry (m’/s)
q = discharge per unit width (Q/B) (m’/s.m) (Note: To estimate channel geometry

conditions under flood conditions the design flood flow may be used.) ®”

Dsy = median size of bed material (m)
F; = side factor to describe bank resistance to scour (Table 8.4)
Table 8.4: Side factors
Bank type Value of F;
Sandy loam 0,1
Silty clay loam 0,2
Cohesive banks 0,3

With Fg=0,1 from Table 8.4 for sandy loam, the width B can be calculated.
B =273 m, which is wider than the proposed bridge of 126,61 m.

Use Equation 8.4 to determine the mean flow depth at the equilibrium width:

y =038 "Dy .(84)
where:
y = mean depth of flow (m)
Dsy = median size of bed material (m)
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q=850/273 =3,114 m*/s.m
Mean depth y = 2,34 m. The maximum depth, Y.x = 1,25y = 2,92 m.

The maximum live-bed depth, Y., is slightly less than the fixed bed depth, y, of 2,98 m, which
reflects that no general short term scour will occur.

(ii) Contraction scour
It has been indicated that contraction scour can be determined by applying either the regime
equations (Equations 8.4 for the case of an alluvial channel) or the contraction equations (Equations

8.5 with 8.6 or 8.7).

The depth of scour is given by:

d, =(y, —y1)+(1+K)(%J ...(8.5)

Sediment-laden flow

8T8
Y1 c 2 1

Clear water flow

2 3/7
yo| —L (8.7)
40D, ** B?

First apply the regime equation on the reduced width of 126,61 m. In this case q = 850/126,61 =
6,714 m*/s.m leading to a mean flow depth, y of 3,915 m. From Table 8.5, y,..x can be determined as
follows: Yimax = 1,25 x 3,915 = 4,893 m. This reflects a scour depth, d; = 4,893 —2,98 =1,913 m

Table 8.5: Factors to convert mean flow depth (y) to maximum channel depth

Description Multiplying factor
Straight reach of channel 1,259
Moderate bend 1,50
Severe bend 1,75
Right-angled abrupt turn 2,00
Note: * Neill recommends that this factor be increased to 1,50 in cases where dune movement

takes place on the riverbed.

Secondly the contraction equations are used to determine the scour depth after it has been established
if the flow will be sediment laden or not.

V. can be determined using Equation 8.8.

Ve= [gDS = +/9,81(2,98)0,002) = 0,242 m/s ...(8.8)

and the term, V«Dso/v =483 >> 13, thus in turbulent flow region (see Figure 8.8).
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The critical shear velocity is:

Vee _ 0,12 ...(8.9)

SS

The settling velocity, Vs can be obtained from Figure 8.9 for the representative particle, Dsp, and the
relative density of 2,65, it follows:

V= 0,24 m/s, and V:. = 0,029 m/s

The velocity at the boundary between sediment movement and no sediment movement (the ‘critical’
velocity), V., is determined from the logarithmic relationship:

V.= 5,75\7*Clog1§—R ...(8.10)

S

From Equation 8.10: V, = 5,75V*clog1§—R = 5,75[(0,029)105{12 Egzzzg =0,625m/s

S

o}

oundary laminar__ | Turbulent
flow region | flow region

Vi
Vss

SEDIMENT MOVEMENT

Vid 59

0.5

\ NTEe =0,12
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1
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Figure 8.8: Modified Lui Diagram showing the relationships for incipient sediment movement
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Figure 8.10: Long constriction in sediment-laden flow: definition of terms
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The average approach flow velocity of 1,299 m/s > “critical’ velocity of 0,625 m/s, thus sediment will
be entrained and Equation 8.11 together with Figure 8.10 can be used to estimate contraction scour.

(3 8

6/7
Y2 _ (;5206] =1,469 (widths and n-values are equal for these sections)
YI s

v, = (1,469)(2,98) = 4,378 m

Assuming a level bed with a total depth of 4,378 m, the velocity in the contraction can be determined:
_ 850

_ ~1,63m/
V2T Ga78N2661-5(15)

Note that in this case the downstream area is 521,5 m?, calculated as follows (4,378 x (126,61 —
5(1,5))). This is larger than the upstream main channel area of 258,73 m? (Table 8.3), and thus the
flow is expanding. Equation 8.12 is used to determine the contraction scour depth.

=2
d, = (y2 -V, ) + (l + K{sz—vlj and with K =1 for a sudden transition ...(8.12)
g

2 2
d, = (4,378 -2,98)+ (1 + 1,0{MJ
2(9,81)

d,= 1,468 m

This scour depth (1,468 m) is less than that obtained with the regime theory (1,913 m).

(iii) Local scour at piers and abutments

For piers in alluvial cohesionless materials:

Use Equations 8.13 and 8.14 to compute local scour in two different ways for alluvial channels
(cohesionless material). Obtain the factors needed for Equation 8.13 from Table 8.6 and Table 8.7.
Obtain the factors needed for Equation 8.14 from Table 8.6 to Table 8.8 and K, in cases where

armouring is applicable. Compare answers obtained from Equations 8.13 and 8.14 and select a
conservative answer using good engineering judgement.
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Table 8.6: Correction factor K;, for pier nose shape

Shape of pier in plan * Lil;%it:/(}f;i)d)th K,
Circular 1,0 1,0
2,0 0,91

Lenticular i:g 0. 607’_706, 7
7,0 041
Parabolic nose 0,8
Triangular 60° 0,75
Triangular 90° 1,25
Elliptic g:g 8:2;

Ogival 4,0 0,86-0,92
2,0 1,11

Rectangular 4,0 1,11 (HEC 18) - 1,40 (F&C)

6,0 1,11

Note: " Table 8.6 is based on the list by Faraday and Charlton (1983, which is more
complete than the list in HEC 18 documentation

Table 8.7: Correction factor K,, for angle of attack of the flow

Angle (skew angle |y, _ 4 L/b=8 L/b=12
of flow)
0 1,0 1,0 1,0
15 1,5 2,0 2,5
30 2,0 2,75 3,5
45 23 3.3 43
90 2,5 3.9 5,0

Note: In the case of L/b larger than 12, the ratio’s for L/b = 12 should be used.

Table 8.8: Correction factor K3, for bed conditions

Bed condition Dune Height (m) K;

Clear-water scour Not applicable 1,1

Plane bed and anti-dune flow Not applicable 1,1

Small dunes 0,6m-3m 1,1
Medium dunes 3m-9m 1,1-12

Large dunes >9m 1,3

From Equation 8.13, with depth y, in the bridge section as determined from regime:

d, =1,8y,"°b"* -y, ...(8.13)
where:
d = local scour depth at pier (m)
Yo = depth upstream of pier (m)
b = pier width (m)

d, =1,8(3,915°7)(1,5°%) - 3,915
d, =1,629 m

Note that the scour level is (3,915 + 1,629) = 5,544 m below the design flood level.

8-97 Bridges and major culverts



Alternatively Equation 8.14, for the longest piers close to the minimum river invert could be used to
calculate the local scour depth at the pier.

0,35
Ys 220 K1K2K3K4(ﬁj Fr ..(8.14)
b b
with
b = 1,5m
4 = 2,98 m (normal flow depth upstream of the bridge, Table 8.3)
Fr, = 0,429 based on main channel data directly upstream of the pier
K; = 1,0 for round nose
K, = 1,0 for zero skew angle
Ks; = 1,1 for small dunes

Ky = 1,0 for uniform sediment (no armouring), see Drainage Manual for details of
calculating K4 correction factor, then

2,08 )"
15 =(2,0)(1,0)(1,0)(1,1)(1,0)( 1’5 j (0,429)** =1,943

b

ys= 2,915 m

Note that the scour level is (2,98 + 2,915) = 5,895 m below the design flood level associated with
the normal flow depth and a fixed bed level.

For abutments in alluvial cohesionless materials:
Apply factors in Table 8.9 to the general short-term average scour depth obtained from Equation 8.13.

From Table 8.9 the factor for flow that impinges at right angles on bank = 2,25; hence the scour at the
abutments can be determined as shown below:

d, (abutments ) = (2,25)(3,915 — 2,98) =2,10 m

(iv) Total scour

Total scour is the sum of the long and short-term general scour, contraction scour and local scour.
Table 8.9 reflects a summary of all the calculated scour depths.

Table 8.9: Summary of the calculated scour depths for Worked Example 8.2

Scour type Calculated scour depth, d; (m)
Short term general scour No scour

. Regime equation 1,913
Contraction scour Contraction equation 1,468
Local . Piers 2915
ocal seot Abutments 2,102
Piers 4,828
Total expected scour Abutments 4,013
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Review of the contraction or short-term scour using different analyses procedures

The potential general scour at the bridge has been determined in (i) using Equations 8.5. A more
correct approach is to estimate contraction scour separately for the main channel and over banks, as is
done in HEC-RAS, where the over bank flows may then reflect clear water scour. The scour depth in
the channel calculated in the approach used in HEC-RAS is less than 3,1 m. With the regime theory
reflecting a scour depth of 1,91 m and the HEC-RAS result of 3,1 m, the contraction scour calculation
of 1,468 m using Equation 8.12 is too conservative and hence discarded.

Based on the summary in Table 8.9 the total scour can be determined as follows.

Total scour at piers in main channel

Total scour level at piers, below design flood level (not accounting for backwater)
=1,913+2915=4,828 m

Total scour at abutments

With the right abutment on the edge of the main channel, the scour would be the sum of main channel
contraction scour plus abutment scour, thus:

Total scour at abutments = 1,913+ 2,1 = 4,013 m below design flood level
The scour for the left bank abutment would be less.
Verify the scour depth with the method based on the principle of applied stream power

For total scour at piers in alluvial rivers, check the answer against values obtained by means of
Equation 8.15 that is based on the principle of applied stream power.

Equation 8.15 reflected the following relationship:

C(Yt )(VSSkS )1/3 —

F
Wz ..(8.15)

With F = 0,8; k, = 0,002 m ; vy, = 0,24 m/s; q = 542,6/126,61 = 4,29 m3/s.m and C calculated from
the Chezy relationship for total section, C = 67,5; it follows that:

Y; = 2,03 m below design flood level, which is substantially less than obtained above.
The designer will experience these conflicting results, which reflect amongst other the complexities
involved in the mathematical description of scour estimates and the shortcoming in the assumption

that the material is cohesionless.

Considering the risk of failure of the structure due to scour and the potential consequences, these cases
require further evaluation by experienced persons.

The problem is also evaluated using HEC-RAS, and the data files are contained as Example 2 in the
supporting data files.
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9 STORMWATER ANALYSES AND DESIGN

9.1 Example 9.1 — Pipe flow
Problem description Example 9.1

Water flows from a submerged catch pit at a kerb inlet through a 20 m concrete drain pipe where it
releases into a river stream. The inside diameter of the pipe is 0,3 m. The pipe has a slope of 0,5 % and
the depth of the water in the catch pit above the top of the pipe is 0,2 m (i.e. available head).

Calculate the discharge rate for this set-up.
Solution Example 9.1

To solve this problem the conservation of energy principle will be used i.e. Equation 9.1. The entrance
(point 1) and exit (point 2), are open to atmosphere and thus p;/y = p,/y = 0 if the stream line is
selected along the top of the water surface.

—+&+z _—+p—2+22 +h, +h,

2g v 2g v o (9.1)

The velocity in the catch pit (V,) is negligible (large catch pit area in comparison with pipe area). If

the datum line is selected through the invert of the pipe outlet (point 2) z, will be zero and z;, can be
calculated as follows:

z, =(0,2) + (20)(0,005)=0,3

The first term is the height above the pipe inlet and the second term the length of the pipe multiplied
by the slope of the pipe to obtain the vertical height difference between inlet and outlet.

The last two terms in the energy equation are the loss terms. The friction loss can be calculated using
the Chezy equation (Equation 9.2) with the C-value determined by Equation 9.3. The absolute
roughness value of the pipe was estimated as k; = 0,0004 m.

=2
L
= .(9.2)
“  C°R
12R 12(4)
C=5,75 \/g log(k—J or C=5,75 \/g log . for circular pipes ...(9.3)

. 2[(0 3))
C=5,754/9,81 log = 60,37

0,0004

=0,07317v;
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A secondary inlet loss will occur at the entrance. From Table 9.1, an inlet coefficient of k = 0,5 will
be used for a blunt entrance.

Table 9.1: Transition losses in pipe flows

Description Sketch k-value
Inlets
72 Protruding J—'--“-“‘““" 0,9
hl e |/
2g Oblique ____Af»_ 0,7
(V= average velocity in T
conduit) Blunt e 0,5
Well-rounded —% 0,2
Diverging sections Sudden > 1,0
k(Vl—Vz)z - —— N, -
hy=——"7——""— Cone 45° <0 < 180° - 1,0
2g “
0 =30° 0,7
0=15° 0,2
Converging sections
h o= kv’ Sudden 0,5
= —
2
8 Cone 0,25
Bends
kv2 0 =90° 0,4
h, = 2
2g 0 = 45° 0,3
Outlets
s 2
hoo K[ oA Sudden 1,0
1 2g A,

The diameter does not change and the velocity where the water enters the pipe can be assumed to be
equal to v, .

h,

kv; _(05)7;
2¢  2(9,81)

=0,02548 V>

The energy equation is simplified as follows:

o) +0+(03)= V)

2(9,81)

v, = 1,416 m/s

Q

3

2(9,81)

VA, =(1,416)[n(0

2
) ] =0,1m’/s
2

+0+0+(0,0731792 )+ (0,02548%2)

This pipe can discharge 100 I/s if it is allowed to dam at the entrance up to 500 mm above the pipe
inlet level.
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9.2 Example 9.2 — Introduction to using EPASWMM

The EPA Storm Water Management Model (SWMM) is a dynamic rainfall-runoff simulation model
that computes runoff quantity and quality from primarily urban areas. The runoff component of
SWMM operates on a collection of subcatchment areas that receive precipitation and generate runoff
and pollutant loads. The routing portion of SWMM transports this runoff through a system of pipes,
channels, storage/treatment devices, pumps and regulators. SWMM tracks the quantity and quality of
runoff generated within each subcatchment and the flow rate, flow depth, and quality of water in each
pipe and channel during a simulation period comprised of multiple time steps.

SWMM was first developed in 1971 and since then has undergone several major upgrades. It
continues to be widely used throughout the world for planning, analysis, and design related to storm
water runoff, combined sewers, sanitary sewers, and other drainage systems in urban areas and has
also been used for modelling non-urban areas. The most current implementation of the model is
version 5.0 which was released in 2005. It has modernized both the model’s structure and its user
interface, making SWMM easier to use and more accessible to a new generation of hydrologists,
engineers, and water resources management specialists.

All the practical exercises after this first tutorial are developed for the same catchment area and each
one builds in some degree on the results of a previous example. Therefore, it is recommended to begin
with Exercise 1 and work sequentially through up to Exercise 6, while hopefully building the required
input data files and running them with SWMM for each exercise. These files, as well as the backdrop
image files that are needed to complete the exercises, are available on the flash disk.

Goal: This first tutorial provides an introduction to using EPA SWMM, Version 5,
for modeling the quantity of storm water runoff produced from an urban area. The
topics to be covered include:

@ Project Setup

@ Constructing a SWMM Model

@ Saving and Opening Projects

@ Setting the Properties of SWMM Objects

@ Running a Single Event Analysis

@ Viewing Simulation Results

In the exercises the decimal separator will be the decimal comma (,) whilst in the EPA SWMM
program the decimal point (.) is used. The EPA SWMM program is constantly upgraded and the
screen layouts on newer versions may differ from what is shown in this example.

PROJECT SETUP

To begin this tutorial, start the EPA SWMM program by double clicking the EPA SWMM icon on the
desktop. The main window should appear as shown in Figure 9.1.
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Figure 9.1: SWMM 5 main window

In this tutorial a drainage system serving a 0,48 ha residential area will be modelled. The system
layout is shown below in Figure 9.2 and consists of subcatchment areas S1 through S3, storm sewer
conduits C1 through C4, and conduit junctions J1 through J4. The system discharges to a stream at the
point labelled Outl. The first steps are to create the objects shown in this diagram on SWMM's Study
Area Map and setting the various properties of these objects. The water quantity response to a 75 mm,
6-hour rainfall event, as well as a continuous, multi-year record will then be simullated.

<
7 B
/s//jw‘f A&

sl V7 '7c1'
%

o1 ¢4 J4 C2
¥ « L < ®

Figure 9.2: System layout
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Our first task is to create a new project in EPA SWMM and make sure that certain default options are
selected. Using these defaults will simplify the data entry tasks later on. The first step in developing a
SWMM application is to start a new project.

1. Go to File menu on the main window and select New.

2. Select Project >> Defaults to open the Project Defaults dialog.

3. On the ID Labels page, set the ID Prefixes as follows (leave the others blank) and shown in

Figure 9.3:
Rain Gages: Gage
Subcatchments: S
Junctions: J
Outfalls: Out
Conduits: C
ID Increment: 1
"Project Defauits (5cm]
1D Labels | Subcatchments | Nodes/Links
| Obect 10 Prefc ]
Ran Gages Gage
Subcatchments S
Junchons J
Outals Out
Divdess
Storage Undts
Condusts c
Pumgs
Reguistors
ID Increement 1
¥ Save a3 defauls for al new progects
0K Cancel Hebp

Figure 9.3: Project Defaults: ID labels

This will make EPA SWMM automatically label new objects with consecutive numbers
following the designated prefix.

4. On the Subcatchments page of the dialog set the following default values (as shown in

Figure 9.4):

Area: 1,619
Width: 120
% Slope: 0,5
% Imperv: 50
N-Imperv: 0,01
N-Perv: 0,10
Dstore-Imperv: 1,3
Dstore-Perv: 1,3
%Zero-Imperv: 25,0
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=

'Project Defautts
ID Labels  Subcatchments | Nodes/Links
[ Progerty Defaut Value |
Area 1619
Widh 120
% Slope 05
% lerpesy S0
Ndmpery 00
N-Perv 01
Dstoeedmpeny 13
Dstoee-Pery 13
“Zeodmpery F
Infitration Model GREEN_AMPT

7| Save as defaulls for all new progects

oK

Cancel

Hep

Infiltration Model <click J to edit>, as

shown in Figure 9.5.

Method:

- Suction Head:
- Conductivity:
- Initial Deficit:

On the Nodes/Links page set the following default values (Figure 9.6):

Green-Ampt
90

12,5

0,26

Figure 9.4: Project Defaults: Subcatchments

Infiltration Editor (=5c=
Inftsation Method (GREENAMPT  +)
[ Propery Value ]
Suction Head )
Conductiviy 125
Iritial Defict 026
Sod capdiaty suction head [nches of mm)
oK Concel | | Hep

Figure 9.5: Infiltration Editor

Node Invert: 0

Node Max. Depth: 1,2

Node Ponded Area: 0

Conduit Length: 120

Conduit Geometry: <click J to edit >, as shown in Figure 9.7.
- Shape: Circular

- Max. Depth: 0,3

- Barrels 1

Conduit Roughness: 0,01

Flow Units: LPS

Routing Model: Kinematic Wave

Force Main Equation: Hazen-Williams
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"Project Defauits =3
ID Labels | Subcatchments | Nodes/Links
{ Option Defauk Vakue |
Node Irvest ]
Node Max. Depth 1.2
Node Ponded Area 0
Condut Length 120
Conduit Geometry CIRCULAR
Condut Roughness om
Flow Unds LPS
Lird Offcets DEPTH
Routing Method Kinematic Wave
Force Man Equation Hazer'willams

7| Save as defauls for ol new propects
[ Comcel

Figure 9.6: Project Defaults: Nodes/Links

Help

" Cross-Section Editor
Shape Barrels
\CIRCULAR - | [
Max Depth
O 03
Standard crculsr ppe

Cancel

Figure 9.7: Cross-Section Editor

6. Select Save as defaults for all new projects and click OK to accept these choices and close the

dialog.

Setting Map Options

Next we will set some map display options so that ID labels and symbols will be displayed as we add
objects to the study area map, and links will have direction arrows.

1. Select Tools >> Map Display Options to bring up the Map Options dialog (see Figure 9.8).
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3.

Nodes
Links
Labels
Annotabon
Syerbols
Flow Amows

Background

Fil Style
Clex

Sobd
@ Disgonal
Cross Hatch

Symbol
Swe 5

Dutine
Thickness 1

¥ | Display link to outhet

Cancel Help

“

)

Figure 9.8: Map Options: Subcatchments

Select the Subcatchments page, set the Fill Style to Diagonal and the Symbol Size to 5 (as

shown in Figure 9.8).

Then select the Nodes page and set the Node Size to 5 (see Figure 9.9).

"Map Options

Subcatchments
.

Links

Labels

Annotation

Syerbels

Flow Amows

Background

&)

Node Sce

58 @

Proportional to Value

¥| Display Boeder

Cancel Help

Figure 9.9: Map Options: Nodes

Select the Annotation page and check off the boxes that will display ID labels for
Subcatchments, Nodes, and Links. Leave the others un-checked as shown in Figure 9.10.
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Map Options 5=
Subcatchments
Ran Gage IDs
Nodes /| Subcatch 1Ds
v Node IDs
Liks Wiio: |
Subcatch Values
Uihak Node Values
Link Values
prsn |
Use Transparent Test
Syenbols -
Fork Size 7 @
Flowe Astows
Al 200m of 10 3
Background
[ Concet | [ Heb

Figure 9.10: Map Options: Annotation

5. Finally, select the Flow Arrows page; sclect the Filled Arrow style, and set the Arrow size
to 7 (see Figure 9.11).

Map Options 5=
Subcatchments

Aurow Stybe
Nodes None
Links Open

O Filed
Labels

Fancy

Annotabon

Anow Sce 7 -~
Syembols o
Background

[ Concel | [ Heo

Figure 9.11: Map Options: Flow Arrows
6. Click the OK button to accept these choices and close the dialog.
Before placing objects on the map we should set its dimensions.
1. Select View | Dimensions ... to bring up the Map Dimensions dialog.

2. You can leave the dimensions at their default values for this example. Set the Map Units to
Meters by selection this option and click on the OK button.

Finally, look in the status bar at the bottom of the main window and check that the Auto-Length
feature is Off. If it is on, then click the down arrow button and select "Auto-Length: Off" from the pop-
up menu that appears.

9-108 Stormwater analyses and design



CONSTRUCTING A SWMM MODEL

Drawing the Drainage Area Subcatchments

We are now ready to begin adding components to the Study Area Map to create the model layout as
shown in Figure 9.12. We will start with the subcatchments.

7 B
7 //ﬁ.

c3y, %/Z c1}

o1 ¢4 J4 C2 A 7
¥ “+ ® < ®

D

Figure 9.12: Model layout

7
1. Begin by clicking the button on the Object Toolbar. (If the toolbar is not visible then
select View | Toolbars | Object). Notice how the mouse cursor changes shape to a pencil.

2. Move the mouse to the map location where one of the corners of subcatchment S1 lies and
left-click the mouse.

3. Do the same for the next three corners and then right-click the mouse (or hit the Enter key) to
close up the rectangle that represents subcatchment S/. You can press the Esc key if instead
you wanted to cancel your partially drawn subcatchment and start over again. Don't worry if
the shape or position of the object isn't quite right. We will go back later and show how to fix
this.

4. Repeat this process for subcatchments S2 and S3. Note.

Observe how sequential ID labels are generated automatically as we add objects to the map. The
model should look similar to the one shown in Figure 9.13.
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Figure 9.13: Model with the three subcatchments

Drawing the Drainage System Nodes

Next we will add in the junction nodes and the outfall node that comprise part of the drainage network.

1. To begin adding junctions, click the @ button on the Object Toolbar.

2. Move the mouse to the position of junction J/ (as shown in Figure 9.12) and left-click it. Do
the same for junctions J2 through J4.

3. To add the outfall node, click the E button on the Object Toolbar, move the mouse to the
outfall's location on the map, and left-click. Note how the outfall was automatically given the

name Outl.

The model should look similar to the one shown in Figure 9.14.
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Figure 9.14: Model with added junctions and outlet

Drawing the Drainage System Links

Now we will add the storm sewer conduits that connect our drainage system nodes to one another.
(You must have created a link's end nodes as described in the previous topic before you can create the
link.) We will begin with conduit C/ which connects junction J1 to J2.

1. Click the button on the Object Toolbar. The mouse cursor changes shape to a crosshair.
2. Click the mouse on junction J1. Note how the mouse cursor changes shape to a pencil.

3. Move the mouse over to junction J2 (note how an outline of the conduit is drawn as you move
the mouse) and left-click to create the conduit. You could have cancelled the operation by
either right-clicking or by hitting the Esc key.

Repeat this procedure for conduits C2 through C4. The model should look similar to the one shown in
Figure 9.15.
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Figure 9.15: Model with added links

Adding a Rain Gage

To complete the construction of our study area schematic a rain gage need to be added.

1. Click the Rain Gage button on the Object Toolbar.

2. Move the mouse over the Study Area Map to where the gage should be located and left-click
the mouse.

Note in Figure 9.15 that the subcatchments are not yet linked to a specific junction. This will be done
later in the exercise.

Re-Positioning Objects

At this point we have completed drawing the example study area. Your system should look like the
one shown in Figure 9.16. If the rain gage, subcatchments or nodes are out of position you can move
them around by:

1. Clicking the El button to place the map in Object Selection mode;
2. clicking on the object to be moved;

3. dragging the object with the left mouse button held down to its new position.

9-112 Stormwater analyses and design



\\
-

C3g 7 c1)
'
/ %
Out1 c4 J4 c2 J2
¥ - ® < ®

Figure 9.16: Model layout

To re-shape a subcatchment's outline:

1.

6.

With the map in Object Selection mode, click on the subcatchment's centroid (indicated by a
solid square within the subcatchment) to select it.

Then click the button on the Map Toolbar to put the map into Vertex Selection mode.

Select a vertex point on the subcatchment outline by clicking on it (note how the selected
vertex is indicated by a filled solid square).

Drag the vertex to its new position with the left mouse button held down.

If need be, vertices can be added to or deleted from the outline by right-clicking the mouse and
selecting the appropriate option from the popup menu that appears.

When finished, click the EI button to return to Object Selection mode.

This same procedure can also be used to re-shape a link.

Saving and opening the project

Having completed the initial design of our example project it is a good idea to give it a title and save
our work to a file at this point. To do this:

1.

4

Select the Title/Notes category from the Data Browser and click the
9.17).

button (see Figure
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Figure 9.17: Title/Notes Editor

2. In the Project Title/Notes dialog that appears, enter "Practical Exercise ES" as the title of

our project and click the OK button to close the dialog.

3. From the File menu select the Save As option.

4. In the Save As dialog that appears (Figure 9.18), select a folder and file name under
which to save this project. We suggest naming the file E5.inp. (An extension of .inp will

be added to the file name if one is not supplied.)

5. Click Save to save the project to file.

The project data is saved to the file in a readable text format. You can view what the file looks like by
selecting Project | Details from the main menu. To open our project at some later time, we would

select the Open command from the File menu.
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Figure 9.18: Save As dialog box

SETTING THE PROPERTIES OF SWMM OBJECTS

Setting Properties

As visual objects are added to our project, SWMM assigns them a default set of properties. To change
the value of a specific property for an object we must select the object into the Property Editor
(shown in Figure 9.19). There are several different ways to do this. If the Property Editor is already
visible then you can simply click on the object or select it from the Data page of the Browser. If the
Editor is not visible then you can make it appear by one of the following actions:

@ Double-click the object on the map.
@ Right-click on the object and select Properties from the pop-up menu that appears.

@ Select the object from the Data page of the Browser window and then click the Browser's

4

button.

Whenever the Property Editor has the focus you can press the F1 key to obtain a more detailed
description of the properties listed.
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Figure 9.19: Property Editor

Setting Subcatchment Properties

Two key properties of our subcatchments that need to be set are the rain gage that supplies rainfall
data to the subcatchment and the node of the drainage system that receives runoff from the
subcatchment. Since all of our subcatchments utilize the same rain gage, Gagel, we can use a shortcut
method to set this property for all subcatchments at once:

1.

2.

4.

From the main menu select Edit | Select All.
Then select Edit | Group Edit to make a Group Editor dialog appear.

Select Subcatchments as the class of object to edit, Rain Gage as the property to edit, and
type in Gagel as the new value (as shown in Figure 9.20).

| Group Editor =

For objects of type

with Tag equal to

[ Subcatchment v

edit the property |FlainGege—vJ
by replacing it with Gagel

0K | Cancel | [ Help

Figure 9.20: Group Editor dialog

Click OK to change the rain gage of all subcatchments to Gagel. A confirmation dialog will

appear noting that 3 subcatchments have changed (Figure 9.21). Select No when asked to
continue editing.
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Figure 9.21: Confirmation dialog

To set the outlet node of our subcatchments we have to proceed one by one, since these vary by
subcatchment:

1. Double click on subcatchment S1 or select it from the Data Browser and click the Browser's

4

button to bring up the Property Editor.

2. Type JI in the Outlet field and press Enter. Note how a dotted line is drawn between the
subcatchment and the node (Figure 9.22).
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Figure 9.22: Linking subcatchment and junction
3. Click on subcatchment S2 and enter J2 as its Outlet.
4. Click on subcatchment S3 and enter J3 as its Outlet.

Finally, we wish to represent area S3 as being less developed than the others. Select S3 into the
Property Editor and set its % Imperviousness to 25 (Figure 9.23).
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Figure 9.23: Setting %o Imperviousness

Setting Node/Link Properties

The junctions and outfall of our drainage system need to have invert elevations assigned to them. As
we did with the subcatchments, select each junction individually into the Property Editor and set its
Invert Elevation to the value shown in Table 9.2.

Table 9.2: Node properties

Node Invert (m)
J1 1129,3
n 11274
I3 1128,3
J4 1126,8

Outl 11259

Only one of the conduits in our example system has a non-default property value. This is conduit C4,
the outlet pipe, whose diameter should be 0,45 m. instead of 0,3 m. To change its diameter (maximum
depth), select conduit C4 into the Property Editor and set the Max. Depth value to 0,45.

Setting Rain Gage Properties

In order to provide a source of rainfall input to our project we need to set the rain gage properties.
Select Gagel into the Property Editor and set the following properties (see Figure 9.24):

Rain Format: INTENSITY
Rain Interval: 1:00

Data Source:  TIMESERIES
Series Name: TS/
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Figure 9.24: Rain Gage property editor

As mentioned earlier, a simulation of the response of the study area to a 75 mm, 6-hour design storm is
required. A time series named TS1 will contain the hourly rainfall intensities that make up this storm.
Thus a time series object is created and populate with data. To do this:

L.

From the Data Browser sclect the Time Series category of objects.

Click the ¥ button on the Browser which will bring up a Time Series Editor form.

. Enter 7S/ in the Time Series Name field.

Enter the values into the Time and Value columns of the data entry grid (leave the Date

column blank) as shown in Figure 9.25.

"Time Series Editor =

Tene Senes Name
5

Descrption
L)
No dates means tmes are relative 1o start of semudsbion
Date Tine - View...
MO |HM) Vakoe (o ]
0 0 Losd.
1 13
2 5 Save
3 18
4 13
5 6 OK
3 0
Cancel
</ [ Heo

Figure 9.25: Time Series Editor
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5. You can click the View button on the dialog to see a graph of the time series values (Figure
9.26). Click Close to return to the Time Series Editor.

--Til'l'b! Series Viewer 5= |

Time Senes TS1

24
2
20

18
16
14
12
10

oON MDD

0 1 2 3 4 5
Elapsed Tme (hours)

Copy To [ Close |

Figure 9.26: Time Series Viewer

6. Click the OK button to accept the new time series.

RUNNING A SINGLE EVENT ANALYSIS

Before analysing the performance of our example drainage system we need to set some options that
determine how the analysis will be carried out. To do this:

1. From the Data Browser, select the Options category and click the 4 button.

2. On the General page of the Simulation Options dialog that appears, select Kinematic Wave
as the flow routing method. The Infiltration model should already be set to Green-Ampt. The
Allow Ponding option should be unchecked (see Figure 9.27).
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Figure 9.27: Simulation options — General

3. On the Dates page of the dialog, set the End Analysis time to 12:00:00 (Figure 9.28) and the
Dates and Times as indicated on Figure 9.28.

Simulation Options (=)

| Genesal | D3e¢ | Tume Steps | Dynamec Wave | Files |

Date M/D/Y) Time (H:M)
Start Analysis on 0ROv2010 51 00:00
Stat Reporting on 0RO%v2010 <) 0000
End Analysis on 002010 -2 1200
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End Sweapirg on 12731

Antecedent 0
Diy Days

|0K|;cm"\nou

Figure 9.28: Simulation options — Dates

4. On the Time Steps page, set the Routing time step to 60 sec (Figure 9.29).
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Figure 9.29: Simulation options — Time Steps

5. Click OK to close the Simulation Options dialog.

We are now ready to run the simulation. To do so, select Project | Run Simulation (or click the g
button). After the run was completed the Run Status will be indicated as shown in Figure 9.30.

Run Status
l Run was successhd
Contruaty Emor
Surface Runolf 023%
Flow Routing 002%

Figure 9.30: Run Status
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VIEWING SIMULATION RESULTS

Viewing Analysis Results

If there was a problem in running the simulation, a Status Report will appear describing what errors
occurred.

Upon successfully completing a run, there are numerous ways in which to view the results of the
simulation. A few will be illustrated:

Viewing the Status Report
Viewing results on the map
Viewing a time series plot
Viewing a profile plot

©o0o0oOo

Viewing the Status Report

The Status Report contains useful summary information about the results of a simulation run. To
view the report, select Report | Status (shown in Figure 9.31)
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Figure 9.31: Status report
For the system we just analysed the report indicates the following:

1. The quality of the simulation is quite good, with negligible mass balance continuity errors for
both runoff and routing (-0.23% and -0.02%, respectively, if all data were entered correctly).

2. Of the 75 mm of rain that fell on the study area, 43,75 mm infiltrated into the ground and
essentially the remainder became runoff.
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The Node Flooding Summary table indicates there was internal flooding in the system at
node J2.

The Conduit Surcharge Summary table shows that Conduit C2, just downstream of node J2,
was at full capacity and therefore appears to be slightly undersized.

Viewing Results on the Map

Simulation results (as well as some design parameters, such as subcatchment area, node invert
elevation, link maximum depth) can be viewed in colour-coded fashion on the study area map. To
view a particular variable in this fashion:

1.

2.

3.

Select the Map page of the Browser panel.

Select the variables to view for Subcatchments, Nodes, and Links from the dropdown combo
boxes in the Themes panel. Try for instance Runoff, Depth and Flow respectively as shown in
Figure 9.32.

Themes
Subcatchments

Runoft b
Nodes

Depth v
Lrks

Flow -

Figure 9.32: Themes panel

The colour coding used for a particular variable is displayed with a legend on the study area
map. To toggle the display of a legend, select View | Legends (see Figure 9.33).

Subcatch
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Figure 9.33: Legends
To move a legend to another location, drag it with the left mouse button held down.

To change the colour coding and the breakpoint values for different colours, select View |
Legends | Modify and then the pertinent class of object (or if the legend is already visible,
simply right-click on it). Attempt to set the breakpoint values as indicated in Figure 9.33.

To view numerical values for the variables being displayed on the map, select Tools | Map
Display Options and then select the Annotation page of the Map Options dialog. Use the
check boxes for Rain Gages, Subcatchments, Nodes, and Links to specify what kind of
annotation to add.

The Date / Time of Day / Elapsed Time controls on the Time Period panel Map Browser
can be used to move through the simulation results in time. Set the Time of Day to 3:00:00 to
obtain the view as depicted in Figure 9.34.
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Figure 9.34: Viewing results (using simulation time)
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8. You can use the controls in the Animator panel of the Map Browser to animate the map
display through time. For example, pressing the 2 button will run the animation forward in
time.

Viewing a Time Series Plot

To generate a time series plot of a simulation result:

2.

Select Report | Graph | Time Series or simply click on the Standard Toolbar.

A Time Series Plot dialog will appear. It is used to select the objects and variables to be

plotted.

For this example, the Time Series Plot dialog can be used to graph the flows in conduits C1 and C2 as
follows (shown in Figure 9.35):
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Figure 9.35: Time Series Plot

1. Select Links as the Object Category.

2. Select Flow as the Variable to plot.

3. Click on conduit C1 (either on the map or in the Data Browser) and then clickEI in the

dialog to add it to the list of links plotted. Do the same for conduit C2.

4. Press OK to create the plot as shown in Figure 9.36.
& Graph - Link Flow (o] ®
)

Link Flow
[——LnkC1 —LinkC2 |

0 2 4 3 8 10 12 14
Elapsed Tme (hours)

Figure 9.36: Graph — Link Flow

After a plot is created you can:
O customize its appearance by selecting Report | Customize or right clicking on the plot (see
Figure 9.37),
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O copy it to the clipboard and paste it into another application by selecting Edit | Copy To or
clicking on the Standard Toolbar

O print it by selecting File | Print or File | Print Preview (use File | Page Setup first to set
margins, orientation, etc.).

Graph Options =x=)

Generdl | Horzontal Avis | Verical Axs | Legend | Sedes

Panel Coloe [JButonFace
Background Color [ whie d
View n 30

S &

30 Effect Percent

Man Title
Link Flow Fort
Delout 0K Concel Hel

Figure 9.37: Graph Options

Viewing a Profile Plot

SWMM can generate profile plots showing how water surface depth varies across a path of connected
nodes and links. Create such a plot for the conduits connecting junction J/ to the outfall Outl of our
example drainage system. To do this:

1. Select Report | Graph | Profile or simply click EI on the Standard Toolbar.

2. Either enter J! in the Start Node field of the Profile Plot dialog that appears or select it on the
map or from the Data Browser and click the B button next to the field.

3. Do the same for node OutI in the End Node field of the dialog.
4. Click the Find Path button. An ordered list of the links which form a connected path between

the specified Start and End nodes will be displayed in the Links in Profile box see Figure
9.38. You can edit the entries in this box if need be.
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Figure 9.38: Profile plot

5. Click the OK button to create the plot (Figure 9.39), showing the water surface profile as it
exists at the simulation time currently selected in the Map Browser.

[ & Profie - Node 1 - Ot ==ron = |

Water Elevation Profile: Node J1 - Out1
2 3

42
N

11%

113%

Ewvation (m)

11281--

1127

1126

30 340 20 00 280 260 240 20 200 180 160 140 120 100 & &0 40 ) Q

02/06/2010 00 15.00

Figure 9.39: Profile — Node J1 — Outl

As you move through time using the Map Browser or with the Animator control, the water depth
profile on the plot will be updated. Observe how node J2 becomes flooded between hours 2 and 3 of
the storm event as shown in Figure 9.40.
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Figure 9.40: Flooding shown at junction J2

The appearance of a profile plot can be customized or it can be copied or printed using the same
procedures as for a time series plot.

Running a Dynamic Wave Analysis

In the analysis just run we chose to use the Kinematic Wave method of routing flows through our
drainage system. This is an efficient but simplified approach that cannot deal with such phenomena as
backwater effects, pressurized flow, flow reversal, and non-dendritic layouts. SWMM also includes a
Dynamic Wave routing procedure that can represent these conditions. This procedure, however,
requires more computation time, due to the need for smaller time steps to maintain numerical stability.

Most of the effects mentioned above would not apply to our example. However we had one conduit,
C2, that flowed full and caused its upstream junction to flood. It could be that this pipe is actually
being pressurized and could therefore convey more flow than was computed using Kinematic Wave

routing. We would now like to see what would happen if we apply Dynamic Wave routing instead.

To run the analysis with Dynamic Wave routing:

1. From the Data Browser, select the Options category and click the 4 button.

2. On the General page of the Simulation Options dialog that appears, select Dynamic Wave as
the flow routing method (see Figure 9.41).
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Figure 9.41: Simulation options

3. Click OK to close the form and select Project | Run Simulation (or click the g button) to re-

run the analysis.

If you look at the Status Report for this run you will see that there is no longer any flooding and that
the peak flow carried by conduit C2 has been increased from 95,17 I/s to 112,56 1/s (the conduit now
flows pressurized).

A profile can be drawn again which will indicate the pressurized flow conditions experienced in link
C2, see Figure 9.42.

We have only touched the surface of SWMM's capabilities. Some additional features of the program
that you will find useful include:

©Oo0oO0oOo

(olNe]

Water quality analysis;

running a continuous simulation;

performing a frequency analysis;

utilizing additional types of drainage elements, such as storage units, flow dividers, pumps,
and regulators, to model more complex types of systems;

using control rules to simulate real-time operation of pumps and regulators ;

employing different types of externally-imposed inflows at drainage system nodes, such as
direct time series inflows, dry weather inflows, and rainfall-derived inflow/infiltration;
modelling groundwater interflow between aquifers beneath subcatchment areas and drainage
system nodes;

modelling snow fall accumulation and melting within subcatchments;

adding calibration data to a project so that simulated results can be compared with measured
values;

utilizing a background street, site plan, or topo map to assist in laying out a system's drainage
elements and to help relate simulated results to real-world locations.
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Figure 9.42: Pressurized flow conditions in link C2

You can find more information on these and other features in the SWMM User's Manual. Once you
have reached this stage of the exercise you should be in a position to answer the following questions
based on the model that has been set-up at this point.

1. What is the maximum depth at junction J2 and when does this occur?

2. What is the determined system runoff coefficient for this exercise? Hint: see Status Report

3. What is the maximum flow at the system outlet?

4. What is the peak runoff from catchment S2 and when does it occur?

5. What is the head difference between junctions J1 and J2 at 02:45?

6. What is the velocity and Froude number in link C4 at 04:00? What would be the type of flow
at this time step?

7. What capacity is still available in link C1?
8. Draw the flow versus time graph for link Cl1.

9. What happens to the flow routing continuity if the Routing time step is set to 5 seconds instead
of 60 seconds?
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10 ASSESSMENT OF HYDRAULIC CAPACITY OF EXISTING DRAINAGE
STRUCTURES

10.1 Example 10.1 — Level pool routing

Problem description Example 10.1

You have to determine the attenuation and translation that results from the routing of a given inflow
hydrograph through a dam, see Figure 10.1 (The methodology is the same as for a culvert, using an

outflow equation from Table 7.1 or the continuity of energy relationship). The following is known:

Outflow stage relationship of the spillway of the dam is given by:

Q=C,LH"
where:
Q = discharge (m’/s)
Cq = discharge coefficient
L = length of the spillway (m)
H = total energy head (measured above the spillway level) (m)

In this case the outflow can be determined by the following relationship: Q = 110H"”’

Area-volume relationship of the storage volume is given as indicated below:

Surface area at the spill level = 7,5 km®
Surface area at a level above spill level = 7,5 + 1,5H km?
H = reflects the difference between the free surface level and the spill level, i.e. total energy (m)

“' o s .
“al ah e

B Vga Yega Vg3

[= 3

o AN .0

.3

5]
Q.

—3;

Figure 10.1: Section through the spillway of the dam

The inflow hydrograph is given in Figure 10.2.
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Figure 10.2: Inflow hydrograph
Solution Example 10.1

It is known that the storage relationship is:

H H
S=[AdH=10°[(7,5+,5H)dH
(6]

O
S=10°(7,5H+0,75 H*> + k)
It is known that S = 0, when H = 0 and hence the integration constant, k = 0.

Assume that the time step, At = 2 hours = 7200 seconds; then it follows that in the auxiliary function:

At 2
N, =N, + L+l O, and by substituting the known values, it follows:

A distance away from the spill section where the velocity approaches zero in the dam the difference
between the water level and the spillway level reflects the total energy, i.e. h=H

10°
7200
N =1041,7H +104,17H* +55H"®

N= (7,5H+0,75H%) +55H"
N =104,17H(10 + H + 0,53/H)

The relationship for N and H to be used in the auxiliary function is shown in Table 10.1 (and
graphically in Figure 10.3).
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Table 10.1: Relationship of N versus O, for different H-values

H (0] N
0,2 9,8 2174
0,4 27,8 4473
0,6 51,1 688,1
0,8 78,7 939.,4
1,0 110,0 1200,9
1,2 144,6 14723
1,4 182,2 1753,7
1,6 222.,6 2044,7
1,8 265,6 23454
2,0 311,1 2655,6
3000
2500
R 2000
0
né 1500
Z 1000
|+ Auxiliary curve
500
0 T T T T T
o] 50 100 150 200 250 300 350
O(m3¥/s)

Figure 10.3: Graphical presentation of the auxiliary function

If the inflow and outflow hydrographs are plotted (Figure 10.4) it will be observed that:

o the intersect of the hydrographs coincides with the maximum storage; and
o the maximum outflow rate will be associated with the time of the intersect.
400
300
q
é 200
c
100
1]
o] 10 20 30 40
Time (hours)

Figure 10.4: The inflow and calculated outflow hydrographs

Summary of the results:

Attenuation = 360-180 = 180 m*/s Translation =24-12=12h
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10.2 Example 10.2 — Level pool routing trough a culvert (inlet controlled)
Problem description Example 10.2

You have to determine the attenuation and translation that results from the routing of a given inflow
hydrograph through an existing culvert, Figure 10.5. The culvert has a square inlet with dimensions of
3,6 m high and 3m wide. The level of the shoulder break point (SBP) is 5 m as measured from the
culvert’s invert.

The methodology for applying level pool routing is the same for a culvert as being described from 1*
principles in Example 10.1 with the exception of using the outflow characteristics as given in Table
10.5. In this example, the Routing Utility given on the accompanying flash drive is used to estimate
the effect of upstream storages to calculate the attenuation and translation for an existing culvert
structure.

Figure 10.5: Existing culvert

The following catchment parameters upstream of the culvert are known and are given in Table 10.2.
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Table 10.2: Catchment parameters upstream of the culvert

Longest water Course - 6,65 km Catchment Area - 9,07 km®

Longitudinal profile for longest water course in catchment

Calculation of the time of concentration for flow in a defined watercourse. (This calculation is by
default done by the Routing Utility and is also given in Table 10.3.)

In a defined watercourse, channel flow occurs. The recommended empirical formula for calculating
the time of concentration in natural channels was developed by the US Soil Conservation Service.

0871 )7
T, =|—2
1000S,,

Where: Tc = time of concentration (hours)

L = hydraulic length of the catchment, measured along the
flow path from the catchment boundary to the point
where the flood needs to be determined (km)

Sav = average slope (m/m)

...(10.1)

The user may calculate the average slope as defined in Figure 10.6.
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Figure 10.6: Slope definition for a defined water course

S = HO,85L _HO,IOL
(1000)(0,75L) .(102)
Where: Sav = average slope of the catchment (m/m) (see Figure 10.6)
Hojoo = elevation height at 10% of the length of the watercourse (m)
Hoss. = elevation height at 85% of the length of the watercourse (m)

L = length of the watercourse (km)

The catchment parameters required to determine the average slope for the catchment from Table 10.2
is given in Table 10.3.

Table 10.3: Catchment characteristics with respect to the defined water course

Catchment parameter Value
Longest Water Course (km) 6,65
Start Elevation (m) 1439
End elevation (m) 1537
10% elevation (m/m) 1443
85% elevation (m/m) 1494
Average slope (m/m) 0,0147
Area (km?) 9,07
Time of Concentration, T, (hr) 1,45

The area-height relationship for the upstream side of the culvert is given in Table 10.4. These values
can be entered in the blue cells in the Routing Utility in the table titled “Area/Volume Relationship
Upstream of Culvert”. From this relationship, the Routing Utility will automatically calculate the
corresponding volume-height relationship (Table 10.4, Figure 10.7).
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Table 10.4: Area-height relationship for the upstream side of the culvert

Elevation Depth measured
(Contour from culvert Area (m°)
intervals) (m) Invert (m)
1401 0 0
1402 1 1300
1403 2 27100
1404 3 47000
1405 4 85100
1406 5 127800
1407 6 139080
16 450000
14 - 400000
1 /I 350000
/ - 300000
10 —_
= == Area vs. Height Relationship i
% = Area vs. Volume Relationship / - 250000 %
= 8 £
o0
Z // - 200000 =
= >
6
~ / 150000
A /
/ 7 100000
= ~ - 50000
0 /_/ O
0 20000 40000 60000 80000 100000 120000 140000
Area (m?)

Figure 10.7: Area-Height and Area-Volume relationship for the upstream side of the culvert

The discharge capacity of culverts operating as inlet controlled systems and varying upstream water
levels, are reflected in Table 10.5. The outlet characteristics can be defined for a rectangular culvert
by the equations as given below in column 2 for the different ratios of H;/D
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Table 10.5: The capacity of culverts

ROUND CULVERTS RECTANGULAR CULVERTS
D = inside diameter (m) D = height (inside) (m)
B = width (inside) (m)
For:
0<H,/D<0,8 0<H/D<1,2

0,05 1,9
L =0,48 S_O &
D?,/gD 0,4 D

Where: Cg = 1,0 for rounded inlets (r > 0,1B)

2 [2
QZECBBHI Eng

Cg = 0,9 for square inlets

And for: 0,8 <H;/D<1,2 *

0,05 1,5
L:() 44 S_O 5
D?\/eD |04 D

(So = slope of culvert bed with slight
effect on capacity)
Note:

* For H/D > 1,2, the orifice formulae applies

0=C, A /Zg(Hl —gj with Cp= 0,6

Where: C,, = 0,8 for rounded inlets

And for: Hy/D > 1,2

Q=C,BD,/2¢g(H, -C,D)

Cy, = 0,6 for square inlets

The estimated peak flow rate for the catchment was anticipated to be 76 m’/s for a return period of
Q1. By assuming a triangular distribution of inflow, the inflow hydrograph is given in Figure 10.8.
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Figure 10.8: Inflow hydrograph
Solution Example 10.2
Step 1: Open the Routing Utility by double clicking on the icon.
Step 2: Accept the user agreement.

Step 3: Enter the site specific catchment and culvert parameters as given in the problem statement
above in the allocate blue cells in the Routing Utility:

e Top width (## Times the Time of Concentration) =0 ;

Maximum inflow (Design Flow rate for normal routing or Q,r for the review of existing
culverts) = 76 m’/s;

Number of Culverts = 1 unit;

Culvert Height = 3,6 m;

Culvert Width = 3,0 m;

Culvert Shape Coefficient - Cg = 0,9;

Culvert Shape Coefficient - Cy = 0,6;

Maximum allowable damming depth measured from invert of culvert = 5 m;
Longest Water Course 6,65 km;

Average Slope 0,0147 m/m; and

Area-Height relationship as given in Table 10.4.
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After entering these parameters in the Variable and Area/Volume Relationship Upstream of
Culvert tables in the Routing Utility, the screen captures should look like that given in Table 10.6
and Table 10.7.

Table 10.6: Print screen of entered catchment and culvert parameters

Only fill in values where the cells are blue shaded |

Variable Value Units |
Top width (## Times the Time of Concentration) 0
Maximum outflow 45,18 | m'/s
Volume of Inflow 594389 | m’
Volume of Outflow 594389 | m’
Routing volume difference 0,0%
Maximum flow depth 4,64 m
Volume of Storage at Maximum flow depth 185794 | m’
Maximum inflow (Design Flow rate for normal routing or Q,t for the review of 3
e 76,00 | m’/s

existing culverts)
% reduction in peak (Attenuation) 40,3%
Total Time H;/D > 1,2 102 min
Standing water that may cause piping 1,70 | hours
Number of Culverts 1,00 units
Culvert Height 3,60 m
Culvert Width 3,00 m
Culvert Shape Coefficient - Cg 0,9
Culvert Shape Coefficient - Cy, 0,6
Maximum allowable damming depth measured from invert of culvert 5,0 m
H/D maximum Ratio 1,29
Longest Water Course 6,65 km
Average Slope 0,0147 | m/m
Calculated Tc 1,45 | hours

. . 436 min
Time duration of Outflow (dV/dt=0) 726 | hours
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Table 10.7: Print screen of entered Area-Height parameters

Area/Volume Relationship
Upstream of Culvert

Elevation (Contour intervals) | Depth measured from Area Delta Volume
(m) culvert Invert (m) (m?) Volume (m?) (m’)
1401 0 0 0 0
1402 1 1300 650 650
1403 2 27100 14200 14850
1404 3 47000 37050 51900
1405 4 85100 66050 117950
1406 5 127800 106450 224400
1407 6 139080 133440 357840
1408 7 69540 427380
1409 8 0 427380
1410 9 0 427380
1411 10 0 427380
1412 11 0 427380
1413 12 0 427380
1414 13 0 427380
1415 14 0 427380
1416 15 0 427380

Step 4: View the auxiliary function.

The auxiliary function used to estimate the outflow from the culvert can be viewed under the
Auxiliary Function tab (Figure 10.9). Notice the vertical increase for outflows exceeding
63 m*/s. This was due to the Area-Height relationship that was not completed for all 16
available increments. However, this does not have any influence on the outcome of the results
since the maximum damming depth is only 4,64 m and that corresponds to an outflow of
45,18 m’/s which is lower than the allowable damming depth of 5 m to the SBP.
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Figure 10.9: Graphical presentation of the auxiliary function

Step 5: Interpret the inflow and outflow hydrographs.

Depicted on the inflow (blue line) and outflow (red line) hydrographs (Figure 10.10) are also
the change in volume with time (dV/dt) as well as the duration for which the upstream energy
head (H,) exceeds a ratio of 1,2D. These values are reflected by the dashed purple line and

green solid line respectively.
If the inflow and outflow hydrographs are plotted (Figure 10.10) it will be observed that:

. the intersect of the hydrographs coincides with the maximum storage; and
. the maximum outflow rate will be associated with the time of the intersect.
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Step 6:

Figure 10.10: Inflow and calculated outflow hydrographs

The results are summarized under the Summary of Results tab and can be printed by clicking

on the Print Summary Sheet button in the upper right corner of the screen (Figure 10.11).
Included on the summary sheet is a table that depicts the outcome of the assessment for
existing culvert structures. In this case the culvert has not met the criteria as described in
Chapter 10 and thus Fails the hydraulic criteria for existing culverts.

Attenuation = 76 - 45,18 = 30,82 m’/s
Translation = 154 - 87= 67 min
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THE S0UTH AFCAN RATORR,

Routing Utility for the Investigation of Existing Hydraulic Structures w&i
Variable Value Units -
Maximum outflow 45.18 m'/s g Print
Maximum inflow (Design Flow rate for normal routing or Q, for the review of S"ST.:‘;W
exisitng culverts) 76.00 m'/s
Total Time H,/D>1.2 102.19 min
Number of Culverts 1.00 units
Culvert Height 3.60 m
Culvert Width 3.00 m
Maximum allowable damming depth ed from invert of culvert 5.00 m
Calculated Time of Concentraction (Tc) 1.45 hours
Time duration of Outflow (dV/dt=0) 7.26 hours

Investigation of existing culvert structures
(Refer to Figure 10.1 SANRAL DRAINAGE MANUAL)

Mo (m') | 0.5 Voo (m’) | Pass/Fail
| Review of maximum temporal storage 185794 297199 Fail

Ts (min) 0,5 Te (min) | Pass/Fail
L Review of the duration of excessive energy (upstream inundation) 102.19 86.90 Fail
L Overall culvert structure outcome: | Culvert Structure FailT

Inflow and Outflow Hydrographs
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Disclaimed: This program was developed for the convenience of its users. Although every reasonable effort has been made to ensure that the program is accurate and refiable the program developers,
Smotech CC and/or Prof SJ van Vuuren accept no liability ofany kind for any results, interpretation thereofor any use made of the results obtained with these programs. Al users of this program do
s0 entirely at theirown risk

Figure 10.11: Summary of the results

Step 7: Re-evaluating the system with an upgraded system of 2 culverts of the same dimensions, it can
be perceived that the maximum outflow is increased from 45,18 m?/s to 60,52 m’/s for the
same inflow characteristics. However, upstream damming is significantly reduced from
4,64 m to 3,51 m. Now the structure meets the hydraulic criteria as given in Chapter 10 and
thus Pass the hydraulic criteria for existing culverts (Figure 10.12).
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THE S0UTH AFCAN RATORR,

Routing Utility for the Investigation of Existing Hydraulic Structures w&i
Variable Value Units -
Maximum outflow 60.52 m'/s g Print
Maximum inflow (Design Flow rate for normal routing or Q,y for the review of S"S";.:‘;ry
exisitng culverts) 76.00 m'/s
Total Time H,/D>1.2 0.00 min
Number of Culverts 2.00 units
Culvert Height 3.60 m
Culvert Width 3.00 m
Maximum allowable damming depth ed from invert of culvert 5.00 m
Calculated Time of Concentraction (Tc) 1.45 hours
Time duration of Outflow (dV/dt=0) 5.16 hours

Investigation of existing culvert structures
(Refer to Figure 10.1 SANRAL DRAINAGE MANUAL)

Vo (m*) | 0.5 Vyom (m’) | Pass/Fail
| Review of maximum temporal storage 85527 297199 Pass

Ts (min) 0,5 Te (min) | Pass/Fail
L Review of the duration of excessive energy (upstream inundation) 0.00 86.90 Pass
L Overall culvert structure outcome: | Culvert Structure PassT

Inflow and Outflow Hydrographs
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Disclaimed: This program was developed for the convenience of its users. Although every reasonable effort has been made to ensure that the program is accurate and refiable the program developers,
Smotech CC and/or Prof SJ van Vuuren accept no liability ofany kind for any results, interpretation thereofor any use made of the results obtained with these programs. Al users of this program do
s0 entirely at theirown risk

Figure 10.12: Summary of the results for re-assessed culvert with 2 units of the same dimensions
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11 FREE SURFACE FLOW DETERMINATION

HEC-RAS is constantly being upgraded and the screen layouts on newer versions may differ
from what is shown in this chapter.

111 Basic flood line determination (HEC-RAS)

STARTING A NEW PROJECT

To begin this exercise, start the HEC-RAS program by double clicking the HEC-RAS icon on the
desktop. The main window should appear as shown in Figure 11.1.

File Edit Run View Options GISTools Help

B CIE SR N
Project: |
Plan: |
Geometry: |
Steady Flow: |

Unsteady Flow: |
Description : l| = B ISI Units

Figure 11.1: HEC-RAS main windew

< P B 1 N e = e 1
=

The first step in developing a HEC-RAS application is to start a new project. Go to File menu on the
main window and select New Project. The New Project window should appear as shown in Figure
11.2. Set the drive and directory you would like to work in. Enter the project title and file name as
shown in Figure 11.2. Once you have entered the information, press the OK button to accepted the
title and file name and create the new project.

Title File Name Selected Folder Default Project Folder Documents
IThis is exercise 1 IEnetciseT pi C:\SANRAL\E xercise 1

[ R Cancel Hep |  CreateFolder.. | [S ¢ [Createk2012)

|Select drive and path and enter new project name.

Figure 11.2: New Project window

Once back at the HEC-RAS Main window select from the menu bar Options, and set the units that
you would like to work in to be metric units as well as be the default setting for all new projects (see
Figure 11.3 and Figure 11.4).
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In the right hand corner of the main screen it will now indicate SI units.

HEC-
File Edit Run View [Options| GISTools Help _
|E~Im X(IC'—T"?J'{ Program Setup b " US Customary
l; Default Parameters » {* System Intemational (Metric System)
Project: This is exerc v .
Unit US Cust /S .. v Set as default for new projects
ek — o '( u' e Cancel I Hel
Bty |— Convert Project Units ... p
Figure 11.3: Options menu Figure 11.4: Unit systems

ENTERING GEOMETRIC DATA

First a steady state flow model will be developed:

The next step is to enter the Geometric Data. This is accomplished by selecting Geometric Data from
the Edit menu on the HEC-RAS Main window (Figure 11.1) or clicking the short cut button on the

menu bar gl Once this option is selected, the geometric data window will be shown (see Figure 5).

This screen can be maximized by clicking on the maximize button =N in the right hand corner of the
window.

[ File Edit Options View Tables Tools GIS Tools Help

Tools| River RS e
3 Reach | frea | Conn. i Description : |
o =—| G <1259 @

Junct.

0.8278, 0.9648

Figure 11.5: Geometric Data window
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Drawing the schematic of the river system

A plan view of the river section with cross sections is shown below in Figure 11.6.

) Planned
development

Figure 11.6: Plan view of river section

The first step is to draw the river system schematically by performing the following steps:
e Although it is only a schematic drawing one would still like to draw it more or less to scale.
To assist with this HEC-RAS has an option to import a background picture.

7
e Click on the Add/Edit background picture button on the menu bar. The program will
show the Background Pictures on Schematic window (Figure 11.7).
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s s SR

[v Display Currently Selected Pictures in Schematic
Remove ... | Propetties ... | _vl_.| ﬂ

Close |

Figure 11.7: Background Pictures on Schematic window

Click on the Add button and select the background picture (Exercise 1 — Background
picture.jpg)

HEC-RAS will indicate that the picture extents past the current schematic boundaries and ask
you if you would want to increase the schematic extents (Figure 11.8). Select Yes.

— v

RAS

The extents of the data are beyond the current schematic extents, so some of the
pictures or river reaches may not be visible. Do you want to increase the
schematic extents?

Yes No

Figure 11.8: Increasing the schematic extents
Once the picture has been selected click on the Close button (Figure 11.7).

Use the Schematic view selector box to drag the extents of the inserted picture over the entire
screen (Figure 11.9).

Now the river section can be drawn over the background picture. Click the River Reach
button on the geometric data window.

Move the mouse pointer over the drawing area and place the pointer at the location in which
you would like to start drawing the reach.
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File Edit Options GIS Tools Help

Tools| River |Storage| $.A. | Pu .
Ecﬁtorsoos Reach | Area | Conn. Slal"ig"n RS m Descupt:on:l
=—| @ p—=g O | <125

Junct,

View Tables Tools

7 Figure 11.9: Viewing the background picture

e Press the left mouse button once to start drawing the reach. Move the mouse pointer and
continue to press the left mouse button to add additional points to the line segment. To end
the drawing of the reach, double click the left mouse button and the last point on the reach will
be placed at the current mouse pointer location (right click will remove the last point drawn).
All reaches must be drawn from the upstream to downstream (in the positive flow direction)
i.e. start at cross section 12 down to cross section 1 (Decreasing numeric values).

e Once the reach is drawn, the interface will prompt you to enter an identifier for the River
name and the Reach name. The River identifier can be up to 32 characters, while the reach
name is limited to 12 characters. In this exercise the river will be called, Tsitsa and the reach
Lower reach (see Figure 10).

Select existing River or enter a new

River name [16 Char Max), and enter
Reach name (16 Char Max).

River: IT sitsa LI

Reach: |Lower reach

Cancel |

Figure 11.10: River and reach names

Once you have finished the drawing of the river system, there are several options available for
editing the schematic. The options include changing the name, adding points to a reach,
removing points from a reach, deleting a reach, and deleting a junction. The editing features
are located under the Edit menu on the Geometric Data window.
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o Since the schematic of the river has now been drawn there is no more need for the background
picture. To switch off the background picture click on the Add/Edit background picture

75
button on the menu bar. Deselect the picture as shown in Figure 11.11.

s s oo TR

|v Display Currently Selected Pictures in Schematic

Add | Remove ... | Properties | ﬂll
[l image Exercise 1 - Background picture. JPG

Close

Figure 11.11: Deselecting the background picture

o  When you first draw the schematic there will be no tic marks representing the cross sections as
shown in Figure 11.12. The tic marks only show up after you have entered cross sections.
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File Edit Options View Tables Tools GISTools Help

Tools| River |Storage| $.A. | Pump RS N e
: Reach | Area | Conn. | Station A Descnphon.l
BN | == -I&—- Or | [<T2m) =

Lower Reach

N

910.55, 1282.50

Figure 11.12: Geometric Data window with Tsitsa river schematic
Entering cross section data

section button on the Geometric window (Figure 11.12). Once this button is clicked, the

SCm§s The next step is to enter the cross section data. This is accomplished by clicking the cross
ection
Cross Section Data editor will appear as shown in Figure 11.13.
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| Ext Edit Options Plot

River: ITsitsa

=]

Reach: |Lower Reach

L] River Sta.:[

Description I

Del Row |

Ins Row |

Cross Section Coordinates

Station

| Elevation

DN B h]|—

Downstream Reach Lengths

[ LOB_ [ Channel | ROB
| |

|
mal
LOB_ | Channel | ROB
|

Main Channel Bank Stations

Left Bank | Right Bank
|

Cont\Exp Coefficient [Steady Flow) jl¥4
Contraction Expansion

Figure 11.13: Cross section Data Editor

To enter cross section data follow these steps:

Select a River and a Reach to work with. In this exercise there is only one River (Tsitsa) and
one Reach (Lower reach).

Go to the Options menu and select Add a new Cross Section. An input box will appear to
prompt you to enter a river station identifier for the new cross section (see Figure 11.14).

Enter a new river station for the new
cross section in reach "'Lower
Reach"

oK |  Cancel |

Figure 11.14: Add a new river station

The identifier does not have to be the actual river station, but it must be a numerical value.
The numeric value describes where the cross section is located in reference to all other cross
sections within the reach. Cross sections are located from upstream (highest river station) to
downstream (lowest river station). For this cross section enter a value of 12.

For this cross section, enter all the data as shown in Figure 11.15.
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River: ITsitsa
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[138

Cont\E xp Coefficient [Steady

148 96
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Expansion
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. Edit Station E levation Data (m)

Figure 11.15: Cross Section Data Editor with data

Enter the:
Description: Upstream boundary of this river section

Downstream reach lengths: LOB = 100, Channel = 95 and ROB = 90

Manning n-values: LOB = 0,05, Channel = 0,035 and ROB = 0,05
Station and elevation details:

Nr Station Elevation
1 100 100,3
2 103 97,3
3 125 96,1
4 133 94,4
5 135 94,3
6 138 95,6
7 148 96,0
8 154 99,5

Main channel stations: Left bank = /25 and Right bank = 738
Cont\Exp coefficients: Contraction = 0,/ and Expansion = 0,3

Once all the data is entered press the Apply Data button. This button is used to instruct the
program to accept the entered data into memory. This button does not save the data to the
hard disk. This is done by clicking on Save Geometry Data under the File menu on the

Geometric Data window (which will be explained later).

Plot the cross section to visually inspect the data. This is accomplished by pressing the Plot
Cross Section option under the Plot menu on the Cross Section Data Editor or by clicking on

the Expand XS editor to include a XS plot . The cross section should look similar to

that shown in Figure 11.16 below.
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Rive: [EET | >(®) | + @)
Reach: [Loweueach j River Sta.: I12 LI ﬂﬂ

This is exercise 1 Plan: First run
Upstream boundary of this river section

| 035 ‘|L

Legend
——
Ground

L d
Bank Sta

Elevation (m)

T30
Station (m)

Figure 11.16: Cross section plot for river station 12

Note the manning roughness values at the top of the cross section and the specified bank
stations (red dots) (Figure 11.16).

In practice the steps listed above would be repeated for every cross section that is entered. In order to
reduce the amount of data entry for this exercise, the current cross section will be copied and adjusted
to represent other cross sections within the river system.
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METHOD 1

Exit Edit Options Plot Help

River. ITsi.sa I

Description [T sitsa River 11

nmmnwsuiﬁ._]
- L.

Bxt  Edit Options Plot Help

River. ITm 'l

Reach: |Lower reach

Desciipion | Tsitsa River 9

Ins Row |

Main Channel Bank Stations

&

Ext Edit Options Plot Help

River. ITai.sa hd |

Reach: |Lower reach

Desciiption | Tsitsa River 7

DelRow |

=

[Ertter to move to next downstream river station location

Figure 11.21: Cross section 7 data

Bxt Edit Options Plot Help

River. ITs'Isa vl

Reach: |Lowe| reach

_v| River Sta:|10

Description | Tsitsa River 10

Main Channel Bank Stations

=]

Bxt Edit Options Plot Help

River: ITaisa vl

Reach: |Lower reach

Desciiplion [Tsitsa Riiver 8

Main Channel Bank Stations

K]

Bxt Edit Options Plot H

River: ITsisa vl

elp

Reach: |Lower reach

_v| River Sta: |6

Desciiplion ]Ts'ﬂsa River 6

DelRow |

K|

Main Channel Bank Stations

[Ertter to move to next downstream river station location

Figure 11.22: Cross section 6 data
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Figure 11.23: Cross section 5 data

Bxit Edit Options Plot Help
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Figure 11.27: Cross section 1 data

Eat Edit Options Plot Help
River: | Tsitsa - pply [
| River Sta:|4

Reach: |Lower reach
Desciiption [ Tsitsa River 4
Del Row | Ins Row_|
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River: |Tsitsa - Apply Data
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[Enter to move to next downstream river station location

Figure 11.26: Cross section 2 data
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If you have completed entering the cross section data as shown in Figure 11.17 to Figure 11.27 skip
the next two pages.

| METHOD 2 |

# Expert users: Follow the following steps to copy the current cross sections and adjust to look
similar to Figure 11.17 to Figure 11.27.

e Go to the Options menu on the cross Section Data Editor and select Copy Current Cross
Section. An input box will appear to prompt you to select a river reach, and then enter a river
station for the new cross section, see Figure 11.28. For this exercise, keep the river and reach
as Tsitsa River and Lower reach, then enter a new river station of /1.

Select a River and Reach and then enter a new river station.

o s |
River. |Tsitsa d|

Reach: ILower reach ﬂ River Sta: 11

0K | Cancel |

Figure 11.28: Copying and existing cross section
Press the OK button and the new cross section will appear in the editor.
e Change the cross section description to “Tsitsa River 11”.

e Adjust all the elevations of the cross sections by —0,2 meter. This is accomplished by
selecting the Adjust Elevations feature from the Options menu on the Cross Section Data
Editor.

e Adjust the cross section stationing to reduce the overbanks by 10%.

e This is accomplished by selecting the Adjust Stations feature from the Options menu on the
Cross Section Data Editor, then select Multiply by a Factor. When the input box appears for
this option, three data entry fields will be available to adjust the stationing of the left
overbank, channel, and the right overbank separately. Enter values of 0,9 for the right and left
overbanks, but leave the main channel field blank. This will reduce the stationing of both
overbanks by 10%, but leave the main channel unchanged.

e Downstream reach lengths change to LOB = 48, Channel = 42 and ROB = 40 for this cross
section.

e Press the Apply Data button (The data should be similar to that shown in Figure 11.17). Plot
the cross section to visually inspect it (see Figure 11.29).
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Figure 11.29: Cross section plot (cross section 11)

These seven steps above should be repeated to enter all the data for Tsitsa River (Lower Reach). The
necessary adjustments are listed in Table 11.1. Perform the cross section duplications in order that
they are listed in the table. Make sure to change the description of each cross section, and also press
the Apply Data button after making the adjustments for each cross section.

Table 11.1: Cross section adjustments for duplicating sections

Cross section Adjusted Adjusted stationing Downstream reach lengths
Description s?::;; elevation (L)e]i; Channel Rolgl;l ¢ (L)eét Channel Rolg];lt
Tsitsa River 11 11 -0,20 0,9 - 0,9 48 42 40
Tsitsa River 10 10 -0,10 1,2 1,0 1,1 95 90 85
Tsitsa River 9 9 -0,10 - 1,1 - 100 102 105
Tsitsa River 8 8 -0,05 - 1,3 - 100 110 120
Tsitsa River 7 7 -0,10 1,5 - - 120 120 125
Tsitsa River 6 6 -0,15 - 2,0 2,0 80 82 85
Cross section at 5 20,05 2,0 . : 80 80 80
Tsitsa River 4 4 -0,05 0,5 1,0 1,0 180 180 180
Tsitsa River 3 3 -0,12 - - 0,5 115 105 100
Tsitsa River 2 2 -0,18 0,5 0,5 - 155 155 150
Downstream

boundary of river 1 -0,10 0,8 - - 0 0 0
section
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Table 11.1 is simply a quick way to generate varying cross sections for this exercise. The method
however is quite useful when working with a man-made structure such as a channel, which has similar
Ccross sections.

# Novice & Expert users continue

This completes all the cross section data for the Tsitsa River (Lower reach) save the data file before
continuing. Saving the data to a file is achieved by exiting the Cross Section Data editor window and
selecting the Save Geometry Data As option from the File menu on the Geometric Data window.
After selecting this option you will be prompted to enter a Title for the geometric data (Figure 30).
Enter “Natural Tsitsa River” for this exercise, and then press the OK button. A file name is
automatically assigned to the geometry data based on what you entered for the project file name i.e.
Exercisel.g01.

Tile File Name Selected Folder  Defauk Project Folder |  Documents |
[Natural Tsitsa river [Exercise1.g01 C:ASANRAL\E wercise 1

Natural T sitsa river

0K Cancel | | CreateFoider... | [ ¢ [Createk2012)
|Select drive and path and enter new Title.

Figure 11.30: Save Geometry Data As

e Return to the Cross Section Data editor window and from the Plot menu select Plot Profile...
to view the longitudinal profile of the entered cross sections (see Figure 11.31).

File Options Help
Reaches .. | 8[| Profies .. |[B](@.] [~ PlotInitial Conditions  Reload Data

This is exercise 1 Plan: First run
Tsitsa Lower reach

—
E
=
c
2
B
=
o
w

Main Channel Distance (m)

Figure 11.31: Longitudinal profile plot
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When returning to the Geometric Data window the user will notice that the Tsitsa River now also
shows the schematic layout with the position of the entered cross sections, see Figure 11.32.

[ File Edit Options View Tables Tools GISTools Help

Tools | Riwer r RS " - -
Editors\_| Fe2ch ; 78 Description : = [ Protws extents for Profie:

=

100wer reach

None of the XS's are Geo-Referenced (= Geo-Ref user entered XS — Geo-Ref interpolated XS — Non Geo-Ref user entered XS — N¢ -

|

730.71. 1111.63

Figure 11.32: Schematic layout of entered system

We have completed the required geometric data and can now continue and enter the Steady Flow
Data.

ENTERING STEADY FLOW DATA

The next step in developing the required data to perform steady flow water surface profile calculations
is to enter the steady flow data. To bring up the steady flow data editor, select Steady Flow Data

from the Edit menu on the HEC-RAS main window or click on the Steady Flow Data button on
the menu bar. The steady Flow Data editor should appear as shown in Figure 11.33.
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[ File Options Help
Enter/Edit Number of Profiles (25000 max}: |2 Reach Boundary Conditions .. | Apply Data _ |

Locations of Flow Data Changes

River. |Tsitsa -l Add Multiple... |

Reach: |Lower reach _v| River Sta:|12 v| Add A Flow Change Location |

Flow Change Location Profile Names and Flow Rates
Reach
Lower reach

|E dit Steady flow data for the profiles (m3/s)

Figure 11.33: Steady Flow Data window

o The first set of required data to enter is the number of profiles to be calculated. For this
exercise enter “3" as shown in Figure 34 (and click on the Apply button). The next step is to
enter the flow data. Flow data are entered from upstream to downstream for each reach. At
least one flow rate must be entered for every reach in the river system. Once a flow value is
entered at the upstream end of a reach, it is assumed that the flow remains constant until
another flow value is encountered within the reach. Additional flow values can be entered at
any cross section location within a reach. In this exercise there is only 1 reach and thus it will
only be required to enter 1 set of flow data. In this exercise, flow data will be entered at the
upstream end of the reach i.e. at cross section 12.

e Profile labels will automatically default to “PF1" and “PF2" etc. These labels can be changed
to whatever is descriptive of the flow. In this exercise these should be changed to 7:20 yr,
1:50 yr and 1:100 yr. Under the Options menu go to Edit Profile Names and change the
profile names. Click on the OK button to accept the names.

e Enter the 1:20, 1:50 and 1:100 year flood peak values of 35, 80 and 150 m?/s respectively (see
Figure 34).
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[ File Options Help
Enter/Edit Number of Profiles (25000 max): |3 Reach Boundary Conditions ... I Apply Data I

Locations of Flow Data Changes

River. |Tsitsa ~| Add Multiple... |

Reach: [Lower reach ~] River Sta:[12 ] Add A Flow Change Location |

Flow Change Location Profile Names and Flow Rates

Reach 1:20 [1:50 yr [1:100 pr
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|Edit Steady flow data for the profiles (m3/s)

Figure 11.34: Steady flow data

e The next step is to enter any required boundary conditions. To enter boundary conditions,
press the Reach Boundary Conditions button at the top of the Steady Flow Data editor (see
Figure 11.34). The boundary conditions editor will appear as shown in Figure 11.35.

Steady Flow Boundary Con
" Set boundary for all profiles " Set boundary for one profile at a time

Available External Boundary Condtion Types

Known W.S. I Critical Depth | Normal Depth I Rating Curve I Delete

Selected Boundary Condition Locations and T

Downstream

Cancel Help

Steady Flow Reach-Storage Area Optimization

[Enter to accept data changes.

Figure 11.35: Steady Flow Boundary Conditions

e Boundary conditions are necessary to establish the starting water surface at the boundaries of
the river system. A starting water surface is necessary in order for the program to begin
calculations. In a subcritical flow regime, boundary conditions are only required at the
downstream end of the river system.

If a mixed flow regime calculation is going to be performed, then boundary conditions must
be entered at all open ends of the river system.

11-164 Free surface flow determination



The boundary conditions editor contains a table listing of every river and reach. Each reach
has an upstream and a downstream boundary condition. Connections to junctions are
considered internal boundary conditions. Internal boundary conditions are automatically
listed in the table, based on how the river system is connected in the geometric data editor.
The user is only required to enter the necessary external boundary conditions.

In this exercise it is assumed that the flow is subcritical throughout the river system (Verify if
this is correct!!!). Therefore, it is only necessary to enter a boundary condition at the
downstream end of the Tsitsa River, Lower reach. Boundary conditions are entered by first
selecting the cell in which you wish to enter a boundary condition. Then the type of boundary
condition is selected from the four available types listed above the table see Figure 11.35
(Known Water Surface, Critical Depth, Normal Depth or a Rating Curve).

In this exercise it is assumed that there are no control points in the river further
downstream and that cross section 1 is far enough downstream and can be assumed to
flow at normal flow depth.

e Click in the cell in the Table (Figure 11.35) under the Downstream column and then click on
the Normal Depth button. In other words the program will start at this downstream
boundary, calculate the normal flow depth and work systematically upstream in the river
section.

A pop up box will appear (see Figure 11.36) requesting you to enter an average slope at the
downstream end of the river reach. Enter a value of 0,001 (m/m) then click on the OK button.

HEC-RAS

E nter the downstream slope for
normal depth computation for reach:
Lower reach for all profiles.

|u.um

0K |  Cancel |

Figure 11.36: Pop-up box (enter the average downstream slope)
This completes all of the necessary boundary condition data (see Figure 11.37).

e Click the OK button on the Boundary Conditions window to accept the data and return to the
Steady Flow Data screen.
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" Set boundary for all profiles " Set boundary for one profile at a time

Available Extemnal Boundary Condtion Ty

Known'W.S. I Critical Depth I Normal Depth I Rating Curve I Delete

Selected Boundary Condition Locations and T

River Reach Profile Ipstream | Downstream
Normmal Depth S = 0.001

Steady Flow Reach-Storage Area Optimization

Cancel Help

[Enter to accept data changes.

Figure 11.37: Accepted boundary condition data

e The last step is to save the data to a file. To save the data, select the Save Flow Data As
option from the File menu on the Steady Flow Data Editor. A pop-up box will prompt you to
enter a description/title of the flow data (Figure 38). For this exercise enter: Calculated flood
peaks. A file name is automatically assigned to the steady flow data based on what you
entered for the project file name i.e. Assignmentl.f01.

Title File Name Selected Folder  Default Project Folder Documents |
| Calculated flood peaks [Exercise1. (01 C:\SANRAL\Eercise 1

Calculated flood peaks Exercisel.f01

0K Cancel | Hep |  CreateFolder... | | S ¢ [Createka012)
[Select diive and path and enter new Title.

Figure 11.38: Save Flow Data As

Once the data has been saved, you can close the Steady Flow Data Editor.

PERFORMING THE HYDRAULIC CALCULATIONS

Now that all of the data has been entered, we can calculate the steady water surface profiles. To
perform the simulations, go to the HEC-RAS main window and select Steady Flow Analysis from the

5

Run menu or click on the Steady Flow Analysis button == on the menu bar. The Steady Flow

Analysis window should appear as shown in Figure 11.39, except yours will not have any plan title or
Short ID yet.
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[ File Options Help
Plan: | ShotID  [Runt
Geometry File : |Natural Tsitsa river

Steady Flow File: | Calculated flood peaks

LedLed

~ Flow Regime ~ Plan Description :

* Subcritical
" Superciitical
| € Mixed

J

Enter to compute water surface profiles

Figure 11.39: Steady Flow Analysis Simulation Window

o The first step is to put together a Plan. The Plan defines which geometry and flow data are to
be used, as well as providing a title and short identifier for the run. To establish a plan, select
New Plan from the File menu on the Steady Flow Analysis window. Enter the plan title as
First run and then press the OK button (Figure 11.40).

File Name Selected Folder _ Default Project Foider | Documents
|Fisl un Exercisel.p” CASANRALME xercise 1

0K Cancel | Help |  CreateFolder... | | S e (Createk2012)
[Select drive and path and enter new Title.

Figure 11.40: Creating new plan

e You will be prompted to enter a short identifier. Enter a title of Run/ in the Short ID box
(Figure 11.41) and click on the OK button.

_
Enter the short plan Identifier (16

char max)

[Rurﬂ

ok | Cancel |

Figure 11.41: Plan identifier

e The next step is to select the desired flow regime for which the model will perform
calculations. For this example we will be performing Subcritical flow calculations only since
only a downstream boundary condition was specified. Make sure Subcritical is the selected
flow regime.
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e Additional job control features are available from the Options menu bar. Select Critical
Depth Output Option... from this menu. A pop-up window will appear in which the user
can select the Critical Always Calculated option (Figure 11.42). The program will then
always calculate the critical flow depth for every flow rate. Click on the OK button.

Select Output Dptions

[v iCritical &lways Calculated

0K | Cancel

Figure 11.42: Critical depth calculation option

e Once you have defined a plan and set all the desired job control imformation, the plan
information should be saved. Saving the plan information is accomplished by selecting Save
Plan from the File menu of the Steady Flow Analysis window.

Now that everything has been saved and set, the steady flow computations can be performed by
pressing the Compute button at the bottom of the Steady Flow Simulation window (Figure 11.39).
Once the computations have been completed, the computation window can be closed, as well as the
Steady Flow Simulation window.

VIEWING RESULTS

Once the model has finished all of the computations successfully, you can begin viewing the results.
Several output options are available from the View menu bar on the HEC-RAS main window. These
options include:

Cross section plots

Profile plots

General profile plot

Rating curves

X-Y-Z perspective plots

Detailed tabular output at a specific
cross section (cross section table)

Limited tabular output at many cross
sections (profile table)

(i IR NN

Cross section plots

Begin by plotting a cross section. Select Cross Sections from the View menu on the HEC-RAS main
window. Any cross section can be plotted by selecting the appropriate river, reach and river station
(see Figure 11.43). Several plotting features are available from the Options menu bar on the cross
section plot window. These options include: zoom in; zoom out; selecting which plans, profiles,
variables to plot; and control over lines, labels, symbols, scaling etc.
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Figure 11.43: Cross section (all three profiles)

Select different cross sections to plot and practice using some of the features available under the
options menu bar.

Profile plot

The second plot, which is of value, is the water surface profile. Select Water Surface Profiles from
the View menu.

This should give you a profile plot as shown in Figure 11.44.

Try and obtain the profile plot to look exactly like Figure 11.44 selecting various options under the
Options menu (grid, labels, line types, text, profiles etc.).
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File Options Help

Reaches ... |ll‘l| Profiles ... I@@

This is exercise 1 Plan: First run
Tsitsa Lower reach

Main Channel Distance (m)

Figure 11.44: Water Surface Profile (for entire reach)
General profile plots

The third plot option, which is of value, is the General Profile Plot. Select General Profile Plot from
the View menu. This should give you a profile plot as shown in Figure 11.45.

From the Standard Plots menu various other useful plots can also be made such as Froude numbers
(on left bank, main channel and right bank), see Figure 11.46.
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Figure 11.46: General profile plot (Froude numbers)
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The data used to generate the plots can also be viewed in Table format by clicking on the Table tab
next to the Plot tab. The generated plot or data can be copied to the clipboard by simply going to the

File menu (for that specific tab), see Figure 11.47 and Figure 11.48.

|File| Options Standard Plots UserPlots Help

Print ...

Exit

Copy Plot to Clipboard

Copy Values to the Clipboard

|File| Options Standard Plots User Plots Help

Copy Table to Clipboard (with Headers)
Write Table Data to File (csv) ...

Exit
2| Tsitsa Lower reach 1
3| Tsitsa Lower reach 10
4| Tsitsa Lower reach 9
5| Tsitsa Lower reach 8
T.ao- | [ ——— -

1066.00
1024.00
934.00
832.00

TN AN

his is exercis
— Tsitsa Lowe

oo oo

N

L ~
Figure 11.48: General profile plot (Writing data to a file (csv type))

This copying of pictures/graphs/data can be done throughout HEC-RAS.

Rating curve

Select Rating Curves from the View menu plot a computed rating curve. A rating curve based on the
computed water surface profiles will appear as shown in Figure 11.49. You can look at the computed
rating curve for any location (cross section) by selecting the appropriate river, reach and river station.
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[ File Options Help

River: ITsitsa LI Ll@ | Reload Data I
Reach: ILower reach ;I River Sta.: |B LI ﬂ

This is exercise 1 Plan: First run
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WS, Elev (m)

80
Q Total (m3/s)

Figure 11.49: Rating Curve (cross section 5)

HEC-RAS basically plots a curve through the three flows used in the calculation i.e. 35 m®/s, 80 m®/s
and 150 m3/s. The more flows used in the calculation the more accurate rating curve will be obtained.

X-Y-Z Perspective Plot

Select X-Y-Z Perspective Plots from the View menu to plot a 3D view of the river section (Figure
11.50). Set the Rotation Angle to —70 and the Asimuth Angle to /9 to obtain the same view as shown
in Figure 11.50. This type of view gives a clear view of the widening of the river at cross section 5
and 6.
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Figure 11.50: X-Y-Z Perspective Plot
Tabular output
Detailed tabular output

Now look at some tabular output. Go to the View menu on the HEC-RAS main window. There are
two types of tables available, a detailed output table and a profile summary table. Select Detailed
Output Tables to get the first table to appear. The table should be similar to the one shown in Figure
11.51 (notice the warning at the bottom of the table for river station number 3). This table shows
detailed hydraulic information at a single cross section. Other cross sections can be viewed by
selecting the appropriate reach and river from the table.
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Max Chl Dpth [m) 3.84 | Hydr. Depth [m) 1.41 310 2.00
Conv. Total [m3/s) 9126.4 | Conv. [m3/s) 1300.9 £988.4 8371
Length Wtd. [m] 105.72 | Wetted Per. [m) 37.27 37.34 14.13
Min Ch El (m) 93.38 | Shear [N/m2) 3.70 818 5.08
Alpha 1.36 | Stream Power [N/m s) 9265.32 0.00 0.00
Frctn Loss (m) 0.05 | Cum Volume (1000 m3) 819 18.09 6.82
C &E Loss [m) 0.01 | Cum SA (1000 m2) 5.78 5.81 3.39
Ermors, Wamings and Notes
Waming: The conveyance ratio (upstream conveyance divided by downstream conveyance] is less than 0.7 or greater than 1.4.
This may indicate the need for additional cross sections.

Enter to move to next downstream river station location

Figure 11.51: Detailed table output
Summary Errors, Warnings, and Notes

The HEC-RAS software has a system of Errors, Warnings, and Notes that are passed from the
computation programs to the user interface. During the computations, the computation programs will
set flags for at a particular node (nodes are cross sections, bridges, culverts, or multiple openings)
whenever it is necessary. These message flags are written to the standard output file, along with the
computed results for that node. When the user interface reads the computed results from the output
file, if any errors, warnings, or notes exist, they are interpreted and displayed in various locations from
the interface.

The user can request a summary of all the errors, warnings, and notes that occurred during the
computations. This is accomplished by selecting Summary Errors, Warnings, and Notes from the
5

View menu on the main HEC-RAS window or clicking the short cut button =

Once this is selected, a window will pop up displaying all of the messages. The user can select a
specific River and Reach, as well as which Profile and Plan to view. The user has the options of
expanding the window; printing the messages; or sending them to the windows clipboard.

Besides the summary window, messages will automatically appear on the cross section specific tables.
When a cross section or hydraulic structure is being displayed, any errors, warnings, or notes for that
location and profile will show up in the Errors, Warnings, and Notes message box at the bottom of the
table. An example of this table is shown in Figure 11.51.
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In general, the errors, warnings, and notes messages should be self-explanatory. The three categories
of messages are the following:

ERRORS: Error messages are only sent when there are problems that prevent the program from being
able to complete the run.

WARNINGS: Warning messages provide information to the user that may or may not require action
on the user’ s part. In general, whenever a warning is set at a location, the user should review the
hydraulic results at that location to ensure that the results are reasonable. If the hydraulic results are
found to be reasonable, then the message can be ignored. However, in many instances, a warning level
message may require the user to take some action that will cause the message to disappear on future
runs. Many of the warning messages are caused by either inadequate or bad data. Some common
problems that cause warning messages to occur are the following:

Cross sections spaced to far apart. This can cause several warning messages to be set.

Cross sections starting and ending stations not high enough. If a computed water surface is higher
than either end point of the cross section, a warning message will appear.

Bad Starting Water Surface Elevation. If the user specifies a boundary condition that is not possible
for the specified flow regime, the program will take action and set an appropriate warning message.

Bad Cross Section Data. This can cause several problems, but most often the program will not be
able to balance the energy equation and will default to critical depth.

NOTES: Note level messages are set to provide information to the user about how the program is
performing the computations.

Profile Summary Table

Go to the View menu on the HEC-RAS main window. There are two types of tables available, a
detailed output table and a profile summary table. Select Profile Summary Table. This table shows a
limited number of hydraulic variables for several cross sections in the selected river reach (see Figure
11.52).

File Options Std.Tables Locations Help
HEC-RAS Plan: Runl River: Tsitsa Reach: Lower reach  Profile: 1:100 Reload Data |

Reach i Profile Min Ch El E.G. Elev|E.G. Slope Flow Area| Top Width| Froude # Chij| -
[ (m) (m) (m/rm) (m2) (m)

Lower reach 1:100 wr 94.30 98.16 0.001839 90.09 48.98 0.46
Lower reach 1:100 v 94.10 97.97 0.002039 84.19 45.35 0.48
Lower reach 1:100 e 94.00 97.88 0.001696 . 9393 50.76 0.44

Lower reach 1:100 wr 93.90 97.73 0.001602 . 95.52 51.94 0.43
Lower reach 1:100 yr 93.85 97.57 0.001242 104.05 56.04 0.38
Lower reach 1:100 pr 93.75 97.44 0.001038 117.35 68.20 0.36
Lower reach 1:100 pr 9360 97.35 0.000267 } 20872 10063 018
Lower reach 1:100 yr 9355 97.33  0.000200 ) 261.42 13763 015
Lower reach 1:100 wr 9350 97.31  0.000246 . 21450 10093 017X

Total flow in cross section.

Figure 11.52: Profile Summary Table (Standard Table)

There are several types of profile tables listed under the Std. Tables menu (see Figure 11.53) of the
profile table window. Each one of these tables shows typical detail relevant to the specific structure.
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v Standard Table 1

Standard Table 2
Four X5 Culvert
Culvert Only

Six %S Bridge
Bridge Only

Bridge Comparison
Multiple Opening
Four %5 Inline Structure
Inline Structure
Lateral Structures
Encroachment 1
Encroachment 2
Encroachment 3
HEC-FDA

HEC-5Q

Ice Cover
Junctions

Storage Area
Conn with Culverts
Pump Stations

Figure 11.53: Std. Tables menu

A special feature of the profile summary tables is the ability for users to define their own output tables.
User defined output tables are available by selecting Define Table::+ from the Options menu of the
profile table. When this option is selected, a window will appear, as shown in Figure 11.54. At the
top of the window is a table for the user selected variable headings (Table Column Headings), the
units, and the number of decimal places to be displayed for each variable. Below this table is a list
containing all of the available variables that can be included in your user-defined table. The variables
are listed in alphabetical order. Below the list of variables is a message box that is used to display the
definition of the selected variable.

Select Variables | Additional Options |

T able Column Headings
Column 1 | 2 | 3 | 4 | 5 | 3 | 7
Variable Q Total Min Ch El W.S. Elev Crit\wW.5. E.G. Elev E.G. Slope Vel Chnl
Units (m3/s) (m) (m) (m) [m) (m/m) (m/s)

Decimal Pts 2 2 2 2 2 5
4 | I

Delete Column | Insert Column | Clear 41l T able Headings |

Filter | X]
# Barrels Number of barrels in a culvert.

Alpha Alpha - energy weighting coefficient.

Area Flow area of the entire cross section including ineffective flow.

Area Channel Flow area of the main channel including ineffective flow.

Area Left Flow area of the left overbank including ineffective flow.

Area Right Flow area of the right overbank including ineffective flow.

Base WS ‘Water surface for first profile [used in comparison of encroachments).

Beta - momentum weighting coefficient.

Total area of the entire bridge opening.

Figure 11.54: Define a table

11-177 Free surface flow determination



To get a definition of a particular variable, simply click the left mouse button once while the mouse
pointer is over the desired variable. The description of the variable will show up at the bottom of the
window. To add variables to the column headings, simply double click the left mouse button while the
mouse pointer is over the desired variable. The variable will be placed in the active field of the table
column headings. To select a specific column to place a variable in, click the left mouse button once
while the mouse pointer is over the desired table column field. To delete a variable from the table
headings, double click the left mouse button while the mouse pointer is over the variable that you want
to delete. The number of decimal places for each variable can be changed by simply typing in a new
value.

User defined tables are limited to 15 variables. Once you have selected all of the variables that you
want, press the OK button at the bottom of the window. The profile table will automatically be
updated to display the new table

Once you have the table displayed in the profile table window, you can save the table headings for
future use. To save a table heading, select Save Table from the Options menu on the profile table
window. When this option is selected, a pop up window will appear, prompting you to enter a name
for the table. Once you enter the name, press the OK button at the bottom of the pop up window. The
table name will then be added to a list of tables included under the User Tables menu on the profile
table window.

Create a user defined table as detailed above with the following columns:
e Q Total (Total flow rate)

W.S. Elev (Water surface elevation)

Crit W.S. (Critical water surface elevation)

Vel Chnl (Velocity in the main channel)

Froude # Chl (Froude number in the main channel)

Save the table (Exercise 1 — Table) and view the summary table thereof with 1:50 and 1:100 year
profiles (selected from the Options menu) (Figure 11.55).
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File Options

Std. Tables Locations Help

HEC-BAS Plan: Runl River: Tsitsa Reach: Lower reach

Reach

River Sta

Crit W.S.

E.G.Elev

E.G. Slope

(m)

()

(m/m)

Lower reach|12

Lower reach| 12

Lower reach| 11

Lower reach| 11

Lower reach| 10

Lower reach| 10

Lower reach

Lower reach

Lower reach

Lower reach

Lower reach

Lower reach

Lower reach

Lower reach

Lower reach

Lower reach

Lower reach

Lower reach

Lower reach

Lower reach

Lower reach

Lower reach

Lower reach

Lower reach

Led |

96.56
97.15

96.37
96.97

96.26
96.85

96.09
96.66

96.38

97.37
98.16

97.18
97.97

97.09
97.88

96.92
97.73

96.75
97.57

96.59
97.44

96.49
97.35

96.46
97.33

96.44
97.3

96.39
97.27

96.34
g7.21

96.19
97.06

Figure 11.55: User defined table

0.001852
0.001839

0.002106
0.002039

0.001839
0.001636

0.001792
0.001602

0.001410
0.001242

0.001539
0.001098

0.000305
0.000267

0.000261
0.000200

0.000275
0.000246

0.000286
0.000270

0.000884
0.000873

0.001002
0.001000

At the end of this exercise the following objectives should have been met:
Be able to set-up a HEC-RAS project

Know how to enter geometric data

Understand the setting of boundaries and controls

Know how to enter steady flow data

Know how to analyse a river system

Know how to extract information
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Questions
1. What is the normal flow depth for the 1:50 year flood at cross section 1?

2. Define the flow type in the river.
3. What is the kinetic energy component at cross section 11 for the 1:50 year flood?

4. What is the kinetic energy component at cross section 5 (the proposed site) for the 1:50 year
flood?

5. Why is there a difference between the kinetic energy component at cross section 5 and 11?

6. What are the flood levels (1:20, 1:50 and 1:100) at the proposed site (cross section 5)?

7. What will the water level be at cross section 5 if the flood peak is 100 m?3/s?

8. What is the energy weighting coefficient (alpha) for cross section 5 for the 1:50 year flood?

9. How wide is the river flowing at cross section 5 during the 1:100 year flood?

10. What is the hydraulic depth in the main channel during the 1:100 year flood at cross section 5?

11. How would you know if cross section 5 or 6 was functioning as a control point in the river
section?

12. Are you in a position to draw in the 1:20, 1:50 and 1:100 year flood lines for the proposed
site?
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11.2 Setting-up a HEC-RAS model (river section, bridge and weir) and performing
unsteady flow analysis

STARTING A NEW PROJECT

To begin this exercise, start the HEC-RAS program by double clicking the HEC-RAS icon on the
desktop. The main window should appear as shown in Figure 11.56.

" HEC-RAS 410 E]"E"ﬂ

File Edit Run View Options GISTools Help

Ela) M =a) S B A PP ElEk fal
=

Project: |

Plar:

Geometry:

Unsteady Flow:
Description :

|
l
Steady Flow: |
|
I

- @[9 Units

Figure 11.56: HEC-RAS main window

The first step in developing a HEC-RAS application is to start a new project. Go to File menu on the
main window and select New Project. The New Project window should appear as shown in Figure
11.57. Set the drive and directory you would like to work in. Enter the project title and file name as
typically shown in Figure 11.57. Once you have entered the information, press the OK button to
accepted the title and file name and create the new project.

= -
New Project
Title File Name Selected Folder Default Project Folder Documents
[Bridge and weir Exercise. prj C:ASANRALME xercise 2
ACA
Y SANRAL

0K Cancel | Hep |  CreateFoider... | [S e [Createk2012) |
|Set diive and path, then enter a new project title and file name.

Figure 11.57: New Project window

Once back at the HEC-RAS Main window select from the menu bar Options, and set the units that
you would like to work in to be metric units as well as be the default setting for all new projects
(assignments). In the right hand corner of the main screen it will now indicate SI units.
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ENTERING GEOMETRIC DATA

The next step is to enter the Geometric Data. This is accomplished by selecting Geometric Data from
the Edit menu on the HEC-RAS Main window (Figure 11.56) or clicking the short cut button on the

menu bar . Once this option is selected, the geometric data window will be shown (see Figure
11.58).

r

_ Geometric Data E] 2]

File Edit Options View Tables Tools GISTools Help

Ri AL Pump ' .
Edw;m's R::c:h St“q;aage l:sonn Station RS m Description : - Qﬁolws extents for Profile:
=—| @ h—=a O

Junct, 2
O

Cross
Section

Brdg/Culy
Inline
Structure

==

Lateral
Structure

[i=is)
e
-

Storage
Area Conn.

|

Pump
Station

HTab
Param.

View
Picture
iel]

]
el i

0.1029, 0.9060

Figure 11.58: Geometric Data window
Drawing the schematic of the river system

A plan view of the river section with cross sections is shown below in Figure 11.59.
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Maya weir

Bleshok river
Lower reach

Figure 11.59: Plan view of river section
The first step is to draw the river system schematically by performing the following steps:

e (Click the River Reach button on the geometric data window.

e Move the mouse pointer over the drawing area and place the pointer at the location in which
you would like to start drawing the reach.

e Press the left mouse button once to start drawing the reach. Move the mouse pointer and
continue to press the left mouse button to add additional points to the line segment. To end
the drawing of the reach, double click the left mouse button and the last point on the reach will
be placed at the current mouse pointer location (right click will remove the last point drawn).

All reaches must be drawn from the upstream to downstream (in the positive flow direction)
1.e. start at cross section /00 down to cross section 70, 65 down to cross section 40 and from
cross section 8§ to 3 (see Figure 11.60).

e Once a reach is drawn, the interface will prompt you to enter an identifier for the River name
and the Reach name. The River identifier can be up to 32 characters, while the reach name is
limited to 12 characters. In this exercise the rivers will be called, Riet and Blesbok and the
reaches Upper and Lower reach (see Figure 11.60).
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e Once you enter the identifiers for Blesbok River or for the lower reach of the Riet River, you
will be prompted to enter an identifier for the junction, in this case Sahara. Junctions in HEC-
RAS are locations where two or more reaches join together or split apart.

e  When you first draw the schematic there will be no tic marks representing the cross sections.
The tic marks only show up after you have entered cross sections.

"

_ Geometric Data - Base Geometry [=

File Edit Options View Tables Tools GISTools Help
Tools| River |Storage | S.A. Pump RS D) = 2
_ ] Ll A | A | e Description: =[] POt WS extents for Profie: | -
EEONES -H 8| om|
Junct. J
o

Cross
Section

Blﬁ Cubs
Inline
Structure

Lower reach

Lateral

Stucture Upper reach

Stor:
frea

HTab
Param.

View
Picture
L=

Lower reach

None of the XS's are Geo-Referenced ( — Geo-Ref user entered XS — Geo-Ref interpolated XS — Non Geo-Ref user entered XS — Non Geo-Ref interpolated XS J

0.2159, 0.3010

Figure 11.60: Geometric Data window (schematic)

Entering cross section data

Cross | The next step is to enter the cross section data. This is accomplished by clicking the cross

15'30“0"( section button on the Geometric window (Figure 11.60). Once this button is clicked, the

Cross Section Data editor will appear as shown in Figure 11.61.
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=~ Cross Section Data - Base Geomerty
Exit Edit Options Plot Help

River: |Riet River

a Baa A
Reach: |Upper reach

Description |

Del Row [ Ins Row |

LOB

LOB

Channel

Main Channel Bank Stations

Left Bank

Right Bank

I

Cont\Exp Coefficient (Steady Flow
Contraction

Expansion

Station Elevation | «

1 |

2

3

4

]

6

7

8

9
10 0.1
11 LI

(0.3

Edit Station Elevation Data (m)

Figure 11.61: Cross section Data Editor

To enter cross section data follow these steps:

e Sclect a River and a Reach to work with (from the drop down lists).

¢ Go to the Options menu and select Add a new Cross Section. An input box will appear to
prompt you to enter a river station identifier for the new cross section (see Figure 11.62).

HEC-RAS

reach”

|1nn

oK |

Enter a new river station for the new
cross section in reach "Upper

Cancel

Figure 11.62: Add a new river station

The identifier does not have to be the actual river station, but it must be a numerical value.
The numeric value describes where the cross section is located in reference to all other cross
sections within the reach. Cross sections are located from upstream (highest river station) to
downstream (lowest river station). For this cross section enter a value of 700.

e For this cross section, enter all the data as shown in Figure 11.63.
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= Cross Section Data - Base Geometry E] ]
Exit Edit Options Plot Help

River: IRiet river LI ,—l & D-
=l

e . [ o 0
Reach: | Upper reach _v| River Sta: | 100

Description |Upslream River Station

Del Row l Ins Row |

LOB Bl |k
Station Elevation | «| 125 28 0.5

1l0 26.82 _] Manning's n Yalues Q.IJ
2|3.05 2586 LOB Channel ROB
3|1457 2469 0.035 0.025 0.035
4853 23.77
59,75 22 95 Main Channel Bank lalions
611067 21.03 Left Bank | Right Bank
7]1219 20.42 853 12256
8]15.24 19.51 Cont\Exp Coefficient (Steady Flow) JL¥4
9/18.29 18.45 Contraction |  Expansion
10]19.81 20.73 0.1 03
111 21.34 22.25 L]

Figure 11.63: Cross Section Data Editor with data

e Enter the:
Description: Upstream River Station
Downstream reach lengths: LOB = 25, Channel = 28 and ROB = 30,5
Manning n-values: LOB = 0,035, Channel = 0,025 and ROB = 0,035
Station and elevation details:

Nr | Station Elevation
1 0,00 26,82
2 3,05 25,60
3 4,57 24,69
4 8,53 23,77
5 9,75 22,25
6 10,67 21,03
7 12,19 20,42
8 15,24 19,51
9 18,29 19,45
10 19,81 20,73
11 21,34 22,25
12 22,56 24,23
13 24,08 24,38
14 25,30 25,91
15 26,21 28,04

Main channel stations: Left bank = 8,53 and Right bank = 22,56
Cont\Exp coefficients: Contraction = 0,/ and Expansion = 0,3
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e Once

all the data is entered press the Apply Data button. This button is used to instruct the

program to accept the entered data into memory. This button does not save the data to the
hard disk (click on Exit on the Cross Section Data editor window). This is done by clicking
on Save Geometry Data under the File menu on the Geometric Data window. After
selecting this option you will be prompted to enter a Title for the geometric data (Figure
11.64). Enter “Base Geometry” for this exercise, and then press the OK button. A file name
is automatically assigned to the geometry data based on what you entered for the project file

name i.e. Exercise2.g01.
Save Geometry Data As
Title File Name Selected Folder Default Project Folder Documents
[Base Geometry Exercise2.g* C:ASANRAL\E xercise 2
0K Cancel | Hep |  CreateFoider... | [S e (Createkamz) =]
|Select diive and path and enter new Title.

Figure 11.64: Save Geometry Data As

e Instead of retyping all the cross section data, an Excel spreadsheet containing all the stations
and elevation data is provided. To quickly enter all the cross sectional data follow the
following 6 steps

(0]
(0]

Step 1: Select a River and a Reach to work with (from the drop down lists).

Step 2: Go to the Options menu and select Add a new Cross Section. An input box
will appear to prompt you to enter a river station identifier for the new cross section
(see Figure 11.62).

Step 3: Set the Horizontal Variation in n Values under the Options menu to true
(ticked) see Figure 11.65.

Add a new Cross Section ...
Copy Current Cross Section ...
Rename River Station ...

Delete Cross Section ...

Adjust Elevations ...

Adjust Stations r
Adjust n or K values ...

Skew Cross Section ...

Ineffective Flow Areas ...
Levees ...

Obstructions ...

Add aLidto X5...

Add Ice Cover ...

Add a Rating Curve ...

v Horizontal Variation in n Values

Heorizontal Variation in K Values

Vertical Variation in n Values ...

Figure 11.65: Horizontal Variation in n Values (Options menu)
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0 Step 4: Go to the Excel spreadsheet (Exercise 2 - Cross sections.xls) and copy the
Station, Elevation and n-value data for the specific cross section/river station (see

Figure 11.66).
@' H9-&-|5 Exercise 2 - Cross sections.ds [Compatibility Mode] - Microsoft Excel o = 2
“ Home Insert Page Layout Formulas Data Review View Acrobat @ 0 o @ =2
% TimesNewRoi~ |10 ~ = =[gg| = Number -~ A S=Inset > X v &7~
2
B~ | B 7 U~ AL EEEFEEH 9% = T Delete - (]~ A4~
e - es5
4 Hi =i = = EE ¥ %0 %% - () Format~ | 2~
Clipboard Font Alignment - Number - Cells Editing
87 £ 0 v
Al B c |- E F G H I &
1 =
2 | Exercise 2 - Cross section data I ‘
3
4 Riet river: Upper reach Riet river: Lower reach Blesbol ‘
5 Cross section: 100 Cross section: 65 Crosss |
6 Station (m) | Elevation (m) | n-value Station (m) | Elevation (m) | n-value Static
| 7| 0.00 26.82 0.035 oon | 2661 0.035 8.
| 8 | 3.05 25.60 & Cut 9.
E9 8 457 24.69 43 Copy 10
10 8.53 23.77 0.025 ) 0.025 13
11 9.75 2225 - . 13
12 10.67 21.03 13
13 12.19 2042 14
| 14 | 1524 19.51 15
1 15 | 1829 1945 Insert... 16
16 1981 20.73 Delete... 18
17 2134 2225 18
18 2256 2423 0035 e 0.035 19
19 2408 2438 Filter b 20
20 | 2530 2591 Sort ’ 21
| 21 | 2621 28.04 23
22 d Insert Comment
23 |Riet river: Upper reach & Format Cells... Bleshol
24 Cross section: 95 Cross s
25 Station (m) | Elevation (m) | n-value Pick From Drop-down List... Static
26 0.00 26.79 0.035 Define Name... 0.035 8.
g; %i? ‘ng{: 9-0 Hyperlink... :
2.4/ &d.d .11 - S
29 445 2473 | 5.33 I 2454 107
M 4 » ¥]| Sheetl /Sheet? ~Sheet3 /¥J el » 1]
Ready | Average:17.30 Count:33  Sum:570.77 |[EB|CI M 100% (=) 0 (+)

Figure 11.66: Copying cross section data from Excel

0 Step 5: Return to HEC-RAS, and select same number (or more) number of rows in the
Cross Section Data editor window (see Figure 11.67). From the Edit menu click on
Paste, to insert the data in the table.
Step 6: Enter the rest of the other characteristic data:

Description:

“»

Downstream reach lengths: LOB = 22,9, Channel = 29,0 and ROB = 33,5

Main channel stations: Left bank = 8,32 and Right bank = 22,56

Cont\Exp coefficients: Contraction = 0,/ and Expansion = 0,3
All the other characteristic data is provided in Table 11.2.

The spreadsheet printout of all the cross section data is attached in Appendix A for
reference.
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~ Cross Section Data - Base Geomerty
Exit | Edit | Options Plot Help

River| Undo Editing
Reacl  cut Ctrl+X |35 -3t
Descr Copy Ctrl+C . EI
De  Ppaste  CrtleV
! Delete ...
1 Insert ...
2 l
_3
4
_5
_5|
7|
_8
_3
_10
mil
12
[Edit Station Elevation Data (m)

Figure 11.67: Pasting the cross section data from Excel into the Cross Section Data Editor table

<~ Cross Section Data - Base Geometry

Bxit Edit Options Plot Help

River: |Riet river LI Apply Data

[B=% ECB ==

e[~ el

Reach: | Upper reach _v| River Sta:| 95

Downstream Reach Lengths
| Channel

~1[¥ 1
S|k

Man nir‘nq':; nY <311.

Description I

__DelRow_| __InsRow_|
Cross Section Coordinates LOB
Station | Elevation| nVal «| 1223

_1{o 26.79 0.035 _|

_2[299 25.6

_ 3347 25.31

__4[445 24.73

_ 5|52 2452

__6B[8.32 23.75 0.025

__ 7957 22.28

__ 8|10 21.77

__9|10.52 21.09

_10]10.82 20.92 |0‘-|

_11{12.07 20.42

121247 2028 ~|

[Enter to move to next downstream river station location

Figure 11.68: Completed Cross Sectional Data (Cross section 95)
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Table 11.2: Cross section data

River | Reach River Main channel Downstream reach length
station bank stations

LOB ROB LOB Channel ROB

100 8,53 22,56 25,0 28,0 30,5

95 8,32 22,56 22,9 29,0 33,5

- 5 90 8,14 22,56 25,9 29,0 30,5
é) & 85 7,92 22,56 23,8 28,0 31,4
= 80 7,71 22,56 25,6 274 30,5

75 7,53 22,56 24.4 29,0 33,5

70 7,32 22,56 0,0 0,0 0,0

65 8,78 31,64 25,0 29,0 33,5

. 60 8,53 31,64 25,9 30,5 36,6

5 4 55 8,32 31,64 274 30,5 30,5
=2 3 50 8,08 31,64 24.4 27,4 30,5
45 7,86 31,64 25,9 29,0 32,0

40 7,62 31,64 0,0 0,0 0,0

8 13,17 20,18 22,9 24.4 274

v . 7 13,23 20,30 244 26,8 29,9
é 4 6 13,26 20,42 21,3 24,4 27,4
% S 5 13,32 20,54 25,9 29,0 30,5
4 13,35 20,67 24,8 25,9 29,9

3 13,41 20,82 0,0 0,0 0,0

For the last cross section of the river system (cross section 4(0) you can enter the
following description: Downstream River Station

Remember to save the Geometry data at regular intervals in case of a power failure or human
error. To assist with this you could also go to the main HEC-RAS screen and set the Backup
saving function at a short interval (Options menu, Program Setup, Set Time for Automatic
Backup... and enter 5 minutes). Make sure the Automatically Backup Data is selected (see
Figure 11.69).

Default File Viewer ...

Default Project Folder ...

Open last project on startup
v Automatically Backup Data

Set Time for Automatic Backup ...

Figure 11.69: Automatically Backup Data
Entering junction data

Junction button on the Geometric window (Figure 11.58). Once this button is

y The next step is to enter the junction data. This is accomplished by clicking the
unct.
| clicked, the Junction Data editor will appear as shown in Figure 11.70.
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Junction Data - Base Geometry

o N = ﬂ 1] | Steady Flow Computation Mode

(¢ Energy
Description |Division of Upper Reach and Lower Reach at D " Momentum
[ .t’l-'ujd _Frit_fllilr'l
- [ AddWeight
From: Riet river - Lower reach Length (m) Unsteady Flow Computation Mode
To: Riet river - Upper reach 24.4 @ Force Equal WS Elevations
To: Blesbok river - Lower reach 213 " Energy Balance Method
0K | Cancel Help

Select Junction to Edit

Figure 11.70: Junction Data Editor

There is only one junction in the river system. For this junction add the following description:
Division of Upper Reach and Lower Reach at Confluence with Blesbok River (see Figure
11.70)

Reach lengths across the junction are entered in the junction editor, rather than in the cross
section data. This allows for the lengths across very complicated confluences (i.e. flow splits)
to be accommodated. This is the reason why the reach lengths in the cross section data for the
last cross section of each reach was left blank or set to zero. Enter the junction lengths of 24,4
m and 27,3 m for the Riet River — Upper reach and Blesbok River — Lower reach respectively
(see Figure 11.70).

In this exercise the energy equation will be used to compute the water surface profiles through
the junction for steady flow computations i.e. select the Energy option. If the momentum
equation was selected, then an angle can be entered for one or more of the reaches flowing
into or out of a junction. The momentum equation is set up to account for the angle of the
flow entering the junction.

For Unsteady flow computations the Force Equal WS Elevations option is selected.

Once you have entered all the data for the junction, click on the Apply button and close the
window by pressing the OK button.

Remember to save the Geometry data by clicking on Save Geometry Data from the File
menu.

Once all the data has been successfully entered your system should look like the schematic
layout shown in Figure 11.60.
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ENTERING AND EDITING UNSTEADY FLOW DATA

Once all of the geometric data are entered, the modeler can then enter the unsteady flow data that
is required. To bring up the unsteady flow data editor, select Unsteady Flow Data from the Edit

S
menu on the HEC-RAS main window or clicking the short cut button on the menu bar. The
Unsteady Flow data editor should appear as shown in Figure 11.71, for this exercise.

File Options Help
Boundaty Conditions | Iritial Conditions | _Apply Data |

Boundary Condition Types

River Reach RS Boundary Condition
Blesbok river Lower reach 8 Flow Hydrograph

—d

Figure 11.71: Unsteady Flow Data Editor

The user is required to enter boundary conditions at all of the external boundaries of the system, as
well as any desired internal locations, and set the initial flow conditions at the beginning of the
simulation.

Boundary conditions are entered by first selecting the Boundary Conditions tab from the
Unsteady Flow Data editor. River, Reach, and River Station locations of the external bounds of
the system will automatically be shown in the table. Boundary conditions are entered by first
selecting a cell in the table for a particular location, then selecting the boundary condition type that
is desired at that location. Not all boundary condition types are available for use at all locations.
The program will automatically gray-out the boundary condition types that are not relevant when
the user highlights a particular location in the table.
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Users can also add locations for entering other internal boundary conditions. To add additional
boundary condition location, select the desired River, Reach, and River Station from the drop
down lists and press the Add a Boundary Condition Location button. In this exercise this is
however not required.

Boundary Conditions

There are several different types of boundary conditions available to the user. The following
is a short discussion of each type:

¢ Flow Hydrograph (this is the type that you can enter for this exercise)
A flow hydrograph can be used as either an upstream boundary or downstream boundary
condition, but is most commonly used as an upstream boundary condition. When the flow
hydrograph button is pressed, the window shown in Figure 11.72 will appear. As shown, the
user can either read the data from a HEC-DSS (HEC Data Storage System) file, or can enter
the hydrograph ordinates into a table (Since River station 8 was selected as shown in Figure
11.71 the flow hydrograph detail for this stations is first required).

Flow Hydrograph
River: Blesbok river Reach: Lower reach RS: 8
" Read from DSS before simulation Select DSS file and Path
File: |
Path: |

¢ Enter Table Data time interval: |1 Hour vl

Select/Enter the Data's Starting Time Reference
¢ Use Simulation Time: Date: | Time: |

" Fixed Start Time: Date: | _JTime: |

No. Urdinatesl Interpolate Missing Yalues I Del Row I Ins Row |

Date Simulation Time Flow

(hours) [m3/s)

00:00
01:00
02:00
03:00
04:00
05:00
7 06:00 ¥

Time Step Adjustment Options [*'Critical”" boundary conditions)
[~ Monitor this hydrograph for adjustments to computational time step

Max Change in Flow [without changing time step) I
Min Flow: | Multiplier: |

Plot Data | 0K | Cancel I

D= jra|—

Figure 11.72: Flow Hydrograph (River station 8 — Blesbok River)

e The user also has the option of entering a flow hydrograph directly into a table, as shown in
Figure 11.72. The first step is to select a Data time interval from the drop down list.
Currently the program only supports regular interval time series data.
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A list of allowable time intervals is shown in the drop down window of the data interval list
box. For this exercise select 15 Minute.

e To enter data into the table, the user is required to select either Use Simulation Time or Fixed
Start Time. For this exercise select Use Simulation Time.

o Instead of entering the data points of the flow hydrographs one-by-one by hand open the Excel
spreadsheet entitled: Exercise 2 - Flow hydrographs.xls. Copy the flow rate values for the
Blesbok River flow hydrograph (only the flow rates). Return to the HEC-RAS Flow
Hydrograph data editor, select at least 25 rows in the hydrograph table and press Ctrl V on
the keyboard to paste the copied data (see Figure 11.73).

Flow Hydrograph
River: Blesbok river Reach: Lower reach RS: 8
" Read from DSS before simulation |1 Select D55 fle andPath ]
File: |
Path: |

% Enter Table Data time interval: |15Minute vl

Select/Enter the Data's Starting Time Reference
¢ Use Simulation Time: Date: | Time: |

" Fixed Start Time: Date: | jTime: |

No. Urdinatesl Interpolate Missing Values I Del Row I Ins Row |

Hydrograph Data

Date Simulation Time Flow
(hours) [m3/s)

1 00:.00 05

2 00:15 05

3 00:30 05

4 00:45 2.

5 01:00 7.

6 01:15 14.

7 01:30 20. Y.

Time Step Adjustment Options ["'Critical”* boundary conditions)
[ Monitor this hydrograph for adjustments to computational time step

Max Change in Flow [without changing time step) I
Min Flow: | Multiplier: |

Plot Data | ok | Cancel |

Figure 11.73: Flow Hydrograph (River station 8 — Blesbok River)

e An option listed at the bottom of the flow hydrograph boundary condition is to make this
boundary a Critical Boundary Condition. When you select this option, the program will
monitor the inflow hydrograph to see if a change in flow rate from one time step to the next is
exceeded.

If the change in flow rate does exceed the user entered maximum, the program will
automatically cut the time step in half until the change in flow rate does not exceed the user
specified max.
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e The other options at the bottom of this editor are Min Flow and Multiplier. Both of these
options apply to user entered hydrographs or hydrographs read from HEC-DSS. The “Min
Flow” option allows the user to specify a minimum flow to be used in the hydrograph. This
option is very useful when too low of a flow is causing stability problems.

o The flow hydrograph for this exercise can be plotted by clicking on the Plot Data button (see
Figure 11.74).

Q Flow Hydrograph E]@
{Piot’] Table
River: Blesbok river Reach: Lower reach RS: 8 J
Legend

ke

301 Flow

357

257

207

Flow (m3/s)

157

107

0
0.00 0.05 0.10 0.15 0.20 0.25
Simulation Time (days) J

Figure 11.74: Flow hydrograph (Plot of River station 8 flow hydrograph)
The maximum peak flow value is 31,0 m%/s (time 2:30)

e Similarly a flow hydrograph can be entered for River station 100, which is the upstream
boundary of the Riet River — Upper reach.

e The completed Flow Hydrograph editor screen and plot screen is shown in Figure 11.75 and
Figure 11.76 respectively. The maximum peak flow value is 84,0 m*/s (time 2:00).

The spreadsheet (Exercise 2 - Flow hydrographs.xls) containing the flow hydrographs is
provided on the supporting flash drive.
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Flow Hydrograph

River: Riet river Reach: Upper reach RS: 100

" Read from DSS before simulation
File: |
Path: |

+ Enter Table Data time interval I 15 Minute - I

— Select/Enter the Data's Starting Time Reference -
' Use Simulation Time: Date: | Time: |

" Fixed Start Time: Date: | _Q'ITirrle: |

No. Elrdinatesl Interpolate Missing Values | Del Row | Ins Row I

Hydroaraph Data

Date Simulation Time Flow
(hours) [m3/s)
1 00:00 1.
2 00:15 10.
3 00:30 20.
4 00:45 30.
5 01:00 48
6 01:15 E6.
7 01:30 76. 2

— Time Step Adjustment Options ["'Critical' boundary conditions]
[™ Monitor this hydrograph for adjustments to computational time step

Max Change in Flow [without changing time step): |

MinFlow. [ Mulipler [

PlotData | ok | Cancel |

Figure 11.75: Flow Hydrograph (River station 100 — Riet River)

2] Flow Hydrograph o]
{Piot’| Tablel
River: Riet river Reach: Upper reach RS: 100 ;I
1007 Legend
e
Flow
807
g 601
E
2
2 401
20+
0 T . . . )
0.00 0.05 0.10 0.15 0.20 0.25
Simulation Time (days) |
;I »

Figure 11.76: Flow hydrograph (Plot of River station 100 flow hydrograph)

11-196 Free surface flow determination



¢ Normal Depth (this is the type that you can enter for this exercise)

The Normal Depth option can only be used as a downstream boundary condition for an open-
ended reach. This option uses Manning’s equation to estimate a stage for each computed
flow. Select River station 40’s cell on the Unsteady Flow Data editor window. Click the
Normal Depth button. A pop-up window will prompt you to enter the downstream friction
slope, which should be used to calculate the flow depth at this downstream boundary for each
flow (in the time series arriving at this river station), see Figure 11.77. Enter a slope of
0,001 m/m.

. Unsteady Flow Data - Base Unsteady Flow
File Options

Boundary Conditions | Initial Conditions |

Help

Boundary Condition Types

Stage Hydrograph FlowHydiogiaph | Stage/FlowHydr. | RatingCuve |
NomalDepth | Lateralinflow Hydi. | Uniform Lateral Inflow | Groundwater
T.S. Gate Openings | Elev Controlled Gates | Navigation Dams |
Rules |

Add Boundary Condition Location

AddRS ... | Add E-rl:l.’-:Jl_]'_ Area I Add SA Connection |
River Reach RS Boundary Condition
1| Blesbok river Lower reach 8 Flow Hydrograph
2| Riet river Upper reach 100 Flow Hydrograph
3| Riet river Lower reach 40 Normal Depth

Figure 11.77: Normal flow depth boundary (River station 40)
Other boundary types not used in this example:

Stage Hydrograph

A stage hydrograph can be used as either an upstream or downstream boundary condition.
The editor for a stage hydrograph is similar to the flow hydrograph editor. The user has the
choice of either attaching a HEC-DSS file and path name or entering the data directly into a
table.
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Rating Curve

The rating curve option can be used as a downstream boundary condition. The user can either
read the rating curve from HEC-DSS or enter it by hand into the editor. The downstream
rating curve is a single valued relationship, and does not reflect a loop in the rating, which
may occur during an event.

Elevation Controlled Gate

This option allows the user to control the opening and closing of gates based on the elevation
of the water surface upstream of the structure. A gate begins to open when a user specified
elevation is exceeded. The gate opens at a rate specified by the user.

Initial Conditions

e In addition to the boundary conditions, the user must establish the initial conditions of the
system at the beginning of the unsteady flow simulation. Initial conditions consist of flow and
stage information at each of the cross sections, as well as elevations for any storage areas
defined in the system. Initial conditions are established from within the Unsteady Flow Data
editor by selecting the Initial Conditions tab. After the Initial Conditions tab is selected, the
Unsteady Flow editor will appear as shown in Figure 11.78.

1

[~ o "
. Unsteady Flow Data - Base Unsteady Flow =8 E=E <"
File Options Help

Initial Flow Distribution Method

" Use aRestart File Filename: | =
(& Enter Initial flow distribution

Locations of Flow Data Changes
River Reach RS Initial Flow
1| Blesbok river Lower reach 8 05
2| Riet river Upper reach 100 |1
3| Riet river Lower reach 65 1.5

Initial Elevation of Storage Areas

Storage Area Initial E levation

1
 —————

Figure 11.78: Unsteady Flow Data (Initial Conditions)

e As shown in Figure 11.78, the user has two options for establishing the initial conditions of
the system. The first option is to enter flow data for each reach and have the program perform
a steady flow backwater run to compute the corresponding stages at each cross section.
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This option also requires the user to enter a starting elevation for any storage areas that are
part of the system. This is the most common method for establishing initial conditions. Flow
data can be changed at any cross section, but at a minimum the user must enter a flow at the
upper end of each reach.

The second option is to read in a file of stages and flows that were written from a previous run,
which is called a “Restart file”. The first option is used in this exercise.

Enter the initial flows as indicated in Figure 11.78, 0,5 m?/s, 1,0 m*/s and 1,5 m3/s for cross
sections 8, 100 and 65 respectively.

Saving the Unsteady Flow Data

e The last step in developing the unsteady flow data is to save the information to a file. To save
the data, select the Save Unsteady Flow Data As from the File menu on the Unsteady Flow
Data editor. A pop-up window will appear prompting you to enter a title for the data as
shown in Figure 11.79. Enter “Base Unsteady Flow” for this exercise, and then press the OK
button. A file name is automatically assigned to the Unsteady Flow Data based on what you
entered for the project file name i.e. Exercisel.u01.

.
Save Unsteady Flow Data As
Title File Name Selected Folder Default Project Folder Documents
|Base Unsteady Flow Exercise2 u* C:ASANRALME xercise 2
= [3Y
4 SANRAL
0K Cancel | Hep |  CreateFolder... | [S e [Createk2012) |
|Select diive and path and enter new Title.

Figure 11.79: Saving Unsteady Flow Data
Other unsteady Flow Data Options

Several options are available from the Unsteady Flow Data editor to assist users in entering
and viewing data. These features can be found under the Options menu at the top of the
window. The following options are available:

Delete Boundary Condition

This option allows the user to delete a boundary condition from the table. To use this option,
first select the row to be deleted with the mouse pointer. Then select Delete Boundary
Condition from the options menu. The row will be deleted and all rows below it will move
up one. Only user inserted boundary conditions can be deleted from the table. If the boundary
condition is an open end of the system, the system will not allow that boundary to be deleted.
There must always be some type of boundary condition at all the open ends of the system.

Internal RS Initial Stages

This option allows the user to specify starting water surface elevations for any internal cross
section within the system. A common application of this would be to specify the starting pool
elevation for the first cross section upstream of a dam (modeled with the inline weir/spillway
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option). The user specifies locations and water surface elevations, which are then used to
establish the initial conditions for the system at the beginning of a run.

Observed Data In DSS
This option allows the user to attach observed data pathnames from a HEC-DSS file to
specific river stations within the model.

When an observed data path name is attached to a specific river station location, the user can
get a plot of the observed flow or stage hydrograph on the same plot as the computed flow and
stage hydrographs. Additionally, the observed data will show up on profile and cross section
plots. To use this option, the user selects Observed Data In DSS from the Options menu of
the Unsteady Flow Data editor.

Minimum Flow and Flow Ratio Table

This option brings up a global editor that will show all the locations in which flow
hydrographs have been attached as boundary conditions. The editor allows the user to enter a
minimum flow or a flow factor for each flow hydrograph boundary condition.

UNSTEADY FLOW ANALYSIS

Performing Unsteady Flow Calculations

Once all of the geometry and unsteady flow data have been entered, the user can begin
performing the unsteady flow calculations. To run the simulation, go to the HEC-RAS main
window and select Unsteady Flow Analysis from the Run menu or click on the Unsteady

Flow Analysis button @ on the menu bar. The Unsteady Flow Analysis window will
appear as shown in Figure 11.80.
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4. Unsteady Flow Analysis
File Options Help

Plan: | ShotiD |

Lol

[

Geometry File : IBase Geometry

=

Unsteady Flow File : |Base Unsteady Flow

=

Plan Description :
— Programs to Run 1 Q
¥ Geometry Preprocessor
[V Unsteady Flow Simulation

~ Simulation Time Window

Starting Date: | _, Starting Time: |
Ending Date: | . Ending Time: |
 Computation Settings

Computation Interval: m Hydrograph Output Interval: m
I~ Computation Level Output Detailed Output Interval: m
DSS Output Filename:  |C:ASANRAL\E xercise 2\Exercise2.dss EI
[ Mixed Flow Regime (see menu: "Options/Mixed Flow Options ..."")

Compute I

Figure 11.80: Unsteady Flow Analysis

o The first step is to put together a Plan. The Plan defines which geometry and flow data are to
be used, as well as providing a title and short identifier for the run.

To establish a plan, select New Plan from the File menu on the Unsteady Flow Analysis
window. Enter the plan title as Base analysis and then press the OK button (Figure 11.81).

Save Plan Data As
Title File Name Selected Folder Default Project Folder [ Documents |
EBase analysig Exercise2 p* C:\SANRAL\E xercise 2
A
Y SANRAL
= Exercise 2
0K Cancel | Hep |  CreateFolder... | [ S e [Createk2012) ~|
rSeIecl diive and path and enter new Title.

Figure 11.81: Creating new plan

e You will be prompted to enter a short identifier. Enter a title of Base in the Short ID box
(Figure 11.82) and click on the OK button.
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HEC-RAS

Enter the short plan Identifier (16
char max)

|8&se!

oK | Cancel |

Figure 11.82: Plan identifier

¢ Selecting Programs to Run
There are three components used in performing an unsteady flow analysis within HEC-RAS.
These components are: a geometric data pre-processor; the unsteady flow simulator; and an
output post-processor (see Figure 11.80).

o

Geometric Pre-Processor

The pre-processor is used to process the geometric data into a series of hydraulic
properties tables, rating curves, and family of rating curves. This is done in order to
speed up the unsteady flow calculations. Instead of calculating hydraulic variables for
each cross-section, during each iteration, the program interpolates the hydraulic variables
from the tables. The pre-processor must be executed at least once, but then only needs to
be re-executed if something in the geometric data has changed.

Unsteady Flow Simulation

The unsteady flow computations within HEC-RAS are performed by a modified version
of the UNET (Unsteady NETwork model) program, developed by Dr. Robert Barkau
(Barkau, 1992) and modified by HEC. The unsteady flow simulation is actually a three-
step process. First, a program called RDSS (Read DSS data) runs.

This software reads data from a HEC-DSS file and then converts all of the boundary
condition time series data into the user specified computation interval. Next, the UNET
program runs. This software reads the hydraulic properties table computed by the pre-
processor, as well as the boundary conditions and flow data from the interface and the
RDSS program.

The program then performs the unsteady flow calculations. The final step is a program
called TABLE. This software takes the results from the UNET unsteady flow run and
writes them to a HEC-DSS file.

Post-Processor

The post-processor is used to compute detailed hydraulic information for a set of user
specified time lines during the unsteady flow simulation periods. In general, the unsteady
flow computations only compute stage and flow at all of the computation nodes, as well
as stage and flow hydrographs at user specified locations. If the post-processor is not run,
then the user will only be able to view the stage and flow hydrographs and no other
output from HEC-RAS. By running the post-processor, the user will have all of the
available plots and tables for unsteady flow that HEC-RAS normally produces for steady
flow.

¢ Simulation time window
The user is required to enter a time window that defines the start and end of the simulation
period. The time window requires a starting date and time and an ending date and time.
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In this exercise the flow hydrograph shown in Figure 11.73 and Figure 11.75 starts at 0:00
and has data until 06:00 and this is used in the simulation time window. The date can be
anything since the option to Use Simulation Time on the Flow Hydrograph window was
selected (see Figure 11.73 and Figure 11.75). Enter the Starting date as 0/JAN2013 and the
Ending date as 0/JAN2013. Enter the Starting time as 0000 and the Ending time as 0600.

Computational settings

The computational Settings area contains the Computational Interval, Hydrograph Output
Interval, Detailed Output Interval, the name and path of the output DSS file, and whether or
not the program is run in a mixed flow regime. The computation interval is probably one of
the most important parameters entered into the model. It should be small enough to accurately
describe the rise and fall of the hydrographs being routed but not small to take forever to
compute.

For this exercise set the Computational Interval at 5 minutes (from the drop down list). Set
the Hydrograph Output Interval to /5 minutes and the Detailed Output Interval also at
15 minutes.

The DSS Output filename is the file that contains all the calculated data in a format that can
be read by HEC-RAS and used in displaying all the results (tables and graphs). The default
will be ....\Exercise2.dss and does not have to be changed for this exercise.

The completed Unsteady Flow Analysis screen is shown in Figure 11.83.

5. Unsteady Flow Analysis
File Options Help
Plan : |Base analysis ShotID |Base
Geometry File : | Base Geometry L]
Unsteady Flow File : | Base Unsteady Flow LI

Plan Description :
Programs to Run D
[v Geometry Preprocessor
v Unsteady Flow Simulation
[V Post Processor

Simulation Time Window

Starting Date: IDHAN 2013 _l Starting Time: |UUEFU
Ending Date: [010AN2013 _] Ending Time: 0600

Computation Settings

Computation Interval: |5Minute v| Hydrograph Output Interval: |15 Minute v[

[~ Computation Level Output Detailed Dutput Interval: | 15 Minute « I
DSS Qutput Filename: IE:\SAN RALA\E xercise 2\Exercise2.dss E{

[ Mixed Flow Regime (see menu: "Options/Mixed Flow Options ...")

h Compute |

Figure 11.83: Unsteady Flow Analysis (completed)

Click on the Compute button to run the Unsteady Flow Analysis.
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VIEWING THE RESULTS

Once the model has finished all of the computations successfully, you can begin viewing the
results. Several output options are available from the View menu bar on the HEC-RAS main
window. These options include:
a) Cross section plots

b) Profile plots
¢) General profile plot
d) Rating curves
e) X-Y-Z perspective plots
f) Detailed tabular output at a specific cross section (cross section table)

g) Limited tabular output at many cross sections (profile table)

e Begin by plotting a cross section. Select Cross Sections from the View menu bar on the HEC-
RAS main window. Any cross section can be plotted by selecting the appropriate river, reach
and river station (See Figure 11.84). Several plotting features are available from the Options
menu bar on the cross section plot window. These options include: zoom in; zoom out;
selecting which plans, profiles, variables to plot; and control over lines, labels, symbols,

scaling etc.

r

=~ Cross Section o | @ |
File Options Help
River |Riet river | »le] | + 0| Reload Data
Reach: |Upper reach ~| RiversSta: [100 ~| &|[x]
Bridge and weir Plan: Base analysis B
Upstream River Station
035 ke 025 035 —]
301 Legend
EG Max WS
281 WS Max WS
Ground
1 *
[ Bank Sta
261
3
< ]
- 244
£ S E— —
w
221
201
18 y T T T J
10 15 20 25 30
Station (m) J
Ed| [

Figure 11.84: Cross section (Riet River: Upper reach — River station 100)

e Select different cross sections to plot and practice using some of the features available under
the options menu bar. First try and view the change in water level at this cross section. Click

on the Play button, L“I, on the Cross Section window. An Animation Control window will

appear (see Figure 11.85). Click on the Expand button, ‘;], to see the entire control.
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r &

. Animation Control @

OUAN20130015 <[ § Ay |

Animation Speed

Zero Delay ﬂ J ﬂ 1 sec/prof

Figure 11.85: Animation Control

Set the Zero Delay horizontal scroll bar as indicated (in Figure 11.85) and click on the play
button, LI, to view the changing water surface levels and energy grade lines at this cross

section. Click the Stop button, !I, to stop the animation.

Try and make a movie clip by viewing the change in flow levels with time (Figure 11.84), this
can be done by clicking on the Record button (red dot Figure 11.84) to start recording and
clicking it again will stop recording. You will be prompted as shown in Figure 11.86,
whether or not you would like to record a movie (AVI). Click on the Yes button, remember
the program starts recording as soon as you click on the Yes button.

r =

RAS 3
Do you want to record a movie (AVI) file from the graphics in the
current plot?
Note - you cannot change the physical size of the window while

recording.
(though you can zoom in, zoom out and pan around)

Yes No

Figure 11.86: Confirming that a movie clip should be recorded

Click on the Play button, L‘-I, to start playing the animation as explained earlier. Once the
animation ends click on the Record button (red dot Figure 11.84) again to stop recording.
The recorded screen captures will be shown as indicated in Figure 11.87. You now have the
option of saving the screens after performing some editorial work to an AVI file by clicking
on the Write AVI button.
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Figure 11.87: Recorded screens

e Next plot a water surface profile. Select Water Surface Profiles from the View menu bar.
This should give you a profile plot as shown in Figure 11.88.

' Reaches ... |8|t| Profiles ... IL.I@ I~ PlotInitial Conditions  Reload Data |
Bridge and weir ~ Plan: Base analysis B
ke Riet river Upper reach =]|
Legend
"EG 01JAN2013 0200
WS 01JAN2013 0200
—— —
| Ground
E
!
w
Main Channel Distance (m) -

Figure 11.88: Water Surface Profile (for Riet River: Upper reach)

11-206 Free surface flow determination



e Also have a look at a General Profile Plot and the X-Y-Z Perspective Plot (Figure 11.89).
Also look at some tabular output. Go to the View menu bar on the HEC-RAS main window.
There are two types of tables available, a detailed output table and a profile summary table.
Select Detailed Output Tables to get the first table to appear. This table shows detailed
hydraulic information at the cross section. Other cross sections can be viewed by selecting the
appropriate reach and river from the table. A table with all the errors, warnings and comments
can also be viewed, by selecting Summary, Err Warn, Notes... from the View menu on the
HEC-RAS main window.

"

% X-Y-Z Perspective Plot =8 El <
File Options
Upstream RS I—_l J_l:“g | i | j Heload D
[oratnas o | | Rotation Angle l =
' - Azimuth Angle 85 .
Bridge and weir ~ Plan: Base analysis af

Legend

[————————]
WS 01JAN2013 0200
Ground

-
Bank Sta

g " -

Figure 11.89: X-Y-Z Perspective plot

You will now be in a position to answer some of the questions at the back of this exercise
(Questions 1 to 5).

BRIDGES

In the next section a bridge structure will be added downstream of the confluence of the two rivers.
HEC-RAS computes energy losses caused by structures such as bridges and culverts in three parts.
One part consists of losses that occur in the reach immediately downstream from the structure where
an expansion of flow takes place. The second part is the losses at the structure itself, which can be
modeled with several different methods. The third part consists of losses that occur in the reach
immediately upstream of the structure where the flow is contracting to get through the opening.

Cross section locations

The bridge routine utilizes four user defined cross sections in the computation of energy losses due to
the structure.
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Cross section 1 is located sufficiently downstream from the structure so that the flow is not affected
by the structure (i.e. the flow has fully expanded)

Cross section 2 is located immediately downstream from the bridge (i.e. within a short distance).

This cross section should represent the natural ground just outside the bridge.

Cross section 3 should be located just upstream of the bridge. The distance between cross section 3
and the bridge should be relatively short. This distance should only reflect the length required for the
abrupt acceleration and contraction of the flow that occurs in the immediate area of the opening.

Cross section 4 is an upstream cross section where the flow lines are approximately parallel and the

cross section is fully effective.

Contraction
reach

-
Flow

Length of
bridge

Expansion
reach

h 4

Entering bridge data

e To enter bridge data the user presses the Bridge/Culvert button on the Geometric data
window (Figure 11.60). Once the Bridge/culvert button is pressed, the Bridge/Culvert Data
Editor will appear as shown in Figure 11.90.
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X Bridge Culvert Data - Base Geometry

File View Options Help

River. |Riet river ~| spply Data__ |

Reach: |Lowet reach LI River Sta.: < ﬂl]
Description | = E]

Bounding XS's: Distance between: [not set) (m)

[E=% ECR =

D
Romv I

Pier

Sloping No Data for Plot

Bridge
Modeling
Approach

Culvert
=4

Multiple
Opening
Analysis

HTah
Param.

No Data for Plot

HTab
Curves

Bridge
Design

Figure 11.90: Bridge/Culvert Data window

To add a bridge to the model, take the following steps:

Select the river and reach that you would like to place the bridge in (from the drop down lists)

1.e. Riet river and Lower reach.

e From the Options menu, select Add a Bridge and/or Culvert from the list. An input box
will appear prompting you to enter a river station identifier for the new bridge.

Enter 52 as shown in Figure 11.91.

HEC-RAS

Enter a new river station for the new
bridge or culvert in reach “"Lower

reach"

|52

0K | Cancel

Figure 11.91: Bridge river station (Riet River: Lower reach)

e Enter the Description of the bridge: Stephnie bridge (see Figure 11.92)
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X Bridge Culvert Data - Base Geometry
File View Options Help

River: I Riet river

~] ApplyData | + |

Reach: I Lower reach

| River Sta.: [52 ~| 3| 1|

E=NHCR *x=

Description ISlephnie bridge] - D
BoundingXS's: 55 | 50 | Distance between: 30.5 (m)
Roekly RS=52 Upstream (Bridge) J
o - Legend
= — 26! [——
Pier E Ground
: °
_l_ .% A Bank Sta
Sloping| & 227
Abutment| o 201
= 18 T T T T T T T 1
Bridge 0 5 10 15 20 25 30 35 40
Modeling
Approach
Culvert RS=52 Downstream (Bridge)
@
[
T 26}\\'-\
Muliple | E
Opening | ¢ 241
Analysis -%
s
HTab | 2
Param, 20
18 T . T - T . , . . v T .
HTab 5 10 15 20 25 30 35 40
Curves Station (m) E
Bridge =l ]
Design

Figure 11.92: Upstream and downstream view of cross sections at bridge

e Enter all of the required data for the new bridge. This includes:
Bridge deck
Sloping abutments (optional)

a.

b.
c.
d.

Piers

(optional)

Bridge modeling approach information

e From the Bridge/Culvert Data Editor select the Deck/Roadway icon to activate the
Deck/Roadway Data Editor as shown in Figure 11.93.

e The first input at the top of the editor is the distance from the upstream side of the bridge deck
to the cross section immediately upstream from the bridge (i.e. river station 55). This distance
is 5 m.

e The bridge deck itself will have a width of 7,5 m. The weir flow coefficient selected for this
analysis is 1,44.

o The bridge deck will be 0,9 m high and will have a slope across it of 0,05 m (for road
drainage).
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Deck/Roadway Data Editor
| Distance |  Widh |  WeiCoef |

0 1.44

Clear | Del Row | Ins Row | Copy US to DS |

|

Station |high chord| low chord |  Station |high chord| low chord || &
__1]5. 235 20. 5. 2345 20.
_2|125 235 20. 125 2345 20. i
3125 235 226 125 2345 226
_4]275 235 226 275 23.45 226
_5|275 235 20. 275 2345 20.
__B|325 235 20. 325 2345 20.

7

—l =]

U.S Embankment 55 |2 D.S Embankment S5 |2

Weir Data
Max Submergence: |U. 95 Min Weir Flow EL: I

Weir Crest Shape
(® Broad Crested
Ogee

ok | Cancel |

Enter distance between upstream cross section and deck/roadway. [m)

Figure 11.93: Bridge/Deck and Roadway data editor window

At every station position the high chord and low chord of the bridge should be entered as
shown in Figure 11.93 to provide a bridge shape as shown in Figure 11.94.

The US and DS Embankment SS (upstream and downstream embankment side slope) values
should be entered as 2 (horizontal to 1 vertical). These values are used for the graphical
representation on the profile plot.

At the bottom of the Deck/Roadway Data Editor, there are three additional fields of data
entry. The first is the Max Allowable Submergence. This input ratio of downstream water
depth to upstream energy, as measured above the minimum weir elevation. When the ratio is
exceeded, the program will no longer consider the bridge deck to act as a weir and will switch
the computation mode to energy (standard step) method. For this exercise the default value of
0,95 (95%) should be selected.

The second field at the bottom of the editor is the Min Weir Flow Elevation. This is the
elevation that determines when weir flow will start to occur over the bridge. If this field is left
blank (as in this exercise), the program will default to use the lowest high cord value on the
upstream side of the bridge. The last field at the bottom of the editor is the selection of the
Weir Crest Shape. This selection will determine the reduction of the weir flow coefficient
due to submergence. For this exercise, a Broad Crested weir shape should be selected.

Click the OK button
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X Bridge Culvert Data - Base Geometry + bridge (o] @ |==)
File View Options Help

River: [Fliet fiver LJ | ir .l

Reach: [Lawer reach :_J River Sta.: [52—L| ﬂﬂ
Description [Slephnie bridge B |;|
Bounding XS's: |88 51 |Dislance between: 20.5 (m)

Rgggte;y RS=52 Upstream (Bridge) _J
Legend

4 —_—
Pier ] r Ground

L f *
I 26-\.. / Bank Sta
Slopina 1 )

2] =

Bridge
Modeling
A b

PP

Elevation (m)

Culw ]
et 224
Mukiple 1

Opening 1
Analysis 201

HTab
Param.

18 — 7
HTab 0 10 20 30 40

Curves Station (m) J

Bridge ] =3

Design

Figure 11.94: Bridge data (View of bridge)

This bridge has three piers that should be entered. From the Bridge/Culvert Data Editor
select the Pier icon to activate the Pier Data Editor as shown in Figure 11.95. The three piers
are entered by specifying the Centerline station at the upstream side as well as the
downstream side. The first pier is positioned at /5 m. It has a width of 0,5 m and it starts at a
level below the ground profile and ends at a level inside the bridge defined cords i.e. 20 and
23 m.

Click on the Add button to add a pier (Pier #2). The second pier is at centerline 20 m, has a
width of 0,5 m and starts at elevation /9 m and ends at elevation 23 m.

Click on the Add button to add a pier (Pier #3). The third pier is at centerline 25 m, has a
width of 0,5 m and starts at elevation /9 m and ends at elevation 23 m.

Click on the OK button to return to the Bridge Culvert Data editor to view the specified piers
(see Figure 11.96).
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Pier Data Editor

Add | Copy I Deleiel

e [ 31

Del Row | Centerline Station Upstream

e
—

Ins Row | Centerline Station Downstream
1~ Floating Pier Debris

AlOn... | AIOK... | ™ Apply floating debris to this pier

SetWd/Htforall... | pebris Width:
Debris Height:

[ |
| ,

Upstream

Pier Width | Elevation | Pier'Width | Elevation

_1]05 20.
_2|05 23,
3
Ll
5]
[
0K Cancel |

Downstream

b4

05
05

20.
23,

Help | Copy Up to Down

Select the Pier to Edit

Figure 11.95: Pier Data Editor

X Bridge Culvert Data - Base Geometry + bridge [0 ® (=]
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Figure 11.96: Bridge data (View of bridge with piers)
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Another cross section within a short distance downstream of the bridge is also required. This

cross section should represent the natural ground where the flow is not affected by the by the

structure (fully expanded). Return to the Geometric Data Editor by exiting the Brid%e
Cross
Section

Culvert Data window (Exit under the File menu). Click on the Cross Section button, 2
on the Geometric window (Figure 11.60). Go to cross section 55, just upstream of the new
bridge (Riet River: Lower reach). Under the Options menu, click on Copy current cross
section. Enter the new River station name, 5/, as shown in Figure 11.97.

Copy Cross Section

Select a River and Reach and then enter a new river station.

River: |Riel river ﬂ
Reach: | Lower reach v| River Sta: 51

e OK

Cancel |

Figure 11.97: New cross section (River station 51)

This will position the new cross section downstream of the newly added bridge (which is at
cross section 52). The reach lengths should also be corrected. This new cross section is § m
downstream of the bridge, thus the distance from River station 55 to the bridge is 5 m, the
width of the bridge is 7,5 m and this cross section is a further § m downstream of the bridge.
The total distance from River station 55 to River station 51 is 20,5 m. Go to River station 55
and change all the reach lengths to 20,5 m. Click on the Apply button to accept the changes.

Now go to the newly created River station 51 and change the reach lengths (by subtracting the
20,5 m from the previous lengths) to:

Downstream reach lengths: LOB = 6,9 Channel = /0,0 and ROB = 10,0

The total reach lengths between River station 55 and River station 50 will thus still remain the
same.

The average slope between River stations 55 and 50 is 0,000656 m/m. The newly added River
station 51 currently has the same elevations as River station 55 (since it is a copy of RS 55).
To adjust the elevation of this River station (RS 51) with a value of the distance multiplied
with the average slope i.e. 20,5 m x 0,000656 = = 13 mm click on Adjust Elevations under
the Options menu. Enter an adjustment of -0,0/3 m (as shown in Figure 11.98) and click on
the OK button.

HEC-RAS

Enter amount to add to Elevations
(+4)

0013

UK Cancel |

Figure 11.98: Adjusting the elevation (River station 51)

The new River station 51 will then have the values as shown in Figure 11.99.
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River: |Riet river - |3;_ -|-‘| Plot Options %l@ I™ KeepPrevXXS Plots _ Clear Prev |
Reach: iLowel reach LI River Sla:[ﬁl l] ﬂﬂ Bridge and weir Plan: 1) Base
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=~ Cross Section Data - Base Geometry + bridge E]
Exit Edit Options Plot Help

-

Figure 11.99: River station 51 data

e Before we continue we need to save the Geometric data. This is done by clicking on S

automatically assigned to the geometry data based on what you entered for the project
name i.e. Exercise2.g02.

Save Geometry Data As
Title File Name Selected Folder Default Project Folder Documents
Base Geometry + bridge Exercise2 g" C:ASAMRALME xercise 2
Base Geometry Exercise2.g01 ACA
I SANRAL
(i3 Cancel | Hep |  CreateFolder... | [S e [Createk2012) ~|

|Select diive and path and enter new Title.

ave
Geometry Data As under the File menu on the Geometric Data window. After selecting this
option you will be prompted to enter a Title for the geometric data (Figure 11.100). Enter
“Base Geometry + bridge” for this exercise, and then press the OK button. A file name is
file

Figure 11.100: Save Geometry Data As

e The next step is to enter the ineffective flow areas. Any ineffective flow areas that exist due to
the bridge should be entered. At a bridge ineffective flow areas normally occur just upstream
and downstream of the road embankment, away from the bridge opening. It was for this

reason that River station 51 was added just downstream of the bridge.

e At River station 55 we need to enter the ineffective flow area by selecting Ineffective Flow

Areas from the Options menu under the Cross Section Data Editor window. An initial
the
bridge to the cross section was used (as an example). In this exercise the upstream cross
section is 5 m upstream of the bridge. Therefore, the left and right ineffective flow areas

estimate of the stationing of the ineffective flow areas, a ratio of 1:1 of distance from

should be set at 5 m left and right of the bridge opening. This however indicates that
ineffective flow area has to be specified since this will already be within the natural profile.
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As an example the ineffective flow areas for this exercise were specified at / m left and right
of the bridge opening at the upstream river station (RS 55), see Figure 11.101. The bridge
opening starts at station 12,5 m and ends at 27,5 m. These will both be permanent ineffective

areas up to the level of the bridge deck.

Ineffective Flow Areas

Select Ineffective Mode

Cancel I

v Permanent

& Nomal " Multiple Blocks
Left Right
Station [115 [28.5
Elevation [235 (235

[v Permanent

Defaults I Clear

Figure 11.101: Ineffective flow areas for river station 55

No ineffective flow areas were specified for the newly created downstream river station 51.
The ineffective flow areas could also be set by clicking on the Bounding XS’s 55 button on
the Bridge Culvert Data Editor screen (see Figure 11.96).

The entered bridge should now look similar to that shown in Figure 11.102.

-
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Figure 11.102: Bridge data (View of bridge with piers and ineffective flow areas)

1
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The contraction and expansion coefficients are used by the program to determine the transition
energy losses between two adjacent cross sections. Typical bridge contraction and expansion
coefficients are 0,3 and 0,5 respectively. Select Contraction\Expansion Coefficients (Steady
Flow) from the Tables menu on the Geometric Data Editor window and change the
contraction and expansion coefficients as indicated in Figure 11.103. These coefficients could
also be changed by clicking on the Cross Section Data editor and changing the cross sections
coefficients individually there. Please note these coefficients shown in Figure 11.103 are for
the Steady Flow analysis only. Similarly coefficients can be entered for an Unsteady Flow
Analysis by selecting Contraction\Expansion Coefficients (Unsteady Flow) from the
Tables menu on the Geometric Data Editor window.

Edit Contraction/Expansion Coefficients (Steady Flow)

River: I Rietriver | | 'éj ! g v Edit Interpolated XS's

Reach: | Lower reach

Selected Area Edit Options

K2

Add Constant ... | Multiply Factor... |  SetValues.. |  Replace.. |
River Station Contraction | Expansion

1|65 01 0.3
2|60 0.1 0.3
3|55 0.3 05
4152 Bridge

5|51 0.3 05
6/ 50 01 0.3
7|45 01 0.3
8/ 40 0.1 0.3

oK I

Cancel I Help |

Figure 11.103: Contraction and Expansion coefficients

Bridge Modeling Approach

The bridge routines allow the modeler to analyse the bridge flows by using different methods
with the same geometry. The different methods are: low flow, high flow and combination
flow.

From the Geometric Data Editor, select the Bridge/Culvert icon and then the Bridge
Modeling Approach button. This will activate the Bridge Modeling Approach Editor as
shown in Figure 11.104.

For this exercise select the energy, momentum and Yarnell equations.

The Energy equation method considers the bridge as just being part of the natural channel and
requires Manning’s “n” values for the friction losses through the bridge and coefficients of
contraction and expansion.

The Momentum Balance method performs a momentum balance through the bridge area and
requires the selection of drag coefficient, C4. Set the drag coefficient to 2,0 (Square nose
piers).

Yarnell Class A flows exists when the water surface through the bridge is completely
subcritical (i.e. above the critical depth). The flow regime without the bridge was subcritical
and thus Yarnell should also be selected. Enter the Yarnell pier coefficient K as 7,25 (Square
nose and tail).
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Select the Highest Energy Answer option. The program will show the results for the answer

for the method with the greatest energy loss as the final solution.

For high flows Energy Only (Standard Step) should be selected.

Bridge Modeling Approach Editor

Add | Copy | Delete | Bidge# [N ~| 3| |

Low Flow Methods
Use Compute
" |V Energy (Standard Step)

" |v Momentum Coef Drag Cd IZ—QJ
¢ ¥ Yamell(ClassAonly)  PierShapeK [1.25 12|
" |~ WSPRO Method (Class A only)  ‘WSPRO Variables |
¢ Highest Energy Answer

High Flow Methods
% Energy Only (Standard Step)
" Pressure and/or Weir
Submerged Inlet Cd [Blank for table) |
Submerged Inlet + Outlet Cd 0.8
Max Low Chord [Blank for default) |
0K Cancel | Help |

Select set of bridge coefficients to Edit

Figure 11.104: Bridge Modeling Approach Editor

HTab
e Go to the Hydraulic Table Parameters Editor by clicking on the HTab Param icon E

Set the Head Water Maximum Elevation value to 24,5 m (see Figure 11.105) and click on

the OK button.

. Parameters for Hydraulic Property Tables  [wi:dm
Number of points on free flow curve: |50

Number of submerged curves: |5El

Number of points on each submerged curves: |20
Apply number of points to all bridges and culverts ]

Head water maximum elevation: |24.5

T ail water maximum elevation (0O ptional): I

Maximum Flow (Recommended): I
Cancel |

Figure 11.105: Bridge Modeling Approach Editor

Before we continue we need to save the Geometric data. This is done by clicking on Save

Geometry Data under the File menu on the Geometric Data window.
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UNSTEADY FLOW ANALYSIS WITH BRIDGE

Performing Unsteady Flow Calculations with the Bridge

Once all of the geometry and unsteady flow data have been entered, the user can begin
performing the unsteady flow calculations. To run the simulation, go to the HEC-RAS main
window and select Unsteady Flow Analysis from the Run menu or click on the Unsteady

Flow Analysis button on the menu bar. The Unsteady Flow Analysis window will
appear as shown in Figure 11.106.

X

A Unsteady Flow Analysis =25
File Options Help

Plan: | ShotID |

Geometry File : | Base Geometry

=]
Unsteady Flow File : IB‘ase Unsteady Flow z

Plan Description :
Programs to Run D
[v Geomety Preprocessor

[V Unsteady Flow Simulation
IV Post Processor

Simulation Time Window :
Starting Date: | _] Starting Time: |
Ending Date: _] Ending Time: |

Computation Settings

Computation Interval: |1 Hour 'rl Hydrograph Output Interval: |1 Hour v|

[~ Computation Level Output Detailed Output Interval: |1 Hour vl
DSS Output Filename: [C:\SAN RAL\E xercise 2\Exercise2.dss =

&

[~ Mixed Flow Regime (see menu: "Options/Mixed Flow Options ...")

Compute

Figure 11.106: Unsteady Flow Analysis

o The first step is to put together a new Plan. The Plan defines which geometry and flow data
are to be used, as well as providing a title and short identifier for the run.

To establish a plan, select New Plan from the File menu on the Unsteady Flow Analysis
window. Enter the plan title as Base analysis + bridge and then press the OK button (Figure
11.107).
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Save Plan Data As

Title File Name Selected Folder Default Project Folder Documents
|Base analysis + bridge Exercise2 p* C:ASAMRAL\E xercise 2
Base analysis Exercise2.p01 = [

EYSANRAL

CoR ) Cancel | Hep |  CreateFolder... | [S ¢ [Createk2012) ~|
|Select diive and path and enter new Title.

Figure 11.107: Creating new plan

e You will be prompted to enter a short identifier. Enter a title of Bridge in the Short ID box
(Figure 11.108) and click on the OK button.

HEC-RAS

Enter the short plan Identifier (16
char max)

Bridge

Y S Cancel |

Figure 11.108: Plan identifier
e Select the correct Geometry file and Unsteady flow file from the drop down list.

e Selecting Programs to Run
There are three components used in performing an unsteady flow analysis within HEC-RAS.
These components are: a geometric data pre-processor; the unsteady flow simulator; and an
output post-processor (see Figure 11.106).

¢ Simulation time window
The user is required to enter a time window that defines the start and end of the simulation
period. The time window requires a starting date and time and an ending date and time.

In this exercise the flow hydrograph shown in Figure 11.73 and Figure 11.75 starts at 0:00
and has data until 06:00 and this is used in the simulation time window. The date can be
anything since the option to Use Simulation Time on the Flow Hydrograph window was
selected (see Figure 11.73 and Figure 11.75). Enter the Starting date as 0/JAN2013 and the
Ending date as 0/JAN2013. Enter the Starting time as 0000 and the Ending time as 0600.

e Computational settings
The computational Settings area contains the Computational Interval, Hydrograph Output
Interval, Detailed Qutput Interval, the name and path of the output DSSS file, and whether or
not the program is run in a mixed flow regime. The computation interval is probably one of
the most important parameters entered into the model. This should be small enough to
accurately describe the rise and fall of the hydrographs being routed but not small to take
forever to compute.
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For this exercise set the Computational Interval at 5 minutes (from the drop down list). Set
the Hydrograph Output Interval to /5 minutes and the Detailed Output Interval also at /5

minutes.

The DSS Output filename is the file that contains all the calculated data in a format that can
be read by HEC-RAS and used in displaying all the results (tables and graphs). The default
will be ....\Exercise2.dss and does not have to be changed for this exercise.

The completed Unsteady Flow Analysis screen is shown in Figure 11.109.

. Unsteady Flow Analysis
File Options Help

)
X

Plan : [Base analysis + bridge Short ID |Blid98

Geometry File : IBase Geometry + bridge

=

Unsteady Flow File : |Base Unsteady Flow

Plan Description :

~

Programs to Run

[V Geometry Preprocessor
IV Unsteady Flow Simulation
[V Post Processor

Simulation Time Window

Starting Date: [oranzm3 | Starting Time: 0000

Ending D ate: |01JAN2013 Eal Ending Time: |0600

Computation Settings

o

Computation Interval: |5Minute vl Hydrograph Output Interval: |15 Minute vl

[~ Computation Level Output Detailed Output Interval: |15 Minute + |

DSS Output Filename: IC:\SANFIAL\E xercise 2\Exercise2.dss
[~ Mixed Flow Regime (see menu: "Options/Mixed Flow Options ...")

=

Compute

Figure 11.109: Unsteady Flow Analysis (completed)

e (Click on the Compute button to run the Unsteady Flow Analysis.
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VIEWING THE RESULTS

Once the model has finished all of the computations successfully, you can begin viewing the
results. Several output options area available from the View menu bar on the HEC-RAS main
window. These options include:

a) Cross section plots

b) Profile plots

¢) General profile plot

d) Rating curves

e) X-Y-Z perspective plots

f) Detailed tabular output at a specific cross section (cross section table)

g) Limited tabular output at many cross sections (profile table)

e Begin by plotting a cross section. Select Cross Sections from the View menu bar on the
HEC-RAS main window. Any cross section can be plotted by selecting the appropriate river,
reach and river station (See Figure 11.110). Several plotting features are available from the
Options menu bar on the cross section plot window. These options include: zoom in; zoom
out; selecting which plans, profiles, variables to plot; and control over lines, labels, symbols,
scaling etc.

r

=~ Cross Section o | @ |3
File Options Help
River |Riet river | »le] | + 0| Reload Data
Reach: |Lower reach ~| RiverSta: [52 _BRU ~[¥] 1|
Bridge and weir Plan: Base analysis + bridge B
Stephnie bridge
035 kS 025 sh— 035 —]
23: Legend
EG Max WS
L WS Max WS
261 Crit Max WS
=i dnd
Ground
Ineff
1 *
-~ 241 Bank Sta
E 4
c
S
®
2
o 2
201
18 T " T T T T T )
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Station (m) J
| L]

Figure 11.110: Cross section view (Riet River: Lower reach — River station 52 (upstream of

bridge)

e Next plot a water surface profile. Select Water Surface Profiles from the View menu bar.
Click on the Play button, Ll, to view the Animation Control window (see Figure 11.111).
Click on the Expand button, Q, to see the entire control.
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Figure 11.111: Animation Control

e Set the Zero Delay horizontal scroll bar as indicated (in Figure 11.111) and click on the play

button, LI, to view the changing water surface levels and energy grade lines of the river reach
profile plot. This should give you a profile plot as shown in Figure 11.112 for the maximum
water surface.

File Options Help
~ Reaches .. | 8| %] Profiles ... IQ I™ PlotInitial Conditions  Reload Data
Bridge and weir Plan: Base analysis + bridge j
ke Riet river Lower reach %
24 - - - ¢ - . -~ "
Legend
"EG Max WS
WS Max WS
| crt maxws
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Ground
E
3
3
w
=4 20 40 60 80 100 120 140 160
Main Channel Distance (m) 3
| L[ L .

Figure 11.112: Water Surface Profile (for Riet River: Lower reach- Maximum WS)

e Also have a look at a General Profile Plot and the X-Y-Z Perspective Plot (Figure 11.113).
Also look at some tabular output. Go to the View menu bar on the HEC-RAS main window.
There are two types of tables available, a detailed output table and a profile summary table.
Select Detailed Output Tables to get the first table to appear. This table shows detailed
hydraulic information at the bridge. Other cross sections can be viewed by selecting the
appropriate reach and river from the table. A table with all the errors, warnings and comments
can also be viewed, by selecting Summary, Err Warn, Notes... from the View menu on the
HEC-RAS main window.
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Figure 11.113: X-Y-Z Perspective plot (Riet river: Lower reach, selected stations)

You will now be in a position to answer some more of the questions at the end of this
exercise (Questions 6 to 10).

ADDING AN INLINE STRUCTURE (WEIR)

In the next section an inline weir will be added in the Blesbok River — Lower reach.

Entering weir data

e To enter inline weir data click on the Inline structure button on the Geometric data window
(Figure 11.58). Once the Inline structure button is pressed, the Inline structure Data Editor
will appear as shown in Figure 11.114.

To add the inline weir in the model, take the following steps:

e Select the river and reach that you would like to place the weir in (from the drop down lists)
i.e. Blesbok River and Lower reach.

e From the Options menu, select Add an Inline structure from the list. An input box will
appear prompting you to enter a river station identifier for the inline structure.
Enter 6.5 as shown in Figure 11.115.
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File View Options Help
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Upstieam X5: Upstream channel length: (not set) (m)
Description = EJ
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Embakment
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W
No Data for Plot
Select the river for inline structure editing

)

Figure 11.114: Inline weir Data window

HEC-RAS

Enter a new river station for the new
inline structure in reach “"Lower
[CE

Cancel |

Figure 11.115: Inline weir river station (Blesbok River:

Lower reach)

Enter the Description of the inline structure: Maya weir (see Figure 11.116).

Enter all of the required data for the new bridge. This includes:
a. Weir/Embankment details
b. Gate detail

From the Inline Structure Data editor select the Weir/Embankment icon to activate the
Inline Structure Weir Station Elevation Editor as shown in Figure 11.117.
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Figure 11.116: View of the cross section at the weir (RS 6.5)
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Figure 11.117: Inline weir (Inline Structure Weir Station Elevation Editor)

e The first input at the top of the editor is the distance from the upstream cross section and the

deck (i.e. river station 7). This distance is /0 m.
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e The deck itself will have a width of 5 m.

o The weir flow coefficient selected for this analysis is 7,44.

in Figure 11.117 to provide the weir as shown in Figure 11.118.

At every station position enter station and elevation of the top of the weir embankment shown

The US and DS Embankment SS (upstream and downstream embankment side slope) values

should be entered as / (1 horizontal to 1 vertical). These values are used for the graphical

representation on the profile plot.

The last field at the bottom of the editor is the selection of the Weir Crest Shape. This
selection will determine the reduction of the weir flow coefficient due to submergence. For

this exercise, a Broad Crested weir shape should be selected.

e (Click the OK button.

w’ Inline Structure Data - Base Geometry + bridge
File View Options Help

=3 EoR =<

River. |Blesbok river | | + ﬂl
Reach: |Lower reach Ll River Sta.: |B,5 j ﬂ ﬂ
Upstream X5: 7—] Upstream channel length: 26.8 (m)
Description ~ [Maya weid = m
Pilot Flow ID.US Breach (plan data) ... | Rules [unsteady data) ... |
Wei ; ; 7
Embasment Bridge and weir Plan: J
Gate 2673
Legend
- Lo
W Ground
5 *
T 24 Bank Sta
- 237
T 2]
2
=
201
19 - : - - - - . -
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Station (m) .
| . |—|

Edit inline structure description

Figure 11.118: Inline weir (Viewing the weir)

o Enter the Pilot flow of 50 /s i.e. 0,05 m?/s (Pilot discharge for leakage or to keep the

downstream channel wet at low flows) (see Figure 11.118).
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Gated Spillway Data

In addition to uncontrolled overflow weirs, the user can add gated spillways (this is optional).
To add gated spillways to the structure, press the Gate button on the Inline Structure Data
editor. Once this button is pressed, the gated editor will appear as shown in Figure 11.119
(except yours will be blank until you have entered some data).

Inline Gate Editor

Gate Group:  |Gate #1 LI ﬂ ﬂ g :‘_Q il

Gate type (or methodology): ISIuice Ll
Geometric Properties Gate Flow

Height T 5|UI(?B Géle Flow - -
Width: F Sluice Discharge Coefficient (0.5-0.7): | :

Invert: | 20
# Openings: |1

Station - Submerged Orifice Flow
—12 16.25 L Orifice Coefficient (typically 0.8): IU.B
E Head Reference: | Sill (Inwvert) ﬂ
—; Weir Flow Over Gate Sill (gate out of water)
E Weir Shape: I Broad Crested LI
7
_8
9| Weir Coefficient: | 1.67
10]
1]
12 |

Cancel Help

Figure 11.119: Gated Spillway Editor

The Gated Spillway editor is similar to the Culvert editor in concept. The user enters the
physical description of the gates, as well as the required coefficients, in the Gated Spillway
editor. The functionality of the gates is defined as part of the Unsteady Flow data. The
following is a list of the data contained on this editor:

¢ Gate Group - The Gate Group is automatically assigned to "Gate #1" the first time you open
the editor. The user can enter up to 10 different Gate Groups at each particular river crossing,
and each gate group can have up to 25 identical gate openings. If all of the gate openings are
exactly the same, then only one gate group needs to be entered. If the user has gate openings
that are different in shape, size, elevation, or have different coefficients, then additional Gate
Groups must be added for each Gate type.

e Height - This field is used to enter the maximum possible height that the gate can be opened
in meters (Enter 7,2 m).

e Width - This field is used for entering the width of the gate in meters (Enter /7,2 m).
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Invert - This field is used for entering the elevation of the gate invert (sill elevation of the
spillway inside of the gate) in meters. (Enter 20 m).

Gate Type - This field is used for selecting the type of gate. A number of different gate types
are available. Select from the drop down list Sluice.

Sluice Discharge Coefficient - This field is used for entering the coefficient of discharge for
the gate opening. This coefficient ranges from 0,5 to 0,7 for sluice gates. For this sluice gate
enter 0,6.

Orifice Coefficient - This field is used to enter an orifice coefficient, which will be used for
the gate opening when the gate becomes more than 80 percent submerged. Between 67 percent
and 80 percent submerged, the program uses a transition between the fully submerged orifice
equation and the free flow equations. When the flow is less than 67 percent submerged, the
program uses the free flow gate equations. Enter an Orifice Coefficient of 0,5.

Head Reference — This field is used to select the reference point for which the upstream
energy head will be computed from. The default is the gate sill (invert), which is normally
used when the flow through the gate goes out into a channel. If the gate causes the flow to jet
out freely into the atmosphere, then the head reference should be selected as the centerline
elevation of the gate opening. If the gate crest is an ogee spillway crest, then the center of the
gate opening should be used. Ogee spillway crests are normally designed to follow the shape
of water jetting freely into the atmosphere. For this exercise select from the drop down list Si//
(invert).

Weir Shape - This parameter allows the user to select between a Broad Crested, Sharp
Crested shape weir and an Ogee shaped weir. Select Broad Crested.

Weir Coefficient - This field is used for entering a weir coefficient that will be used for the
gate opening. This coefficient will only be used when the gate is opened to an elevation
higher than the upstream water surface elevation. When this occurs, the flow through the gate
1s calculated as weir flow. Enter the Weir Coefficient of 1,67.

Centerline Stations - This table is used for entering the centerline stationing of the identical
gate openings. The user should enter a different centerline stationing for each gate opening
that is part of the current gate group. All gate openings within the same gate group are exactly
identical in every way, except their centerline stationing. As a user adds new centerline
stationing values, the number of identical gates in the group is automatically incremented and
displayed in the field labelled "# Openings". Enter the Centerline Station as /6,25 m.

Once all of the data for the gates has been entered (as shown in Figure 11.119), the user needs
to press the OK button for the data to be accepted. If the user presses the OK button, this does
not mean that the data is saved to the hard disk; it is only stored in memory and accepted as
being good data. This data is part of the geometry data, and is stored in the geometric data file.
The data can be stored to the hard disk by selecting from the File menu of the Geometric
Data window Save Geometry Data As.

After selecting this option you will be prompted to enter a Title for the geometric data (Figure
11.120). Enter “Base Geometry + bridge + weir” for this exercise, and then press the OK
button. A file name is automatically assigned to the geometry data based on what you entered
for the project file name i.e. Exercise2.g03.
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. Save Geometry Data As

= Exercise 2

Title File Name Selected Folder Default Project Folder I Documents
IBase Geometry + bridge + weir Exercise2. g C:ASAMRAL\E xercise 2

Base Geometry Exercise2 g01 A

Base Geometry + bridge Exercise2 g02 4 SANRAL

0K Cancel | Hep |  CreateFolder... | [S e [Createk2012)

[Select drive and path and enter new Title.

Figure 11.120: Save Geometry Data As

w Inline Structure Data - Base Geometry + bridge + weir
File View Options Help

River - bopDta | + ]
Reach: |Lower reach L, River Sla.:]ﬁﬁ ;I ﬂﬂ

Upstream XS: 7 | Upstream channel length: 26.8 (m)
Description  |Maya weir - [;I
Pilot Flow 0.05 Breach (plan data) ... | Rules (unsteady data)... |
‘Weir / . . a
Enbamkment Bridge and weir Plan: &}
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[Select the fiver for inline structure editing
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Figure 11.121: Inline weir (Viewing the weir + gate)

o The newly added weir will be shown on the Geometric Data editor window as shown in

Figure 11.122.
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Figure 11.122: Layout of river system (Bridge + weir)

Entering the gate opening characteristics

Once all of the geometric data are entered, the modeller can then enter the unsteady flow data that
is required for the gate. To bring up the unsteady flow data editor, select Unsteady Flow Data
from the Edit menu on the HEC-RAS main window or clicking the short cut button on the menu
bar al. The Unsteady Flow data editor should appear as shown in Figure 11.123, for this

exercise.
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File Options Help

Boundary Conditions | Initial Conditions |

Boundary Condition Types

Stage Hydrograph Flow Hydrograph | Stage/Flow Hydr

Apply Data

Normal Depth Lateral Inflow Hydr | Uniform Lateral Inflow

| Rating Curve J
|

| Groundwater Interflow

Elev Controlled Gates | Navigation Dams

| IB Stage

|
|
T.5. Gate Openings |
Rules |

Add Boundary Condition Location

AddRS ... I Add Storage Area | Add S& Connection

|
a5

Add Pump Station |

Select Location in table then select Boundary Condition Type

River Reach RS Boundary Condition
1| Blesbok river Lower reach 8 Flow Hydrograph
2| Blesbok river | Lower reach 65 IS ) 1
3| Riet river Upper reach 100 Flow Hydrograph
4| Riet river Lower reach 40 Normal Depth

Figure 11.123: Unsteady Flow Data Editor

The boundary conditions at all the external boundaries of the system have already been entered.

The internal control at the weir will now also be entered.

e [fthe River station 6.5 IS is not in the list of Boundary Conditions click on the Add RS button

and add this internal boundary.

e Click in the Boundary Condition column next to the River station 6.5 IS. HEC-RAS allows
the user to select the type of boundary required from the available buttons: T.S. Gate Opening,

Elev Controlled Gates, Navigation Dams or Rules.

o For this exercise the gates will be controlled, opening and closing by means of the water
surface elevation. With the Boundary Condition Type block highlighted click on the Elev
Controlled Gates button. This will show the Elevation Controlled Gates data editor as

shown in Figure 11.124.
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Elevation Controlled Gates

River: Blesbok river Reach: Lower reach RS: 6.5

Gate Group: IGate #1 - I ﬂ ﬂ

Reference: Based on upstream WS -

Upstream WS Elevation Reference
Upstream WS elevation at which gate begins to open:

Upstream WS elevation at which gate begins to close:
Gate Opening R ate: (m/min):

Gate Closing Rate:(m/min):

Maximum Gate Opening:

Minimum Gate Opening:

Initial Gate Opening:

=l
—
-
.
-
B
,

oK I

Figure 11.124: Elevation Controlled Gates data editor

This option allows the user to control the opening and closing of gates based on the elevation
of the water surface upstream of the structure. A gate begins to open when a user specified
elevation is exceeded in this case 23,5 m (see Figure 11.125). The gate will begin to close
again when the water surface elevation reaches 22,5 m.

The gate opens at a rate specified by the user (0, m/min).
The closing of the gate is at a user specified rate (also 0,/ m/min.).

The user must also enter a maximum and minimum gate opening. For this exercise the
Maximum Gate Opening is set at /,/ m and the Minimum Gate Opening is set at 0 m.

The Initial gate opening is closed and thus this value must be entered as (. Figure 11.125
shows the completed data for this gate.

Elevation Controlled Gates

River: Blesbok river Reach: Lower reach RS: 6.5

Gate Group: Gate #1 _vJ ﬂ J

Reference: Based on upstream WS v

Upstream ‘WS Elevation Reference
Upstream WS elevation at which gate begins to open:  |23.5

Upstream WS elevation at which gate begins to close:  |22.8
Gate Opening Rate:(m/min):
Gate Closing Rate:(m/min):
Maximum Gate Opening:
Minimum Gate Opening:
Initial Gate Opening:
Cancel

T

Figure 11.125: Elevation Controlled Gates data editor
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Saving the Unsteady Flow Data

o The last step in developing the unsteady flow data is to save the information to a file. To save
the data, select the Save Unsteady Flow Data As from the File menu on the Unsteady Flow
Data editor. A pop-up window will appear prompting you to enter a title for the data as shown
in Figure 11.126. Enter “Base Unsteady Flow + gates” for this exercise, and then press the
OK button. A file name is automatically assigned to the Unsteady Flow Data based on what
you entered for the project file name i.e. Exercise2.u02.

Save Unsteady Flow Data As
Title File Name Selected Folder  Default Project Folder Documents
[Base Unsteady Flow + gates Exercise2 u* C:ASANRALME xercise 2
Base Unsteady Flow Exercise2.u01 ACA
Y SANRAL
= Exercise 2
0K Cancel | Hep |  CieateFoider... | [S e [Createk2012) |

[Select diive and path and enter new Title.

Figure 11.126: Saving Unsteady Flow Data

The completed Unsteady Flow Data screen should now include the additional boundary at the
inline structure (RS 6.5) as shown in Figure 11.127.

File Options Help

A Unsteady Flow Data - Base Unsteady Flow + gates

Boundary Conditions ] Initial Conditions |

Boundary Condition Types

|

T.S. Gate Openings

Elev Controlled Gates |

Navigation Dams |

Rules

|
|

AddRS ..

Add Boundary Condition Location

Select Location in table then select Boundary Condition Type

River Reach RS Boundary Condition
1| Blesbok river Lower reach 8 Flow Hydrograph
2| Blesbok river Lower reach 65 IS IE!ev Controlled Gates ’
3| Riet river Upper reach 100 Flow Hydrograph
4| Riet river Lower reach 40 Normal Depth

Figure 11.127: Unsteady Flow Data

o Initial conditions. There is no need to add any initial flow conditions at the new internal
control since the flow entered at River station 8 will also flow over the weir at the start of the

analysis.

11-234

Free surface flow determination



UNSTEADY FLOW ANALYSIS WITH INLINE STRUCTURE AND BRIDGE

Performing Unsteady Flow Calculations with the Inline Structure and the Bridge

Once all of the geometry and unsteady flow data have been entered, the user can begin
performing the unsteady flow calculations. To run the simulation, go to the HEC-RAS main
window and select Unsteady Flow Analysis from the Run menu or click on the Unsteady

Flow Analysis button on the menu bar. The Unsteady Flow Analysis window will
appear as shown in Figure 11.128.

A Unsteady Flow Analysis =25
File Options Help

Plan: | ShotID |

Geometry File : | Base Geometry LI
Unsteady Flow File : IB‘ase Unsteady Flow z

Plan Description :
Programs to Run D

[v Geomety Preprocessor
[V Unsteady Flow Simulation
IV Post Processor

Simulation Time Window

Starting Date: _] Starting Time: |
Ending Date: . Ending Time: |

Computation Settings

Computation Interval: |1 Hour 'rl Hydrograph Output Interval: |1 Hour v|

[~ Computation Level Output Detailed Output Interval: |1 Hour vl
DSS Output Filename: [C.’\SAN RAL\E xercise 2\Exercise2.dss EI

[~ Mixed Flow Regime (see menu: "Options/Mixed Flow Options ..."")

L Lompute

Figure 11.128: Unsteady Flow Analysis

o The first step is to put together a new Plan. The Plan defines which geometry and flow data
are to be used, as well as providing a title and short identifier for the run.

To establish a plan, select New Plan from the File menu on the Unsteady Flow Analysis
window. Enter the plan title as Base analysis + bridge + weir and then press the OK button
(Figure 11.129).
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New Plan Data

Title File Name Selected Folder Default Project Folder Documents
[Base analysis + bridge + weil |E:~ ercisel.p CASANRAL\Exercise 2

Base analusis Exercise2 p01 - |90

Bage analysis + bridge Exercise2 p02 (A SANRAL

DK Cancel | Help | Create Folder ... ] | = c: [Createk2012) LJ
|Select drive and path and enter new Title.

Figure 11.129: Creating new plan

You will be prompted to enter a short identifier. Enter a title of Base+b-+w in the Short ID
box and click on the OK button.

o Select the correct Geometry file and Unsteady flow file from the drop down list i.e. Base
Geometry + bridge + weir and Base Unsteady Flow + gates respectively.

e Selecting Programs to Run
There are three components used in performing an unsteady flow analysis within HEC-RAS.
These components are: a geometric data pre-processor; the unsteady flow simulator; and an
output post-processor (see Figure 11.128).

¢ Simulation time window
The user is required to enter a time window that defines the start and end of the simulation
period. The time window requires a starting date and time and an ending date and time.

In this exercise the flow hydrograph shown in Figure 11.73 and Figure 11.75 starts at 0:00
and has data until 06:00 and this is used in the simulation time window. The date can be
anything since the option to Use Simulation Time on the Flow Hydrograph window was
selected (see Figures 18 and 20). Enter the Starting date as 0/JAN2013 and the Ending date
as 01JAN2013. Enter the Starting time as 0000 and the Ending time as 0600.

e Computational settings
The computational Settings area contains the Computational Interval, Hydrograph Output
Interval, Detailed Output Interval, the name and path of the output DSS file, and whether or
not the program is run in a mixed flow regime. The computation interval is probably one of
the most important parameters entered into the model. This should be small enough to
accurately describe the rise and fall of the hydrographs being routed but not small to take
forever to compute.

In this exercise the newly added gates close within 1 minute and thus a smaller
Computational Interval of / minute (from the drop down list) should be selected. Set the
Hydrograph Output Interval to / minute and the Detailed Output Interval also at / minute.

The DSS Output filename is the file that contains all the calculated data in a format that can
be read by HEC-RAS and used in displaying all the results (tables and graphs). The default
will be ....\Exercise2.dss and does not have to be changed for this exercise.

o Also select the Mixed Flow Regime option since mixed flow might occur at the flow over the
weir. The completed Unsteady Flow Analysis screen is shown in Figure 11.130.
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. Unsteady Flow Analysis -]
File Options Help
Plan : |Base analysis + bridge + weir Short ID |Base+b+w
Geometry File : IBase Geometry + bridge + weir LI

Unsteady Flow File : |Base Unsteady Flow + gates LI

Plan Description :
Programs to Run D
[V Geometry Preprocessor
IV Unsteady Flow Simulation
[V Post Processor

Simulation Time Window

Starting Date: [01JAN2013 _, Starting Time: [0000
Ending Date: [o10an2013 [E2 Ending Time: |0600

Computation Settings

Computation Interval: | 1 Minute | Hydrograph Output Interval: | 1 Minute « I
[~ Computation Level Output Detailed Output Interval: |1 Minute vl
DSS Output Filename: IC;\SAN RAL\Exercise 2\Exercise2 dss E’

v Mixed Flow Regime [see menu: "Options/Mixed Flow Options ..."")

Compute |

Figure 11.130: Unsteady Flow Analysis (completed)
Click on the Compute button to run the Unsteady Flow Analysis.

VIEWING THE RESULTS

Once the model has finished all of the computations successfully, you can begin viewing the
results. Several output options are available from the View menu bar on the HEC-RAS main
window. These options include:

a) Cross section plots

b) Profile plots

¢) General profile plot

d) Rating curves

e) X-Y-Z perspective plots

f) Detailed tabular output at a specific cross section (cross section table)
g) Limited tabular output at many cross sections (profile table)

e Begin by plotting a cross section. Select Cross Sections from the View menu bar on the HEC-
RAS main window. Any cross section can be plotted by selecting the appropriate river, reach
and river station (See Figure 11.131 and Figure 11.132). Several plotting features are
available from the Options menu bar on the cross section plot window. These options include:
zoom in; zoom out; selecting which plans, profiles, variables to plot; and control over lines,
labels, symbols, scaling etc.
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Figure 11.131: Cross section view (Blesbok river: Lower reach — River station 6.5 (Inline
structure) at maximum water surface (gates open)
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Figure 11.132: Cross section view (Blesbok river: Lower reach — River station 6.5 (Inline

structure) at time step when gates just closed completely

e Next plot a water surface profile. Select Water Surface Profiles from the View menu bar.
Click on the Play button, Ll, to view the Animation Control window (see Figure 11.133).

Click on the Expand button,

, to see the entire control.
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Figure 11.133: Animation Control

e Set the Zero Delay horizontal scroll bar as indicated (in Figure 11.133) and click on the play

button, LI, to view the changing water surface levels and energy grade lines of the river reach
profile plot. This should give you a profile plot as shown in Figure 11.134 for the maximum

water surface.

- Reaches ... Ill‘il Profiles ... |ﬂ@ [ PlotInitial Conditions  Reload Data

Bridge and weir Plan: Base analysis + bridge + weir I B

Elevation (m)

Main Channel Distance (m) =

4

Figure 11.134: Water Surface Profile (for Blesbok river: Lower reach- Maximum Water surface
and gate open)

e Also have a look at the tabular output at the inline structure (RS 6.5). Go to the View menu
bar on the HEC-RAS main window and select Detailed Output Tables. From the Type menu
select Inline structures. This table shows detailed hydraulic information at the inline
structure. Other cross sections or structures can be viewed by selecting the appropriate reach
and river from the table and select the type of data to view.
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' Inline Structure Output
File Type Options Help

River. |Blesbok river

=] Profie: [T - |

E=S[I=R ")

[Gate Group: Gate #1

Reach [Lower reach ~| ms: 65 ~| 8t Plan:  [Basesbew ~]
Plan: Base+b+w Blesbok river Lowerreach RS: 6.5 Gate Group: Gate #1 Profile: Max WS

E.G. Elev (m) 23.92 | Q Gates [m3/s) 417
‘W.S. Elev (m) 23.82 | Q Gate Group [m3/s) 417
Q Total (m3/s) 31.00 | Gate Open Ht (m) 1.10
Q Weir (m3/s) 26.83 | Gate #0pen 1
‘Weir Flow Area (m2] 14.70 | Gate Area (m2) 1.32
‘Weir Sta Lft (m] 10.89 | Gate Submerg 0.80
‘Weir Sta Rat [m) 2213 | Gate Invert [m) 20,00
‘Weir Max Depth [m) 1.93 | Gate Weir Coef
‘Weir &vg Depth (m) 1.3
‘Weir Coef [m™1/2) 1.441 | Q Breach (m3/s)
Weir Submerg 0.52 | Breach Avg Velocity (m/s)
Min E|'Weir Flow (m) 22.00 | Breach Flow Area [m2)
‘Wi Top Wdth [m) 11.23

amings and Notes

|
iSeIecl Profile

Figure 11.135: Detailed Tabular Output (Blesbok river: Lower reach, Inline structure)

At the end of this exercise the following objectives should have been met:

e Be able to a river system containing more than one river reach

e  Know how to enter unsteady flow data and defining and entering the boundary controls

e Be able to analyse the river system (unsteady flow)

e  Know how to define a bridge structure and a weir

e  Know how to set the boundaries for unsteady flow with opening and closing gates

e  Know how to obtain results from an unsteady flow analysis

Questions

1. Define the flow type in the river.

2. Does the flow at any of the cross section flow onto the banks of the river system?

3. At what time does the maximum flow at cross section 40 occur and what is the peak flow?
What is the normal flow depth during this peak flow?
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10.

11.

12.

13.

What will be the effect on the obtained water level at cross section 3 during maximum flow, if
the Junction was analysed using Momentum instead of energy with the Blesbok river joining
at an angle of 45°.

Describe the reason for the differences in the Rating curves (Flow rate versus Water Surface
Elevation) for cross section 40 and cross section 100.

What effect does the bridge have on the maximum water surface level at cross section 70?
What is the maximum damming upstream of the bridge?

Is the bridge function as a control?

What will happen if the flow hydrographs of the Upper reach of the Riet river is increased
with 100%?

What increase in flow velocity is experienced due to the bridge compared to the before
scenario?

What is the maximum flow through the gate at the inline structure and at what time step does

this occur?

What effect does the added inline structure have on the flow conditions at the bridge (flow
depth, velocity etc.)?

What will be the effect if the Computational Interval, Hydrograph Output Interval and
Detailed Output Interval are also set to 15 minutes and the rate of opening and closing of the
gates are set to 1,2 m/min.
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12 SUB-SURFACE DRAINAGE

12.1 Example 12.1 - Herringbone drainage system

Problem description Example 12.1:

Calculate the maximum infiltration rate (mm/day), which may be discharged wvia the depicted sub-
surface herringbone system to a main drainage pipe. The diameter of the central pipe is 150 mm and
its slope 1:500. The diameter of the laterals is 100 mm and their slopes 1: 100. The Manning n-value

for the pipes is 0,011s/m">. Figure 12.1 reflects the layout.

1:500

150mm

S

105m

Figure 12.1: Layout of the herringbone drainage system

Solution Example 12.1:

For each lateral, flowing 70% full:

_ (2692x10°)a% 5, J0.7)

nA

A =S (L+§) Refer to Figure 12.2

L = 152415 =212Im

S

L

== 10,61m (Valid in this example since laterals are placed at 45° and dimensions

are equal 15 mx 15 m)

= 10,61((21,21)+10é61j

= 281,3m?

_ (2692x10°)(0,1* 0,01 ) 0,7)

(0,011)(281,3)

=1312 mm/day
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>y lateral
—1
/‘1
/\s
\
/} a
- “a 92 \
- y

Lateral
Slope S,

Plan of lateral

Area drained

Figure 12.2: General view of a herringbone drainage system

Flow rate, Q, for 14 laterals:

Q =(1,312)(281,3)(14)
Q = 5167 m*/day
Hence Q =~ 0,06 m®/s

Capacity of main pipe: (Manning Formula)

2/3 12
% (0’152)(02:5) (5(1)0)
Q =

0,011

Q=10,00805 m?*/s
But this << 0,06 m3/s !
Q = 695 m*/day

695

A = (081,3)14)

qmax = 177 mm/day (<< 1312 mm/day)

12-243

Sub-surface drainage



APPENDICES

A-244 Appendices



APPENDIX 3A
STATISTICAL ANALYSIS
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Single station direct statistical analysis

The following frequency distributions are discussed for untransformed and log;o-transformed data:
e Untransformed data
Normal, Extreme Value Type 1 and General Extreme Value
e Log-transformed data
Log-Normal, Log-Gumbel and Log-Pearson Type 111

Step 1: Determine the mean, standard deviation and skewness coefficient of the raw data and the log;
transformed data as follows:

Mean ;:2 ...(3A.1)
N
,5

Standard deviation ...(3A.2)

Skewness coefficient

S_[z(xxf °
N-1
- [(N —1;(11\1 _Z)J[Z(X - X)SJ ...GA3)

Coefficient of variation Cy == ...(3A4)
X
where:
X = observed value (or of the logarithm of the observed value for the log
distributions)
X = mean of observed values (or of the logarithm of the observed value for the

log distributions)

N = the total number of observations

] = the standard deviation of the observed values (or of the logarithm of the
observed values)

g = skewness coefficient

cy = coefficient of variation

Step 2: The peak value for the desired return period and assumed distribution function can be derived
for each of the frequency distributions as follows:

e Normal distribution

The normal distribution is applicable where the observed values represent the effects of a large
number of independent processes. The distribution is symmetrical about the mean and is
therefore only suitable for data where the skewness coefficient (g) is equal to, or close to zero.
The spread about the mean is a function of the coefficient of variation. For high coefficient of
variation values, the bottom tail may extend below zero and may result in negative flows
being generated when the distribution is applied to untransformed data.

The standarized normal distribution has a cumulative distribution function:

) 1 2
G(y)= j P ...(3A.5)
N2z
where y is the standarized variable and is related to x by:

p=X X ..GA6)
S
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The value of y for a given value of G(y) cannot be solved directly from Equation 3A.4, and
hence published tables have to be used. Based on the return period, read from Table 3A.1b
the value of G(y) and obtain y from Table 3A.1a.

Q =x +sy ...(3A.7)
Extreme Value Type 1 (EV1/MM) distribution

From Table 3A.4 (g = 1,14) read the value of Wy for the required return period. Calculate Qr
directly using:

Q, =x +5(0,780W, —0,450) ...(3A.8)

General Extreme Value (GEV/MM) distribution

For the known value of the skewness coefficient (g) read off the value Wt from Table 3A.4
and the values of k, E(y) and var(y) from Table 3A.2 by using linear interpolation.

For EV2 distribution:

S2

(1-E(y)— kW, ) ...GA.9)

QT=;+

For EV3 distribution:
2

Q;=x+

(-1-E(y)+ kW, ) ...(3A.10)
var(y)

Log-normal (LN/MM) distribution

For this distribution, the logarithms of the data are assumed to be normally distributed. Based
on the skewness coefficient (g), obtain the value Wt for the required return period from
Table 3A.3.

Qp = antilog[log(x) + Sjg WT] ...(3A.11)

where:
Slog = the standard deviation of the logarithms of the observed values as shown in
equation 3A.11

3 (log(x) - logfx)” | ..(3A.12)

log N-1
and
logi x) = the logarithm of the mean of the observed values
Confidence bands

The confidence, with which the values of the magnitude-return period relationships are
estimated, depends on the number of observations contained in the data set. The greater the
number of observations, the greater the degree of assurance, and subsequently the narrower
the confidence band.

A-247

Appendices



The displacement of the two-sided 95% confidence band about the estimated value can be
read from Table 3A.3 where N is the number of observations. The 95% confidence limits are:

Qs = antilog[log(x) + Sjg (WT W, )] ...(3A.13)
where:
W, = displacement of the confidence band (column 5 in Table 3A.3)

e Log-Gumbel (Log-Extreme Value Type 1) (LEV1/MM) distribution

From Table 3A.4 (g = 1,14) read the value of Wy for the required return period. Calculate Qr
directly using:

Q, =antilogllog(x) + .., (0.780W, —0.450)] .(3A.14)

e Log-Pearson Type III (LP3/MM) distribution

From Table 3A.3 determine the value of Wr for the known skewness coefficient (g) of the
log-transformed data by linear interpolation.

Q, = antilog[log(x) + 81 WT] ...(3A.15)

Based on an example from Flood Risk Reduction Measures by WJR Alexander the incorporation of
the influence of historical information, missing data and outliers is required to determine the

confidence of the results. It is thus required to calculate the historically weighted mean (X1 ), standard

deviation (S, ) and skewness coefficient (g, ).

- _((WT)Zx, +Xx,)

= T e ...3A.16)
[ ((wn)za: +xa?)

Sh__(YT W) 1)} ...BA.17)

(YT-(WT)LW))(WT)Zd} +Xd?)

3

g = ...(3A.18)
" (YT-(LW)YWT)- 1) YT —(WT)LW)-2)

where:

YT = total time span (= NA + NB + NC)

WT = weight applied to data= (YT —NA)/NB

NA = floods equal to or above the high threshold

NB = floods between high and low thresholds

NC = missing data

LW = low outliers including zero flows

ZR = zero flows

and where: Xy = isthe value of a peak equal to or above the high threshold
Xp = is the value of a peak below the high threshold
d,anddy, = are deviations of X, + X, from Xn

All values being the logarithms of the data.
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These historically weighted values of the mean, standard deviation and the skewness coefficient are
then used in the equations for the LN/MM, LP3/MM, EV1I/MM and GEV/MM distribution in the

usual way @V

For a detailed description of the adjustment required when:

e Jlow outliers are removed from the data;

e gauged zero flows exist; or

e how to handle missing data;

see Flood Risk Reduction Measures by WIR Alexander.

Evaluating Example 3.2 for the Tsitsa River, utilizing Equations 3A.1 to 3A.15 (if the missing data is

not included in the statistical analysis) will provide the following results:

Table 3A.5a: Summary of parameters - Example 3.2

(missing data excluded)

Variable | Untransformed data | Transformed data
X 484,550 2,5463
YT 40 40
NC 0 0
S 390,677 0,366
g 1,344 -0,1462
Cy 0,8063 0,1437

Table 3A.5b: Summary of results — Example 3.2 (missing data excluded)

Return period | N'MM | EVI/MM | GEV/MM | LN/MM | LEV1I/MM | LP3/MM
2 485 421 414 352 307 358
5 813 766 758 714 645 719
10 985 994 991 1035 1057 1022
20 1127 1214 1221 1401 1696 1359
50 1287 1497 1527 1980 3126 1850
100 1394 1710 1764 2507 4953 2286

The next set of results is based on the historically weighted mean ()_(h), standard deviation (S, ) and

skewness coefficient (g, ) (Table 3A.6a and b) which incorporates the missing data.

Table 3A.6a: Summary of parameters - Example 3.2
(missing data included)

Variable | Untransformed data | Transformed data
;h 476,912 2,542
YT 53 53
NC 13 13
S, 378,305 0,362
g, 1,304 -0,157
Cy 0,793 0,142

Table 3A.6b: Summary of results - Example 3.2 (missing data included)
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Return period | N/MM | EVI/MM | GEV/MM | LN/MM | LEVI/MM | LP3/MM
2 477 416 418 348 304 355
5 795 749 726 702 635 706
10 962 971 934 1012 1034 999
20 1099 1183 1137 1367 1651 1323
50 1254 1457 1407 1924 3022 1790
100 1357 1664 1615 2429 4764 2202

Step 3: Graphical representation of historical data

where:

Arrange the observed data in descending order of magnitude and assign to each value a rank
number starting from one. Determine the plotting position (return period) for each value using
the Weibull formula. The general equation is given below and the values for the constants a
and b are provided in Table 3A.7.

T-n*a ... (3A.19)

= return period in years

length of record in years

number, in descending order, of the ranked annual peak floods
constant (see Table 3A.7)

= constant (see Table 3A.7)

oo g5 4
I

If the horizontal axis has a probability classification, the probability (P) is calculated as:

P= ... 3A.20)

1
T

Some of the commonly used plotting positions recommended for use in hydrological analyses
are given in Table 3A.7. If several distributions are plotted on a single graph, then the general
purpose Cunane plotting position should be used.

Table 3A.7: Commonly used plotting positions

Type Plotting position Distribution
Weibull (1939) a=1&b=0 Normal, Pearson 3
Blom (1958) a=0,25& b=0,375 | Normal
Gringorten (1963) a=0,12&b=0,44 | Exponential, EV]1 & GEV
Cunane (1978) average of a=02&b=04 General purpose
above two
Beard (1962) a=04&b=03 Pearson 3
Greenwood (1979) a=0&b=0,35 Wakeby, GEV

Plot the values against their estimated return periods on log-probability paper; draw the best
fitting straight line through the plotted points and extrapolate to determine the estimated
maximum value for the required return period. Alternatively utilize software such as Utility
Programs for Drainage or HEC-SSP included on the supporting flash drive.
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Table 3A.1: Properties of the standardized normal distribution

Table 3A.1a Table 3A.1b
Standardized normal distribution Standardized normal distribution
y G(y)% y G(y)% T G(y)% Wr
0,00 50,00 -0,00 50,00 1000 0,1 -3,09
0,05 51,99 0,05 48,01 500 0.2 2,88
0,10 53,98 0,10 46,02
0,15 55,96 0,15 44,04 200 0,5 -2,58
0,20 57,93 0,20 42,07 100 1,0 -2,33
0,25 59,87 0,25 40,13 50 2,0 -2,05
033 Pt 035 %62 20 5.0 1,64
.35 K -0,35 §
0,40 65,54 0,40 3446 10 10,0 -1,28
0,45 67,36 -0,45 32,64 5 20,0 -0,84
0,50 69,14 0,50 30,86 b 50,0 0,00
0,55 70,88 0,55 29,12
0,60 72,57 0,60 2743 5 80,0 0,84
0,65 74,22 0,65 25,78 10 90,0 1,28
0,70 75,81 0,70 24,19 20 95,0 1,64
0o e 00 215 50 98,0 2,05
0,85 80,24 0,85 19,76 100 99,0 2,33
0,90 81,59 -0,90 18,41 200 99,5 2,58
0,95 82,80 0,95 17,11 500 99,8 2,88
1,00 84,13 -1,00 15,87
1,05 85,31 -1,05 14,69 1000 99.9 3,09
1,10 86,43 -1,10 13,57 5000 99,98 3,55
115 87,49 -1,15 12,51 10000 99,99 3,72
1,20 88,49 -1,20 11,51
1,25 89,44 125 10,56
1,30 90,32 -1,30 9,68
1,35 91,15 1,35 8,85
1,40 91,26 -1,40 8,08
1,45 92,65 145 7,35
1,50 93,32 -1,50 6,68
1,55 93,94 -1,55 6,06
1,60 94,52 -1,60 5,48
1,65 95,05 -1,65 4,95
1,70 95,54 -1,70 4,46
1,75 95,99 -1,75 4,01
1,80 96,41 -1,80 3,59
1,85 96,78 -1,85 322
1,90 97,13 -1,90 2,87
1,95 97,44 -1,95 2,56
2,00 97,72 2,00 228
2,05 97,98 2,05 2,02
2,10 9821 2,10 1,79
2,15 98.43 2,15 1,57
2,20 98,61 2,20 1,39
2,25 98,78 225 1,22
2,30 98,93 2,30 1,07
235 99,06 235 0,94
2,40 99,18 2,40 0,82
2,45 99,29 2,45 0,71
2,50 99,38 2,50 0,62
2,55 99,46 2,55 0,54
2,60 99,53 2,60 0,47
2,65 99,60 2,65 0,40
2,70 99,65 2,70 0,35
2,75 99,70 2,75 0,30
2,80 99,74 2,80 0,26
2,85 99,78 2,85 0,22
2,90 99,81 2,90 0,19
2,95 99,84 2,95 0,16
3,00 99,86 -3,00 0,14
3,05 99,88 3,05 0,16
3,10 99,90 23,10 0,10
3,15 99,92 3,15 0,08
3,20 99,93 320 0,07
3,25 99,94 325 0,06
3,30 99,95 3,30 0,05
3,35 99,96 335 0,04
3,40 99,97 -3,40 0,03
3,45 99,97 345 0,03
3,50 99,98 3,50 0,02
3,55 99,98 3,55 0,02
3,60 99,98 3,60 0,02
3,65 99,99 3,65 0,01
3,70 99,99 3,70 0,01
3,75 99,99 3,75 0,01
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Table 3A.2: Parameters of the standardized general extreme value distribution

Standardized general extreme value distribution
g k E(y) var(y)
-2,000 1,406 1,247 3,204
-1,900 1,321 -1,182 2,505
-1,800 1,240 -1,127 1,984
-1,700 1,163 -1,080 1,590
-1,600 1,089 -1,041 1,287
-1,500 1,018 -1,008 1,052
-1,400 0,950 -0,980 0,868
-1,300 0,885 -0,957 0,721
-1,200 0,824 -0,938 0,602
-1,100 0,765 -0,922 0,507
-1,000 0,708 -0,910 0,428
-0,900 0,655 -0,901 0362
-0,800 0,604 -0,894 0,307
-0,700 0,555 -0,889 0,261
-0,600 0,509 -0,887 0,222
-0,500 0,465 -0,886 0,188
-0,400 0,424 -0,886 0,159
-0,300 0,384 -0,888 0,134
-0,200 0,346 -0,892 0,112
-0,100 0311 -0,896 0,094
0,000 0277 -0,901 0,077
0,100 0,245 -0,907 0,063
0,200 0215 0,914 0,050
0,300 0,187 -0,922 0,039
0,400 0,160 -0,930 0,030
0,500 0,134 -0,938 0,022
0,600 0,110 -0,947 0,016
0,700 0,088 -0,956 0,010
0,800 0,067 -0,966 0,006
0,900 0,047 -0,975 0,003
1,000 0,028 -0,985 0,001
1,100 0,010 -0,994 0,000
1,200 -0,006 1,004 0,000
1,300 -0,022 1,013 0,001
1,400 -0,037 1,023 0,002
1,500 -0,050 1,032 0,005
1,600 -0,063 1,041 0,008
1,700 -0,075 1,049 0,011
1,800 -0,086 1,058 0,016
1,900 -0,097 1,066 0,021
2,000 -0,107 1,074 0,026
2,100 -0,116 1,082 0,032
2,200 -0,125 1,089 0,038
2,300 -0,133 1,097 0,044
2,400 -0,140 1,104 0,051
2,500 -0,148 1,110 0,058
2,600 -0,154 1,116 0,065
2,700 -0,160 1,123 0,072
2,800 -0,166 1,128 0,080
2,900 -0,172 1,134 0,087
3,000 -0,177 1,139 0,094
3,100 -0,182 1,145 0,102
3,200 -0,187 1,150 0,110
3,300 -0,191 1,154 0,117
3,400 -0,195 1,159 0,125
3,500 -0,199 1,163 0,132
3,600 -0,203 1,168 0,140
3,700 -0,207 1,172 0,148
3,800 -0,210 1,176 0,155
3,900 -0,213 1,180 0,163
4,000 -0,217 1,183 0,170
4,100 -0,220 1,187 0,178
4,200 -0,223 1,191 0,186
4,300 -0,225 1,194 0,193
4,400 -0,228 1,197 0,201
4,500 -0,231 1,201 0,208
4,600 -0,233 1,204 0215
4,700 -0,236 1,207 0,223
4,800 -0,238 1,210 0,230
4,900 -0,240 1,213 0,237
5,000 -0,242 1215 0,244
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Table 3A.3b: Values of the standardized variate Wy for the Pearson Type III distribution

Table 3A.3a: Values of the standardized variate Wy for the normal and exponential

distributions
Return Non- Normal distribution Brpemeni]
period | exceedance W, Confidence limits W, distribution
(years) | probability 75% 95%
2 0,50 0,00 1,63/2N | 2,77/\2N 0,69
5 0,80 0,84 1,89/\2N | 3232N 1,61
10 0,90 1,28 2,20/V2N | 3,74/\2N 2,30
20 0,95 1,64 2,49/\2N | 425/\2N 3,00
50 0,98 2,05 2,87/\2N | 4,89/\2N 391
100 0,99 2,33 3,13/V2N | 5,34/42N 4,61
200 0,995 2,58 3,38/42N | 5,76/\2N 5,30
500 0,998 2,88 3,69/\2N | 6,27/\2N 6,21
1000 0,999 3,09 3,91/¥2N | 6,66/v2N 6,91
10000 0,9999 3,72 4,58/\2N | 7,80/v2N 9,21

Return Pearson Type III distribution (Values of Wr)
period g
(years) -1,0 -0,8 -0,6 -0,4 -0,2 0,0 0,2 0,4 0,6 0,8 1,0
2 0,16 0,13 0,10 0,07 0,03 0,00 -0,03 -0,70 -0,10 -0,13 0,16
5 0,85 0,87 0,86 0,86 0,85 0,84 0,83 0,82 0,80 0,78 0,76
10 1,13 1,17 1,20 1,23 1,26 1,28 1,30 1,32 1,33 1,34 1,34
20 1,32 1,39 1,46 1,52 1,59 1,64 1,70 1,75 1,80 1,84 1,88
50 1,49 1,61 1,72 1,83 1,94 2,05 2,16 2,26 2,36 2,45 2,54
100 1,59 1,73 1,88 2,03 2,18 2,33 2,47 2,62 2,76 2,89 3,02
200 1,66 1,84 2,02 2,20 2,39 2,58 2,76 2,95 3,13 3,31 3,49
500 2,88
1000 1,79 2,02 2,27 2,53 2,81 3,09 3,38 3,67 3,96 4,24 4,53
10000 1,88 2,18 2,53 2,90 3,30 3,72 4,15 4,60 5,05 5,50 5,96
Table 3A.4a: Values of the standardized variate Wy for the general extreme value distribution
(EV1 & EV2)
General extreme value (Values of W)
Return g
iod
perio 1,04 [ 12 | 14 | 16 | 1,8 | 20 | 25 | 30 | 35 | 40 | 45 | 50 | 55 | 60
(years)
EV1 EV2
2 037 | 037 037 | 037 | 037 | 0,37 | 0,38 | 0,38 | 0,38 | 0,38 | 0,38 | 0,38 | 0,38 | 0,38
5 1,50 | 1,51 1,55 1,58 1,60 1,63 1,68 1,72 1,75 1,77 1,79 1,80 1,82 1,83
10 2,25 | 2,28 | 235 2,43 2,49 2,55 2,67 2,76 2,84 2,90 2,94 2,98 3,01 3,04
20 297 | 3,01 | 3,15 3,28 3,40 3,50 3,73 3,91 4,05 4,16 425 4,33 4,39 445
50 3,90 | 3,97 | 422 | 445 | 466 | 486 | 528 | 562 | 589 | 6,12 | 6,30 | 6,46 | 659 | 6,70
100 460 | 4,71 | 5,05 5,38 5,68 5,97 6,59 7,10 7,52 7,86 8,15 8,39 8,59 8,77
200 5,30 | 5,44 | 5,90 6,34 6,76 7,16 8,04 8,77 9,38 9,89 | 10,31 | 10,67 | 10,97 | 11,24
500 6,21 | 6,41 | 7,05 7,68 8,29 8,87 | 10,19 | 11,32 | 12,26 | 13,06 | 13,74 | 14,32 | 14,81 | 15,24
1000 691 | 7,15 7,95 | 8,75 | 9,53 | 10,29 | 12,02 | 13,53 | 14,82 | 15,92 | 16,86 | 17,66 | 18,36 | 18,96
10000 9,21 | 9,64 | 11,13 | 12,68 | 14,25 | 15,82 | 19,65 | 23,19 | 26,34 | 29,13 | 31,58 | 33,73 | 35,63 | 37,31
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Table 3A.4b: Values of the standardized variate Wr for the general extreme value distribution

(EV3)
- General extreme value (Values of Wr)
eturn
gy eer;:S) 10 | 08 | -06 | -04 | -02 | 0,0 0,2 0,4 0,6 0,8 1,0
EV3
2 033 | 034 | 034 | 034 | 035 | 035 | 036 | 036 | 036 | 037
5 100 | 106 | 12 | 117 | 123 | 128 | 133 | 138 | 143 | 147
10 128 | 137 | 146 | 1,57 | 1,67 | 1,78 | 1,89 | 2,00 | 2,10 | 2,19
20 144 | 1,57 | 171 | 1,86 | 2,02 | 2,19 | 237 | 254 | 271 | 286
50 1,58 | 174 | 1,93 | 215 | 238 | 264 | 290 | 318 | 345 | 372
100 1,64 | 183 | 205 | 231 | 260 | 292 | 326 | 362 | 399 | 435
200 1,68 | 1,89 | 2,14 | 244 | 277 | 3,06 | 3,58 | 402 | 449 | 497
500 172 | 1,95 | 223 | 256 | 296 | 342 | 394 | 451 | 513 | 576
1000 1,74 | 198 | 227 | 264 | 3,07 | 359 | 419 | 48 | 558 | 635
10000 1,76 | 202 | 236 | 278 | 332 | 400 | 48 | 581 | 696 | 824
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Table 3B.1: Information required for the calculation of the SDF

Basin f{i‘:ﬁ SAWS site M R fz Cuo | MAP | MAE
number (mm) | (days) | (%) | (%) | (mm) | (mm)

1 546 204 Struan 56 30 10 40 550 1800
2 675125 Autoriteit 62 44 5 30 450 1900
3 760 324 Siloam 64 28 5 40 470 1700
4 553 351 Waterval 58 20 10 50 630 1600
5 680 059 Leydsdorp 78 10 15 70 620 1700
6 369 030 Siloam 51 54 15 60 670 1500
7 328 726 Olivine 49 39 15 60 510 1700
8 322 071 Danielskuil 47 39 5 20 380 2100
9 258 452 Jacobsdal 43 47 15 60 380 1800
10 233 049 Wonderboom 54 55 10 50 560 1600
11 236 521 Mashai 39 66 40 80 430 1400
12 143 258 Scheurfontein 39 52 5 30 290 2100
13 284361 | Wilgenhoutsdrif 40 55 5 15 70 2600
14 110 385 Middelpos 25 13 10 30 140 2400
15 157 874 Garies 22 11 5 20 130 2100
16 160 807 | Loeriesfontein 28 11 10 40 210 1900
17 84 558 Elandspoort 45 1 40 80 500 1500
18 22113 La Motte 59 4 30 60 810 1400
19 69 483 Letjiesbos 34 16 10 35 160 2200
20 34762 Uitenhage 53 12 15 60 480 1600
21 76 884 Albertvale 45 23 10 35 460 1700
22 80 569 Umzoniana 84 26 15 60 820 1200
23 180 439 Insizwa 60 45 10 80 890 1200
24 240 269 Newlands 76 15 15 80 910 1200
25 239 138 Whitson 55 9 10 80 830 1200
26 336283 Nqutu 61 17 15 50 760 1500
27 339415 Hill Farm 85 17 30 80 890 1400
28 483 193 Maliba Ranch 75 54 15 60 740 1400
29 556 088 Mayfern 66 11 15 50 740 1600
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Daily rainfall from TR102

Table 3B.2
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Daily rainfall from TR102 (cont

Table 3B.2
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Daily rainfall from TR102 (conti

Table 3B.2
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APPENDIX 3C
STANDARD FLOOD CALCULATION FORMS
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RATIONAL METHOD (ALTERNATIVE 1)

Description of catchment
River detail
Calculated by | Date |
Physical characteristics
Size of catchment (A) km? Rainfall region |
Longest watercourse (L) km Area distribution factors
Average slope (S.y) m/m Rural () Urban (B) Lakes (y)
Dolomite area (Do) %
Mean annual precipitation (MAP)©@” mm
Rural® Urban@
Surface slope % Factor C, Description %o | Factor | G,
Vleis and pans Lawns
Flat areas Sandy, flat (<2%)
Hilly Sandy, steep (>7%)
Steep areas Heavy soil, flat (<2%)
Total 100 - Heavy soil, steep (>7%)
Permeability % Factor C, Residential areas
Very permeable Houses
Permeable Flats
Semi-permeable Industry
Impermeable Light industry
Total 100 - Heavy industry
Vegetation % Factor C, Business
Thick bush and plantation City centre
Light bush and farm-lands Suburban
Grasslands Streets
No vegetation Maximum flood
Total 100 - Total (Cy) 100 -
Time of concentration (T¢) Notes: |
Overland flow® Defined watercourse
rL 0,467 0787L2 0,385
T, = 0,604[ \/s_} Tc (1 000S,. j
| hours | hours
Run-off coefficient
Return period (years), T 2 5 10 20 50 100 Max
Run-off coefficient, C,
(C] = Cs+ Cp+ Cv)
Adjusted for dolomitic areas, Cip
(: Cl(1 - D%)+C1D%(Z(Dfactorx CS%))@
Adjustment factor for initial saturation, F,®
Adjusted run-off coefficient, C;r
=CipxF)
Combined run-off coefficient Cy
(= aCy1 + BC, +vCs)
Rainfall
Return period (years), T 2 5 10 20 50 100 Max
Point precipitation (mm), Pr®
Point intensity (mm/hour), Pir (= P1/T¢)
Area reduction factor (%), ARFr@
Average intensity (mm/hour), It
(=Pirx ARFy)
Return period (years), T 2 5 10 20 50 100 Max
Peak flow (ms), Q, = —112
3,6
Note: # Reference to the appropriate figures and tables is made in the legend table of this method. R1 - Pagel/2
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RATIONAL METHOD (ALTERNATIVE 1)

LEGEND TABLE Table 3C.1
Rational method (Alt 1) Rural (C))
ID - Reference Component Classification Mean annual precipitation (mm)
© |ygure3s orSA 600 | 600-900 | 900
Weather Services
[0) Table 3C.1 Vleis and pans (<3%) 0,01 0,03 0,05
@ Table 3C.2 Surface slope | Flat areas (3 to 10%) 0,06 0,08 0,11
® | Table 3C.3 (Cy) Hilly (10 to 30%) 0,12 0,16 0,20
g EE;Z ;g‘s‘ Steep areas (>30%) 0,22 0,26 0,30
® Figure 3.'7 Very permeable 0,03 0,04 0,05
® Figure 3.8 (or Permeability | Permeable 0,06 0,08 0,10
Figure 3.26 DM) (Cy) Semi-permeable 0,12 0,16 0,20
Impermeable 0,21 0,26 0,30
Thick bush and plantation 0,03 0,04 0,05
Vegetation Light bush and farm-lands 0,07 0,11 0,15
(Cv) Grasslands 0,17 0,21 0,25
No vegetation 0,26 0,28 0,30
Table 3C.2 Table 3C.3
Urban (Cy) Surface description Recolmmefnded
value of r
Use Factor Paved areas 0,02
Lawns Clean compacted soil, no stones 0,1
Sandy, flat (< 2%) 0,05-0,10 Sparse grass over fairly rough surface 0,3
Sandy, steep (>7%) 0,15-0,20 Medium grass cover 0.4
Heavy soil, flat (< 2%) 0,13-0,17 Thick grass cover 0,8
Heavy soil, steep (>7%) 0,25-0,35
Residential areas
Houses 0,30 - 0,50
Flats 0,50-0,70 Table 3C.4
Industry Adjustment factor to C,
Light industry 0,50 - 0,80 Surface slope classification Ditactor
Heavy industry 0,60 - 0,90 Steep areas (slopes >30%) 0,50
Business Hilly (10 to 30%) 0,35
City centre 0,70 - 0,95 Flat areas (3 to 10%) 0,20
Suburban 0,50 - 0,70 Vleis and pans (slopes <3%) 0,10
Streets 0,70 - 0,95
Maximum flood 1,00
Table 3C.5
Return period (years) 2 5 10 20 50 100
Adjustment factor (F;) for
steep and impermeable 0,75 0,80 0,85 0,90 0,95 1,00
catchments
Adjustment factor (F;) for
flat and permeable 0,50 0,55 0,60 0,67 0,83 1,00
catchments
R1 - Page 2/2
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RATIONAL METHOD (ALTERNATIVE 2)

Description of catchment
River detail
Calculated by | Date |

Physical characteristics
Size of catchment (A) km? Days of thunder per year (R)® | | days/year
Longest watercourse (L) km Weather Service station®
Average slope (S.y) m/m | Weather Service number®
Dolomite area (D) % Area distribution factors
Mean annual precipitation (MAP)©@”" mm Rural (a) Urban (B) Lakes (y)
2-year return period rainfall (M) © mm

Rural® Urban®
Surface slope % Factor C, Description % | Factor \ G,
Vleis and pans Lawns
Flat areas Sandy, flat (<2%)
Hilly Sandy, steep (>7%)
Steep areas Heavy soil, flat (<2%)
Total 100 - Heavy soil, steep (>7%)
Permeability % Factor C, Residential areas
Very permeable Houses
Permeable Flats
Semi-permeable Industry
Impermeable Light industry
Total 100 - Heavy industry
Vegetation % Factor C, Business
Thick bush and plantation City centre
Light bush and farm-lands Suburban
Grasslands Streets
No vegetation Maximum flood
Total 100 - Total (Cy) 100 -
Time of concentration (T¢) Notes:
Overland flow® Defined watercourse
rL 0,467 0787L2 0,385
T. = 0,604{ 5 ] Te (1 000S,. ]
| hours | hours
Run-off coefficient
Return period (years), T 2 5 10 20 50 100 Max
Run-off coefficient, C,
(C] = Cs+ Cp+ Cv)
Adjusted for dolomitic areas, Cip
(: Cl(1 - D%)+C1D%(Z(Dfactorx CS%))©
Adjustment factor for initial saturation, F,@
Adjusted run-off coefficient, C;r
(= C]D X Ft)
Combined run-off coefficient Cr
(= (lcl'[ + BCz + ’YC3)
Rainfall
Return period (years), T 2 5 10 20 50 100 Max
Point precipitation (mm), Pr®
Point intensity (mm/hour), Pir (= P1/T¢)
Area reduction factor (%), ARFr®
Average intensity (mm/hour), It
(=Pirx ARFy)
Peak flow (ms) Q, = STl
3,6

Note: # Reference to the appropriate figures and tables is made in the legend table of this method. R2 - Page 1/2
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RATIONAL METHOD (ALTERNATIVE 2) ‘ J

n-day rainfall data

Weather Service station

Weather Service station number

Mean annual precipitation (MAP) | mm

Coordinates

Duration
(days)

Return period (years), T

5 10 20 50 100 200

1 day

2 days

3 days

7 days

LEGEND TABLE
Rational method (Alt 2)

]

Reference

Figure 3.5 or SA
Weather Services

TR102 or other

Figure 3.9

Table 3C.1

Table 3C.2

Table 3C.3

Table 3C.4

Table 3C.5

® Q066 e elel e

Table 3C.6

Figure 3.10

®e|e

TR102

Table 3C.6

Selection criteria

Calculation method

T < 6 hours

Modified Hershfield equation
P, = 1,13(0,41 + 0,64InT) (= 0,11+ 0,27Int ) (0,79M *“R"*")

6 hours < T¢ < 24 hours

Linear interpolation between calculated modified Hershfield
equation point rainfall and 1-day point rainfall from TR102

Tc > 24 hours

Linear interpolation between n-day point rainfall values from TR102

R2 - Page 2/2
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RATIONAL METHOD (ALTERNATIVE 3)

Description of catchment
River detail
Calculated by | Date |

Physical characteristics
Size of catchment (A) km? Weather Service station®
Longest watercourse (L) km Weather Service number
Average slope (S,) m/m Area distribution factors
Dolomite area (Ds;) % Rural(0) | Urban(B) |  Lakes(y)
Mean annual precipitation (MAP)©" mm

Rural® Urban@
Surface slope % Factor C, Description % | Factor \ C,
Vleis and pans Lawns
Flat areas Sandy, flat (<2%)
Hilly Sandy, steep (>7%)
Steep areas Heavy soil, flat (<2%)
Total 100 - Heavy soil, steep (>7%)
Permeability % Factor C, Residential areas
Very permeable Houses
Permeable Flats
Semi-permeable Industry
Impermeable Light industry
Total 100 - Heavy industry
Vegetation % Factor C, Business
Thick bush and plantation City centre
Light bush and farm-lands Suburban
Grasslands Streets
No vegetation Maximum flood
Total 100 - Total (C,) 100 -
Time of concentration (T¢) Notes:
Overland flow ® Defined watercourse
0 0,467 0.8712 0,385
T. = 0,604[ = J Te (1 000S,. J
| hours | hours
Run-off coefficient
Return period (years), T 2 5 10 20 50 100 Max
Run-off coefficient, C;
(Ci=Cs+ Cp+Cy)
Adjusted for dolomitic areas, Cip
(= Ci( - Dy)+CiDoy(3 (Dsactor X Cs0,)) @
Adjustment factor for initial saturation, F,®
Adjusted run-off coefficient, Ct
=CipxF)
Combined run-off coefficient Cy
(= aCit + BC, +yCs)
Rainfall
Return period (years), T 2 5 10 20 50 100 Max
Point precipitation (mm), Pt ®
Point intensity (mm/hour), Pt (= P1/T¢)
Area reduction factor (%), ARFr @
Average intensity (mm/hour), It
(= Pirx ARFy)
Peak flow (m’/s) Q. = Crlldt
3,6

Note: # Reference to the appropriate figures and tables is made in the legend table of this method. R3 - Page 1/2
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7 |
RATIONAL METHOD (ALTERNATIVE 3) " J
Table 3C.7
LEGEND TABLE Rural (Cy)
Rational method (Alt 3) Component Classification Mean annual rainfall (mm)
ID Reference 600 | 600-900 | 900
© | Figure 3.5 or SA Wetlands and pans (<3%) 0,01 0,03 0,05
o \T”;ﬁteh;é?fmm Surface slope | Flat areas (3 to 10%) 0,06 0,08 0,11
® | Table 3C.8 (Cs) Hilly (10 to 30%) 0,12 0,16 0,20
® Table 3C.9 Steep areas (>30%) 0,22 0,26 0,30
@ Table 3C.10 Very permeable 0,03 0,04 0,05
© | Table3C.11 Permeability | Permeable 0,06 0,08 0,10
© g.lﬂlre 3.12 and Figure (Cp) Semi-permeable 0,12 0,16 0,20
@ Figure 3.8 (or Figure Impermeable 0,21 0,26 0,30
3.26 DM) Thick bush and plantation 0,03 0,04 0,05
Figure 3.10, Figure Vegetation Light bush and farm-lands 0,07 0,11 0,15
3.13 or other (Cv) Grasslands 0,17 0.21 0,25
No vegetation 0,26 0,28 0,30
Table 3C.8 Table 3C.9
Urban (C,) Surface description Re:::ll;n:;lged

e EACLON Paved areas 0,02

Lawns Clean compacted soil, no stones 0,1

Sandy, flat (< 2%) 0,05-0,10 Sparse grass over fairly rough surface 0,3

Sandy, steep (>7%) 0,15-0,20 Medium grass cover 04

Heavy soil, flat (< 2%) 0,13-0,17 Thick grass cover 0,8

Heavy soil, steep (>7%) | 0,25-0,35
Residential areas

Houses 0,30 - 0,50
Flats 0,50 - 0,70 Table 3C.10
Industry Adjustment factor to C,
Light industry 0,50 - 0,80 Surface slope classification Dractor
Heavy industry 0,60 - 0,90 Steep areas (slopes >30%) 0,50
Business Hilly (10 to 30%) 0,35
. Flat areas (3 to 10%) 0,20
City centre 0,70 - 0,95 Wetlands and pans (slopes <3%) 0,10
Suburban 0,50-0,70
Streets 0,70 - 0,95
Maximum flood 1,00
Table 3C.11
Return period (years) 2 5 10 20 50 100
Adjustment factor (F,) for
steep and impermeable 0,75 0,80 0,85 0,90 0,95 1,00
catchments
Adjustment factor (Fy) for
flat and permeable 0,50 0,55 0,60 0,67 0,83 1,00
catchments

Note: # Calculate the point intensity rainfall by making use of the provided Design Rainfall estimation software.
The exact point intensity can be calculated by means of linear interpolation between two consecutive values
considering the time of concentration.

R3 - Page 2/2
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UNIT HYDROGRAPH METHOD

Description of catchment

River detail

Calculated by | Date
Physical characteristics
Size of catchment (A) km? Veld type®
Longest watercourse (L) km Lag (T)®@
Average slope (S.y) m/m Coefficient (Ky) ®
Length to catchment centroid (L¢) km Peak discharge K A m/s
Mean annual precipitation(MAP)©@” mm of unit Q, = T
Catchment L _LLc hydrograph (Qp) -
index e S..
Return period (years), T | T= |
Storm duration (hours), Tsp
Point precipitation (mm), Pr®
Point intensity (mm/hour), Pir (= P1/Tsp)
Area reduction factor, ARF;;®
Average rainfall (mm), Payir (= Pr X ARFip)
Flood run-off factor (%), fir®
Effective rain (mm), heir (= fir X Paygir)
) . Tsp =1 hour Tsp = hours Tsp = hours
(h"(l)"lllrrnsc; (T 2 Q @ | S-curve, | Lagged S- S _S S;-S;r | Lagged S- S _sS S-Sy
’ L Q, S;® curve, Sor L=t Ty, curve, Sor 1= =2 Tgy
Return period (years) | T=
Storm duration (hours), Tsp
Unit Hydrograph peak (m%/s), Qpir®
Peak discharge (m?/s), Q;r (= Qpir X heir)
Adjusted peak for Qpi7/Q, < 1 (m?/s)
LEGEND TABLE
Unit Hydrograph method

ID Reference ID Reference

©) Figure 3.5 or SA Weather Services ® Figure 3.8 (or Figure 3.26 DM for large areas)

©) Figure 3.15 ® Figure 3.17

©) Figure 3.16 @ Table 3.9

® Table 3.6 Paragraph 3.5.2.5 in DM

@ Design rainfall Database or Figure 3.7 ©)] Qpir = Qu X [(S1 — S21)/Tsplmax

U - Page 1/1
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STANDARD DESIGN FLOOD METHOD

THE SOUTH AFRICAN MATIONAL

OGS I

a\

Description of catchment
River detail
Calculated by | Date |
Physical characteristics
Size of catchment (A) km? e GfF 5 10385
. 0,87L
Longest watercourse (L) km concentration T =( j hours
1000S
Average slope (S,,) m/m (Tc) o
SDF basin®" Time of concentration, t (= 60T¢) minutes
2-year return period rainfall (M)® | mm Days of thunder per year (R)® days/year
TR102 n-day rainfall data
Weather Service station Mean annual precipitation (MAP) | | mm
Weather Service station no. Coordinates | &
. Return period (years)
Duration (days) 2 5 10 20 50 100 | 200
1 day
2 days
3 days
7 days
Rainfall
Return period (years), T 2 5 10 20 50 100 200
Point precipitation depth (mm), P,z@
Area reduction factor (%), ARF
(=(90000-128001A + 98301nt)0‘4)
Average intensity (mm/hour), It
(=P.rx ARF / T¢)
Run-off coefficients
Calibration factors® | C, (2-year return period) (%) | Cig0 (100-year return period) (%) |
Return period (years) 2 5 10 20 50 100 200
Return period factors (Y1) 0 0,84 1,28 1,64 2,05 2,33 2,58
Run-off coefficient (Cr),
eS| Cn G
100 \ 2,33 { 100 100
Peak flow (m?/s), Q. = C1l1A
3,6
LEGEND TABLE
Standard Design Flood method
ID Reference ID Reference
©) Figure 3.21 @ Table 3C.12
) Table 3B.1
Table 3C.12
Criteria Calculation method
Modified Hershfield equation
T < 6 hours P,y =1,13(0,41 + 0,64InT) (— 0,11 + 0,27Int) (0,79M “R )
Linear interpolation between calculated modified Hershfield
JLOTS GRS 2 IR equation pl;)I)int rainfall and 1-day point rainfall from TR102
Tc > 24 hours Linear interpolation between n-day point rainfall values from TR102
Note: # Reference to the appropriate figures and tables is made in the legend table of this method. S - Page 1/1
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SCS-SA METHOD

Description of catchment

River detail

Calculated by

Date |

Physical characteristics

Size of catchment (A)

Time of Concentration (T¢)

km?

Defined watercourse

Longest watercourse (L)

km

871>

0
T =| =2
C(10

0,385
00S,, ]

Average slope (S,y)

m/m

Overland flow

L =0,6T,

Lag estimation

hours

T, = 0,604{

rL

0,467
£)

hours

Return period (years)

1:2

1:5

1:10

1:20

1:50

1:100

Daily rainfall depth (one-day design
rainfall, P) (mm) ©

Area reduction facture (only applied
for large catchments, ARF) (%) ©

Catchment design rainfall
(P x ARF/100) (mm)

SOIL®

LAND COVER®

Area
(A
(%)

HRU
Form

Series

Typical
Textural
Class

Depth
(m)

SCS
Group-
ing

Land
Cover
Class

Cover
Category
(S/1/D)

Practice/
Treat-
ment

Storm-
Flow
Potential
@

(T I S OSSR

HRU 1

HRU 2

HRU 3

HRU 4

HRU 5§

Initial Curve Number (CN) @

Final Curve Number ®

Potential maximum soil water
retention (S, mm) ®

Initial losses (mm) | [,=0,128

Return period (years)

1:2 |

1:5 |

1:10

1:20 |

1:50 |

1:100

HRU

Design Stormflow depth (Q;) @

AW |[—

5

Total stormflow depth (3 %}

(mm)

Total runoff volume (V, m’x10°)

Peak discharge (q,, m’/s) ©

Note: # Reference to the appropriate figures and tables is made in the legend table of this method.

C - Page 1/2
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SCS-SA METHOD

LEGEND TABLE
SCS-SA method

ID Reference

Figure 3.12 or Figure
3E.1 to Figure 3E.6

Figure 3.25 or 3.26

Table 3E.1 or 3E.2

Table 3E.3

Table 3E.3

Table 3C.8

Table 3C.9

Table 3C.10

Table 3C.11

0O®0e 0 eV e ©

Table 3C.12

Table 3C.8
Adjustment of Curve Numbers

CN. - 1100
Median Condition Method 1100 AS

CN-II 254
N - CN-TI
Y 70,4036+ 0,0059CN - II

Wet/saturated Conditions

Table 3C.9
25400

Potential maximum soil water retention S = —254
Table 3C.10
(P-Ta)?

Stormflow depth =
P Q=p i ss

forP >1,
Table 3C.11
QA

Stormflow volume V=—n—
1000

Table 3C.12

. o 0,2083AQ
Peak discharge estimation YTl

C - Page 2/2
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EMPIRICAL METHODS

Description of catchment

River detail

Calculated by | Date |
Physical characteristics
Size of catchment (A) km? Veld type®
Longest watercourse (L) km Catchment parameter (C) Co ANS
Length to catchment centroid (Lc) km with regard to reaction time LLc
Average slope (Say) m/m Kovacs region@ |
Mean annual precipitation (P)© mm |
Return period (years), T 10 20 50 100

Constant value for K1 ®

3
Peak flow (m?/s), Qr based Q, =0,0377K,PA%C®

on Midgley & Pitman
Peak flow (m?/s), Qrmr based on Kovacs@® |
Return period (years), T 50 100 200
QT/QRMF ratios®
Peak flow (m*/s), based on Q1/Qgrymr ratios
LEGEND TABLE
Empirical methods
ID Reference ID Reference ID Reference
® youre 3.9 0r SA ® Figure 3.26 ® Table 3C.14
©) Figure 3.15 ©) Table 3C.13 ® Table 3D.1 or 3D.2
Table 3C.13
Constant values of Ky
Return : Veld type (Figure 3.15) -
eriod T 4&
Ii)n years 1 Winter All s SA E Winter All [ : 2
year year
10 0,17 0,42 0,83 0,29 0,59 0,59 0,33 0,67 0,67 0,42 0,50
20 0,23 0,52 1,04 0,40 0,68 0,80 0,45 0,91 0,91 0,57 0,68
50 0,32 0,68 1,36 0,55 0,95 1,11 0,63 1,26 1,26 0,79 0,95
100 0,40 0,80 1,60 0,70 1,20 1,40 0,80 1,60 1,60 1,00 1,20
Table 3C.14
RMEF region classification in southern Africa
Kovacs K* Number of Transition zone Flood zone
region floods # Area range Qrmr Area range Qrmr
(km?) (m?3/s) (km?) (m3/s)
K1 2,8 6 1-500 30A%2% 500 — 500 000 1,74A%7
K2 3.4 12 1-300 50A%2% 300 — 500 000 5,25A%%
K3 4,0 26 1-300 70A% 300 — 300 000 15,9A%¢
K4 4,6 55 1-100 100A%® 100 — 100 000 47,9A%
K5 5,0 155 1-100 100A% 100 — 100 000 100A%
K6 52 61 1-100 100A** 100 — 30 000 145A%%
K7 54 34 1-100 100A*% 100 — 20 000 209A°%4
K8 5,6 25 1-100 100A*¢* 100 — 10 000 302A%
Notes:
* RMF K value as used in Equation 3.32
# Recorded flood data are reflected in the DWAF report TR105 — Maximum flood peak discharges
in South Africa: An empirical approach

E -Page 1/1
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APPENDIX 3D
Q1/Qrvr RATIOS FOR DIFFERENT CATCHMENT AREAS
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Table 3D.1: Q1/Qrumr ratios for different catchment areas in South Africa, Lesotho and

Swaziland ¢
. Return Effective catchment area - A, (km?)
Region period | Ky
(years) <10* 30%* 100 300 1000 3000 | 10000 | 30000 | 100000 | 300000
K8 50 5,06 0,537 0,508 0,474 0,503 0,537 0,570 0,607
(5.6) 100 5,25 0,668 0,645 0,617 0,640 0,668 0,695 0,724
’ 200 | 541 | 0,803 | 0,788 | 0,769 | 0,784 | 0,803 | 0,821 | 0,838
< 50 470 | 0447 | 0416 | 0380 | 0411 | 0447 | 0482 | 0,523
(5.4) 100 4,89 0,556 0,525 0,492 0,523 0,556 0,588 0,623
? 200 5,04 0,661 0,635 0,607 0,633 0,661 0,687 0,716
K6 50 4,50 0,447 0,416 0,380 0,411 0,447 0,482 0,526 0,566
(5.2) 100 4,69 0,556 0,528 0,494 0,524 0,556 0,588 0,626 0,660
’ 200 4,86 0,676 0,650 0,624 0,650 0,676 0,701 0,733 0,758
K5 50 430 | 0447 | 0416 | 0380 | 0411 | 0447 | 0482 | 0,525 | 0,567 | 0,617
(5-exceptin | 100 | 448 | 0,550 | 0,521 | 0488 | 0,517 | 0,550 | 0,582 | 0,619 | 0,657 | 0,699
SW Cape) 200 4,64 0,661 0,636 0,608 0,633 0,661 0,687 0,718 0,748 0,780
K5 50 4,45 0,531 0,502 0,468 0,497 0,531 0,564
(5-G,Hin 100 4,63 0,654 0,629 0,600 0,625 0,654 0,680
SW Cape) 200 4,78 0,777 0,758 0,738 0,757 0,777 0,795
4 50 3,84 | 0416 | 0385 | 0350 | 0381 | 0416 | 0453 | 0496 | 0541 | 0,591
b 100 | 4,04 | 0524 | 0495 | 0462 | 0491 | 0524 | 0,558 | 0,597 | 0,636 | 0,679
? 200 4,20 0,629 0,603 0,576 0,602 0,629 0,660 0,692 0,724 0,758
K3 50 3,26 0,426 0,426 0,426 0,390 0,426 0,463 0,506 0,548 0,602 0,651
) 100 3,50 0,562 0,562 0,562 0,529 0,562 0,595 0,631 0,666 0,710 0,749
200 3,68 0,692 0,692 0,692 0,665 0,692 0,718 0,745 0,771 0,804 0,831
K2 50 2,40 0,317 0,317 0,317 0,281 0,317 0,353 0,398 0,444 0,500 0,560
B 100 | 2,66 | 0428 | 0428 | 0428 | 0391 | 0428 | 0463 | 0,506 | 0,549 | 0,598 | 0,651
) 200 | 291 | 0570 | 0570 | 0,570 | 0,536 | 0570 | 0,600 | 0,638 | 0,672 | 0710 | 0,753

Note:  * Estimated ratios
** Ratios of this region may also be used in region K1 (2,8)

Table 3D.2: Q/Qrumr ratios for different catchment areas in Namibia and Zimbabwe G13)
. Return Effective catchment area - A, (km?)
Region period Ky
(years) <10+ | 30+ | 100 | 300 | 1000 | 3000 | 10000 | 30000 | 100000 | 300000
Namibia
K5 50 450 | 0,562 | 0,534 | 0,501 | 0,529 | 0,562 | 0,594 | 0,631
%) 100 470 | 0,708 0,686 0,661 0,683 0,708 0,732 0,759
200 4,85 0,841 0,828 0,813 0,826 0,841 0,855 0,871
K4 50 4,14 | 0,589 0,561 0,530 0,558 0,589 0,620 0,654 0,690 0,727
(4,6) 100 434 | 0,741 0,721 0,699 0,719 0,741 0,763 0,787 0,811 0,835
200 448 | 0,871 0,860 0,848 0,860 0,871 0,883 0,895 0,909 0,920
K3 50 3,50 0,562 0,562 0,562 0,529 0,562 0,595 0,631 0,666 0,710
&) 100 | 3,66 | 0,676 | 0,676 | 0,676 | 0,648 | 0,676 | 0,703 | 0,731 0,759 | 0,793
200 3,77 | 0,767 0,767 0,767 0,746 0,767 0,788 0,809 0,829 0,856
K2 50 2,88 | 0,550 0,550 0,550 0,517 0,550 0,585 0,619 0,656 0,696
3,4 100 3,01 0,639 0,639 0,639 0,610 0,639 0,669 0,698 0,729 0,762
200 3,13 0,733 0,733 0,733 0,711 0,733 0,758 0,779 0,803 0,828
Zimbabwe
K6 50 465 | 0,531 | 0,502 | 0,468 | 0,497 | 0,531 | 0564 | 0,603 | 0,640
(5,2)%* 100 | 4.86 | 0,676 | 0,652 | 0,625 | 0,649 | 0,676 | 0,702 | 0,731 0,759
200 | 503 | 0822 | 0,807 | 0,791 | 0,806 | 0,822 | 0,838 | 0855 | 0871

Note:  * Estimated ratios
** In region K5 use the same ratios as those applicable to South Africa
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APPENDIX 3E
SCS-SA ADDITIONAL INFORMATION
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Table 3E.1: Example of classification of soils in southern Africa into hydrological soil
groups by soil form, family and textural class (taxonomic classification)

7 Typical Typical
el Code || Soil Family | Textural || >C> Soil Form | Code | Soil Family | Textural | . SC>
Form Grouping Grouping
Class Class
IADDO |Ad 1111 |Glenconnor  |[LmSa IA/B IARCADIA |Ar 1100  |Lonehill Cl IC/D
B IAd 1111 |Glenconnor _ [SaLm B C/D IAr 1100 |Lonehill Cl C/D
IAd 1111 |Glenconnor _ [SaClLm B IAr 1200 [Rustenburg Cl C/D
IAd 1111 |Glenconnor _ [SaCl B/C IAr 1200 [Rustenburg Cl C/D
IAd 1112 |Dalby ILmSa IA/B IAr 2100 Minerva Cl C/D
IAd 1112 |Dalby SaLm B IAr 2100 [Minerva Cl C/D
IAd 1112 |Dalby SaClLm B IAr 2200  |Diepsloot Cl C/D
IAd 1112 |Dalby SaCl B/C IAr 2200  |Diepsloot Cl C/D
IAd 1121  [Centlivres LmSa B IAr 3100  [Bospoort ClL C/D
IAd 1121  [Centlivres SaLm B/C IAr 3100  [Bospoort ClL C/D
IAd 1121  |Centlivres SaClLm B/C IAr 3200  |[Deercroft Cl C/D
IAd 1121 |Centlivres SaCl C IAr 3200  [Deercroft Cl C/D
IAd 1122 |[Kentvale ILmSa B IASKHAM |Ak 1000 |Aroab LmSa IA/B
IAd 1122  [Kentvale SaLm B/C B IAk 1000 |Aroab SalLm B
IAd 1122 [Kentvale SaClLm B/C IAk 1000 |Aroab SaClLm B
IAd 1122 |Kentvale SaCl C Ak 1000 |Aroab SaCl IB/C
IAd 1211  [Spekboom LmSa IA/B Ak 2000  [Noenieput LmSa B
IAd 1211  [Spekboom SaLm B IAk 2000  [Noenieput SaLm B/C
IAd 1211 |Spekboom SaClLm B Ak 2000  [Noenieput SaClLm _ |B/C
IAd 1211  |Spekboom SaCl B/C IAk 2000  |[Noenieput SaCl B/C
IAd 1212 |Gorah L mSa IA/B IAUGRABIE |Ag 1110 |[Hefnaar LmSa IA/B
IAd 1212 |Gorah SalLm B B Ag 1110  |[Hefnaar SalLm B
IAd 1212 |Gorah SaClLm B Ag 1110 [Hefnaar SaClLm B
IAd 1212 |Gorah SaCl B/C Ag 1110 [Hefnaar SaCl IB/C
IAd 1221 [Walkraal LmSa B Ag 1120  |Giyani LmSa B
IADDO |Ad 1221 [Walkraal SaClLm B/C Ag 1120 |Giyani SalLm IB/C
B IAd 1221 [Walkraal SaCl C Ag 1120 |Giyani SaClLm [B/C
IAd 1222 |Sylvania ILmSa B Ag 1120 |Giyani SaCl C
IAd 1222  [Sylvania SalLm B/C Ag 1210  |Khubus L mSa IA/B
IAd 1222  [Sylvania SaClLm B/C Ag 1210  |Khubus SaLm B
IAd 1222  [Sylvania SaCl C Ag 1210 |Khubus SaClLm B
IAd 2111 Maurmond LmSa A/B Ag 1210 [Khubus SaCl B/C
IAd 2111 [Maurmond SalLm B IAg 1220 |Shilowa LmSa B
IAd 2111  [Maurmond SaClLm B LEGEND
IAd 2111  [Maurmond SaCl B/C A - low runoff potential
IAd 2112 |Airedale LmSa IA/B B - moderately low potential
IAd 2112 |Airedale SalLm B C - moderately high potential
IAd 2112 |Airedale SaClLm B D - high runoff potential
IAd 2112 |Airedale SaCl B/C Sa - sand
IAd 2121  |Felsenheim LmSa B Cl - clay
IAd 2121  |Felsenheim SalLm B/C Lm - loam
IAd 2121  |Felsenheim SaClLm B/C
IAd 2121  |Felsenheim SaCl C
IAd 2122 |Longhill ILmSa B
IAd 2122 |Longhill SaLm B/C
IAd 2122  |Longhill SaClLm B/C
IAd 2122 |Longhill SaCl C
IAd 2211 |Mimosa LmSa A/B
IAd 2211  [Mimosa SalLm B
IAd 2211  [Mimosa SaClLm B
IAd 2211  [Mimosa SaCl B/C
IAd 2212 |Peperboom ILmSa A/B
IAd 2212 [Peperboom SalLm B
IAd 2212 |Peperboom SaClLm B
IAd 2212 |Peperboom SaCl IB/C
IAd 2221  |Suttondale LmSa B
IAd 2221  |Suttondale SalLm B/C
IAd 2221  |Suttondale SaClLm B/C
IAd 2221  |Suttondale SaCl C
IAd 2222  [Tregaron ILmSa B
IAd 2222  [Tregaron SaClLm B/C
IAd 2222  [Tregaron SaCl C
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Table 3E.2: Example of classification of soils in southern Africa into hydrological
soil groups by soil form and series (binomial classification)

Typical SCS Typical SCS
Soil Form Code Soil Series | Textural . Soil Form Code | Soil Series | Textural .
Grouping Grouping
Class Class
IARCADIA |Ar 40 |Arcadia Cl C/D IBAINSVLEI |Bv 14 Wykeham [SalLm IA/B
C/D Ar 11 IBloukrans Cl IC/D IBONHEIM Bo 41 IBonheim ILmSa C/D
Ar 21 Clerkness Cl C/D C IBo20  |Bushman  [SaClLm C
IAr 41 Eenzaam Cl C/D Bo 30 |Dumasi SaClLm C
IAr 20 Gelykvlakte Cl C/D Bo 31 Glengazi SaCl C/D
Ar 10 Mngazi Cl C/D Bo 10 Kiora SaClLm C
IAr 32 |Nagana Cl C/D Bo 21 IRasheni SaCl C/D
Ar 12 [Noukloof Cl C/D Bo 11 Stanger SaCl C/D
Ar 31 IRooidraai Cl C/D Bo 40  |Weenen SaClLm C
IAr 30 IRydalvale Cl C/D CARTREF Cf 10 |IAmabele LmSa B/C
Ar 42 |Wanstead Cl C/D C Cf12 \Arrochar SaClLm C
Ar 22 [Zwaarkrygen [Cl C/D Cf13 Byrne SaCl C/D
IAVALON IAv 13 |Ashton SalLm A/B Cf21 Cartref SalLm C
B IAv 26 |Avalon SaClLm B Cf22 Cranbrook [SaClLm C
IAv 12 Banchory Sa A Cf 30 Grovedale [Sa B/C
IAv 27  |Bergville SaCl B/C Cf31 Kusasa SaLm B/C
IAv 37  |Bezuidenhout [SaCl C Cf32 INoodhulp  [SaClLm C
IAv 33  Bleeksand SaLm IB/C Cfl11 Rutherglen [SalLm C
IAv 34 Heidelberg SaLm IB/C Cf20 \Waterridge |[LmSa B/C
IAv 20  [Hobeni ILmSa IA/B CHAMPAGNE |Ch 11 IChampagne [SaLm D
IAv 14  [Kanhym SalLm IA/B D Ch 21 Ivanhoe SaClLm D
IAv 24 |Leksand SaLm B Ch 10  [Mposa SalLm D
Av 10 [Mastaba LmSa A ICh 20  |Stratford SaClLm D
AVALON IAv 32 Middelpos Sa B CLOVELLY |Cv33 |Annandale [SalLm B
B IAv31  [Mooiveld ILmSa B IA/B Cv 18 Balgowan |Cl B
IAv 25  [Newcastle SaLm IA/B Cv 40 IBleskop LmSa A
IAv 17 Normandien SaCl B Cv 36 |Blinkklip  [SaClLm B
IAv 22 |Rossdale Sa IA/B Cv 17 _ [Clovelly SaCl B
IAv 16 [Ruston SaClLm [B Cv 28 Clydebank |Cl B
IAv 36 |Soetmelk SaClLm _ [B/C Cv 35 IDenhere SaLm IA/B
IAv 21 |Uithoek LmSa IA/B Cv 46 |Dudfield SaClLm IA/B
IAv 30 |Viljoenskroon |LmSa B Cv 1l Geelhout  [LmSa A
IAv 23 |Villiers SaLm B Cv 25 Gutu SaLm A
Av 11  [Welverdien LmSa A Cv 47 Klippan SaCl B
IAv 35  |Windmeul SaLm B Cv 38  [Klipputs Cl B/C
Av 15 |Wolweberg SaLm A Cv 10 |Lismore ILmSa A
IBAINSVLEI [Bv23 |Ashkelon SalLm A/B LEGEND
IA/B Bv 36  |Bainsvlei SaClLm B A - low stormflow potential
Bv 12 |Camelot Sa A B - imoderately low potential
Bv 20  |Chelsea ILmSa A C - imoderately high potential
Bv 30  [Delwery ILmSa IA/B D - high stormflow potential
Bv 13 |[Dunkeld SaLm IA/B Sa - sand
Bv 16  |Elysium SaClLm [A/B Cl - clay
Bv 10 |Hlatini ILmSa A Lm - loam
Bv 34  |Kareekuil SalLm B
Bv 31  [Kingston ILmSa IA/B
Bv 26 |Lonetree SaClLm _ |A/B
Bv 25  |Maanhaar SaLm A
Bv 11l |Makong ILmSa A
Bv 27  Metz SaCl B
Bv 22  |Oosterbeek Sa A
Bv 37  |Ottosdal SaCl IB/C
Bv 24  |[Redhill SaLm IA/B
Bv 32 [Trekboer Sa IA/B
Bv 15 Tygerkloof SaLm A
Bv 33  [Vermaas SalLm B
Bv 21  [Vungama ILmSa A
Bv 35 [Wedgewood  [SaLm IA/B
Bv 17 [Wilgenhof SaCl B
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Table 3E.3 Initial Curve Numbers for selected land cover and treatment classes,
stormflow potentials and hydrological soil groups (various sources)

Land Cover Land Treatment/ Practice/Description Stormflow Hydrological Soil Group
Class Potential | A ([A/B| B |B/C|C [C/D| D
1 = Straight row 77| 82(86| 89|91| 93 94
Fallow 2 = Straight row + conservation tillage High 75| 80| 84| 87|89 91 92
3 = Straight row + conservation tillage Low 74| 79|83| 85|87| &9 90
1 = Straight row High 72| 77181| 85|88| 90 91
2 = Straight row Low 67| 73|78| 82|85| 87 89
3 = Straight row + conservation tillage High 71 75179| 83|86| 88 89
4 = Straight row + conservation tillage Low 64| 7075 79|82 84 85
5 = Planted on contour High 701 75179 82|84| 86 88
Row Crops 6 = Planted on contour Low 65| 69|75| 79|82 84 86
7 = Planted on contour + conservation tillage High 69| 74|78 81|83| 85 87
8 = Planted on contour + conservation tillage Low 64| 70|74 78|80| 82 84
9 = Conservation structures High 66| 70|74 77|80| 82 82
10 = Conservation structures Low 62| 67|71 75|78| 80 81
11 = Conservation structures + conservation tillage High 65| 7073 76|79 80 81
12 = Conservation structures + conservation tillage Low 61| 6670 73|76| 78 79
1 = Straight row Low 45| 56|66 72|77 80 83
Garden Crops . .
2 = Straight row High 68| 71|75| 79|81| 83 84
1 = Straight row High 65| 71|76| 80|84| 86 88
2 = Straight row Low 63| 69|75 79|83| 85 87
3 = Straight row + conservation tillage High 64| 70|74 78|82 84 86
4 = Straight row + conservation tillage Low 60| 67|72 76|80| 82 84
5 = Planted on contour High 63| 69|74 79|82| 84 85
6 = Planted on contour Low 61| 67|73 78|81| 83 84
Small Grain 7 = Planted on contour + conservation tillage High 62| 68|73 77|81 83 84
8 = Planted on contour + conservation tillage Low 60| 66|72 76|79| 81 82
9 = Planted on contour - winter rainfall region Low 63| 66|70 75|78 80 81
10 = Conservation structures High 61| 67|72 76|79 81 82
11 = Conservation structures Low 59| 65[70( 75|78 80 81
12 = Conservation structures + conservation tillage High 60| 67|71 75|78| 80 81
13 = Conservation structures + conservation tillage Low 58| 64169 73|76| 78 79
1 = Straight Row High 66| 72|77| 81|85 87 89
Close Seeded 2 = Straight Row Low 58| 65|72 75|81| 84 85
Legumes or 3 = Planted on contour High 64| 70|75| 80|83| 84 85
Rotational 4 = Planted on contour Low 55| 63|69| 74|78| 81| 83
Meadow 5 = Conservation structures High 63| 68|73 77|80| 82 83
6 = Conservation structures Low 51| 60|67 72|76| 78 80
1 = Straight row: trash burnt 43| 55|65 72|77| 80 82
2 = Straight row: trash mulch 45| 56|66 72|77 80 83
3 = Straight row: limited cover 67| 73|78 82|85| 87 89
Sugarcane 4 = Straight row: partial cover 491 60|69 73[79| 82 84
5 = Straight row: complete cover 39| 50|61| 68|74 78 80
6 = Conservation structures: limited cover 65| 70|75| 79|82| &4 86
7 = Conservation structures: partial cover 25| 46|59| 67|75 80 83
8 = Conservation structures: complete cover 6 14(35| 59|70 75 79
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Table 3E.3 Initial Curve Numbers for selected land cover and treatment classes,
stormflow potentials and hydrological soil groups (various sources) (continued)

Land Cover Land Treatment/ Practice/Description Stormflow Hydrological Soil Group
Class Potential | A [A/B|B |B/C|C|C/D| D
1 = Veld/pasture in poor condition High 68| 74179| 83|86 88 89
2 = Veld/pasture in fair condition Moderate 49| 61|69 75|79| 82 84
Veld (range) 3 = Veld/pasture in good condition Low 39| 51(61| 68|74| 78 80
and Pasture 4 = Pasture planted on contour High 47| 57|67| 75|81 85 88
5 = Pasture planted on contour Moderate 25| 46(59| 67|75 80 83
6 = Pasture planted on contour Low 6 14|35 59(70| 75 79
Irrigated Pasture Low 35| 41(48| 57|65| 68 70
Meadow Low 30| 45|58| 65|71 75 81
1 =Woods High 45| 56|66| 72|77| 80 83
2 = Woods Moderate 36| 49|60| 68|73 77 79
Woods and Scrub
3 =Woods Low 25| 47|55| 64|70 74 77
4 = Brush - Winter rainfall region Low 28| 36|44| 53|60| 64 66
Orchards 1 = Winter rainfall region, understory of crop cover 39| 44(53] 61|66 69 71
1 = Humus depth 25mm; Compactness: compact 52| 62|72 77|82| 85 87
2= " " " moderate 48| 58|68 73|78| 82 85
3= " " " loose/friable | 37| 49|60| 66|71| 74 77
4 = Humus depth 50mm; Compactness: compact 48| 58|68 73|78| 82 85
5= " " " moderate 42| 54|65 70|75 78 81
Forests & 6= " " " loose/friable | 32| 45|57| 62|67| 71| 74
Plantations
7 = Humus depth 100mm; Compactness: compact 41| 53|64| 69|74 77 80
8= " " " moderate 34| 47|59| 64|69 72 75
9= " " " loose/friable | 23| 37|50 56|61| 64 67
10 = Humus depth 150mm; Compactness: compact 371 49]60| 66|71 74 77
1= " " " moderate 30| 43(56| 61|66| 69 72
2= " " " loose/friable | 18| 33 (47| 52|57| 61 65
1 = Open spaces, parks, cemeteries  75% grass cover 39| S1(61| 68|74 78 80
2 = Open spaces, parks, cemeteries  75% grass cover 49| 61|69 75|79 82 84
3 = Commercial/business areas 85% grass cover 89| 91(92| 93|94 95 95
4 = Industrial districts 72% impervious 81| 85(88| 90(91| 92 93
5 = Residential: lot size 500m’ 65% impervious 77| 81(85| 88|90 91 92
6= " " 1000m? 38% impervious 61| 69|75 80|83| 85 87
Urban/Sub- 7= " " 1350m®  30% impervious 57| 6s|72| 77|81| 84| 86
urban Land Uses 2 . .
g§= " " 2000m 25% impervious 54| 63|70 76|80| 83 85
9= " " 4000m* 20% impervious 51| 61|68 75|78| 82 84
10 = Paved parking lots, roofs, etc. 98| 98(98| 98|98 98 98
11 = Streets/roads: tarred, with storm sewers, curbs 98| 98(98| 98|98 98 98
12=" gravel 76| 81|85| 88|89| 90 91
13=" dirt 72| 77(82| 85|87| 88 89
4= " dirt-hard surface 741 79|84| 88|90| 91 92

A-278

Appendices



3 f 4
b= F=
24 G ) [2¢

~ L1
25" o - 25"
26° M= ﬁ&l 26*
27 - (, - A, a7
) o o )
_ prte ? Dl
N v S0
% 4 Sy | g [28°
Sramgeugne R“""'&Jﬁf'l’. ~ \‘/_\‘_/'/ : /"J / .
{ ol & , l ll‘!’tllr’\\ et
29 \k 7 1] L " LN / TOtMEONTE 2g:
J 1
30° & 30"
E [31°
3 3
E23 330
(YS /. / 1 Day 2 Year Return Period Rainfall (mm) |24
] International and Provincial Boundaries
49 T T T Y T T T T T T ' Y ¥ T r T T ¥ 30
16° 17" 18" 19" 20" 21" 22 23 24" 25" 26" 2r 28" 29° 30" 3 kel 33 34

Figure 3E.1: One-day design rainfall distribution over southern Africa for 2 year return

period
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Figure 3E.2: One-day design rainfall distribution over southern Africa for 5 year return

period
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Figure 3E.3: One-day design rainfall distribution over southern Africa
for 10 year return period
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Figure 3E.4: One-day design rainfall distribution over southern Africa
for 20 year return period
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Figure 3E.5: One-day design rainfall distribution over southern Africa
for 50 year return period
16° 17 18° 19 20° 21 22" 23 24" 25° 26" 27 31 32" 3 34
3 23
2 24
25 28"
2 -
7 Far
nomub )31, ) ‘?fm ko
O 3 /el \2 _
2w L nm.l-m- /D \ -‘;\b %
>~ umsrprey - % \' ) - )
290 7 notmoull’ﬁ\""% r’/T_c - f 29
@ wibguIR & %)
300 O\ & —_ -
an Fa1*
az o
33 Ea
. Town/City
LTS /. /1 Day 100 Year Return Period Rainfall (mm) |34
[ International and Provincial Boundaries
35 Y y ’ Y T T Y y y T Y Y r g Y Y y Y )
16° 17 18 19° 200 2 22 2% 24 28 % I W 2% 3 E N - S - 34

Figure 3E.6: One-day design rainfall distribution over southern Africa
for 100 year return period
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